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Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special sta-
tus or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it in-
tended to imply that the entities, equipment, products, or materials are necessarily the best available

for the purpose.

National Institute of Standards and Technology Special Publication 1800-25C, Natl. Inst. Stand. Technol.
Spec. Publ. 1800-25C, 489 pages, (December 2020), CODEN: NSPUE2

As a private-public partnership, we are always seeking feedback on our practice guides. We are
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you
have implemented the reference design, or have questions about applying it in your environment,
please email us at ds-nccoe@nist.gov.

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
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Gaithersburg, MD 20899
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework
and details the steps needed for another entity to re-create the example solution. The NCCoE was
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County,
Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit

https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe regulations
or mandatory practices, nor do they carry statutory authority.

Ransomware, destructive malware, insider threats, and even honest user mistakes present ongoing
threats to organizations. Organizations’ data, such as database records, system files, configurations,
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user files, applications, and customer data, are all potential targets of data corruption, modification, and
destruction. Formulating a defense against these threats requires two things: a thorough knowledge of
the assets within the enterprise, and the protection of these assets against the threat of data corruption
and destruction. The NCCoE, in collaboration with members of the business community and vendors of
cybersecurity solutions, has built an example solution to address these data integrity challenges.

Multiple systems need to work together to identify and protect an organization’s assets against the
threat of corruption, modification, and destruction. This project explores methods to effectively identify
assets (devices, data, and applications) that may become targets of data integrity attacks, as well as the
vulnerabilities in the organization’s system that facilitate these attacks. It also explores methods to
protect these assets against data integrity attacks using backups, secure storage, integrity checking
mechanisms, audit logs, vulnerability management, maintenance, and other potential solutions.
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attack vector; asset awareness; data integrity; data protection; malicious actor; malware; ransomware
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The following volumes of this guide show information technology (IT) professionals and security
engineers how we implemented this example solution. We cover all of the products employed in this
reference design. We do not re-create the product manufacturers’ documentation, which is presumed
to be widely available. Rather, these volumes show how we incorporated the products together in our
environment.

Note: These are not comprehensive tutorials. There are many possible service and security
configurations for these products that are out of scope for this reference design.

1.1 How to Use this Guide

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a
standards-based reference design and provides users with the information they need to replicate the
data integrity identify-and protect-solution. This reference design is modular and can be deployed in

whole or in part.
This guide contains three volumes:

= NIST SP 1800-25A: Executive Summary
= NIST SP 1800-25B: Approach, Architecture, and Security Characteristics — what we built and why

= NIST SP 1800-25C: How-To Guides — instructions for building the example solution (you are
here)

Depending on your role in your organization, you might use this guide in different ways:

Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary (NIST SP 1800-25A), which describes the following topics:

= challenges that enterprises face in identifying assets and protecting them from data integrity
events

= example solution built at the NCCoE
= benefits of adopting the example solution

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in NIST SP 1800-25B, which describes what we did and why. The
following sections will be of particular interest:
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= Section 3.4.1, Assessing Risk Posture, provides a description of the risk analysis we performed.

= Section 3.4.2, Security Control Map, maps the security characteristics of this example solution
to cybersecurity standards and best practices.

You might share the Executive Summary, NIST SP 1800-25A, with your leadership team members to help
them understand the importance of adopting standards-based data integrity solutions.

IT professionals who want to implement an approach like this will find the whole practice guide useful.
You can use this How-To portion of the guide, NIST SP 1800-25C, to replicate all or parts of the build
created in our lab. This How-To portion of the guide provides specific product installation, configuration,
and integration instructions for implementing the example solution. We do not recreate the product
manufacturers’ documentation, which is generally widely available. Rather, we show how we
incorporated the products together in our environment to create an example solution.

This guide assumes that IT professionals have experience implementing security products within the
enterprise. While we have used a suite of commercial products to address this challenge, this guide
does not endorse these particular products. Your organization can adopt this solution or one that
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and
implementing parts of a data integrity identify-and-protect solution. Your organization’s security experts
should identify the products that will best integrate with your existing tools and IT system
infrastructure. We hope that you will seek products that are congruent with applicable standards and
best practices. Section 3.5 of Volume B, Technologies, lists the products we used and maps them to the
cybersecurity controls provided by this reference solution.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and
success stories will improve subsequent versions of this guide. Please contribute your thoughts to ds-

nccoe@nist.gov.

1.2 Build Overview

The National Cybersecurity Center of Excellence (NCCoE) built a hybrid virtual-physical laboratory
environment to explore methods to effectively identify assets and protect them against a data
corruption event in various IT enterprise environments. The NCCoE also explored identifying
vulnerabilities in advance of an incident. The servers in the virtual environment were built to the
hardware specifications of their specific software components.
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The NCCoE worked with members of the Data Integrity Community of Interest to develop a diverse but
noncomprehensive set of use case scenarios against which to test the reference implementation. These
are detailed in Volume B, Section 5.2. For a detailed description of our architecture, see Volume B,
Section 4.

Typographic Conventions

The following table presents typographic conventions used in this volume.

Typeface/Symbol Meaning Example
Italics file names and pathnames; For language use and style guidance,
references to documents see the NCCoE Style Guide.

that are not hyperlinks; new
terms; and placeholders

Bold names of menus, options, Choose File > Edit.
command buttons, and
fields

Monospace command-line input, on- mkdir

screen computer output,
sample code examples, and
status codes

Monospace Bold command-line user input service sshd start
contrasted with computer
output
blue text link to other parts of the All publications from NIST’s NCCoE
document, a web URL, or an | are available at
email address https://nccoe.nist.gov.
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2 Product Installation Guides

This section of the practice guide contains detailed instructions for installing and configuring all of the
products used to build an instance of the example solution.

2.1 Active Directory and Domain Name System (DNS Server)

As part of our enterprise emulation, we included an Active Directory server that doubles as a DNS
server. This section covers the installation and configuration process used to set up Active Directory and
DNS on a Windows Server 2012 R2 machine.

2.1.1 Installing Features

1. Open Server Manager.

Server Manager * D

WELCOME TO SERVER MANAGER

@ configure this local server

B§ fite and Storage Services P
CHACK START

‘wrﬁm\u

! FEARN MORE
ROLES AND SERVER GROUPS

K File and Storage
Sefvices

(T Manageaniity (T} Manageasility (D Manageatiity
Events | B
Pertormance services Seraces
BPA results Performans e Ferformance

8P reawlts £PA remwilts

2. Click the link Add roles and features.
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Before you begin

Installation Type

Server Selaction

DESTINATION SERVER
WIN-RMHOZISELND

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
hosting a website.

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Metwork settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[[] Skip this page by default

< Previous | | Nes = | | Install || Cancel

3. Click Next.

4. Select Role-based or feature-based installation.
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DESTINATION SERVER

Select installation ‘[ype WIN-RMHOZISELNO

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

Before You Begin

@ Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

Server Selection

() Remote Desktop Services i
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.

<Previous | [ Nwt> | | Instal | [ Cancel

5. Click Next.
6. Select Select a server from the server pool.
7. Select the intended Active Directory server.
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DESTINATION SERVER

Select destination server AD.DNS

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Installation Type (®); Select a server from the server pool

) Select a virtual hard disk

Server Roles Server Pool
Features
Filter: |
MName IP Address Operating System

AD-DNS L Microsoft Wind

1 Computerl(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

< Previous ﬂe_ﬂL> | Install | | Cancel

8. Click Next.
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Select server roles

Before You Begin
Installation Type

Server Selection

Features

Select one or more roles to install on the selected server.

DESTIMATION SERVER
AD-DNS

Roles Description
. : 7 5 ~ Active Directory Domain Services
[ Active Drectury Cerllfla Services — (AD DS} stores information about
Dir nain Serv objects on the network and makes
Active Directory Federation Services this information available to users
[] Active Directory Lightweight Directory Services anc o fk administraioe: #D D3
uses domain controllers to give
[] Active Directory Rights Management Services network users access to permitted
[] Application Server s resources anywhere on the network
[] DHCP Server through a single logon process.
[] DMNS Server
[ Fax Server
> [®] File and Storage Services (1 of 12 installed)
[ Hyper-V
[] Network Policy and Access Services -
[] Print and Document Services
[ Remaote Access
[[] Remote Desktop Services —
v
| < Previous | | Mext = | | Install | | Cancel

9. Check the box next to Active Directory Domain Services.
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Add Roles and Features Wizard = IEl

WI

DESTINATION SERVER

Select server roffig

AD-DNS
— W,
Add features that are required for Active Directory
i i 74
Domain Services? =
You cannot install Active Directory Domain Services unless the irechory_r Domﬂif_l Services
following role services or features are also installed. stores information about
bn the network and makes
[Tacls] Group Policy Management ation available to users

ork administrators. AD DS

ain controllers to give
4 Role Administration Tools users access to permitted

4 AD DS and AD LDS Tools = al_'l]rwhere on the network
Active Directory module for Windows PowerShell asingle logon/process.

4 AD DS Tools

4 Remote Server Administration Tools

[Tools] Active Directory Administrative Center
[Tools] AD DS Snap-Ins and Command-Line Tools

Include management tools (if applicable)

|MdFeat{\sH Cancel ‘

| < Previous | | Next > | | Install | | Cancel

10. Click Add Features.
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Select server roles ASiois

Select one or more roles to install on the selected server.

Before You Begin

Installation Type Roles Description
SEnEL kelion [ Active Directory Certificate Services (4] f:;“;;;’;f;"{n?;’::;;e;‘:ﬁ
e Directory Domain Services| objects on the network and makes
Features [] Active Directory Federation Services this information available to users
AD DS [] Active Directory Lightweight Directory Services and ”e“’“’fk Al P‘D s
uses domain controllers to give
Confirmation [ Active Directory Rights Management Services network users access to permitted
[] Application Server s TEsOUrces al_'l)rwhere on the network
] DHCP Server through a single logon process.
[] DNS Server
[] Fax Server
p [® File and Storage Services (1 of 12 installed)
O Hyper-v
[] Network Policy and Access Services ]
[ Print and Document Services
[] Remote Mccess
[J Remote Desktop Services ]

< Brevious | [ Next | install | [ Cancel

11. Click Next.
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Select features

Before You Begin
Installaticn Type

Server Selection

Server Roles

AD DS

Confirmation

Select one or more features to install on the selected server.

Features

[ [H] .MET Framewark 4.5 Features (2 of 7 installed)

P O Background Intelligent Transfer Service (BITS)
[] BitLocker Drive Encryption
[ BitLocker Network Unlock
[ BranchCache
[] Client for NFS
[] Data Center Bridging
[] Direct Play
[] Enhanced Storage
[] Failover Clustering
Group Policy Management
[1 115 Hostable Web Core
[ Ink and Handwriting Services

—ag = =

| >

<] " |

DESTIMATION SERVER
AD-DNS

Description

.MET Framework 3.5 combines the
power of the .NET Framework 2.0
APls with new technologies for
building applications that offer
appealing user interfaces, protect
your customers' personal identity
information, enable seamless and
secure communication, and provide
the ability to model a range of
business processes.

< Previous ﬂ% = | Install

| [ cancel

12. Click Next.
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Before You Begin
Installation Type
Server Selection

Server Roles

Features

Confirmation

DESTINATION SERVER

Active Directory Domain Services AD-DNS

Active Directory Domain Services (AD DS) stores information about users, computers, and other devices
on the network. AD DS helps administrators securely manage this information and facilitates resource
sharing and collaboration between users. AD DS is also required for directory-enabled applications

such as Microsoft Exchange Server and for other Wind Server technologies such as Group Policy.

Things to note:

* To help ensure that users can still log on to the network in the case of a server outage, install a
minimum of two domain controllers for a domain.

AD DS requires a DNS server to be installed on the network. If you do not have a DNS server
installed, you will be prompted to install the DNS Server role on this machine.

Installing AD DS will also install the DFS Namespaces, DFS Replication, and File Replication services
which are required by AD DS,

install | [ Cancel

13. Click Next.
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DESTINATION SERVER

Confirm installation selections ADioiiE

Before You Begin To install the following roles, role services, or features on selected server, dlick Install.

Installation Type [] Restart the destination server automatically if required
server Selection Optional features (such as administration tools) might be displayed on this page because they have
| been selected automatically. If you do not want to install these optional features, click Previous to clear
SERELRDS their check boxes.
Features
AD DS Active Directory Domain Services

Group Policy Management

Remaote Server Administration Tools
Reole Administration Tools
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD DS Tools
Active Directory Administrative Center
AD DS Snap-Ins and Command-Line Tools

Export configuration settings
Specify an alternate source path

<Previous || Nea> | [ pinstall | [ cancel

14. Click Install.
15. Wait for the installation to complete.
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DESTINATION SERVER

Installation progress ap-0ns

View installation progress

o Feature installation
N
Configuration required. Installation succeeded on AD-DNS.

Active Directory Domain Services A
Additional steps are required to make this machine a domain controller.
Promaote this server to a domain controller
Group Policy Management
Remote Server Administration Tools
Role Administration Tools =
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD DS Tools
Active Directory Administrative Center | |
AD DS Snap-Ins and Command-Line Tools | v

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

< Previous | | Next > | fﬂose | | Cancel

16. Click Close.
[

A Post-deplaymens Configura_ |

e R —

Canfiquestion required far Active Directoey Daain
: “"’m' . Services at AD-DNS t
: ::am o Configure this local server Proee s g 1. domi conils
) Festure instaliation

BB Filo and Storage Services b (et PMETTR

ation requied Inctallation succeeded an

AD-ONS.

ekl Rises anet Faaturet

4 Task Datade
ol o Hde
ROLES AND SERVER GROUPS
Roles2 | Servergroups: 1 | Servers totat 1
Fite and Storage
AD 1 1
il b3 R Services
@ manageability (D Manageatility | @ manageabitity (D Mansgeavility
Events Events | B [
Seracts Performance Senicns Services
Porfarmance: BEA resailts Performance: Pestormance
BPA results BPA results B results

2017 235 PM

17. Click Promote this server to a domain controller.
18. Select Add a new forest.
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19. Enter a Root domain name.

Deployment Configuration

iguration

Select the deployment cperation
Domain Centroller Options

) Add a domain controller to an existing domain
Additional Options

) Add a new domain to an existing forest

Paths ® Add a new forest

Review Cptions 2 2z : ¢ _
Specify the domain information for this operation

Prereguisitas Check

Root domain name: | DI.IPDd

More about deployment configurations

TARGET SERVER
AD-DNS

< Previous MNext i | Install

| | Cancel

20. Click Next.

21. Select Windows Server 2012 R2 for Forest functional level and Domain functional level.

22. Check the box next to Domain Name System (DNS) server.
23. Enter a password.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events
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< Previous ﬂm

- - TARGET SERVER
Domain Controller Options it
Deployment Configuration | . -
| Select functional level of the new forest and root domain
DNS Options Forest functional level: | Windows Server 2012 R2 | = |
Additional Cptions Domain functional level: | Windows Server 2012 R2 | - |
Paths S 2 .
pecify domain controller capabilities
BeVEWOpon: Domain Name System (DNS) server
Prereguisites Chack Global Catalog (GC)
[] Read only domain controller (RODC)
Type the Directory Services Restore Mode (DSRM) password
Password: sssssssssssssse
Confirm password: -|
More about domain controller options
[ nstall | [ cancel

24. Click Next.

DNS Options

Deployment Configuration | = _ :
Specify DNS delegation options

Domain Controller Options | x
| [ Create DNS delegation

Additional Cptions
Paths

Review Cptions

Prareguisites Chack

More about DNS delegation

TARGET SERVER
AD-DNS
<Brevious | [ Nep> | | instal || Cancel
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25. Click Next.

26. Ve

rify the domain name.

TARGET SERVER

Additional Options AD-DNS

Deployment Configuration . - s g
Verify the NetBIOS name assigned to the domain and change it if necessary

Domain Controller Options

DN5 Options

The NetBIOS domain name: [o]]

Paths
Review Cptions

Prereguisites Chack

< Previous ﬂﬂ) | Install | | Cancel

27. Click Next.
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Paths

Deployment Configuration

Domain Controller Options
DNS Options
Additional Cptions

Review Cptions

Prereguisitas Chack

TARGET SERVER
AD-DNS

Specify the location of the AD DS database, log files, and SYSVOL

Database folder: CAWindows\NTDS [-]
Log files folder: CAWindows\NTDS =]
SYSVOL folder: CAWindows\SYSVOL [-]
More about Active Directory paths

< Previous | | M S | | Install | | Cancel

28. Click Next.

Review Options

Deployment Configuration

Domain Controller Options
DNS Options

Additional Options

Paths

Prereguisites Chack

TARGET SERVER
AD-DNS
Review your selections:
Configure this server as the first Active Directory domain controller in a new forest. E
The new domain name is "DLIPDR". This is also the name of the new forest.
The NetBIOS name of the demain: DI =
Forest Functional Level: Windows Server 2012 R2
Domain Functional Level: Windows Server 2012 R2 | |
Additional Options:
Global catalog: Yes
DNS Server: Yes
Create DNS Delegation: No z

These settings can be exported to a Windows PowerShell script to
additional installations

View script

More about installation options

< Previous || Nef = | | Install || Cancel
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29. Click Next.

o TARGET SERVER
Prerequisites Check AD-DNS
| ® Al prerequisite checks passed successfully. Click ‘Install’ to begin installation. Show mare x

Deployment Configuration e . _ ’ - T .
Prerequisites need to be validated before Active Directory Domain Services is installed on this

Domain Controller Cptions | computer

DNS Options
Additional Cptions
Paths ~ View results
Review Cptions A Windows Server 2012 R2 domain controllers have a default for the security setting [~]

named "Allow cryptography algerithms compatible with Windows NT 4.0" that prevents
weaker cryptography algorithms when establishing security channel sessions.

For more information about this setting, see Knowledge Base article 942564 (hitp://
go.microsoft.com/fwlink/?Linkld=104751).

A This computer has at least one physical network adapter that does not have static IP
address(es) assigned to its IP Properties. If both IPv4 and IPv6 are enabled for a network |
adapter, both IPv4 and |Pv6 static IP addresses should be assigned to both IPv4 and
IPvG Properties of the physical network adapter. Such static IP address(es) assignment |
should be done to all the physical network adapters for reliable Domain Name System v

A If you dlick Install, the server automatically reboots at the end of the promotion operation.

More about prerequisites

<Previous | | Newt> | [ mal ][ Cancel

30. Click Install.
31. Wait for the installation to complete.
32. The server automatically reboots.

2.1.2 Creating a Certificate Authority

1. Open Server Manager.
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WELCOME TO SERVER MANAGER

B Local Server

WE AN Servers

W apos

& o

BR Fie and Storage Services b

carvers o manage

4 Create a server group

ROLES AND SERVER GROUPS
Roder:1 | Server groupe 1 | Servers tatak 1
File and Storag
i@ apDs 1) & oDns | 1, Bdedois sl m
(@ manageaniliy | | @ wmanageabany @ Manageatility (@ Manageabiity
Events Events tvents | S
Services Senvices Services Services
Performance Performance Pectormance Performance
BPA results BPA resubts P results BPA rosults

(@ Mansgestiity
- ]

2. Click Add roles and features.

DESTIMATION SERVER

Before you begin AD-DNS.DLIPDR

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organization, such as sharing documents, or
Installation Type hosting a website.

Server Selection .
To remove roles, role services, or features:
Start the Remove Roles and Features Wizard
Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Metwork settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[] Skip this page by default

< Previous | i

Install | | Cancel

3. Click Next.
4. Select Role-based or feature-based installation.
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. . DESTINATION SERVER
Select installation type AD-DNS D119DR
Before You Begin Seied. the installation .type..\"ou can 'msfzil roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).
Server Selection (® Role-based or feature-based installation )
Configure a single server by adding roles, role services, and features.
Server Roles
B Dhecl 2o
Features o 5 P.Ses 3 % . -
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.
Nesiy [ instan || cancel
Click Next.

Select Select a server from the server pool.

Select the intended Active Directory server.
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DESTIMATION SERVER

Select destination server AD-DNS.DLIPDR

Before You Begin Select a server or a virtual hard disk on which to install roles and features,

Installation Type

() Select a virtual hard disk

Server Roles Server Pool
Features
Filter:
MName IP Address Operating System

AD-DNS.DLIPDR 92, /! i erver 2012

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

<Previous | [ Nedy | | nstal || Cancel

8. Click Next.

DESTIMATION SERVER
Select server roles AD-DNS DL1PDR
Before You Begin Select one or more roles to install on the selected server.
Installation Type Roles Description
Server Selection | Active Directory Certificate Services
(AD C5) is used to create
Active Directory Domain Services (Installed) certification authorities and related
Features [] Active Directory Federation Services role services that allow you to issue
[] Active Directory Lightweight Directory Services ::::;2:::,;:?3:5 ==t
[] Active Directory Rights Management Services
[] Application Server =
[] DHCP Server
DNS Server (Installed)
[] Fax Server
 [H] File and Storage Services (2 of 12 installed)
[] Hyper-v
[] Network Plicy and Access Services N
[] Print and Document Services
[] Remote Access
[] Remote Desktop Services ol
| < Previous | | Next > | | Install | | Cancel

9. Check the box next to Active Directory Certificate Services.
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Add Roles and Features Wizard =8| %

ﬂl

DESTINATIOM SERVER

Select server rofie

AD-DNS.DLIPDR
X

Add features that are required for Active Directory

Certificate Services? i
The following tools are required to manage this feature, but do not irmow Certificate Services
have to be installed on the same server. is used to create

ion authorities and related
4 Remote Server Administration Tools ices that allow you to issue

age certificates used in a

4 Role Administration Tools :
f applications.

4 Active Directory Certificate Services Tools
[Tools] Certification Authority Management Tools

Include management tools (if applicable)

|dens|| Cancel |

| < Previous | | Next > | | Install | | Cancel

10. Click Add Features.

DESTINATION SERVER
Select server roles AD-DNSDLEDR
Before You Begin Select one or more roles to install on the selected server,
Installation Type Roles Description
Server Selection A Active Directory Certificate Services
e ——————___ - (AD C5) is used to create
v| Active Directory Domain Services (Installed) certification authoritiss and related
izl [] Active Directory Federation Services role services that allow you to issue
ADCS [] Active Directory Lightweight Directory Services anc_l g ct_Ertiflcates etine
variety of applications.
Rolz Services [] Active Directory Rights Management Services
Confirmation [ Application Server =
[] DHCP Server
DNS Server (Installed)
[] Fax Server
b [®] File and Storage Services (2 of 12 installed)
[ Hyper-v
[[] Network Policy and Access Services N
[] Print and Dacument Services
[] Remote Access
[] Remote Desktop Services -
< Previous | ‘ Mext | Install | | Cancel
2

11. Click Next.
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Select features

Before You Begin
Installation Type

Server Selection

Server Roles

ADCS
Role Services

Confirmation

Select one or more features to install on the selected server.

Features

LNET Framew

[ [H] .NET Framework 4.5 Features (2 of 7 installed)
[ Background Intelligent Transfer Service (BITS)

[] BitLocker Drive Encryption

[ Bitlocker Network Unlock

[] BranchCache

[ Client for NFS

[] Data Center Bridging

[ Direct Play

[] Enhanced Storage

[] Failover Clustering

Group Policy Management (Installed)

[] 115 Hostable Web Core
[] Ink and Handwriting Services

| >

W

< [ |

Bl

DESTIMATIOM SERVER
AD-DNS.DLIPDR

Deseription

.NET Framework 3.5 combines the
power of the .NET Framework 2.0
APls with new technologies for
building applications that offer
appealing user interfaces, protect
your customers' personal identity
information, enable seamless and
secure communication, and provide
the ability to model a range of
business processes.

[ st | [ cancel

[ <previous | | uemkj

12. Click Next.

Before You Begin
Installation Type
Server Selection

Server Roles

Features

Role Services

Confirmation

Active Directory Certificate Services

DESTIMATIOM SERVER
AD-DMS.DLIPDR

Active Directory Certificate Services (AD C5) provides the certificate infrastructure to enable scenarios
such as secure wireless networks, virtual private networks, Internet Protocol Security (IPSec), Network
Access Protection (NAP), encrypting file systemn (EFS) and smart card log on.

Things to note:

* The name and domain settings of this computer cannot be changed after a certification authority
(CA) has been installed. If you want to change the computer name, join a domain, or promote this
server to a domain controller, complete these changes before installing the CA. For more

infarmation, see certification authority naming.

< Previous | | ﬂeﬂ‘th [ st || cancel

13. Click Next.
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14. Check the box next to Certification Authority.

Select role services

Before You Begin
Installation Type
Server Selection

Server Roles

Features
ADCS

Confirmation

DESTINATIOM SERVER
AD-DMS.DUPDR

Select the role services to install for Active Directory Certificate Services

Role services

ty

[] Certificate Enrollment Policy Web Service
[] Certificate Enrallment Web Service

[] Certification Autharity Web Enrollment
[] Metwork Device Enroliment Service

[] Online Responder

Description
Certification Authority (CA) is used
to issue and manage certificates.

Multiple CAs can be linked to form a
public key infrastructure.

< Previous ﬂ% S | Install | | Cancel

15. Click Next.

Before You Begin
Installation Type
Server Selection
Server Roles
Features

ADCS

Role Services

Confirm installation selections

DESTINATIOM SERVER
AD-DNS.DLIPDR

To install the following rales, role services, or features on selected server, click Install.

Optional f

(such as administration tools) might be displayed on this page because they have

been selected automatically. If you do not want to install these opticnal features, click Previous to clear

their check boxes.

Active Directory Certificate Services
Certification Authority

Remote Server Administration Tools
Role Administration Tools
Active Directory Certificate Services Tools
Certification Authority Management Tools

Export configuration settings
Specify an alternate source path

< Previous | | Mext =

[ |mtaL\\§J| Cancel
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16. Click Install.

17. Wait for the installation to complete.

Installation progress

DESTIMATION SERVER
AD-DNS.DLIPDR

View installation progress

o Feature installation

0 ——
Configuration required. Installation succeeded on AD-DNS.DIIPDR.

Active Directory Certificate Services

Additional steps are required to configure Active Directory Certificate Services on the destination
server

Configure Active Directory Certificate Services on the destination server
Certification Authority

Remote Server Administration Tools

Role Administration Tools
Active Directory Certificate Services Tools
Certification Authority Management Tools

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

< Previous | | Mext > i | CIos{\ | | Cancel

18. Click Close.
2.

WELCOME TO SERVER MANAGER

B Local Server
W8 Al Servers
o oancs

i aDos QUICK START

& oS [

W file and Storage Services B

0 Configure this local server Sontuse fcue Dysgipry Cenficale Servions eo -
J 1
) Festure instatation
 ————
2 Add roles and features

recl. installation sueceeded an

Ca
AD-DNSDUSDR,
Acld Rales sndd Features

4 Cr Server group Task Details

L 8
ROLES AND SERVER GROUPS
Ralewc 4 | Server groups 1 | Servers totak 1
File and Sterage
"8 socs 1 # aops 1 & ONS 1 g i
@ Manageability @ Manageakility @ Manageability @ Manageaability
Events Events Events Events
Services Sernces Sernces Services
Performance Performance Performance Performance
BPA results BPA results BEA results BPA results.
(@ Manageability @ Manageability
- . [ ]
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19. Click Configure Active Directory Certificate Services on the destination server.

Credentials

Role Services

DESTINATION SERVER
AD-DNS.DLIPDR

Specify credentials to configure role services

To install the following role services you must belong to the local Administrators group:
* Standalone certification authority
* Certification Authority Web Enrollment
* Online Responder
To install the following role services you must belong to the Enterprise Admins group:
Enterprise certification authority
Certificate Enrollment Policy Web Service
Certificate Enrollment Web Service
MNetwork Device Enrollment Service

Credentials: D\Administrator

More about AD CS Server Roles

< Previous | | MNext = | | LConfigure | | Cancel

20. Click Next.

21. Check the box next to Certification Authority.
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Role Services

Credentizls

Setup Type
CA Type
Private Key
Cryptography
CA MName
Velidity Period
Certificate Database

Confirmation

DESTINATION SERVER
AD-DNS.DLIPDR

Select Role Services to configure

Certification Authority

[[] Certification Authority Web Enrollment
[] Online Responder

[[] Metwork Device Enrcliment Service

[[] Certificate Enrollment Web Service

[[] Certificate Enroliment Policy Web Service

Maore about AD CS Server Roles

< Previous | | ﬂé{}) l | Configure | | Canoel

22. Click Next.
23. Select Enterprise CA.
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Setup Type

Credentials

Raole Services

CA Type

Privata Key
Cryptography
CA Mame
Validity Period

Certificate Database

Confirmation

DESTINATION SERVER
AD-DNS.DLIPDR

Spedify the setup type of the CA

Enterprise certification authorities (CAs) can use Active Directory Domain Services (AD DS) to
simplify the management of certificates. Standalone CAs do not use AD DS to issue or manage
certificates.

@ Erferprize CA
Enterprise CAs must be domain members and are typically online to issue certificates or
certificate policies.

() Standalone CA

Standalone CAs can be members or a workgroup or domain. Standalone CAs do not require AD
DS and can be used without a network connection (offline).

More about Setup Type

< Previous Nepeg = Configure Cancel

24. Click Next.
25. Select Root CA.

CA Type

Cradentials

Role Services

Setup Type

Private Key
Cryptography
CA Name
Validity Period

Certificate Database

Confirmation

DESTINATION SERVER
AD-DNS.DLIPDR

Specify the type of the CA

When you install Active Directory Certificate Services (AD C5), you are creating or extending a
public key infrastructure (PKI) hierarchy. A root CA is at the top of the PKI hierarchy and issues its
own self-signed certificate. A subordinate CA receives a certificate from the CA above it in the PKI
hierarchy.

@ Root CA
Root CAs are the first and may be the only CAs configured in a PKI hierarchy.

O Subordinate CA

Subordinate CAs require an established PKI hierarchy and are authorized to issue certificates by
the CA above them in the hierarchy.

More about CA Type

< Previous | | ﬂeﬁdv | Lonfigure | | Cancel

26. Click Next.
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27. Select Create a new private key.

Private Key

Credentials

Role Services

Setup Type
CA Type

Cryptography

CA Name

Validity Period
Certificate Database

Confirmation

DESTINATION SERVER
AD-DNS.DLIPDR

Specify the type of the private key

To generate and issue certificates to clients, a certification authority (CA) must have a private key.

(®) Create a new private key

Use this option if you do not have a private key or want to create a new private key.

() Use existing private key
Use this option to ensure continuity with previously issued certificates when reinstalling a CA.
() Select a certificate and use its associated private key

Select this option if you have an existing certificate on this computer or if you want to
import a certificate and use its associated private key.

() Select an existing private key on this computer

Select this option if you have retained private keys from a previous installation or want to
use a private key from an alternate source.

More about Private Key

< Previous | | ﬂeﬂdw | Lonfigure | | Cancel

28. Click Next.

29. Select RSA#Microsoft Software Key Storage Provider.
30. Set the Key length to 2048.
31. Select SHA512 from the list.
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Cradentials
Role Services
Setup Type
CA Type

Private Key

CA Name
Validity Pericd
Certificate Databaze

Confirmation

DESTINATION SERVER

Cryptography for CA AD-DNS.DLIPDR

Specify the cryptographic options

Select a cryptographic provider: Key length:
[ Rsa#Microsoft Software Key Storage Provider [~][2048 [-]

Select the hash algorithm for signing certificates issued by this CA:

SHA256 ~|
SHA384 =
[SHA512 i
SHA1

M5 hdl |

[ Allow administrator interaction when the private key is accessed by the CA.

More about Cryptography

< Previous | | ﬂﬁ)- | | Configure | | Cancel

32. Click Next.

CA Name

Credantials
Role Servicas
Setup Type
CA Type

Private Key

Cryptography

Validity Period
Certificate Databasze

Confirmation

DESTINATION SERVER
AD-DNS.DLIPDR

Specify the name of the CA

Type a common name to identify this certification authority (CA). This name is added to all
certificates issued by the CA. Distinguished name suffix values are automatically generated but can
be modified.

Common name for this CA:

DI-AD-DMNS-CA

Distinguished name suffix:
DC=DI,DC=IPDR

Preview of distinguished name:
CN=DI-AD-DNS-CA,DC=DI,DC=IPDR

More about CA Name

< Previous ﬂ$> | LConfigure | | Cancel
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33. Click Next.
34. Set the time to 5 years.

DESTINATION SERVER

Validity Period AD-DNS.DLIPDR
Credentials Specify the validity period
Role Services
Setup Type Select the validity period for the certificate generated for this certification authority (CA):

caTyRe 5 Yeas  [°]

CA expiration Date: 11/6/2022 3:19:00 PM

Private Key
Cryptography The validity period configured for this CA certificate should exceed the validity period for the
CA MName certificates it will issue,

Certificate Databaze

Confirmation

More about Validity Period

< Previous | | ﬂe:% | | LConfigure | | Cancel

35. Click Next.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

DESTINATION SERVER

CA Database AD-DNS.DLIPDR
Credentials Specify the database locations
Role Services
Setup Type Certificate database location:
CA Type CAWindows'systern32\Certlog
RvAtekey Certificate database log location:
Cryptography CAWindows\system32\Certlog
CA Name
Validity Period
Confirmation
| More about CA Database
[<Brevious | [ Mrt> | | Configue || Cancel ]
36. Click Next.

DESTINATION SERVER

Confirmation AD-DNS.DLIPDR
Cradentials To configure the following roles, role services, or features, click Configure.
Role Services ~ Active Directory Certificate Services
Setup Type
Certification Authority
CA Type 3
CAType: Enterprise Root
Evate key Cryptographic provider: RSA#Microsoft Software Key Storage Provider
Cryptography Hash Algorithm: SHAS1Z
CA MName Key Length: 2048
validity Pariod Allow Administrator Interaction: Disabled
Certificate Validity Period: 11/6/2022 3:19:00 PM

Certificate Database

Distinguished Name: CN=DI-AD-DNS-CA DC=DI.DC=IPDR
Certificate Database Location:  C:\Windows\system32\Certlog
Certificate Database Log C\Windows\system32\Certlog
Location:
< Previous || Next > | | Qonﬁgure || Cancel

37. Click Configure.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

Results

DESTINATION SERVER

AD-DNS.DLIPDR
The following roles, role services, or features were configured:
»~ Active Directory Certificate Services
Certification Authority o Configuration succeeded
More about CA Configuration
< Previous | | Next > | | Clt?a | | Cancel

38. Click Close.

2.1.3 Configure Account to Add Computers to Domain

1. Open the Start menu.

2. Enter dsa.msc and run the program.
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;)

Windows
Peraerehell

A

e=

Controd Panel

3. Right-click on Users in the left panel.

] Active Directory Users and Computers
File Action View Help

|2 {8 XEc=z HE taarda

: Active Directory Users and Com|| Name Type Description

I ] Saved Queries _aJ- Administrator  User Built-in account for ad...

4 3 DLIPDR BIFJAllowed RO.. Security Group... Members in this group c...
4 - Builtin 42 Cert Publish... Security Group... Members of this group ...
b Computers 82, Cloneable D... Security Group... Members of this group t...
F al Domain Controllers 52, Denied ROD... Security Group... Members in this group c...
b = FDreignSecurit;,.rPrincipall ia_,DnsAdmins Security Group... DNS Administrators Gro...
- || Managed Service Accour

52, DnsUpdateP... Security Group... DNS clients who are per...
= L&ers 52, Domain Ad... Security Group... Designated administrato...
52, Domain Co...  Security Group...  All workstations and ser...
82, Domain Con... Security Group... All domain controllers ...
42 Domain Gue... Security Group... All domain guests

2, Domain Users  Security Group... Al domain users
Sla‘EnterpriseA... Security Group... Designated administrato...
82, Enterprise R...  Security Group... Members of this group ...
:’EGroup Polic... Security Group... Members in this group c...
!. Guest User Built-in account for gue...
52, Protected Us... Security Group... Members of this group ..
52, RAS and IAS ... Security Group... Servers in this group can...
42 Read-only D... Security Group... Members of this group ...
2 Schema Ad... Security Group... Designated administrato...
< m 5 ||| %, WinRMRem... Security Group... Members of this group ...

4. Click Delegate Control.
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- Welcome to the Delegation of
A i
~ Control Wizard
B
B
This wizard helps you delegate control of Active Directory
objects. You can grant users pemmission to manage Users,

groups, computers, organizational units, and other objects
stared in Active Directory Domain Services.

To cortinue, click Mext.

5. Click Next.

Users or Groups
Select one or more users or groups to whom you want to delegate control.

Selected users and groups:

6. Click Add to select users or groups.
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7. Add users or groups.
Delegation of Control Wizard | x|

Select this object type:
|Users, Groups, or Built-in security principals

From this location:
|DI.IF‘DF{

Enter the object names to select (2amples):
Domain Admins

<Back | MNed> || Gamed | | Heb
8. Click OK.
Users or Groups
Select one or maore users or groups to whom you want to delegate control.
Selected users and groups:
52, Domain Adming (DI'\Domain Admins)
<Back | MNet> || Cancel | | Heb
i
9. Click Next.
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10. Choose Create a custom task to delegate.
Delegation of Control Wizard =N
Tasks to Delegate T&
3

You can select common tasks or customize your own. l’

() Delegate the following common tasks:

[] Create, delete, and manage user accounts -
] Reset user passwords and force password change at next logon
[ Read all user information

] Create, delete and manage groups

[ Modify the membership of a group

] Create, delete, and manage inetOrgPerson accounts

[ | Reset inetOraPerson passwords and force password change at next Ic
<| m | >

(® Creste a custom task to delegate;

<Back | [l'w¢> | | Cancel | | Hebp

11. Click Next.

12. Choose Only the following objects in the folder.

13. Check the box next to Computer objects.

14. Check the box next to Create selected objects in this folder.
15. Check the box next to Delete selected objects in this folder.
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Active Directory Object Type
Indicate the scope of the task you want to delegate.

Delegate control of:
() This folder, existing objects in this folder, and creation of new objects in this folder
(#) Onty the following objects in the folder:

[] account objects
[] aC5Resourcelimits objects

[7] applicationVersion ohjects
[[] boctable Device objects

[] cerficationAuthority objects
[+] Computer object

— - e

[#] Create selected objects in this folder
[l ielete selected obiects in this folden

16. Click Next.
17. Check the boxes next to Reset password, Read and write account restrictions, Validated write
to DNS host name, and Validated write to service principal name.
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Permissions
Select the permissions you want to delegate.

Show these pemissions:
[w] General
[ | Property-specific
[ Creation/deletion of specific child objects
Permizsions:
[] Receive as Z_
[+] Read and write account restrictions
[] Fead and wite personal information
[] Read and write public information E
[+] Validated write to DMS host name |
Validated write to service principal name ™
18. Click Next.
Completing the Delegation of
Control Wizard
You have successfully completed the Delegation of Caontrol
wizard.
‘You chose to delegate control of objects ]
in the following Active Directory folder: ]
DLIPDR/Users =
The groups, users, or computers to which you
have given control are: —
Domain Admins (D1Domain Admins)
They have the following pemissions: ||
W
To close this wizard, click Finish.
<Back | | Hep

19. Click Finish.
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2.1.4 Adding Machines to the Domain

1. Right-click the network icon in the task bar on a computer that you wish to add to the domain.

2. Click Open Network and Sharing Center.

?]

T | & » Control Panel » Networkand Intemet » Network and Sharing Center v C,| | Search Control Panel
Coik v e View your basic network information and set up connections
View your active networks
Change adapter settings
Change advanced sharing Network Access type: Internet
settings Public network Connections: « Ethemetd
Change your networking settings
Set up a new connection or netwark
" Setup a broadband, dial-up, or VPN connection; o set up a router or access point.
Troubleshoot problems
Diag and repair rk probl or get troubleshooting infi i
See also
Internet Options
Windows Firewall

3. Click the name of the internet adapter.
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IPv4 Connectivity: Internet

IPvi Connectivity: No Internet acoess
Media State: Enabled
Duration: 02:16:05
Speed: 1.0 Gbps

Bytes: 3,043,324 | 2,073,372

| “Properties | | “ypisable || oiagnose |

4. Click Properties.

Networking

Connectusing:
# Intel{R) 82574L Gigabit Network Connection

This connection uses the follawing items:

i & Client for Microsoft Networks

¥ 8L File and Prnter Sharing for Microsoft Networks

¥ 8l oS Packet Scheduler

[ wa Microsoht Network Adapter Multiplexor Pratocal

i .4 Link-Layer Topology Discovery Mapper |fO Driver
™ & Link-Layer Topology Discovery Responder

¥ i Internet Protocol Version 6 (TCP/IPvE)

Description
Transmission Control Protocelfintemet Protocol. The default wide
area network protocol that provides communication across
diverse inferconnected networks.

[ ok [[ comca |

5. Double-click Internet Protocol Version 4 (TCP/IPv4).
6. Select Use the following DNS server addresses.
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7. Enter the IP address of the DNS server.

General mwmi

You can get IP settings assigned automatically If your network
suppaorts this capability. Otherwise, you need to ask your network
administrator for the appropriate IF settings.

(@) Obtain an IP address automatically
(7} Uee the following TP address:

() Obtain DNS server address automatically
(@) Use the following DNS server addresses

Preferred DNS server: 192 .168 . 78 . 4
e I B

it snsese

o« [[ omem |

8. Click OK.
9. Click OK.

Connection
P4 Connectivity: Tnternet
IPv6 Connectivity: No Intermet access
Media State: Enabled
Duration: 02:30:01
Speed: 1.0 Gbps

Bytes: 3,043,845 I 2,074,110

| S Froertes | | yosable || oiagrose |

10. Click Close.
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11. Navigate to This PC.

Computer  View v @
+ [ » ThispC » v @] [ Search This e 2]
% Favorites 4 Folders (6)
W Desktop
ls Downloads Desktop )1 Documents
2 Recent places

W This PC h Downloads b Music
& Network \h Pictines i

4 Devices and drives (3)

g LoD
y Floppy Disk Drive (A) o~ m

71.0 GB free of 79.6 GB
DVD Drive (D)
IR2_555_X64FREV_EN-US_DV5

0 bytes free of 4.16 GB

r

9 items 3=

12. Right-click in the window and click Properties.

+ |ﬂ » Control Panel » System and Security » System v 0‘ ‘ Search Control Panel 2 |

Control Panel Home " o .
SIS View basic information about your computer

9 Device Manager Windows edition
@ eiriote séogs Windows Server 2012 R2 Standard
% Advanced system settings © 2013 Microsott Corporation. All rights reserved. .Windows Server2012R2
System
Processor: Intel(R) Xeon(R) CPU E5-2660 0 @ 220GHz 2.20 GHz
Installed memory (RAM):  8.00 GB
System type: 64-bit Operating System, x64-based processar
Pen and Touch: No Pen or Touch Input is available for this Display

Computer name, domain, and workgroup settings
Computer name: REMOTEDESKTOP1 & Change settings
Full computer name: REMOTEDESKTOP1
Computer description:
Workgroup: WORKGROUP
Windows activation
Windows is not activated. Read the Microsoft Software License Terms
Product ID: 00252-70000-00000-AA535 Activate Windows
See also
Action Center
Windows Update

13. Click Change Settings.
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ComputerName |Hardware | Advanced | Remote |
" Windows uses the following inft ion 1o identify your computer on
the network.

Computer dascriplion: i|
For example: "IS Production Server” or "Accounting
Server’.

Full computer name: REMOTEDESKTOP1

Workgroup: WORKGROUP

To this puter or change its domain or 'Dhitm

workgroup. click Change. =

ok || cameat || Apoy |

14. Click Change.
15. Select Domain.
16. Enter the domain.

You can change the name and the membership of this computer.
Changes might affect access lo network resources.

Compuler name.
REMOTEDESKTOP1 |

Full computer name.
REMOTEDESKTOP1

Member of
(@) Domain:
|mu=DR |

() Waorkgroup:
|WORKGROUP |

17. Click OK.
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18. Enter the username and password of an account with privileges to add computers to the

domain.

Computer Name/Domain Changes
Enter the name and password of an account with permission to join the
domain.
| DihAdministrator I
I I l BRSNS NNRORRBES I
Domain: DI
| ok || Cancel
19. Click OK.

You must restart your computer to apply
these changes

Before restarting, save any open files and close all
programs.

20. Click OK when prompted to restart the computer.

2.1.5 Configure Active Directory to Audit Account Activity

1. Open the Start menu.
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iy

Conired Panel

Search

Security Policy

2. Enter “Local Security Policy” in the search bar and open the program.

3. Navigate to Local Policies > Audit Policy.

4. Right-click Audit account management.

3

File

e

Action  View Help

Local Security Policy

_I:I-

4

A

-

I
I

4

T Security Settings

4 Account Policies

4 Local Policies

I [ Audit Policy

I+ & User Rights Assignment

I 4 Security Options

~| Windows Firewall with Advanced Seci
| Metwork List Manager Policies

| Public Key Policies

~| Software Restriction Policies

| Application Control Policies

[ .g IP Security Policies on Local Compute

|| Advanced Audit Policy Configuration

m >

-

Policy
| Audit account logon events
4| Audit accountgnanagement
| Audit directory Service access
| Audit logon events
| Audit object access
| Audit policy change
| Audit privilege use
| Audit process tracking
| Audit system events

Security Setting
Me auditing
Ne auditing
Mo auditing
Mo auditing
Mo auditing
MNe auditing
Mo auditing
Mo auditing
Mo auditing

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

47



"S7-008T'dS"LSIN/8Z09'0T/810°10p//:5d1y ‘w0l a81eyo jo 92 3|qe|iee si uonedgnd siyL

5. Click Properties.
6. Check the boxes next to Success and Failure.

Local Securty Setting | Explain

Audit account management

Audit these attempts:
[w] Success

[v] Failure

& This setting might not be erforced if other policy is configured to
£=%  pvemde category level audit policy.
For mare information, see Audit account management. (3921468)

0K Cancel Apply
ok ) [caes | [owr |

7. Click OK.

2.1.6 Configure Reverse Lookup Zones

1. Open DNS Manager by right-clicking the DNS server in Server Manager.
2. Click Reverse Lookup Zones.
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4 5 AD-DNS.DLIPDR
b (] Forward Lookup Zones

| Reverse Looku{ Zonss|
b ] Trust Points
b [ Conditional Forwarders
v |[ Global Logs

File Action ew Help
= smcBm §ES
£ Dns

@ Add a New Zone

The Domain Name System (DNS) allows a DNS namespace to be divided inte zones, Each zone stores
i ion about one or more conti DNS domains.

To add 3 new zone, on the Action menu, click New Zone.

3. Click Action > New Zone.

i

- Welcome to the New Zone
Wizard

This wizard helps you create a new zone for your DNS
SErver,

A zone translates DNS names to related data, such as IP
addresses or network services.

To continue, dick Next.

4. Click Next.
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Zone Type
The DMS server supports various types of zones and storage.

Select the type of zone you want to create:

(#®) Primary zone
Creates a copy of a zone that can be updated directly on this server.

() Secondary zone
Creates a copy of a zone that exists on another server, This option helps balance
the processing load of primary servers and provides fault tolerance.,

() Stub zone

Creates a copy of a zone containing only Name Server (NS), Start of Authority
(S0A), and possibly glue Host (A) records. A server containing a stub zone is not
authoritative for that zone.

[ Store the zone in Active Directory (available only if DNS server is a writeable domain
controller)

5. Click Next.

Active Directory Zone Replication Scope
‘fou can select how you want DMS data replicated throughout your network.

Select how you want zone data replicated:
() To all DNS servers running on domain controllers in this forest: DI.IPDR

(® To all DNS servers running on domain controllers in this domain: DI IPDR.

() To all domain controllers in this domain (for Windows 2000 compatibility): DL IPDR

() T all domain controllers spedified in the scope of this directory partition:

6. Click Next.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

Reverse Lookup Zone Name
A reverse lookup zone translates IP addresses into DNS names.

Choose whether you want to create a reverse lookup zone for IPv4 addresses or IPv6
addresses.

(@) IPv4 Reverse Lookup Zone

() IPv6 Reverse Lookup Zone

7. Click Next.
8. Enter the first three parts of the IP address of the Active Directory (AD)/DNS server (for
example, 192.168.1).

Reverse Lookup Zone Name
A reverse lookup zone translates IP addresses into DNS names.

To identify the reverse lookup zone, type the network ID or the name of the zone.
(® Network ID:

|192 IR

The network ID is the portion of the IP addresses that belongs to this zone. Enter the
network ID in its normal {not reversed) order.

If you use a zero in the network ID, it will appear in the zone name. For example,
network ID 10 would create zone 10.in-addr.arpa, and netweork ID 10,0 would create
zone 0. 10.in-addr.arpa.

() Reverse lookup zone name:
| 1.168. 192.in-addr.arpa

9. Click Next.
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Dynamic Update
‘fou can spedfy that this DNS zone accepts secure, nonsecure, or no dynamic
updates.

Dynamic updates enable DMS dient computers to register and dynamically update their
resource records with a DNS server whenever changes occur.

Select the type of dynamic updates you want to allow:

(®) Allow only secure dynamic updates (recommended for Active Directory)
This option is available only for Active Directory-integrated zones.

() Allow both nonsecure and secure dynamic updates %
Dynamic updates of resource records are accepted from any dient.
& This option is a significant security wulnerability because updates can be
accepted from untrusted sources.
() Do not allow dynamic updates

Dynamic updates of resource records are not accepted by this zone. You must update
these records maniually.

<Back || Next> | [ concel |

10. Click Next.

Completing the New Zone Wizard

‘You hawve successfully completed the Mew Zone Wizard. You
spedified the following settings:

Mame:  1.168.192.in-addr.arpa
Type: Active Directory-Integrated Primary

Lookup type: Reverse

Mote: You should now add records to the zone or ensure
that records are updated dynamically. You can then verify
name resolution using nslookup.

To dose this wizard and create the new zone, dick Fmii.

11. Click Finish.
12. Click on the newly created reverse lookup zone.
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File Action View Help

e« rnEEczBE § 88

£ DNS Name Type Data Timestamp
4 | AD-DNS.DIIPDR 5 (same as parent folder) Start of Authority (SOA)  [1], ad-dns.di.ipdr, hostm... ~static
I+ [ Ferward Lockup Zones || ] (same as parent folder) Name Server (NS} ad-dns.diipdr. static

4[] Reverse Lookup Zones
(2] 1.168.192.in-addr.arp|

> | Trust Points

b [ Conditional Forwarders [%

b Global Logs

| < n >

13. Right-click in the window and select New Pointer (PTR)....
14. Enter the IP address of the AD/DNS server.
15. Enter the hostname of the AD/DNS server.

Pointer (PTR)
Host IP Address:
| 192.168.1.12

Fully qualified domain name (FQDM):
| 12.1.168. 192.in-addr.arpa |

Host name:
|ad-dns.di.ipdr| | | Browse. .. |

[T] Allgw any authenticated user to update all DNS records with the same
name. This setting applies only to DNS records for a new name.

N

16. Click OK.
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File Action View Help

e« 2EEcRz Bm 6 86

£, DNS Name Type Data Timestamp
4 i AD-DNS.DLIPDR ] (same as parent folder) Start of Authority (SOA) [1], ad-dns.di.ipdr, hostm... static

b 1 Forward Lookup Zones || ] (same as parent folder) Name Server (NS} ad-dns.diipdr. static

4 [7] Reverse Lookup Zones || =] 192,168.1.12 Pointer (PTR) ad-dns.diipdr

|21 1.168.192.in-addr.arp|
p ] Trust Points
p ] Conditional Ferwarders
b (] Global Logs

2.2  Microsoft Exchange Server

As part of our enterprise emulation, we include a Microsoft Exchange server. This section covers the
installation and configuration process used to set up Microsoft Exchange on a Windows Server 2012 R2
machine.

2.2.1 Install Microsoft Exchange

1. Run Exchange2016-x64.exe.
2. Choose the directory for the extracted files.

Choose Directony For Bdracted Fles

C:\Program Files"Microsoft'Exchange Server|

3. Click OK.
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Application Tools

Home View Manage A ﬂ
© = 4 [ « LocalDisk (C) » Program Files » Microsoft » Exchange Server » w & [ search Exchange Server 2]
- .
A
7 Favorites o G ML = =
I Desktop L syl B/14/201710:22 AM  File folder
{8 Downloads Losv 8/14/201710:22 AM  File folder
& Recent places e 81472017 1022 AM  File folder
o ta 8/14/201710:22 AM  File folder
18 This PC Lte B/14/201710:22 AM  File folder
& th 8/14/2017 10:22 AM  File folder
€ Network B 8/14/201710:22 AM  File folder
o uk 81472017 10:22 AM  File folder
& ur 8/14/2017 10:22 AM  File folder
i vi 8/14/201710:22 AM  File folder
. zh-hans 8/14/201710:22 AM  File folder
L zh-hant 8/14/2017 10:22 AM  File folder
] autorun 9/20/2015 441 AM  Setup Information 1KB
@ exchangeserver 9/20/2015 441 AM  Windows Installer ... 22,383 KB
%] microsoft.exchange.cabutility.dil 9/20/20154:41 AM  Application extens.., 278 KB ]
@ microsoft.exchange.data.common.dil 9/20/2015 441 AM  Application extens... 1,684 KB
@ microsoft.exchange.diagnostics.dil 9/20/2015 441 AM  Application extens... 1,648 KB =
@ microsoft.exchange.setup.acquirelangua...  9/20/20154:41 AM  Application extens... 68 KB -
@ microsoft.exchange.setup.bootstrapper.c..  9/20/20154:41 AM  Application extens... 90 KB
@ microsoft.exchange.setup.signverfwrapp...  9/20/2015 441 AM  Application extens... 83 KB
[ET setup N 9/20/2015 441 AM  Application 31KB ]
T2items 1 item selected 300K - =]

4. Enter the directory and run setup.exe.

5. Select Connect to the Internet and check for updates.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

55



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Check for Updates?

You can have Setup download Exchange Server 2016 updates from the Internet before you install Exchange. If updates are available,
they'll be downloaded and used by Setup. By downloading updates now, you'll have the latest security and product updates. If you
don't want to check for updates right now, or if you don't have access to the Internet, skip this step. If you skip this step, be sure to
download and install any available updates after you've completed Setup.

Select one of the following options:

@ LConnect to the Internet and check for updates

O Don't check for updates right now

@8 Exchange

6. Click Next.
7. Wait for the check to finish.
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MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Downloading Updates...

No updates found, click next to continue with setup.

@8 Exchange

8. Click Next.
9. Wait for the copying to finish.
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MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Introduction

Welcome to Microsoft Exchange Server 2016!

Exchange Server is designed to help you increase user productivity, keep your data safe, and provide you with the control you need.
‘You can tailor your solution to your unique needs with flexible deployment options, including hybrid deployments that enable you to
take advantage of both on-premises and online solutions. You can use compliance management features to protect against the loss of
sensitive information and help with internal and regulatery compliance efforts, And, of course, your users will be able to access their
email, calendar, and voice mail on virtually any device and from any location. This wizard will guide you through the installation of
Exchange Server 2016,

Plan your Exchange Server 2016 deployment:
Read about Exchange Server 2016
Read about supported languages

Use the Exchange Server Deployment Assistant

@8 Exchange

10. Click Next.
11. Click I accept the terms in the license agreement.
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MICROSOFT EXCHANGE SERVER 2016 SETUP s ? X

License Agreement

Please read and accept the Exchange Server 2076 license agreement,

MICROSOFT SOFTWARE LICENSE TERMS i
MICROSOFT EXCHANGE SERVER 2016 STANDARD, ENTERPRISE, TRIAL AND HYBRID
These license terms are an agreement between Microsoft Corporation (or based on where you live, one of its affiliates)

and you. Please read them. They apply to the software named above, which includes the media on which you received
it, if any. The terms also apply to any Microsoft

» updates,

« supplements,

s Internet-based services, and
* support services

for this software, unless other terms accompany those items. I so, those terms apply.

By using the software, you accept these terms. If you do not accept them, do not use the software.
d If you cannot obtain a refund there, contact Microsoft or W

B efiem S bt e

@ | zccept the terms in the license agreement

\i\l | do not accept the terms in the license agreement.

@8 Exchange

12. Click Next.
13. Click Use Recommended Settings.
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MICROSOFT EXCHANGE SERVER 2016 SETUP ?7 X

Recommended Settings

(@) Userecommended settings

Exchange server will automatically check online for selutions when encountering errors and provide usage feedback to Microsoft to
help improve future Exchange features,

O Don't use recommended settings

Manually configure these settings after installation is complete (see help for more information).

Read more about providing usage feedback to Microsoft

Read more about checking for error solutions online

@8 Exchange

14. Click Next.

15. Check Mailbox role.

16. Check Automatically install Windows Server roles and features that are required to install
Exchange Server.
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MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Server Role Selection

Select the Exchange server roles you want te install on this computer:

Mailbox role

Automatically install Windows Server roles and features that are required to install Exchange Server

@8 Exchange

17. Click Next.
18. Specify the installation path for MS Exchange.
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MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Installation Space and Location

Disk space required: 8696.2 MB

Disk space available: 19407.9 MB

Specify the path for the Exchange Server installation:

I C\Program Files\Microsoft\Exchange Server\V13

[&Exchange

19. Click Next.
20. Specify the name for the Exchange organization, e.g., DI.
21. Decide whether to apply split permissions based on the needs of the enterprise.
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MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Exchange Organization

Specify the name for this Exchange organization:
‘Dll

[:I Apply Active Directory split permissions security model to the Exchange organization

The Active Directory split permissions security model is typically used by large organizations that completely separate the responsibility
for the management of Exchange and Active Directory among different groups of people. Applying this security model removes the
ability for Exchange servers and adrministrators to create Active Directory objects such as users, groups, and contacts. The ability to
manage non-Exchange attributes on those objects is also removed.

You shouldn't apply this security model if the same person or group manages both Exchange and Active Directory, Click '?' for more
information.

@8 Exchange back | [ net

22. Click Next.
23. Select No.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

63



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Malware Protection Settings

Malware scanning helps protect your messaging environment by detecting messages that may contain viruses or spyware, It can be
turned off, replaced, or paired with other premiurm services for layered protection.

Malware scanning is enabled by default. However, you can disable it if you're using another product for malware scanning. If you
choose to disable malware scanning now, you can enable it at any point after you've installed Exchange.

Disable malware scanning.

O Yes
® Mo

Internet access is required to download the latest anti-malware engine and definition updates.

@8 Exchange back | | et

24. Click Next.
25. Install any prerequisites listed.
26. If necessary, restart the server and rerun setup.exe, following through steps 3—22 again.
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MICROSOFT EXCHANGE SERVER 2016 SETUP ? X

Readiness Checks

The computer will be checked to verify that setup can continue,

Prerequisite Analysis 100%
Warning:

Setup can't detect a Send connector with an address space of "', Mail flow to the Internet may not work properhy.

For more information, visit: hitp://technet.microseft.com/library(EXCHG.160) /ms.exch.setupreadiness.MoConnectorT oStar.aspx

@8 Exchange

27. Click Install.

2.3  Windows Server Hyper-V Role

As part of our simulated enterprise, we include a Windows Hyper-V server. This section covers the

instructions for installing the Windows Server Hyper-V Role on a Windows Server 2012 R2 machine.

The instructions for enabling the Windows Server Hyper-V Role are retrieved from
https://technet.microsoft.com/en-us/library/hh846766(v=ws.11).aspx and are replicated below for

preservation and ease of use.

2.3.1 Production Installation

1. In Server Manager on the Manage menu, click Add Roles and Features.
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| F

» Dashboard =

Manage View Help

Add:Boles and Features

Remove Roles and Features

Server Manage

'WELCOME TO SERVER MANAGER

Dashboard Ak Seren

B Local Server

& Al Servers

Create Server Group

0 Configure this local server Pt Marpaei gt

QUICK START
i 2 Add roles and features

3 Add other servers to manage
4 Create a server group

5 Connect this server to cloud services
Hide

ROLES AND SERVER GROUPS —

Roles:0 | Servergroups:1 | Servers total: 1
# Local Server 1 BE All Servers 1
® Manageability @ Manageability
Events Events g

2. Onthe Before you begin page, verify that your destination server and network environment are
prepared for the role and feature you want to install.

DESTIMATION SERVER

Before you beg in WIN-MR2BOTCRMO1.DLTEST

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organizaticn, such as sharing documents, or
Installation Type hosting a website,

Server Selection

u Begin

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Metwork settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[ Skip this page by default

| < Previous | | ﬂeﬂ{\g | | Install || Cancel |

3. Click Next.
4. Onthe Select installation type page, select Role-based or feature-based installation.
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DESTINATION SERVER

Select installation Type WIN-MR2BO7CRMO1.DLTEST

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

Before You Begin

(®) Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

Server Selection

Server Rolas
n S
Features £ PSS 3 2 B
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based

or session-based desktop deployment.

| < Previous | ‘ ﬂe&) | | Install | | Cancel

5. Click Next.
6. On the Select destination server page, select a server from the server pool.

DESTIMATION SERVER

Select destination server WIN-MR2B07CRMO1.DLTEST

Before You Begin Select a server or a virtual hard disk on which to install roles and features,

Installation Typs (@) Select a server from the server pool

() Select a virtual hard disk

Server Roles Server Pool
Features
Filter: |
MName IP Address Operating System

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

< Previous ﬂi’ﬁ B | Install | ‘ Cancel

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

7. Click Next.
8. On the Select server roles page, select Hyper-V.
9. To add the tools that you use to create and manage virtual machines, click Add Features.

DESTINATION SERVER

Select server roles WIN-MR2307CRMO1.DLTEST

Before You Begin Select one or more roles to install on the selected server,

Installation Type Roles Description

Server Selection - i i
[ Active Directory Certificate Services o Hypetl provdes the senncestheit
) X . you can use to create and manage
[0 Active Directory Domain Services wvirtual machines and their resources.
Features [ Active Directory Federation Services Each virtual machine is a virtualized
Hyper-v P T computer systemn that operates in an
® - e isolated execution environment. This
Virtual Switches [] Active Directory Rights Management Services allows you to run multiple operating
Migration 3 Application Server (Installed) - systems simultaneously.
Dafault Stores LIPDHeR Serer
DNS Server
Confirmation o
[ Fax Server
> [H] File and Storage Services (2 of 12 installed)
Hyper-V]

[ Network Policy and Access Services
[ Print and Document Services

[] Remote Access

[] Remote Desktop Services

< Previous Ney:> Install Cancel

10. Click Next.
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Select features

Before You Begin

Select one or more features to install on the selected server.

DESTINATION SERVER
WIN-MRZBOTCRMO1.DILTEST

Installation Type Features Description
Server Selection i
b NET Framework 3.5 Features (Installed) AL GHED framework s ocombines the
Server Roles power of the .NET Framework 2.0
2 .NET Framewaork 4.5 Features (Installed) APIs with new technologies for
I [] Background Intelligent Transfer Service (BITS) = building applications that offer
Hyper-v [ BitLocker Drive Encryption appealing user interfaces, P rotPTct
) — your customers' personal identity
Virtual Switches [ BitLocker Network Unlock information, enable seamless and
Migration [J BranchCache secure communication, and provide
- the ability to model a range of
Default Stores L1 Sietior ey business processes.
) [] Data Center Bridging
Confirmation )
[] Direct Play
[] Enhanced Storage
[] Failover Clustering
[] Group Policy Management
115 Hostable Web Core (Installed)
[ Ink and Handwriting Services |
— . o e v
<] " | ]
< Previous | | Mext >,\eJ | Install | | Cancel
b

11. Click Next.
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Hyper-V

Before You Begin
Installation Typs
Server Selection
Server Roles

Features

Virtual Switches

Migration
Default Stores

Confirmation

DESTINATIOM SERVER
WIN-MRZBOTCRMO1.DLTEST

Hyper-V allows you to virtualize your server workloads by running those workloads on virtual machines.
You can use virtual machines to consolidate multiple workloads on one physical server, to improve
server availability, and to increase efficiency in developing and testing software.

Things to note:

* Before you install this role, you should identify which network connections on this server you want to
use for setting up virtual switches.

* After you install Hyper-V, you can use Hyper-V Manager to create and configure your virtual
machines,

More information about Hyper-V

< Previous | | MNext >%J | Install | | Cancel

12. Click Next.

13. On the Create Virtual Switches page, select the appropriate options.
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DESTINATION SERVER

Create Virtual Switches WIN-MR2BOTCRMO1.DLTEST

Before You Begin Virtual machines require virtual switches to communicate with other computers. After you install this
role, you can create virtual machines and attach them to a virtual switch.

Installation Typs
One virtual switch will be created for each network adapter you select. We recommend that you create

Server Selection at least one virtual switch now to provide virtual machines with connectivity to a physical network. You

Server Boles can add, remove, and medify your virtual switches later by using the Virtual Switch Manager.
Features Network adapters:
Hyper-V MName Description

Ethernet Intel(R) PRO/1000 MT Network Connection

Migration

Default Stores

Confirmation 'J.I We recommend that you reserve one network adapter for remote access to this server, To reserve a

network adapter, do not select it for use with a virtual switch.

< Previous ﬂft B ‘ Install | | Cancel

14. Click Next.
15. On the Virtual Machine Migration page, select the appropriate options.

DESTINATION SERVER

Virtual Machine Mlg ration WIN-MR2BOTCRMO1.DLTEST

Hyper-V can be configured to send and receive live migrations of virtual machines on this server,
Configuring Hyper-V now enables any available network on this server to be used for live migrations. If
Installation Type you want to dedicate specific networks for live migration, use Hyper-V settings after you install the role.

Before You Begin

Server Selection . e . ;
[[] Allow this server to send and receive live migrations of virtual machines

Server Roles

Authentication protocol

FedliEs Select the protocol you want te use to authenticate live migrations,
Hyper-V (®) Use Credential Security Support Provider (CredSSP)
Virtuzl Switches This protocol is less secure than Kerberos, but does not require you to set up constrained

delegation. To perform a live migration, you must be logged on to the source server.

() Use Kerberos
Default Stores This protocel is more secure but requires you to set up constrained delegation in your

Carfirmation environment to perform tasks such as live migration when managing this server remotely.

b, If this server will be part of a cluster, do not enable migration now. Instead, you will canfigure the
server for live migration, including specifying networks, when you create the cluster.

<£reviuus‘: ext > | | Install || Cancel
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16. Click Next.
17. On the Default Stores page, select the appropriate options.

DESTINATION SERVER
Default Stores WIN-MRZBOTCRIMO1 DLTEST
Before You Begin Hyper-V uses default locations to store virtual hard disk files and virtual machine configuration files,
unless you specify different locations when you create the files. You can change these default locations
Installation Type now, or you can change them later by modifying Hyper-V settings.
Server Selection
Default location for virtual hard disk files:
Server Roles
Eealiiies CAUsers\Public\Documents\Hyper-Vi\Virtual Hard Disks Browse...
Hyper-V Default location for virtual machine configuration files:
Virtual Switches CAProgramData\Microsoft\Windows\Hyper-V Browse...
Migration
Confirmation
< Previous | | ﬂ:{\g = | | Install | | Cancel

18. Click Next.
19. On the Confirm installation selections page, select Restart the destination server automati-
cally if required.
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[ Add Roles and Features Wizard - | = [

DESTINATION SERVER

Confirm installation selections WIN-MR2BOTCRMO1 DLTEST

Before You Beain To install the following roles, role services, or features on selected server, click Install.

Installation Restart the destination server automatically if required

Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear
their check boxes.

Hyper-V
Remote Server Administration Tools
Role Administration Tools

Hyper-V Management Toals
Hyper-V Medule for Windows PowerShell

Hyper-V GUl Management Tools

Export configuration settings
Specify an alternate source path

< Previous Next > Cancel

20. Click Install.

21. When installation is finished, verify that Hyper-V installed correctly. Open the All Servers page
in Server Manager, and select a server on which you installed Hyper-V. Check the Roles and
Features tile on the page for the selected server.

2.4 MS SQL Server

As part of both our enterprise emulation and data integrity solution, we include a Microsoft Structured
Query Language (MS SQL) Server. This section covers the installation and configuration process used to
set up Microsoft SQL Server on a Windows Server 2012 R2 machine.

2.4.1 Install and Configure MS SQL

1. Acquire SQL Server 2014 installation media.
2. Locate the installation media in the machine and click on SQL2014_x64_ENU to launch SQL
Server Installation Center.
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Planning
Installation
Maintenance
Tools
Resources
Advanced

Options

Microsoft SQL Server2014

Hardware and Software Requirements

View the hardware and software requirements.

Security Documentation

View the security documentation.

Online Release Notes

View the latest information about the release. %

How to Get SOL Server Data Tools

SQL Server Data Tools provides an integrated environment for database developers to
carry out all their database design work for any SGL Server platform,

System Cenfiguration Checker

Launch a teol to check for conditions that prevent a successful SGL Server installation.

Install Upgrade Advisor

Upgrade Advisor analyzes any SOL Server 2012, SCL Server 2008 R2, 50L Server 2008 or
SQL Server 2005 compenents that are installed and identifies issues to fix either before
or after you upgrade to SOL Server 2014,

Online Installation Help

Launch the online installation documentation.

How to Get Started with SOL Server 2014 Failover Clustering
Read instructions on how to get started with S5QL Server 2014 failover clustering.

How to Get Started with a PowerPivet for SharePoint Standalone Server Installation

Read instructions on how to install PowerPivot for SharePoint in the fewest possible
steps on a new SharePoint 2010 server,

[>

<

3. On the left menu, select Installation.

Planning
MaintéRance
Tools
Resources
Advanced

Options

Microsoft SQL Server2014

Mew SCGL Server stand-alone installation or add features to an existing installation

Launch a wizard to install QL Server 2014 in a non-clustered environment or to add
features to an existing SOL Server 2014 instance.

MNew SCL Server failover cluster installation

Launch a wizard to install a single-node 5L Server 2014 failover cluster.

Add node to a 5OL Server failover cluster
Launch a wizard to add a node to an existing SOL Server 2014 failover cluster.

Upgrade from SQL Server 2003, SOL Server 2008, SOL Server 2008 R2 or SOL Server 2012

Launch a wizard to upgrade 5QL Server 2005, 5QL Server 2008, SQL Server 2008 R2 or SQL
Server 2012 to SQL Server 2014,
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4. Select New SQL Server stand-alone installation or add features to an existing installation. This

will launch the SQL Server 2014 setup.
5. Inthe Product Key section, enter your product key.

b SQL Server 2014 Setup - |o [T

Product Key
Specify the edition of SOL Server 2014 to install.
Product Key Validate this instance of 5QL Server 2014 by entering the 25-character key from the Microsoft ~

certificate of authenticity or product packaging. You can also specify a free edition of SQL Server, such
as Evaluation or Express. Evaluation has the largest set of SQL Server features, as documented in SQL

License Terms

Global Rules Server Books Online, and is activated with a 180-day expiration. To upgrade from one edition to

Product Updates another, run the Edition Upgrade Wizard,

Install Setup Files

Install Rules () Specify a free edition:

Setup Role Evaluation =

Feature Selection i
(@) Enter the product key:

[———

Feature Rules

Feature Configuration Rules
Ready to Install
Installation Progress

Complete

< Back | il | | Cancel

6. Click Next.
7. Inthe License Terms section, read and click | accept the license terms.
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License Terms

To install SOL Senver 2014, you must accept the Microsoft Software License Terms.

Product Key
License Terms
Global Rules
Product Updates
Install Setup Files
Install Rules

Setup Role

Feature Selection
Feature Rules
Feature Configuration Rules
Ready to Install
Installation Progress

Complete

MICROSOFT SQL SERVER 2014 ENTERPRISE SERVER/CAL EDITION

These license terms are an agreement between Microsoft Corporation (or based on where you
live, one of its affiliates) and you. Please read them. They apply to the software named above,
which includes the media on which you received it, if any. The terms also apply to any Microsoft

» updates,

'+ supplements,

[w] | accept the license terms.

0 Turn on Customer Experience Improvement Program ("CEIP") and Error Reporting to help improve the
quality, reliability and performance of Microsoft SQL Server 2014,

See the Microsoft SQL Server 2014 Privacy Statement for more information.

* Microsoft SOL Server 2014 also includes a Visual Studio component that will have CEIP settings turned
off by default. If Visual Studio is installed, this component will use the CEIP settings for Visual Studio.

< Back H ﬂext)h || Cancel

8. Click Next.

9. Inthe Install Rules section, note and resolve any further conflicts.
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Install Rules

Setup rules identify potential problems that might occur while running Setup. Failures must be corrected before Setup
can continue.

Product Key Cperation completed, Passed: 6. Failed 0. Warning 1. Skipped 0.

Global Rules

Product Updates Hide details <<

Install Setup Files View detsiled report

Install Rules

Setup Rele Rule Status

Ecafure Selechon @ Fusion Active Template Library (ATL) Passed

Feature Rules @ Previous releases of SOL Server 2008 Business Intelligence Devel... | Passed

Feature Cenfiguration Rules @ Consistency validation for SQOL Server registry keys Passed

Ready to Install @ Computer domain controller Passed

Installation Progress (@ | Microsoft [NET Application Security Passed

Complete I\ | Windows Firewall Warning
@

Block install when Microsoft SQL Server 2014 CTP1 is present. Pacsed

< Back | | Next % | | Cancel | | Help

10. Click Next.
11. In the Setup Role section, select SQL Server Feature Installation.
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< SQL Server 2014 Setup [= [ o [

Setup Role

Click the SQL Server Feature Installation option to individually select which feature components to install, or click a
feature role to install a specific configuration.

Product Key (® S0L Server Feature Installation

License Terms Install SQL Server Database Engine Services, Analysis Services, Reporting Services, Integration Services,
Global Rules and other features,

Product Updates () S0OL Server PowerPivot for SharePoint

Install Setup Files Install PowerPivot for SharePoint on a new or existing SharePoint server to support PowerPivot data
Install Rules access in the farm. Optionally, add the SQL Server relational database engine to use as the new farm’s
database server,

Setup Role

Feature Selection

Feature Rules (O All Features With Defaults

Feature Cenfiguration Rules Install all features using default values for the service accounts.

Ready to Install
Installation Progress

Complete

< Back | \_%axt > ‘ | Cancel | | Help

12. Click Next.

13. In the Feature Selection section, select the following options:
a. Database Engine Services

Client Tools Connectivity

Client Tools Backwards Compatibility

Client Tools SDK

Management Tools — Basic

Management Tools — Complete

SQL Client Connectivity SDK

Any other desired features

S®m 0 oo T
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Feature Selection

Select the Enterprise features to install.

Product Key

License Terms

Global Rules

Product Updates
Install Setup Files
Install Rules

Setup Role

Feature Selection
Feature Rules

Instance Configuration

Server Configuration

Features:

Instance Features

[/] Database Engine Services
[] sOL Server Replication
pl

[] Full-Text and Semantic Extractions for Sea _

[[] Data Quality Services
[[] Analysis Services
[] Reporting Services - Native
Shared Features
[] Reporting Services - SharePoint
[] Reporting Services Add-in for SharePoint Pro
[] Data CQuality Client
[w] Client Tools Connectivity

Feature description:

The configuration and operation of each
instance feature of a SOL Server instance is
isolated from other SOL Server instances. SQL
Server instances can operate side-by-side on

Prerequisites for selected features:

Already installed: Al
i Windows PowerShell 2.0

Micrasnft MET F ke 3.5 |
m

Disk Space Requirements

Drive C: 2534 MB required, 21593 MB available B

Datal Engine Confi [] Integration Services

Feature Configuration Rules <1 m [ I ] L

Ready to Install

_ | Selectall || Unselectan |

Installation Progress

Complete Instance roct directony: |C:\Program Files\Microsoft SQL Server\, | I:I
Shared feature directory: |C:\Program Files\Microsoft SQL Server\, | I:I
Shared feature directory (x86): |C:\Prugram Files (x86)\Microsoft SQL Server\, | I:I

‘ < Back | ‘ Next )R ‘ | Cancel ‘ | Help |

14. Click Next.

15. In the Instance Configuration section, select Default instance.
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Instance Configuration

Specify the name and instance ID for the instance of SOL Server. Instance ID becomes part of the installation path.

Product Key (®) Default instance
License Terms
Global Rules
Product Updates
Install Setup Files
Install Rules

O Named instance:  MSSOLSERVER |

Instance | \ MSSQLSERVER |

Setup Role
Feature Selection SQL Server directory:  C:\Program Files\Microsoft SOL Server\MSSCQL12.MSSQLSERVER

Feature Rules
Instance Configuration

Installed instances:

Server Configuration Instance Name Instance ID Features Edition Version

Database Engine Configuration

Feature Configuration Rules
Ready to Install
Installation Progress

Complete

16. Click Next.

Server Configuration
Specify the service accounts and cellation configuration.
Product Key m
License Terms
Global Rules Microsoft recommends that you use a separate account for each SOL Server service,
Product Updates | Service Account Name Password Startup Type
Install Setup Files NT Service\SQLSERVERA.... Manual w
Install Rules 5CL Server Database Engine NT Servicet MSSOLSERVER Automatic v
Setup Role SQL Server Browser NT AUTHORITY\LOCAL ... Disabled v
Feature Selection
Feature Rules
Instance Configuration
Server Configuration
Database Engine Configuration
Feature Configuration Rules
Ready to Install
Installation Progress
Complete
< Back ‘ | Ltg'l ES | | Cancel | | Help
£ |
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17. In the Server Configuration section, click Next.
18. In the Database Engine Configuration section, make sure Mixed Mode is selected.
19. Add all desired users as Administrators under Specify SQL Server Administrators by pressing
Add Current User.
a. For Domain accounts, simply type in SDOMAINNAME\SUSERNAME into Enter the
object names to select text box.
Click OK.
For local computer accounts, click on locations and select the computer’s name.
Click OK.
Type the username into the Enter the object names to select text box.

o

Once you are finished adding users, click Next.

b SQL Server 2014 Setup - | o =

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Product Key Server Configuration | Data Directories | FILESTREAM
License Terms

Specify the authentication mede and administrators for the Database Engine.
Global Rules

Product Updates Authentication Mode

e e O Windows authentication mode

Install Rules . L X .

® Mixed Mode (SQL Server authentication and Windows authentication)
Setup Role
Feature Selection Specify the password for the SQL Server system administrator (sa) account.

Feature Rules ITITI) |

Enter password: |“

Instance Configuration

Confirm password: |l.l....l.l....l |

Server Configuration

Database Engine Configuration Specify SOL Server administrators
Feature Configuration Rules WIN-MRZBO7CRMOT\Administrator (Administrator) ST e

Ready to Install have unrestricted access
Installation Progress to the Database Engine.

Complete

Add Current User | ‘ Add... | | Remove |

‘ < Back | ‘ ﬂefg‘» ‘ | Cancel ‘ | Help

20. In the Ready to install section, verify the installation and click Install.
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Ready to Install

Verify the SQL Server 2014 features to be installed.

Product Key

License Terms

Global Rules

Product Updates

Install Setup Files

Install Rules

Setup Role

Feature Selection

Feature Rules

Instance Configuration
Server Configuration
Database Engine Configuration
Feature Configuration Rules
Ready to Install

Installation Progress

Complete

Ready to install SQL Server 2014:

= Summary -~
- Edition: Enterprise

- Action: Install (Product Update)

[=1- Prerequisites =
B Already installed:

Windows PowerShell 2.0

Microseft NET Framework 3.5

Microsoft NET Framework 4.0

-To be installed from media:

Microsoft Visual Studic 2010 Redistributables
Microsoft Visual Studie 2010 Shell

(=1 General Configuration

5. Features

‘... Database Engine Services

Client Tools Connectivity

Client Tools Backwards Compatibility

Client Tools 5DK

¥ + Trnle - Bari

Configuration file path:

|C:\Proglam Files\Microsoft SOL Server\12045etup Bootstrap\Logh20170814_070653\ ConfigurationFile.ini |

< Back ‘ | lnstTI | Cancel | | Help |

21

Complete

Wait for the installation to finish.

Your SQL Server 2014 installation completed successfully with product updates,

Product Key

License Terms
Global Rules
Product Updates
Install Setup Files
Install Rules

Setup Role

Feature Selection
Feature Rules
Instance Configuration
Server Configuration

Datak Engine C

Feature Configuration Rules
Ready to Install

Installation Progress
Complete

Information about the Setup operation or possible next steps:

Feature Status |~
& Management Tools - Complete Succeeded
(@ Client Tools Connectivity Succeeded =
(@ Client Tools SDK Succeeded
(@ Client Tools Backwards Compatibility Succeeded
% Management Tools - Basic Succeeded L
(4 Database Enaine Services Succeeded |
Details:
Viewing Product Documentation for SQL Server ~

Only the components that you use to view and manage the documentation for SQL Server have
been installed. By default, the Help Viewer component uses the online library. After installing
SQL Server, you can use the Help Library Manager component to download documentation to

your local computer. For more information, see Use Microsoft Books Online for SQL Server

(<http://go.microsoft. com/fwlink/?LinkID=299578=).

Summary leg file has been saved to the following location:

C:A\Program Files\Microsoft SQL Server\120\Setup BootstraphLogh20170814 070 553\5um@g WIN-

MRZBOTCRMCT 20170814 070653 txt
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22. Click Close.

2.4.2 Open Port on Firewall

1. Open Windows Firewall with Advanced Security.

File Action View Help
s

Py elts| Windows Firewall with Advanced Security on Local Computer |

3 Inbound NES

OutboundRules ‘ ; 2 1
Beicoi: fin Secuity Bl Windows Firewall with Advanced Securty provides network security for Windows computers. &) Import Pelicy...
I+ %, Monitoring 45| Export Policy...
Overview Restore Default Policy
Domain Profile Diagnose / Repair
@ Wiindows Firewsllis on View N
€ Inbound connections that do not match a nile are blocked =
6] Refresh
@ Outbound connections that do not match a rule are allowed
Properties
Private Profile H vep

@ Windows Firewallis on
© Inbound connections that do not match a rule are blocked.
@ Outbound connections that do not match a nuls ars allowed

Public Profile is Active

@ Windows Firewsllis on

® Inbound connections that do not maich a e are blocked
@ Outbound connections that do not match a rule are allowed.

Windaws Firewall Propeties

Getting Started

Create cannection secutty rules to speciy haw and when connections between computers are authenticated and
protected by using Intemet Protocol securiy (IPsec).

Connection Security Rules

View and create firewall rules

Create firewall rules to allow or block connections to specified programs or ports. You can also allow a connection «
it is authenticated. or f it comes from an aLthorized user. group. or computer. By defaul. inbound connactions are |
blocked unless they match a rule that allows them, and outbound connections are allowed unless they match a ruk
blocks them

> | <] n [

2. Click Inbound Rules.
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File Action View Help

R GINEIN

fnboiindRuks) Name Group Profie  Ensbled A~ || Inbound Rules -
OutboundiBilesy @ BranchCache Content Retrieval (HTTP-In)  BranchCache - Content Retr... Al No @ NewRul
% Connection Security Rules @ BranchCache Hosted Cache Server (HTT...  BranchCache - Hosted Cach... All No y
v %, Moritoring ranchCache Peer Discovery (WSD-In)  BranchCache - Peer Discove... Al No W Filter by Profile 4
(@) COM+ Network Access (DCOM-In) COM Network Access Al Yes T Filterby State 3
@ COM- Remote Administration (DCOM-In) COM Remote Administrati.. Al Ne || Fiter by Group v
(@ Core Networking - Destination Unreacha... Core Networking Al Ves
(@ Core Networking - Destination Unreacha... Core Networking Al Yes Hiew ’
(@ Core Networking - Dynamic Host Config... Core Networking All Yes 1G] Refresh
(@ Core Networking - Dynamic Host Config... Core Networking Al Yes B ExportList..
{8 Core Networking - Internet Group Mana...  Core Networking Al Yes AT @ Hep
(@ Core Networking - IPHTTPS (TCP-In) Core Networking Al Yes A
(@ Core Netwarking - IPv6 (IPvé-In) Core Networking Al Yes A
{8 Core Networking - Multicast Listener Do...  Core Networking Al Yes A
(@ Core Networking - Multicast Listener Qu... Core Networking Al Ves A
{8 Core Networking - Multicast Listener Rep.. Core Networking Al Ves A
{8 Core Networking - Multicast Listener Rep.. Core Networking Al Ves A
(@ Core Networking - Neighbor Discovery A... Core Networking Al Ves A
(@ Core Networking - Neighbor Discovery S... Core Networking Al Ves A
(@ Core Networking - Packet Too Big (ICMP... Core Networking Al Ves A
(@) Core Networking - Parameter Problem (1. Core Networking Al Yes A
(@) Core Networking - Router Advertisement... Core Networking Al Ves A
(@ Core Networking - Router Solicitation (IC... Core Networking Al Yes A
(@ Core Networking - Teredo (UDP-In) Core Netwrking Al Yes A
@ Core Networking - Time Exceeded (ICMP... Core Netwarking Al Yes A
(@ Distributed Transaction Coerdinator (RPC)  Distributed Transaction Coo.. Al Yes A
(@ Distributed Transaction Coordinator (RP... Distributed Transaction Coo.. Al Yes A
(@ Distributed Transaction Coordinator (TC... Distributed Transaction Coo.. Al Yes A
@ File and Printer Sharing (Echo Request - | File and Printer Sharing Al No A
@ File and Printer Sharing (Echo Request - | File and Printer Sharing Al No A
le and Printer Sharing (LLMNR-UDP-In)  File and Printer Sharing Al No A
@ File and Printer Sharing (NE-Datagram-In) ~ File and Printer Sharing Al No A
@ File and Printer Sharing (NE-Name-In)  File and Printer Sharing Al No AL
<[ m ] S >
New Rule..

3. Click New Rule.
4. Select Port.

5. Click Next.
6
7

. Select TCP and Specific local ports.

. Type 1433 into the text field.
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Protocol and Ports
Specify the protocols and ports to which this rule applies.
Steps:
@ Rule Type Does this e apply to TCF or UDF?
& Protocol and Ports ® TCP
@ Action ) UDP
@ Profile
@ Name . .
Does this nule apply to all local ports or specific local ports?
O All local ports
® Specific local ports: |1433
Example: 80, 443, 5000-5010
8. Click Next.

9. Select Allow the connection.
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Action
Specify the action to be taken when a connection matches the conditions specified in the rule.

Steps:
@ Rule Type What action should be taken when a connection matches the specified conditions?
@ Protocol and Ports
z ® Allow the connection

@ iction This includes connections that are protected with |Psec as well as those are not.
@ Profile

N () Allow the connection if it is secure
@ Name

This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in IPsec properties and rules in the Connection Security
Rule node.

) Block the connection

<Back || Net> |[ Cancel

10. Click Next.
11. Select all applicable locations.
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Profile

Steps:

Rule Type
Protocol and Ports
Action

Profile

& & & &

Name

Specify the profiles for which this rule applies.

When does this rule apply?

[+ Domain
Applies when a computer is connected to its corporate domain.
[ Private

Applies when a computer is connected to a private network location, such as a home
or work place.

[v] Public
Applies when a computer is connected to a public network location.

<Back || uead>ws| Cancel

12. Click Next.

13. Name the rule Allow SQL Access.
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Name

Specify the name and description of this rule.

Steps:

# Rule Type

@ Protocol and Ports

@ Action

@ Profie Hamey
[Alow SQL Access

@ Name
Description {optionial):

< Back

B, | |

Cancel

14. Click Finish.

2.4.3 Add a New Login to the Database

1. Open SQL Server Management Studio.
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” Microsoft SO Server Management Studio (Administrator) [=lol= x|
fie Ede Vs Tosh Window Hep

1 07 e ] New ey L
Eibjact Laplooes =0
Connect= & 3, m T 1.5

s LUl ]y ] Y 2o

Conmect 1o Server

Microsoft SQL Server 2014

2. Click Connect to connect to the database.
3. Inthe Object Explorer window, expand the Security folder.

Fie Lt Www Oebog Tooh Window Mep

L e e e AW e e L B e R e =

Blpgect Explorer

Conset= i 34 m T 1.4
i WAN-MRIROTCRMON (501 San
® i Databases

- 3%

4. Right-click on the Logins folder and click New Login....
5. Input the desired user.
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i Microsoft SOL Server Management Studsa (Administrator) (=[O =

[ e L A o e e R e N I £} =3 F 0 e

5 | WIN-ARIBOTCRMAN (S0 Server 1201
# 22 Dotibunies
3 ey
# 1 Logi
u 3 Sarver Roles.
= 3 Credentis
= 3 Cryptogeashic Providers

anageman
= (L Inbegraton bervices Catalegs
{7 501 Server figent (Agant 1Py diiabi

6. Click OK.

2.5 Microsoft IIS Server

As part of our enterprise emulation, we include a Microsoft Internet Information Services (lIS) server.
This section covers the installation and configuration process used to set up Microsoft Exchange on a
Windows Server 2012 R2 machine. This was conducted on the same machine as in Section 2.4.

2.5.1 Install 11S

1. Open Server Manager.
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WELCOME TO SERVER MANAGER

B Lot Server
B A0 Servers
B File and S1cenge Senvicrs &

[ ]

—

ofc

figure this local server

Add roles and features

e
A oK
ROLES AND SERVER GROUPS
Botew1 | Sarvrrgroupe 1 | Servers
File and Storage
1 1 All 1
s B tocal server B sorvers
() Manageabiity (D Manageabisty @ Manageabisey
Events. Events Events.
Perfomunce Sanvices Services
BPA results Pertormance Pedamance
BPA resuits BPA results

2. Click Add Roles and Features.

Before you begin

Installation Type

Server Selection

DESTINATIOM SERVER
MESQLDLIPDR

This wizard helps you install roles, role services, or features. You determine which roles, role services, or
features to install based on the computing needs of your organizaticn, such as sharing documents, or
hosting a website,

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Metwork settings, such as static |P addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[ Skip this page by default

<Prewous|| MNext > | | Install || Cancel

3. Click Next.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

91



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

Select Role-based or feature-based installation.

DESTINATION SERVER

Select installation type MSSQLDLPDR

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, or on an offline virtual hard disk (VHD).

Before You Begin

® Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

Server Selection

() Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VD) to create a virtual machine-based
or session-based desktop deployment.

< Previous | | Mext > | | Install | ‘ Cancel

Click Next.
Select MSSQL (or the correct Windows Server name) from the list.

DESTINATION SERVER

Select destination server MSSQLOLIPDR
Before You Begin Select a server or a virtual hard disk on which to install roles and features,

Installation T ®) Select a server from the server pool
Ype p!
) Select a virtual hard disk

Server Rolas Server Pool
Features
Filter: |
MName IP Address Operating System

Microsoft Win

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

< Previous | | Next > | | Install | | Cancel

Click Next.
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DESTINATION SERVER

Select server roles MSSQLDLPDR

Before You Begin Select one or more roles to install on the selected server,

Installation Type Roles Description

Server Selection

[>

o Web Server (IIS) provides a reliable,
[ Application Server manageable, and scalable Web
[] DHCP Server application infrastructure.

[] DNS Server
[ Fax Server
p @ Fileand Storage Services (1 of 12 installed)
[] Hyper-v
[] Metwork Policy and Access Services
[] Print and Document Services
[] Remote Access
[] Remote Desktop Services
[ Volume Activation Services
[MRWeb Server (IIS]
[ Windows Deployment Services
[[] Windows Server Essentials Experience
[J Windows Server Update Services

Features

W

| < Previous || MNext » | | Install || Cancel

8. Check the box next to Web Server (lIS).
s Add Roles and Features Wizard -|O]| x

DESTINATION SERVER
MSSQLDLIPDR

X

Select server ro B

Add features that are required for Web Server (IIS)?
tion
The following tools are required to manage this feature, but do not

have to be installed on the same server. eallbliproveks e ietiabley

pble, and scalable Web
on infrastructure.

4 Web Server (IIS)
4 Management Tools

[Tools] IS Management Console

Include management tools (if applicable)

| Add Features | | Cancel

< Previous | | Next > ‘ | Install | | Cancel
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9. Click Add Features.

Select server roles

Befcre You Begin
Installation Type

Server Selection

Features
Web Server Role (lI5)
Role Services

Confirmation

Select one or more roles to install on the selected server.

Roles

[] Application Server
[] DHCP Server
[] DNS Server
[] Fax Server
> [®] File and Storage Services (1 of 12 installed)
[ Hyper-v
[] Network Policy and Access Services
[] Print and Daocument Services
[] Remate Access
[[] Remote Desktop Services

[1 Volume Activation Services

[>

Neb Server (lIS)

[] Windows Deployment Services
[[] Windows Server Essentials Experience
[] Windows Server Update Services

w

DESTINATIOM SERVER
MSSQLDLIPDR

Description

Web Server (IIS) provides a reliable,
manageable, and scalable Web
application infrastructure,

| < Previous | | Mext » | | Install | | Cancel

10. Click Next.

11. Ensure that all desired features are selected.

Select features

Before You Begin
Installation Type

Server Selection

Server Roles

‘Web Server Role (I1S)
Role Services

Confirmation

Select one or more features to install on the selected server.

Features

S | Background Intelligent Transfer Service (BITS)
[] BitLocker Drive Encryption
[ BitLocker Netwark Unlock
[] BranchCache
[ Client for NFS
[[] Data Center Bridging
[] Direct Play
[] Enhanced Storage
[] Failover Clustering
[ Group Policy Management
[] 1s Hostable Web Core

[] Ink and Handwriting Services

[ [M] .NET Framework 4.5 Features (2 of 7 installed)

[<]

<] [} |

DESTINATION SERVER
MSSQLDUIPDR

Description

NET Framework 3.5 combines the
power of the .NET Framework 2.0
APIs with new technologies for
building applications that offer
appealing user interfaces, protect
your customers' personal identity
information, enable seamless and
secure communication, and provide
the ability to model a range of
business processes.

< Previous ||

Net> | | nstall |[ Cancel

12. Click Next.
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Before You Begin
Installation Type
Server Selection

Server Roles

Features

Role Services

Confirmation

Web Server Role (lIS)

Web servers are computers that let you share information over the Internet, or through intranets and
extranets. The Web Server role includes Internet Information Services (IIS) 8.5 with enhanced security,
diagnostic and administration, a unified Web platform that integrates IS 8.5, ASP.NET, and Windows

Communication Feundation.

Things to note:

* Using Windows System Resource Manager (WSRM) can help ensure equitable servicing of Web
server traffic, especially when there are multiple roles on this computer,

* The default installation for the Web Server (1I5) role includes the installation of role services that
enable you to serve static content, make minor customizations (such as default documents and HTTP
errars), monitor and log server activity, and configure static content compression.

More information about Web Server IS

DESTINATION SERVER
MSSQLDIIPDR

<Previu|.|s|| MNext = | |

install | [ Cancel

13. Click Next.

14. Ensure that Default Document, Directory Browsing, HTTP Errors, Static Content, HTTP Logging,

and any other desired Role services are selected.

Select role services

Before You Begin
Installation Type
Server Sslection
Server Roles

Features

Web Server Role {1IS)

Confirmation

Select the role services to install for Web Server (115)

Role services

4
4 Common HTTP Features
Default Document
Directory Browsing
HTTP Errors.
Static Content
[] HTTP Redirection
[[] WebDAV Publishing
4 Health and Diagnostics
HTTP Logging
[] Custom Logging
[] Logging Tools
[] obec Logging
[] Request Monitor

| >

<| 1]

HEY

1<|

DESTIMATION SERVER
MSSQLDIIPDR

Description

Web Server provides support for
HTML Web sites and optional
support for ASP.NET, ASP, and Web
server extensions. You can use the
Web Server to host an internal or
external Web site or to provide an
environment for developers to
create Web-based applications.

<Previuu5|| Mext » |

[ instal | [ Cancel
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15. Click Next.

DESTIMATION SERVER

Confirm installation selections MSSQLDLPDR

Before You Begin To install the following roles, role services, or features on selected server, click Install.

Installation Type [] Restart the destination server automatically if required
Server Salection Optional features (such as administration tools) might be displayed on this page because they have
| been selected automatically. If you do not want to install these optional features, click Previous to clear
Seper Roks their check boxes.
Features
-
Web Server Role (IS) Web Server (IIS) —

Management Tools

Role Services

115 Management Console

‘Web Server
Common HTTP Features
Default Document

Directory Browsing
HTTP Errors
Static Content

Health and Diagnostics

<]

Export configuration settings
Specify an alternate source path

<Previous | | Mext> | [ nstall | [ Cancel

16. Click Install.

DESTIMATION SERVER

Installation progress MSSQLDLPDR

View installation progress

o Starting installation
[ ]

[>]

‘Web Server (l15)
Management Tools
115 Management Console
Web Server
Common HTTP Features
Default Document
Directory Browsing
HTTP Errors
Static Content

Health and Diagnostics
HTTP Logaina

<]

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

< Previous ‘ ‘ Next > | ‘ Install | | Cancel
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17. Wait for the installation to complete.

. DESTINATION SERVER
Installation progress MSSQLDLEDR
View installation progress
o Feature installation
| —
Installation succeeded on MSSQLDLIPDR.
Web Server (115) Z

Management Tools
115 Management Consaole
Web Server
Common HTTP Features
Default Document
Directory Browsing
HTTP Errors
Static Content

Health and Diagnostics

[<]

HTTP Logaina

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Motifications in the command bar, and then Task Details.

Export configuration settings

< Previous ‘ | Next > | | Close | | Cancel

18. Click Close.
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2.5.2 IIS Configuration

1. Open Windows Explorer and click This PC.

Drive Tools
Home Share View Manage A 0
® = [ » ThisPC » Local Disk (C) v & [ Sesrch Local Disk (<) o]
=
A Favorites Name Date modified Type Size
B Desktop inetpub 1/26/2018 1:52PM  File folder
P
|l Downloads | Perflogs 8/22/2013 &:52 AM  File folder
5l Recent places |, Program Files 11/6/2017 6:26 PM File folder
h Program Files (x86) 11/9/2017 &:26 PM File folder
18 This PC L Users 11/9/2017 @27 PM  File folder
1 Windows 1/26/2018 1:52 PM File folder
f" Metwork

6 items {;]
2. Right-click and select Create Folder.
3. Name the folder www.

Home Share View v 9
(€ (3) ~ 1 [E » ThisPC b Local Disk (C) » v @& [ Search Local Disk (C:) 2]

ﬁ Eavorites Name - Date modified Type Size
B Desktop | inetpub 1/26/2018 3:52 PM  File folder
|18 Downloads | Perflogs 8/22/2013 &:52 AM  File folder
% Recent places |\ Program Files 1/29/2018 4:04 PM File folder
L. Program Files (x86) 1/29/2018 2:40 PM File folder
18 This PC L Users 1/26/20185:52 PM  File folder

1/28/2018 2:25 PM File folder
2/1/2018 1:38 PM File folder

f! Network

7items  1item selected
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Open the Internet Information Services (IIS) Manager.

@Y » StartPage

File View Help

erne 0 atio & es 8
b8 MSSQL (MSSQL\Administratc
Name Server Connect to localhost 1IS News and Information
SmssaL e Connect to a server... 1IS Downloads
Connect to a site... 1IS Forums
Connect to an application... TechNet
MSDN
ASP.NET News
Microsoft Web Platform
<] m [>]
- 7 . 7 o o

IS News.

115 News is disabled, click the Enable IIS News link to get the most recent enline news.

<] m B

Ready
5. Click the arrow next to MSSQL (or the chosen name of the server).
6. Click Sites.

CEEE G sites |@ Adavicbate
‘g mrm“*m ; Filter: = ¥ 6o - @ ShowAll | Groupby: No Grauping | Set Websie Defaghe..
-} Application Peols Neme  * ] Status Binding Path | ® Help
+ (16 Sines] @ Defout Web Site 1 Started (ht...  *:30 {htp] HSystemDrive Khinetpublymract
[<] w )
i - 1 15| [ estures view |2 Content View
Ready “ld

7. Click Add Website....
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Site name: Application pook:

“ | |DelauhAppPooI ‘ | Select... |

Content Directory
Physical path:

Pass-through authentication

| Connect as... ‘ ‘ Test Settings... |
Binding
Type: IP address: Port:
|http v| |Al( Unassigned v| |BD |
Host name:

Example: www.contoso.com or marketing.contaso.com

[ Start Website immediately

| o |[ canea ]

Enter the desired site name.

Site name: Application pook

[MssaLsITE | [mssause | [ select..

Content Directory
Physical path:

I[=]

Pass-through authentication

‘ Connect as... | | Test Settings... |
Binding
Type: IP address: Port:
|http v| |AIE Unassigned v| |M |
Host name:

Example: www.contoso.com or marketing.contoso.com

[ Start Website immediately

o || Cancel

Click ... under Physical path:.
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Add Website CalEC

Site name: Application pook

[MsSQLSITE | [mssaLsiTe | Select...

Content Directory
Physical path:

Pass-through authentication h

Select a directory for the application.
Test Settings...

Binding b B Videos [~
T [ b < Floppy Disk Drive (4:)

|http v| |A|I Unassigr| D

» &% DVD Drive (D:) SQLSERVER

Host name: I 4 Libraries
| [ f- MNetwork =
Example: www.contoso.com or ma 1 B8 Control Panel by

'E] Recycle Bin

[ vakenewFolder | [ ok |[ cancel

[w] Start Website immediately

‘ oK | | Cancel

10. Locate and select the folder created in step 3.

Add Website B

Site name: Application pool:

[MssQLSITE | [mssaLsie || select..

Content Directory
Physical path:

Pass-through authentication *

Select a directory for the application.
Connect as... Test Settings...

Binding 4 iy Local Disk (C:) |~
Type: IP address: b & inetpub
|http v| |AHUnasswgr & Perflogs
I . Program Files
Host name: I . Program Files (x86) il
| I . Users =
Example: www.contoso.com or mai I Windows
L &% DVD Drive (0:) SO SERYER i
[ MakerewFoder | [ ok || cancel
[ Start Website immediately
ok || caneel

11. Click OK.
12. Set Type to http and Port to 80.
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13. Ensure that the IP address and Host name fields are filled in with the correct information for

the machine.
14. Ensure that Start Website immediately is selected.
Add Website | 2 [
Site name:
[MssausiTE | [mssausiTe [ [ setect..
Content Directory
Physical path:
|C:\Www | lII
Pass-through authentication
| Connect as.. | |Test Settings... |
Binding
Type: IP address: Port:
http v v [s0 |
Host name:
| MssaLdiipdr |
Example: www.contoso.com or marketing.conteso.com
Start Website immediately
oK | | Cancel

15. Click OK.

2.6 GreenTec WORMdisks

See the Installation of GreenTec Command Line Utilities document, which should accompany the
installation disk, for a detailed guide on how to install the GreenTec command line utilities.
Furthermore, refer to the GT_WinStatus User Guide, which should also accompany the installation disk,
for instructions on how to effectively use GreenTec WORM(disks to preserve data. Read these
instructions carefully, as locking GreenTec WORM(disks can result in making some or all of the disk or
the entire disk unusable. Having portions of the disk or the entire disk permanently locked is sometimes
desirable, but it is dependent on the needs of your organization, e.g., if you want to store backup

information or logs securely.

The GT_WinStatus User Guide provides instructions for locking and temporarily locking disk sectors. In
this practice guide, we will not include instructions on when to lock GreenTec WORMdisks. However, we
will provide instructions detailing how to save data to these disks and various commands used in
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manipulating the disks. Below, find descriptions of some commands useful for automation of GreenTec
WORM(disks. Actual automation of these disks will vary per organization.

2.6.1 Format GreenTec WORMdisks
To format GreenTec WORM(disks for use, the following command can be used.

> gt _format.exe <disk number> /parts:<number of parts> /label:<id>

This command can be used to split a disk into a specified number of partitions, with each partition being
labeled according to the label id specified.

For example, this command will split drive 1 into four parts, labeled DI001, DI002, DIO03, and DI004:
> gt _format.exe 1 /parts:4 /label:DlI

Formatting drive 1 partition 1 file system NTFS label "DI00O1"
Format successful

Formatting drive 1 partition 2 file system NTFS label "DI1002"
Format successful

Formatting drive 1 partition 3 file system NTFS label "DI003"
Format successful

Formatting drive 1 partition 4 file system NTFS label "DI004"

Format successful

2.6.2 Obtain Status Information About GreenTec WORM(disks

To verify information about GreenTec WORM(disks, use the following command.

> wvlist.exe <drive number>

This command can be used to display basic information about a drive, such as the amount of space of
each partition, whether it is a WORM(disk, whether they have been locked, and what drive letter to
which they are mapped.

For example, this command will list the characteristics of drive 1.

> wvlist.exe 1

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 103



"GZ-008T"dS’ LSIN/8Z09°0T/840°10p//:sd11y :wolj 984eyd jo 9aJ) d|qe|ieae s| uonealjgnd siy |

WVLIST: List WORM Volume (WDV) Status on Physical WORMdisks(tm).
Copyright (C) 2015 GreenTec-USA, Inc. All rights reserved.
Drive#=1 Type=ATA F/W=GT5G Size=500{GB)
> IS WORM > IS *NOT* Finalized

Fxx*k  WORMdisk Volume (WDV) Info ****
WDV # TB ENFORCED GREENTEC TLOCKED

S S D > <o > <emmee >
001 0.125 NO YES NO G:\
002 0.125 NO YES NO H:\
003 0.125 NO YES NO I:\
004 0.125 NO YES NO J:\

2.6.3 Map GreenTec WORMdisks to Drive Letters

1. To unmap a partition from a drive letter, use the following command:
> wvmap.exe <drive letter>:
For example,
> wvmap.exe H:
will unmap H:, making it available for mapping to another partition.
2. To map a partition to a drive letter, use the following command:
> wvmap.exe <drive letter>: <drive number>.<partition number>
For example,
> wvmap.exe H: 1.2

will map the second partition of drive 1 to H:, making files available through accessing that drive
letter.

3. To map the next partition to a drive letter, use the following command:
> wvnext.exe <drive letter>:

For example, if H: is mapped to partition 2 of drive 1 (1.2)
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> wvnext.exe H:

will attempt to map H: to partition 3 of drive 1 (1.3).

2.6.4 Activate Write Protection in GreenTec WORMdisks

1. Running GT_WinStatus.exe will open the Graphical User Interface (GUI), which displays various
information such as drive mappings, partitions, total space, and space used, as well as a range
of other options.

6/28/2018 7:10:35 PM
7 Active, 0 Added, 0 Remaved

Size (KB) Pct BytesUsed
WORM (RW) | 255,999,996 005  |130437.120
WORM (RO) 102.399.9% 009 [93.130.752
WORM (RW) | 129,853.436 009 [117.055488
WORM (RW) | 122.063.240 0.09 |116.776.960
WORM (RW) | 122,063,240 009 |116,776,960
WORM (RW) | 122,063,240 009 [116,776,960
WORM (RW) | 122.065.736 009 |116.776,960

2. More columns can be added by right-clicking anywhere in the Active window, opening the
Settings window.
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%Graenfl‘m"‘
p— | e | (SR — i
e m— Y — o s it 5]
[ Promptfor User Flds ~ [] Assigndiive letter ] Run when Auto finalizing (] Finalze ot (4ful): [39_ | [[coor |
PhySiot_DivePat ScsilD SenalNum Path Model Cortroler C_E S FimwareVer Fie Siatus Sze  PolUsed BylesUsed BytesDelq oK
St |DivePan |ScsilD |SeralNum |Path |Model |Controller |C_E_S |F F Status |Size (KB) Pt | BytesUsed | BytesDelta
Show Active yes yes no no |yes | no no yes yes yes ves | yes yes yes Apply
Show Added yes yes yes yes yes | yes yes yes yes yes yes yes yes yes yes
Show Removed yes yes yes yes yes | yes yes yes yes yes yes yes yes yes
Aignment [ et |leht et et R et ket Jeft [ O O Y left

3. Inthe Settings window, User Field 1 and User Field 2 are for any metadata to be stored for a
drive. Pre: runs a script prior to finalizing a drive, and Post: runs a script after finalizing a drive.

4. Also, from the Settings window, right-clicking on Critical Threshold or Warning Threshold will
allow the user to set up alert preferences for drives that are nearly full (at a configurable
percent value).
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User Information Logon Information

From Name: [WoRMaler | User Name: |

From Email Address: [WORMaler @greentec usa.com | B password: |

5. To display the GUI with options to lock and enforce locks on drives, the following command
must be used to start the GUI:

> GT_WinStatus.exe /tlock /enf

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

107



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

6. This will add columns called TLock and Enforce (as well as the ability to use the Finalize

column).

7. The TLock column temporarily locks/unlocks a partition of the drive. This is useful to prevent
modification during times when modification should be disallowed.

Important: The following functions in steps 8 and 9 will permanently lock portions of the
drive, making them read-only.

The Enforce function permanently locks all volumes up to the enforced volume.

The Finalize function permanently locks the entire drive.

8. The Enforce column is a permanent incremental lock. This means that it permanently prevents
modification for the selected volume of a drive as well as all volumes that come before that
volume on the drive. Once these sections are enforced, they cannot be written to ever again.
This functionality is particularly useful in protecting data or backups that must never be
modified, but as the enforce function is permanent, it must be used carefully.

9. The Finalize column permanently locks the entire drive. This is useful when a drive is full and no
longer needs to be written to. Data can still be read and copied from this drive to other places,
but no write actions will be possible after this is used, so it also must be used carefully.
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2.7 CryptoniteNXT

See the CryptoniteNXT 2.6.2 Unified Installation Guide, which should accompany the device for a

detailed guide on how to install CryptoniteNXT on the provided device.

The CryptoniteNXT 2.6.2 Unified Installation Guide provides a full installation on both the

CryptoniteNXT device and the management workstation. When finished, it should be possible to log in

on the management workstation and interact with the CryptoniteNXT ACC GUIL. Instructions are

provided below for performing various useful functions, including adding new devices/users, as well as

creating policy, but specific recommendations for policy are not provided, as those will be specific to the

organization. Some integrations with other security products used in this guide will be provided, as
exceptions for those products in CryptoniteNXT are often necessary for their functionality.

2.7.1 Configure Cryptonite NXT

2.7.1.1 Verify a New Device

1. Open the CryptoniteNXT ACC GUI application.

CryptoniteMXT ACC Client

ACC Engine Server Name/IP:
Keystore File:

Keystore Password:

CRYPTONITE

N
|acc |
|sers\Admiantmtor.DI\Dncuments\acc_gui_keystore.jks| [ Keystore File: ]
|113111111111131 | E

2. Click OK.

3. Enter the password for the account created during the installation.

Connect to the ACC Engine >

Enter password for username ‘administrator': |**************l|

[ 0K ] [ Cancel ]

4. Click OK.
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W CrypranteldT ACC Client - Usen administratar (READ_ONLY) = =] E
SopEorng | ([ synchwehsever | [ About )
[ Refrash Registrabon State at Intenval (seck: L
Access Control Poboes 4 Users 1 Endponts
O Shor S Groims B RS R B | | Shaw: g R | | Show: e O
Fheron: (NoFter < B | | feron: [NoFRer =)
[AETes Tl Paboes.
| SowceGroups | Promwcol | PortRange | Acton | Destnaso.. | Defaur | id"_.“___l ‘ll\ll s: a;“ Mmﬁ .WMB. ":;
: : = . adrminws | SN TSAdmns 9 <] [=]
SHXTSALT Engne [UDP 5353 whuntud.... | alknm %] 8] O
"
| ingress i we | Ges@etiGops
| @ | abtraffc, block-dhcp A
5. Click Enable Editing at the top of the application.
6. Click the Endpoints tab.
ACE Chent - - a o
Tratie [8trs [ StpEdeng | Sy, wieh Sarver — |
B o | B9 copmtt e G oo AN-‘_S.WIQ.. | @ 0| B ot osmn
ATTINTION: There e uvverfid sndsom(s) 0 the sscivs (hghighted n ed)l
1. et e ardpont i the e 1
;‘.ummmpmmarzwunw.u:nmwwmaﬂwn
O 1 ey ] [ W oW rmD
A I MES NS Lo JE N = !
srratite | & hd [ F N ) z

Marra: .-7

Bescrpton: N |

s 1

Tbeund ity (1=
hodres: | ]

L B, € set, for

Statun e

Stat 1P Permaon: (= E—

7. Click the Unverified tab. Any new devices connected to the network should appear here, if

configured to use Dynamic Host Configuration Protocol (DHCP).
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I Cryptonehiil ACC Chant - User: samiristeatce [1DIT) - B8 X

oo ey oot

B rosey| B3 crosnenct sotes| (] tncsorss | B pecs | @ mtacaten | @), etwork i | ) Daoty | By settmare Uit

Werfied (3| Uoverfed (5] | Parmanestly Un-venfied (0] | Quarastned {0

Exteenl e ac W remD

atmngr 1961244

Descophon:

A

Twmer: MO T 20T

e gatemar: T SET

Extaml ngrew (rbound] B Addoei:

W Ao o extiemal ingrens 7,  sat, for aprems [outhound) taffe
St Unvarted

Statc B Pemission: Caalimnd

8. Click the machine to verify.

9. Enter a name.

10. Enter a description of the machine.

11. Select an owner if desired. If not selected, the owner will be the first user to log in to
CryptoniteNXT on the machine.

12. Leave Inbound gateway: as NOT SET to have it choose a default gateway.

13. Leave External ingress (inbound) IPv4 Address: blank.

14. Ensure the box next to Also use external ingress IP, if set, for egress (outbound) traffic is
checked.

15. Set Status: to Verified.

Confirm Change of State x

0 Warning: Switching to 'Verified' state will make the policies of the endpoint take effect immediately.
=¥ Please check it's policies in the Policy tab before making the change.

Are you sure you want to change the endpoint’s verification state fru% un-verified to verified?

16. Click Yes.
17. Click Save.
18. The machine should now appear in the Verified tab.
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B CryptoneehlT ACC Cleast - Lier sdenmtratee (EOT) = a ®

Enable E5tng [ Sopiotrg | Synich with Server T
Refresh Repetration State 3t Intenal {sec): ¢
B #oso | B oo oses]| F tosoorss| B, encine| § oo | @, e s | @) oo | B sotware e
ATTENTION: Thare are Uty i) I tha secie

1. Stfect U endoont s the Lrerfed b
2. I Engeoen Ostaly’ pane, change the endssnt "SLluy’ 1o 4} Verfied, ] Permananty Unverfied or <) Quarantned

Wli]lmﬂzlmmﬂjmmi .
o i DU ] O i aiapien; I BBy Ja A MO ) P
3 1 DEDER IS 1 sdmngtrator 1 AcE 8 0N | [u] t

o | we:Facbisld:e060 Jdrmstraton & Adern | O [w] Ed

Hame: ubortugesTe

Descrpton: - 1

e

Inbound

2.7.1.2 Create a New User

1. Go to the Policy tab.

I CoyptoriteliT ACE ot - Uter sdevisatrates (EENT) - a8 x
Enable E5tng [ Sopiotrg | Syivch with eroer About 1
Rafremn Repetration State 3t Intenal (sac): |«
B 7ok |3 comtoncuotnotes| F enoorss| B, evcie | . | @, ek s | @) 0o | B st o |
‘Access Control Polces 4 Users + Endponts.
00 Show System Grouss L R R e — E o R T — =2
E Fer On: o Fitwr | Fleer On: (g ¥t =]
Nae | SosceGrpt  Auth Tyt e Sorte Grinst L Oeatonfoops | LOwe
v | 8 o [;;—‘ B a s] O
admi-ves ST HAG i s O
ubuntutesiten | abinue a a_ O
3
= Y
T 9Gs |
| O | st blockdhen a

Right-click in the Users window and select New User.
3. Enter the username, and uncheck the box next to Auto-generate and distribute first user TOTP
key to the portal.
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Insert Mew User >

Mew user name: |ubuntu—user

[) Auto-genererate and distribute first user TOTP key to the portal

R (o) ()

4. Click OK.

I CryptontebirT ACE Chent - User: sdmisisssater EDT) - 8 X

1

P — &
[ Y —
[ Mame | SosceGraps  utTioe | Enabied [
fadmni._. a -] af fjace a a| O
ot oar [y & | O [l | piTgadmr. al 8 O
ey . a a o
| Pl sars + Souten Groups + CrpptentendcT Nodas
PR 3 & R | [ e ¢ ey ke =
- =
(Lol - e L A e B
g pradaie R — ! tame Sauree Graes R e Egrem Dewt) Grouen !
i oy Dt L A e D accen 3] |lew 3 | abtraffc, Bock-ncp sl
ahenc o1 o1 =+ |||iE a1 : :

5. The new user should show up in the Users window. Click the key icon for the newly created user
under Auth Type.

6. Decide on an authentication method for the user. (Note: It is not recommended to use
passwords, but as this authentication decision depends on the needs of the organization,
passwords are used for the purposes of this practice guide.)
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Ml Modify User Authentication Key X
User name: ubuntu-user
Authentication Type:
@ Keep current type: TOTP KEY <VALUE HIDDEN=
OR
(O Auto-generate and distribute new TOTP key (STRONGLY RECOMMENDED if making changes)

(O Manually enter TOTP key (for hardware tc-kens)[} | |

(Enter Base32 encoded key, exactly 32 characters using only A-Z, 2-7 MO zeros or ones)

O Basic password (WARNING: THIS 15 INSECUREL): | |

(Passwords in general can be easiy replayed by malware, do not use this option!)

7. Click Save.

ACC Cher - L DT - o %

| Acowss Control Polcms + lindoonts
1| £ show sysem eoups B R X E || s [Eubed il K R | | shew (Vered ] i O
| | : s = Lo R T —
Puame Seurce Grougm LA
[y [ ocTsadmen ] =)
brudeskiop | L] 8]l O
|
| )
| o Y
g e Erest Dess] Graven. ]
| shirate, bisck-en ]

On the client machine, the user should be required to sign in on the CryptoniteNXT portal to
access the internet. Authenticate using the newly created user.
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User Portal

New user? If you were given a retrieval code, enter it in the Token field. If not, enter your password in the Token field.

“Only install safe software from legitimate sources.”

Status

2.7.1.3 Create a New Policy

Creating policy in CryptoniteNXT essentially requires specifying allowed types of traffic. To do this,
source groups and destination groups are created.

1. To create a source group, right-click in the Source Groups window and select New Source
Group.
2. Enter the name of the group.

Insert Group *

Mame of new client group
|alHinux |

| oK | | Cancel |

3. Click OK.
4. The newly created group should appear in the Source Groups window.
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5. Inthe Endpoints window, click the arrow button under the Source Groups column for any
machines to be added to this Source Group.
Select the newly created group (or groups).

7. Click the >> button to add the endpoint to this group.

M Select source groups for endpoint 'ubuntudesktop’ X
Available source groups Selected source groups
SNXTSAdmINS SNXT$Al Endpoints
al-pcs alHinux
all-users
temp
<<

fye| [cox]

8. Click Save.
9. The group should show under the Source Groups column for those endpoints.
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Destination groups are used to govern the allowed destinations of endpoints within certain source
groups. While destination groups can be created according to organizational property, this example
uses an existing group, all-traffic.

1. To allow or prevent the use of ping, we add it to the all-traffic group. In the Access Control

Policies window, right-click on the row labeled To: ‘all-traffic’ and select New Access Control

Policy Entry.
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2. Click the arrow button under the Source Groups column.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

117



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

3. Select the newly created source group.

Available source groups

SNXTSACC Engine
SNXTSAdmMINS
SNXT$AI Endpoints
SNXTSAI Nodes
SNXTSAN Users
alHinux

all-pcs

all-users

temp

<<

t

@ Select source groups that can connect to destination group ... X

Selected source groups

4. Click the >> button.

Available source aroups

SNXTSACC Engine
SNXTSAdmMINS
SNXT$Al Endpoints
SNXTSAI Nodes
SNXTSAN Users
all-pcs

allusers

temp

<=

s

Ml Select source groups that can connect to destination group .. X

Selected source groups

alHinux

5. Click Save.

6. Select the Protocol. In this case, to prevent the machine from using ping, we choose ICMP.
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7. Enter the port range that this traffic can operate on.
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8. Select INVISIBLE for the Action column.
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9. This will prevent the members of this group from using ping.
10. To allow the members of this group to use ping, delete this rule. Right-click the entry and select
Delete Access Control Policy Entries.
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Ll i1 T— [Ty T —
[t | Gl Ao Died | ok Mo | emiwes | s Aoe,
. a @ | 0|l b= e a] a8l O
| [ L s s O
utentudeieee | dbina aj [ 1]

+ CryptonbeliXT tiedes
" [ Eroses Hesten Gatwedy Noces
- e A - L.
Dafnt 1 T | i SR s | Pame .
- - Mo | Defah W hewmD 1
jacan a B bt socuhen ]
oy o o 1 fe t r1 -
oo | O =] &8
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) [ o 5] [0

11. Add the newly created group to the existing policy entry by clicking the arrow for that entry
under Source Groups.
12. Select the newly created group.
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M Select source groups that can connect to destination group .. X

Available source groups Selected source groups
$NXTSACC Engine SNXTSAN Users
SNXT$AdmIns

$NXTSAl Endpoints
$NXTSAl Nodes
alHinux

al-pcs

allusers

temp

N

o

13. Click the >> button.

M@l Select source groups that can connect to destination group .. >

Available source groups Selected source groups
$NXT$ACC Engine SNXT$Al Users
SNXT$AdmINS 2lHinux

$NXT3$Al Endpoints
SNXTSAI Nodes
al-pcs

all-users

temp

<<

N
sove

14. Click Save.
15. Click Stop Editing when finished.
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16. Now, the new machine should be allowed to use ping. With these policies it is possible to

2.7.2

In this section, devices listed in Active Directory will be imported into CryptoniteNXT. For this to be
successful, the DNS server must have reverse lookup zones configured for the AD server. Please see

manage all traffic through the specification of groups, ports, and protocols.

Integrate CryptoniteNXT with Active Directory

Section 2.1.6 for setting up reverse lookup zones on the AD/DNS server.

2.7.2.1 Generate a Keytab File

1.

Open Active Directory Users and Computers.
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File Action View Help

e 2@ f0/ XDz Hm T rYih

 Active Directory Users and Com
p ] Saved Cueries
4 3 DUPDR
p ] Builtin
b [ Computers
p & Domain Controllers
b (] ForeignSecurityPrincipald
b ] Managed Service Accour
p (2] Microsoft Exchange Secy|

T 5

Name Last Narne Type Description

&, Abrsham Leptoceratops User User Account |
R, ndeministrator User Built-in account
B, Allowed RODC Password Replication... Security Group... Members in this
&, BRATVA_BACKDOOR O User Not & suspiciou
2 BRATVA_BACKDOOR_1 User Mot a suspiciout
&, BRATVA_BACKDOOR_2 User Mot a suspicious
82, Cert Publishers Security Group... Members of this
82, Cloneable Domain Controllers Security Group... Members of this
%, Denied RODC Password Replication ... Security Group.. Members in this &
2, oi y il { a 26641 User

82, DnsAdmins Security Group... DINS Administra
82, DnsUpdateProny Security Group... DNS clients whe
82, Domain Admins Security Group... Designated adm
82, Domain Computers Security Group... Al workstations
82 Domain Controllers Security Group...  All domain cont
82, Domain Guests Security Group...  All domain g:ﬂ_
82, Domain Users Security Group... All domain user|
B, Enterprise Admins Security Group... Designated adm
&2, Enterprise Read-only Domain Contra... Security Group... Members of this
2, Exchange Online-Applicati User

B, FederatedEmail 4c1f4d8b-8179-4148... FederatedEmail.4c1f4d8b-8179-4148-930f-000.. User

&, Franklin Delano Raptorvelt User User Account
2, Group Policy Creator Owners Secunity Group... Members in this
2, Guest User Built-in account
2 Harry S Triceratops User User Account
& 1ohn Quincy Ankylosaurus User User Account
L, Lynden & Ighnsen User User Account |~
<| [ | H

2. Right-click the Users folder in the left pane and select New > User.

3. Enter a name for this user, such as nxtadmin.

s Createin:  DIIPDR/Users

N —

Last name: |NXTADMIN

|NXTADMIN

—
|

|[@oLiPor

User logon name (pre-Windows 2000):

|DI\

| [rudadm'n

4. Click Next.

5. Enter a password for this user, and set the password policy.
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& Createin: DIIPDR/Users

Password: |oooooo|oooooool

Confirm password: |oouonooouon

[[] User must change password at next logon
["] User cannot change password

6. Click Next.

& Createin: DIIPDR/Users

When you click Finish, the following object will be created:

Full name: NXTADMIN
User logon name: ridadmin@DI1.IPDR
The password never expires.

7. Click Finish.
8. Right-click the newly created user and select Add to a group....
9. Enter DnsAdmins.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 124



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

Select this object type:
‘Gmups or Built4n security principals

From this location:
‘DI.IF‘DF{

Enter the object names to select (examples):
DnsAdmins

10. Click OK.
11. Right-click the Users folder in the left pane and select New > Group.
12. Enter NXTAdmins as the group name.

13. Click OK.
14. Right-click the Users folder in the left pane and select New > Group.
15. Enter NXTNodes as the group name.
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16. Click OK.
17. Click Computers in the left pane.
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File Action View Help

Y E R EEE

HeE damTEha

 Active Directory Users and Com|| Name Last Name Type Description
b [ Saved Queries 1 BACKUP-STORAGE Computer
4 4 DLIPDR 1%/ DESKTOP-7REQTKD Computer
» (] Builtin 18 EXCHANGE Computer
@ &I HYPERV Computer
b ﬁ Domain Controllers 1&IMssaL Computer
b (1] ForeignSecurityPrincipal!| g petoTepeskToRT Computer
b [Z) Managed Senvice Accou g peyroTepESKTOR2 Comptiter
4 g y""”"ﬂ Exchange Secu | o pEMOTEDESKTOP3 Computer
. (&I TRIPWIRE-E Computer
1% UC-TEST-SERVER Computer
& WIN-0LIQ7SMEHS2 Computer
18 WIN-JHAL7I215VT Computer
1% WIN-KRI2P6EGOKS Computer
1 WINDOWS10-1 Computer
& WINDOWS10-2 Computer
& WINDOWS10-3 Computer
ks
< wm >« "

18. Right-click Computers in the left pane and select New > Computer.

19. Enter the name of the acc server for CryptoniteNXT (Node A).
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The following user or group can join this computer to a domain.

User or group:

[ Assign this computer account as a pre-Windows 2000 computer

20. Click OK.
21. Right-click the newly created computer and select Add to a group....
22. Enter NXTAdmins in the box labeled Enter the object names to select (examples):.

Select this object type:
‘Gma&ihmiyni@da
From this location:

‘DI.IPDR

Enter the object names to select (examples):

23. Click OK.
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Active Directory Domain Services -

0 The Add to Group operation was successfully completed.

24. Click OK.

25. Open a new Administrator PowerShell window.

26. Enter the following command, using the newly created user in the DnsAdmins group:
> Ktpass -princ DNS/<user>.<domain>@<DOMAIN> -mapuser
<user>@<domain> -pass <user password> -out .\<keytab filename>
-ptype krb5_nt_principal -crypto all

For example:

> Kktpass -princ DNS/nxtadmin.di.ipdr@l.I1PDR -mapuser
nxtadmin@di . idpr -pass passwordl23 -out .\keytab.out -ptype
krb5_nt_principal -crypto all

27. This will produce a keytab file. Copy this file to the CryptoniteNXT Management workstation.

2.7.2.2 Import Keytab File to ACC

1. Onthe management workstation, open the CryptoniteNXT ACC GUI.

CryptoniteMNXT ACC Client >

CRYPTONITE

ACC Engine Server Name/IP: [acc |

Keystore File: |sers\.-'-\dmiantmtor.DI'-\Documents\acc_gui_keystore.jks| [ Keystore Fila:

|::=::::::=::::: | g

Keystore Password:

2. Click OK.
3. Enter the password configured during installation.
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Connect to the ACC Engine >

Enter password for username "administrator' |**************||

| oK | [L\,gancel ]

4. Click OK.
= ACE Chient - User {READ_GNLY} - o %
Enable Edung Zopfitng | [ Smchwihderer | [ About |
) Refresh Regstration Statw at Interval (sec):
Access Control Pokces + Uienn 1
O St Gk BB X | | shew = L N e T — E =]
: bl et T
8| |[aec B a| O
& | |[adrews | sroTsadmes @ ] al 0O
roentec | SiTsAdmes... | 1]
ubuntud.... | abine 8| = 5]
l.mm
A
[ e
| 5 | abtrti, binck-dhap a
|

5. Click Enable Editing.
6. Click the Integration tab.
7. Check the box next to Use Keytab file (for LDAP and/or DDNS):.
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- ALCC Client - Use ]

R

il ol (e

B reier| B3 Coptontetr ot (O Endports| B Encve| ' ntegrson | @ etwork A | ) Doy B sftwar Ut

rloag
Mot Symched with LDAP Server
Dorram name: |
Sarver ama: |
(E73]
Dynamc DHS (DOKS)

Enabie Dynamic DiS: [0

Use Keytab fle (for LOAR and/or DONS): &2 | SeleqHew Heytas

Fain Ao Hietworks
Enabla tagraven whh Palo Ao Networks: ()
Hasts
Wy 551 Cortificate:
Usemama:
Fasswor:
Domain:

Bult-n RADIIS Configuration
Enable Dult-In RADIUS Accountng Server:

Ketheros Server: | i
X%
Karhars Resime | | Bent Shared Sares |
Doman Suffi X
TIL {sek: [Bsann il
[5ave) [cancal
1CT AP Kimvs
e %
Gererane Key |

8. Click Select New Keytab.

Active Directory Integration

N

x

B If both LDAP and Dynamic DNS are enabled, single keytab file must contain credentials suitable for both.

9. Click OK.

10. Navigate to the keytab file.

Ol Select Keytab File

4 w0 & =y uss Drive (E) »

& |y Templtes :

- |y Videos LD

Ly cryersen

&

&®

|y cryersen.DI
- |y dataintegrity
- |y Default.migrated

[

m

- |y jsexton

m

- |y mekstrom

m

+ |y Public

®

| wiliarm

i Windows

| Windows10Uparade
UsaDrive (E)

di dpc

File folder [J File folder
DI_Dermo_15_25_9_25 ... keytab.out
Microsoft PowerPoint Pr... u QUT File [}
220.59 MB 362 b

Selected files: | | | keytab

| |\_|' All files '| [Vchoosel [ KCanceI]

11. Click Choose.
12. Click Save.
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13. Under LDAP, enter the Domain name (such as DI.IPDR) and the Server name (such as ad-dns).

14. Check the box next to Enable Dynamic DNS:.
15. Enter the fully qualified domain name of the DNS server (such as ad-dns.di.ipdr).
16. Enter the Kerberos realm (such as DI.IPDR).
17. Enter the domain suffix (such as di.ipdr).

B Croptonieshif ACC Chent - Uner: sdmanistitor (10T - o
o e - =3
B ooy | B crvmmontanctiiotes | (F tncpants B, incen & rinnen | @) ietwerk dviirss | ) Dwoiy | By scftware Updian
roa o rer——
iy Erbi ntegurce weh P Al Nekemsfss ]
et S e LOAP Sarew —
Nerai name (1 B0R Wy B O
PR Usamare:
[Emc] Pamwerd:
Domar:
Dmarmic DS (DONG)
Shih B Exilt-n RADIUS. Confguratun
Crable Dult-In RADMLS Accountng Sarme
Cabora tivee:  [sm o .
E
Wher Ream OLPDL T ’-‘E"
Doran Sf Lpd
1L (e B
T AP s
& "
et @ Ganerae wry
18. Click Save.
19. Click the Policies tab
B Crppteraehd T AZC Clane - Usen sdvenicracor (ET) a kS
(_shep Forg et
B robcr | B crvatencetce hestes | (F ndosees | B, Encis | & btwersion | B, detwork s | € Oucire| B St Uocat
e cone ket : - - - + e ' T i
0 s sy s BE SRS || e B | | sow [ -
= o Ot .'.‘.Q'.'!’.. =l
- iknad PeEraTn s
£ L] [:]
s .lhnYudmm M Ol
| geeerac SHCTSAdmN, dusers o
ubsriuiace | i LI 8]
BURBL pec-ghc W
BAERE ks n
L
by o « Seure Graow « Crptnt DT Maden
| 8 K| e i - G R | [ inceent hoow 1 Gatam g
(R = — — ol
Detaik o T | ST S T T g PR ceelseco o AR o
| L] G TR T LR | perer B o 3| st ook 3

Jabnn i  « 1] 3

20. Right-click in the Access Control Policies Window and select New Destination Group.
21. Enter kerberos.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 132



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

Mew Destination Group >

Name of new destination group

|kerber05

22. Click OK.

23. Select TCP under Action.

24. Enter 53:53 under Port Range.

25. Select VISIBLE under Action.

26. Click the arrow under Source Groups.
27. Select SNXT$SAdmins.

28. Click the >> button.

@ Select source groups that can connect to destination group .. X

Available source groups Selected source groups

SNXT$ACC Engine SNXT5AdmINS
SNXT3$Al Endpoints
SMXTSAI Nodes
SNXTSAI Users
alHinux

all-pcs

allusers

temp

29. Click Save.
30. Right-click the To: ‘kerberos’ destination group, and select New Access Control Policy Entry.
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31. Repeat steps 21-29, but replace 53:53 with 88:88.

32. In the Gateway Nodes window, click the arrow under Egress (Dest) Groups.

33. Select “kerberos”.
34. Click the >> button.

Available destination groups

Basic External Access

Save

<

Ml Select destination groups for gateway node 'gw’ X

Selected destination groups

$MNXT$InternalNodeComm
al-traffic

block-dhcp

kerberos

35. Click Save.

36. In the Endpoints window, click the arrow under Source Groups associated with the

Administration Control Center (ACC).

37. Select SNXTSAdmins.
38. Click the >> button.
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Ml Select source groups for endpoint ‘acc’ X

Available source groups Selected source groups
alHinux SNXTSACC Engine
al-pecs SMNXTSAdmINS
all-users SNXTSAl Endpaints
temp

39. Click Save.

B CryptentenxT ALE Dt - Lbar: mdevnal e B0-T) -
TR Y [ TS |

Prbens Angmralar Se 2t Belered [noi 2

40. Return to the Integration tab.
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41. Click Sync.

2.8 Backups

For this capability we use an integration of two open-source tools: Duplicati and FileZilla. FileZilla acts
as a File Transfer Protocol (FTP) (over TLS) server component, while Duplicati acts as an encrypted
backup client. This section details the installation and integration of both tools, as well as the process
for creating a backup schedule, but does not provide specific recommendations on backup frequency or
backup targets as those are specific to the organization.

2.8.1 FileZilla FTPS Server Setup

1. Run FileZilla_Server-0_9_60_2.exe.
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License Agreement
Please review the license terms before installing FileZilla Server beta 0.9.60.

Press Page Down to see the rest of the agreement.

| GNU GEMERAL PUELIC LICEMSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

_The_lioense; for mest ;oﬂware are designed to take away your

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install FileZilla Server beta 0.9.60.

Mullsoft Inskall System 3.0

lagee | | Cancel

2. Click I Agree.
3. Select Standard from the drop-down menu.

Choose which features of FileZila Server beta 0.9.60 you want to install. E

Check the components you want to install and uncheck the components you don't want to
install, Click Mext to continue.

Select the type of install: |513ndard v |

Or, select the optional FileZilla Server (Service)

if:gﬁnents you wish to Administration interface

Description

FPosition your mouse
aver a component ko
[[] Source Code see jts description,

Start Menu Shortcuts
Desktop Icon

Space reguired: 6.0MB

Mullsaft Install System w30

4. Click Next.
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Cheose Install Location
Choose the folder in which to install FileZilla Server beta 0,9.60. E

Setup will install FileZila Server beta 0.9.60 in the following folder. To install in a different
folder, dlick Browse and select another folder, Click Next to continue.

Destination Folder

C: \Program Files (x86) \FileZilla Server

Space required: 6.0MB
Space available: 476.0GE

Mullsoft Imskall Systenm w3.0

Click Next.
Select Install as service, started with Windows (default) from the drop-down.
Specify a port (for the administrator interface to run on) if desired (the default is 14147).

© N W,

Ensure the box next to Start Server after setup completes is checked.

Startup settings
Select startup behaviour for FileZilla Server

Blease choose how FileZilla Server should be started:
|Ins13|| as service, started with Windows {default)

Please choose the port, the admin interface of FileZilla Server should listen on {1-65535):

Mote: This portis only used to administrate the server using the FileZilla Server Interface. It
is not the FTP port used by FTP dlients.

s

[w] start Server after setup completes

tullsaft Inskall Systern «3.0

9. Click Next.
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Startup settings
Select startup behaviour for FileZilla Server

Please choose how the server interface should be started:

|S13rt if user logs on, apply to all users (default)

[w] Start Interface after setup completes

rullsaft Install System v3.0

10. Click Install.

Installation Complete
Setup was completed successfully.

Completed

Create shortcut: Cr\ProgramData \MicrosoftiWindows\Start Menu'Programs'FileZilla 5... :
Create shortcut: C:\ProgramData \Microsoft\Windows\Start Menu'\ProgramsFileZilla ...
Create shortcut: Ci\ProgramData MicrosoftiWindows\5tart Menu'\Programs'FileZilla ...
Create shortout: Ci\Users\Public\Desktop'FileZilla Server Interface.ink

Execute: "C:\Program Files {x86)\FileZilla Server\FileZilla Server.exe” fadminport 14147
Execute: "C:\Program Files (x86)\FileZilla ServerFileZilla Server Interface.exe”™ fadmi...
Installing Service...

Execute: "C:\Program Files {x86)\FileZilla Server'FileZilla Server.exe” finstall auto

Put FileZilla Server Interface into registry...

Completed

rullsaft Install System w3.0

11. Click Close.

2.8.2 FileZilla Configuration

1. When the administrator interface comes up, ensure that the port is correct and click Connect.
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- Passive mode settings
Security settings
Miscellaneous
Admin Interface settings

- Logging

Speed Limits

- Filetransfer compression
- FTP over TLS settings

- Autoban

2. Click Edit > Settings.

General settings FileZilla Server

Connection settings
List of ports between 1 and 65535. These

Listen on these ports: ports are used both for plain FTP and explicit

FTP over TLS. {Default port: 21)

Max. number of users: l:l (0 for unlimited users)

Performance settings

Number of threads: This value should be a multiple of the number of processors

installed on your system, Increase this value if your server
is under heavy load.

Timeout settings

Connections timeout: E in seconds (1-3999, 0 for no timeout).

El in seconds (500-8393, 0 for no timeout). This value spedifies

No Transfer timeout: the time a user has to initiate a file transfer,

Login timeout: in seconds {1-9999, 0 for no timeout). This value spedfies

the time in which a new user has to login.

[=I- General settings
L Welcome message

- Passive mode settings
- Security settings

- Miscellaneous

- Admin Interface settings
- Logging

Speed Limits

- Filetransfer compression

Autobi

[ ]

3. Click FTP over TLS settings.

FTP over TLS settings FileZilla Server

[w] Enable FTP over TLS support (FTPS)
[ pisallow plain unencrypted FTP

X.509 Certificate

Private key file: | | Browse...
Certificate file: | | Browse. ..

| Password will be stored in
plaintext.

Key password:

Generate new certificate. ..

Explicit and implicit FTP over TLS
[w] Allow explicit FTP over TLS (default: yes)
Mote: Explicit FTF over TLS shares the normal FTP port configured on the General settings page.

Listen for implicit FTP over TLS connections on the following ports (default: 990):
[520

File transfer security
These settings need to be enabled for file transfers to be secure.

[w] Force PROT P to encrypt file transfers when using FTP over TLS
[+ Require TLS session resumption on data connection when using PROT P

4. Check the box next to Enable FTP over TLS support (FTPS).
5. Check the box next to Disallow plain unencrypted FTP.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

140



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

=l General settings
. Welcome message
1P bindings
TP Filter
- Passive mode settings
- Security settings
- Miscellaneous
- Admin Interface settings
- Logging
- Speed Limits
- Filetransfer compression
- FTP over TLS settings
- Autoban

FileZilla Server Options

FTP over TLS settings
able FTP over TLS support (FTPS)
isallow plain unencrypted FTP

%.509 Certificate

Private key file: ‘ ‘ Browse...
Certificate file: ‘ ‘ Browse...
Key password: ‘ Passwaord will be stored in

plaintext.

enerate new certificate.

Explicit and implicit FTF over TLS
Allow explicit FTP over TLS (default: yes)

Mote: Explicit FTP over TLS shares the normal FTP port configured on the General settings page.

Listen for implicit FTP over TLS connections on the following ports (default: 930):

| 390

File transfer security

These settings need to be enabled for file transfers to be secure.
Force PROT P to enarypt file transfers when using FTP over TLS

Reguire TLS session resumption on data connection when using PROT P

6. Click Generate new certificate.

connections.

confuse dients.
Key size:  (®) 1230 bit

This dialog will help you to create a new private key and a
self-signed certificate, needed by FileZilla Server to accept TLS

Please fill out the reguired information. Wrong or missing information may

() 2048 bit () 4096 bit

2-Digit country code: I:I

Full state or province:

Locality (City):

Organization:

Contact E-Mail:

Common name
(Server address):

Save key and

|
|
|
Organization unit: |
|
|
certificate to this file: |

|| Browse... |

Generating the certificate may take some time depending on the key size.

| Generate certificate | | Cancel |

7. Select 4096 bit for Key Size.

8. Enter the information for the certificate specific to your organization.
9. For the common name, enter the address of the server on which this is installed.

10. Click Browse and specify a file location for the certificate.
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This dialog will help you to create a new private key and a
! self-signed certificate, needed by FileZilla Server to accept TLS
connections.
Please fill out the required information. Wrong or missing information may
confuse dients.

Key size: () 1280 bit () 2048 bit (®) 4096 bit
2-Digit country code:

Full state or province: | Maryland

Locality (City): | Rockville

Organization: | b1

QOrganization unit: |

Contact E-Mail: | administrator @di.ipdr

Common name p
(Server address): | backserv.di.ipdr

Save key and rator.DI\Dhcuments\filezila—cert
certificate to this file: | o | | | S |

Generating the certificate may take some time E}epending on the key size.

[ generate certificate | | Cancel |

11. Click Generate certificate. (The file now contains both the private key and the certificate. These
can be separated, for ease of use, as long as the correct file locations are specified in the
settings.)

é’i Certificate generated successfully.

N

12. Click OK.

=) General settings FTP over TLS settings FileZilla Server

Wel
clcome message [¥]Enable FTP over TLS support (FTPS)

P bindings
P Filter [+ Disallow plain unencrypted FTP
- Passive mode settings X.509 Certificate
Security settings
Miscellaneous Private key file: | C:Wsers\admm\shamr‘DI\Dnmmants\ﬁlanllaﬂ‘ Browse...
- Admin Interface settings
-Logging Certificate file: | C:Wsers\admm\shamr‘DI\Dnmmants\ﬁlanllaﬂ‘ Browse...
- Speed Limits . .
Filetransfer compression Key password: | [ ;Zﬁ“;’,&‘f will be stored in

FTP over TLS settings :
- Autoban Generate new certificate...

Explicit and implicit FTP over TLS
[v] Allow explicit FTP over TLS (default: yes)
Note: Explicit FTP over TLS shares the normal FTP port configured on the General settings page.
Listen for implicit FTP over TLS connections on the following ports (default: 990):
[s=0

File transfer security

lIl These settings need to be enabled for file transfers to be secure. Q

[ Farce PROTP to encrypt file transfers when using FTP over TLS

[+ Reguire TLS session resumption on data connection when using PROT P
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13. Enter a password for the key.

14. Ensure the box next to Force PROT P to encrypt file transfers when using FTP over TLS is
checked.

15. Ensure the box next to Require TLS session resumption on data connection when using PROT P
is checked.

FileZilla Server Options .

= General settings FTP over TLS settings

" el
- Ipebf:g::;essage Enable FTP over TLS support (FTPS)

L TP Filter Disallow plain unencrypted FTP

Passive mode settings X.509 Cerlificate
- Security settings
.. Miscellaneous Private key file: | C:\Users\Administrator.DI\Documents \ﬁ'EZ\"E‘(I‘ Browse...

Admin Interface settings

Logging Certificate file: | C:\Users\Administrator. DI\Documents \ﬁlenlla-ct‘ Browse...
- Speed Limits .

Password will be stored in

- Filetransfer compression Key password: | FEEERRERRRRINNY et
.. Autoban Generate new certificate. ..
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Explicit and implicit FTP over TLS
Allow explicit FTP over TLS (default: yes)
Note: Explicit FTP over TLS shares the normal FTP port configured on the General settings page.
Listen for implicit FTP over TLS connections on the following ports (default: 990):
520

File transfer security

These settings need to be enabled for file transfers to be secure.

Force PROT P to encrypt file transfers when using FTP over TLS

Reguire TLS session resumption on data connection when using PROT P

16. Click Passive mode settings. Check the box next to Use custom port range. (This is necessary in
cases of a local server behind Network Address Translation (NAT) or a firewall.)

17. Enter a range of ports for passive mode to use. Ensure that these ports are allowed through the
firewall.

18. Select Use the following IP.

19. Enter the server address.
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= General settings Passive mode settings FileZilla Server

[#] Use custom port range: {1-65535)
IPv4 spedfic
External Server [P Address for passive Use custom PASY settings if you are A
mode transfers: operating the server from behind a NAT |
- Miscellaneous () Default router or a firewall. In that case, the IP
- Admin Interface settings - address of the server is not accessible from
-Logging (®) Use the following IP: ﬁiside ofmzéwber}; 50 you sg‘ou\d fillin
: e correct address here. Use the port
SFEEd Limits . | backupserv.di.ipdr | range to limit the number of ports that will
- Filetransfer compression ‘You can also enter hostnames need to be forwarded through the router.
FTP over TLS settings
. Autoban () Retrieve external IP address from:
| http:/fip. filezila-project.orgfip.php | ||
v

(Default: http:/fip. filezila-project. org/ip.php)

Information for users with dynamic IPs: If your external IP changes, it might take up to 5 minutes
after the next failed transfer until FileZila Server recognizes the changed
In most cases, the IF is updated within 30s after a failed transfer.

[ Dar't use external IP for local connections

‘You can use this site to test that your settings work correctly:
hitps:, e

20. Click OK.

2.8.3 Add a User to FileZilla

1. Inthe FileZilla administrator interface, click Edit > Users.

Account settings Users
[ Enable account

Sedidders || Clpwowors: [ ]

Speed Limits

[ Bypass userlimit of server

Maximum connection count:

Connection [imit per IP: l:l
[ |Faree TLS for user login

Description [%

[>]

H

You can enter some comments about the user

2. Click Add.
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Please enter the name of the user account that should

be added:

User should be member ofﬂ'lefollow’}ng group:

| “none:

v]

3. Enter a name for the user.

Please enterthe n.

be added:

of the user account that should

|George

User should be member of the following group:

| “nones

4. Click OK.

5. Check the box next to Password.

6. Enter a password for the user.

- General
- Shared folders
- Speed Limits
‘... P Filter

Account settings
[w] Enable account

leassnorc:
S—

["1Bypass userlimit of server

Maximum connection count: I:I
Connection limit per IP: l:l

fou can enter some comments about the user

7. Check the box next to Force TLS for user login.
8. Click Shared Folders.
9. Click Add, under Shared Folders.
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Please select a folder that should be added to the folders list
of the selected user account.

C:\backupsigeorge

I | @ Videos
I+ & Floppy Disk Drive {A:)
4 a Local Disk (C:)

4 |, backups

. PerfLogs

. Program Files

. Program Files (x88)
’

P

Users Q

Windows

10. Select a place for backups for this user to be stored.

11. Check the boxes next to Write and Append, under Files.
12. Check the box next to Create, under Directories.

13. Select this entry and click Set as home dir.

Page: Shared folders Users
Files
-~ General Directories Mliases [V Read

Shared folders H C'backu;
: ps'george ]
- Speed Limits M wite

TP Filter [ Delete
[ Append

Directories
[WiCreate
[] Delete
[ List

Si— ;| Besson

[ Add | [ Remove | [ Rename | [Satashomedr] [ Rename || copy |

A directory slias will also appear at the specified location. Aliases must contain the full vitual
path. Separate multiple aliases for one directory with the pipe character (|}

If using aliases, please avoid cyclic directory structures, it will only confuse FTP clients

L

[ o ]

14. Click OK.

2.8.4 Duplicati Client Installation (Windows)

1. On the client machine, run duplicati-2.0.3.3_beta_2018-04-02-x64.msi.
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1 Duplicati 2 Setup - *

m Welcome to the Duplicati 2 Setup Wizard
]

The Setup Wizard will install Duplicati 2 on your computer.
Click Next to continue or Cancel to exit the Setup Wizard.

2. Click Next.
3. Check the box next to | accept the terms in the License Agreement.
1 Duplicati 2 Setup - *
End-User License Agreement I.
Please read the following license agreement carefully =
"~
GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation,
Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301,
USA
Evervone is permitted to coov and distribute verbatim N
[11 accept the terms in the License Agreement
N
Print Back Cancel

4. Click Next.
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1 Duplicati 2 Setup - *

Custom Setup .
Select the way you want features to be installed. =

Click the icons in the tree below to change the way features will be installed.

Installs the required files for

= ~ | Launch Duplicati at startup Duplicati.

This feature requires 40MB on your
hard drive. Ithas 2of 2
subfeatures selected, The
subfeatures require 10KB on your
hard drive.

Location: C:\Program Files\Duplicati 2\ l}

| Reset I Disk Usage || Back [ nMext || concel |

5. Click Next.
1 Duplicati 2 Setup - *

Ready to install Duplicati 2 |

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard,

Back | Install | | cancel

6. Click Install.
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1 Duplicati 2 Setup - hed

m Completed the Duplicati 2 Setup Wizard

Click the Finish button to exit the Setup Wizard.

N

Launch Duplicati now

Back Cancel

7. Click Finish.
8. Start Duplicati by going to localhost:8200.

2.8.5 Duplicati Client Installation (Ubuntu)

1. Install mono by using the following command:

> sudo apt install mono-runtime

2. Download the Duplicati package by running the following command:
> wget

https://github.com/duplicati/duplicati/releases/download/v2.0.3.9
-2.0.3.9_canary_2018-06-30/duplicati_2.0.3.9-1 _all.deb

3. Install Duplicati by using the following command:
> sudo dpkg -1 duplicati_2.0.3.9-1 all.deb
4. Run Duplicati as a service by running the following command:

> sudo systemctl enable duplicati
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2.8.6 Configure Duplicati

1. When it first starts, Duplicati will have a First run setup.

) WINDOWS10-1 - Duplic= % \\ \

C | ® localhost8200/ngax/indexhtmi

First run setup

If your machine is in a multi-user environment (i.e. the machine has more than one
account), you need to set a password to prevent other users from accessing data on

your account. Do you want to set a password now?

No, my machine has only a single account Yes

2. Click Yes.
3. Check the box next to Password.

e - O x
£ WINDOWS10-1 - Duplic: X \ \
< C | @ localhost8200/ngax/index htmi#/settings o ¥t
. Duplicati n MENU ::

. W Beta

No scheduled tasks

Settings

Access to user interface

@ Password |sse

O Allow remote access (requires restart)

Pause after startup or hibernation @

Pause |0 v |Seconds ¥

User interface settings

Language in user interface

nited States), en-US)

Display and color theme  The default blue on white theme (

4. Enter a password.

by Alex) ¥
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2 WINDOWS10-1 - Duplic= 3 \\_

<« C | @ localhost8200/ngax/index. himi#/settings or ¥

B Duplicat B

‘ No scheduled tasks

We use them to generate public usage statistics [

All usage reports are sent anonymously and do not contain any personal information
They contain information about hardware and operating system, the type of backend,
backup duration, overall size of source data and similar data. They do not contain paths,
filenames, usernames, passwords or similar sensitive information.

Default options

Options added here are applied to all backups, but can be overridden in each individual
backup

Options Edit as text

- pick an option - "

| P
Visit us on n O ..

Add advanced option

5. Click OK.
6. Onthe home page, click Add backup.
7. Select Configure a new backup.

WINDOWS10-1 - Duplie: X
€ @ @ letalhese

.! rE)ﬂL:plicati N b AN 1

8. Click Next.

9. Enter a name for the backup.

10. Select AES-256 encryption, built in from the drop-down menu.
11. Enter a password.
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12. Click Next.

13. Select FTP for Storage Type.

14. Check the box next to Use SSL.

15. Enter the server name and port (default: 21) of the server running FileZilla.

16. Enter a path for the backup to be stored in (within the specified shared directory of the user).
17. Enter the username and password created for FileZilla.

WINDOWS10-1 - Duplics % a = 0 X

&« C | @ locathost t » o P

18. Click Test Connection (if the connection fails, ensure that the port is allowed in your server’s
firewall).
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19. If you receive an error about a certificate, you can go to Advanced Options, select accept-

specified-ssl-hash, and enter the thumbprint from the server’s certificate.

BEO..
20. Click Next.

21. Select the folders on the local machine to be backed up to the server according to your

organization’s needs.

WINDOWS10-1 - Duphc: X 8 = a =

< C | @ meabost o o |

22. Click Next.
23. Select a backup schedule according to your organization’s needs.
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R AL T ———) o |

- DupliCati No scheduled tasks [ Dosate I
= Bew
AU R U UL
If & date wirs missed, the job will run 8% 300n a3 possible.
{t Home
+ Add backup et tine 09,28 PM 07/31/2018
¥ sstore
[_:l Restore Run again every 1 Days ]
£ Settings
Allowed days
@ About 2 Mon
Bl Logout "
&
® wed
® Thu
8 fn
o sat
8 Sun

24, Click Next.
25. Select any other options according to your organization’s needs.

L T~ G |
.! E:':Plicati | No scheduled tasks [ Dosate I .
om-mm
{t Home

+ Add backup General options

) Restore

# Ssettings Upload volume size 50 Myt v
@ About Backup retention Keep ol backups ¥
E Log out Nothing will be deleted. The backup size will grow with sach
ehange
Advanced options ~ M)

vrsen?® BEQ S

26. Click Save.
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BEHO ™

27. When finished, you can choose to Run now to start a backup immediately.

2.9 Semperis Active Directory Forest Recovery

This section details the installation of Semperis Active Directory Forest Recovery (ADFR), a tool used
for backing up and restoring Active Directory forests. This installation requires both a copy of SQL Server
Express as well as the Semperis Wizard. See the Semperis ADFR v2.5 Technical Requirements
document for specifics on the requirements. For a Windows Server 2012 R2 installation, simply meet

the following requirements:

e .NET Framework Version 3.5 SP1

e .NET Framework Version 4.5.2 or later

e not joined to the Active Directory domain it is protecting

e SQL Express is not installed on the machine, but the installer SQLEXPR_x64_ENU.exe is
downloaded.

2.9.1 Install Semperis ADFR

1. Place the SQLEXPR_x64_ENU.exe installer in a directory called Setup, and ensure that the
Semperis Wizard is adjacent to the Setup folder (not inside it).
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P
| Recent places

8| This PC
m Desktop
| Documents
& Downloads
o Music
=| Pictures %
& Videos
15, Local Disk (C:)
8 DVD Drive (D) IR2_S

G'! Netwaork

2items

"ANN AN Downloads x
Home Share View v @
+ | & » ThisPC » Local Disk (C) » Users » Administrator » Downloads v C,| | Search Downloads o |
S
¢ Favorites Mame Date modified Type Size
B Desktop 1 Setup 8/8/2018 9:06 AM File folder
& Downloads » Semperis.Wizard.exe 8/9/2018 9:05 AM Application 143,965 KB

2. If prompted to restart the computer, do so.
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AGREEMENT

Welcome to Semperis installer
The wizard will guide you through installation of the Semperis products

5
L5
t.‘_:

b

Semperis SERVICE AGREEMENT

THIS SERVICE AGREEMENT (THE AGREEMENT) GOVERNS THE USE OF THE SERVICE, INCLUDING ITS WEB-BASED
APPLICATION AND ITS PC-DESIGNATED COMPONENT.

THIS PRODUCT AGREEMENT (THE "AGREEMENT") GOVERNS THE USE OF SEMPERIS'S DISASTER RECOVERY AND
MAMNAGEMENT SOFTWARE PRODUCTS, FOR ORGANIZATIONAL IT-IDENTITY (ACTIVE DIRECTORY) PLATFORM (THE
"PRODUCT". AS SPECIFIED IN THE PROPOSAL PROVIDED TO YOU).

LEGAL ENTITY (A COMPANY. A PARTNERSHIP, OR ANY O

ER LEGAL ENTITY, HEREINAFTER: "ORG

| Agree Cancel

1

Semnperis

3. Click I Agree.
4. Select Evaluation License.
5. Select Active Directory Forest Recovery.

THIS AGREEMENT COMNSTITUTES A BINDING CONTRACT BETWEEN SEMPERIS LTD., ("WE", "US", "OUR" OR "5EMPERIS"), AND
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AGREEMENT LICENSE CONFIGURATION INSTALLATION SUMMARY

License

@® Evaluation license

@/ Active Directory Forest Recovery

O Active Directory State Management -

O Full License

Browse

Semperils .

6. Click the > button.

y Click OK to begin the installation. Click Cancel to go back and review
i any of your installation settings

7. Click OK.
8. Wait for the installation to complete.
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Semperis Management Server has been installed successfully.

¥  Installing Windows Server features
¥  Generating certificates
¥  Generating the configuration file

¥  Configuring Registry entries

v  Configuring the SQL Server database

¥ Installing the Semperis Management Server

Semperis

9. Click the > button.

¥ Installing SQL Server Express. This may take up to 20 minutes to complete.

INSTALLATION
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SUMMARY

Installation completed =
=

successfully! 0

" lana Sern
Installation Completed Succesfully! FIEARGRITEN'. Sarvar

To configure ADFR, go to the ADFR Management Site

Semperis

10. Click Finish.

11. There should now be a shortcut on the desktop linking to the web console for Semperis ADFR.

12. On the login page, enter the full domain as well as the NetBIOS name.
13. Enter the username and password of an administrator on the domain.
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C | @ secure | https//semperis-adfi/ADFRAdmin/Login/ o

Semperis

Aclive Directory Forest Recovery

Topok Log in to run AD

DLIPDR

L Administrator

B esssssasanin

14. Click Login.
15. Check the box next to any domain controllers that should be backed up.

'.u. Semperis Active Director X

& C | & Secure | https://semperis-adfr/ADFRAdmin/NoAgents O ¢t| J

Semperis

@ AGENT MANAGEMENT

AGENT
MANAGEMENT
EI JOB STATUS
DOWNLOAD AGENT INSTALLER Deploy Eatest Verson

6 NAME = v STATUS = * AGENT VERSION = | OS VERSION = * 1S GC ACTION
o 20-dns08 di.ipdr MNa Agent - - rue RS |
“ ad-ans.di.ipdr Mo Agent - - true bR & |

16. Click Run Action.
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17. Enter the password in the prompt.

o sempesis trive Divwcts ¢
]]_'(— G | @ seae | tryp

Deploy latest version on 1 agents - Identity Verification

Plexs anter with ini
the ADFR agent, version 2.5 6744.25103

Domain oi

on the target machine 1o deploy
Usarname Administrator

Changa s

Password.

18. Click OK.

o Success

The requested operation is running.

19. Click Close.
20. After the installation finishes, click Login at the top of the page.
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21. Enter the login credentials for the domain.

& | @ Secure | hitpsy/semperis-adfr/ADFRAdmIn/Login/ ot i

Semperis

Active Directory Fore:

Administration Panel

1 Administrator

22. Click Login.

23. Create a recovery password. (Note: In the event of a restoration, Active Directory will
potentially be unavailable, so a separate password that is not domain-associated is needed here
for restorations.)

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 163



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

< Sempers Active Director X

€2 a |ﬂ Secure | hitps//semperis-adfr/ADFRAdmin

o Wl i

Set Initial Recovery Password & Security Questions

Set your recovery password

Password:

Confirm Password

Question =1
What was your chilghood nickname? v Answer:  D@t@lntegrity=1

Question =2
What is the middle name of your oldest child? v | Answer:  D@t@lntegrity=1

24. Set recovery questions for the password.
25. Click Set.

2.9.2 Create a Backup Schedule for the Domain Controller

Click the Backup Settings tab.
Enter a name for the rule.
Select the days and times that the domain controller should be backed up.

P wnNPE

deleted upon creation of a new backup, which would exceed this maximum.)
5. Ensure that Encrypt and Rule enabled are both turned on.

Enter the maximum number of backups that should be kept. (Note: The oldest backup will be
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I o semees A i <
€ & C |8 secur | e/ AD) i o |t
(U]

Semperis o
RULE DAYS RETENTION RULE ENABLED VALIDATION. ACTION
|
® | [B3ckup Nowl - 5 backups e - &M
[ AN oo
MANAGE BACKUP GROUPS BACKUP NOW
BACKUP
STATUS
Create New Backup Rule
BACKUP
SETTINGS
Rule name: Backup
AGENT
MANAGEMENT [MMondsy [Tuesdsy [Wesnessay BThursdsy [JFridey (Saturday [ Sunday
Backup window starting at: 10-00 AM v
DISTRIBUTION
BORyS Number of backups retained- 5 ®
Rule enables ]
X ; L
Encrypt: n @
JD ROLE-BASED ADD BACKUP GROUP
ACCESS CONTROL
‘ BACKkuP GROUR aackup e DISTRIBUTION POINT
OPERATION
C Ho Backup Groups selected. Ciick the "Add Backup Group” button above 1o select groups for this Backup Rule
CREATE RULE SUMMARY

6. Click Add Backup Group.
¥ o sempensacie e« N ——————————— = | N

€ .| 8 Ssecur | i pSottng o x| :

Add Backup Group

Select backup grouss to 200
Either no Backup Groups have been created of the tule you are editing already applies to
3l exigting Backup Groups,

[Create new Backup Group...] [Edit Backup Groun. . ]

= : e

7. Click Create new Backup Group.
8. Enter a name for the backup group.
9. Select the domain controllers to be part of the backup group.
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Create Backup Group

Backup Group nang:  Domaing

Backup Group entities:

[« DNSHOSTAME b siTe

@ ouPDR Bd-ans Default-First-Site-Mame

10. Click OK.
11. Select the newly created backup group.

Add Backup Group

Select backup groups 1o add:
B Domains &

ICreate new Backug Grouw...] [Edit Backwp Groug...]

12. Click OK.
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o e

< C | @ secure | ? adfi/ADFRAGmin#bac o o w|

Semperis

€
(<%

B oo
§ o
o

RULE DAYS HEIENIION | HULE ENASLED | VALIDANON ACHUN

(0] [Backup Now] 3 < backups true < esn

<
~

MANAGE BACKUP GROUPS BACKUP NOW

Create New Backup Rule

BACKUS
SETTINGS
Rule name: Backup

[MMonday [ITvesday [JWeonescay [@Thursday [Fricay [0Saturday [0 Sunoay
Backup window starting at: 10:00 AM v
Number of backups retained: 5 ®

Rule enabled Hl e

Encrypt: | o
ADD BACKUP GROUP
BACKUP GROUP BACKUP TIME DISTRIBUTION POINT

I
I

Domains 10:00 AM v Semperis Management Server v

omreree o]

i - - —

13. Click Create Rule.

2.9.3 Recover the Active Directory Forest from a Backup

Open the Semperis ADFR web console.
Select Recovery Panel from the drop-down.
Select the Domain that you wish to recover.

P wnN e

Enter the username and password.
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Prete =

Lo C | @ Secure | hitps/fsempenis-adfi/ADFRAdmin/Login

Semperis

Active Directory Fore: overy

Recovery Panel

1 Administrator

password

-

Click Login.

!Niﬂnb x ’.u- Sempers Active Disecte X

= C | @ Secure | b peris-acr/ A0FRS Ladh - 4 B

| Semperis Activ O

SEMPERIS ACTIVE DIRECTORY FOREST RECOVERY

Choose an Action

= -
™
ol—l | B

HINE &
Partition Recovary Farost Recavary

Apstore 3 snge Ao
Domain Controller Rostora The fores oy

secory panition n Fvcover the entie Acive Dinctory forest
N AAncraFive

Fiestors 3 5ingle comeEn onsroiler from 3
Syem SR ackun

Select an action based on the recovery needs of the organization. In this example we select

Domain Controller Restore.

Provide the information for the restoration, namely the domain, the domain controller, and

which backup to use.
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Fowre s e T

i G | @ Secure | hetps//semperis-aden AL #res C :

| Samperis Active Direciony Fonest Recovery - evalushon expives on Seo 0, 2018 I

DOMAIN CONTROLLER RESTORE

Choose Domain DIAPDR -
Choose Doman Controller to restore -, & Bpor .
Choose biackup to restode from

RACKLP DATE RACKLIP TAG

- O/ 2G18. - 10-00 AM (FRBAAARS SEC 1.4CT5-9013-FARARISRE0L0)

Shawing resulrs 1 - 141 1 ] N
«FIRST < PREVIOUS NEXT > LAST » 10« Gotecage | i &0

8. Click Restore.
Prewra W e« S

« C | @ Secure | Bipssemperis-adie ADFR, #res o %

[ ‘Samgeris ACTive Duacioey Formst Recovary - svakistion szpirst o Sap 8, 1018

DOMAIN CONTROLLER RESTORE

Confirm next stap. ..

Ar you sure you want to continue ¥

= - srn —

9. Click Start Restore to begin the restoration process.
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Restoring the Forest to 08/16/2018. 12:09 AM

3Show progress log [*all times are displayed in UTC] B

ABORT

10. Click Next when the restoration finishes.

2.10 Semperis Directory Services Protector

This section details the installation of Semperis Directory Services Protector (DSP), a tool used for
monitoring Active Directory environments. This installation requires both a copy of SQL Server Express
as well as the Semperis Wizard. See the Semperis DS Protector v2.5 Technical Requirements document
for specifics on the requirements. For a Windows Server 2012 R2 installation, simply meet the following
requirements:

e .NET Framework Version 3.5 SP1

e _.NET Framework Version 4.5.2 or later

e joined to the Active Directory domain it is protecting

e either the installer for SQL Express Advanced or connection information and credentials for a
full version of Microsoft SQL (MSSQL)

2.10.1 Configure Active Directory for Semperis DSP

1. Open Active Directory Users and Computers.
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File Action View Help

e hm 48| XEG= Bm tauTER
3 Active Directory Users and Com || Name Last Mame Type Description
B [ Saved Queries & Abraham Leptoceratops User User Account
4 3 DLIPDR & Administrator User Built-in account
b 1 Builtin 2 Allowed RODC Password Replication... Security Group... Members in this
b ] Computers % Cert Publishers Security Group... Members of thi
b & Demain Controllers % Cloneable Domain Controllers Security Group... Members of thi
v 3 ForeignSecurit.yPrincipa\: 2, Denied RODC Password Replication ... Security Group... Members in this
b &) Managed Service Accour 2, DiscoverySearchMailbox {DS19BADS-... MsExchDiscoveryMailbox D919BADS-46A6-41...  User _
b 5] Microsoft Exchange Sect 2 DnsAdmins Security Group..., DNS Administra -
% DnsUpdateProxy Security Group...  DNS clients who
% Domain Admins Security Group... Designated adm
2, Domain Computers Security Group...  All workstations
2 Domain Controllers Security Group...  All domain cont
2 Domain Guests Security Group... All domain gue:
% %Domam Users Security Group...  All domain user
% Enterprise Admins Security Group... Designated adrm
52, Enterprise Read-only Domain Contro... Security Group... Members of thi
&;. Exchange Online-ApplicationAccount User
&3. FederatedEmail 4c1f4dBb-8179-4148... FederatedEmail 4c1f4d8b-8179-4148-93bf-00a...  User
& Franklin Delano Raptorvelt User User Account
% Group Policy Creator Qwners Security Group.. Members in this
&;.Guast User Built-in account
& Harry 5 Triceratops User User Account
& lehn Quincy Ankylosaurus User User Account
& Lyndon Brontosaurus Johnson User User Account
(<] [ [>] ('| — — [ [ [>]

2. Right-click Users in the left pane and select New > User.
3. Enter the information for a new user for the DSP service.

& Createin:  DILIPDR/Users

First name: |DSP

| Initials: I:l

Last name: |Senrice

Full name: |DSP Service

User logon name:

|d5psem'ce

| [@DliPOR

User logon name {pre-Windows 2000):

| DI\

| |d5p5enrice|

4. Click Next.

5. Enter a password twice for this user.
6. Set the password policy.
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& Createin:  DILIPDR/Users

Password: [oseseseereress

Confirm password: |iiiiiiiiliiiiii

[ ] User must change password at next logon
[ ] User cannat change passwond

[w] Password never expires

[ ] Account is disabled

7. Click Next.
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& Createin:  DILIPDR/Users

When you click Finish, the following object will be created:

Full name: DSP Service

IUser logon name: dspservice@D1.IFOR
The password never expires.

8. Click Finish.
9. Open Group Policy Management.
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B

|5, File Action View Window Help

@ m & B

5k Group Policy Management
4 A% Forest: DIIPDR
I+ iﬁ Domains
I [‘a Sites
fﬂ Group Policy Modeling
[E Group Policy Results

Group Policy Management

Contents

Name
/2 Forest: DLIPDR

10. Right-click Domains > DI.IPDR > Domain Controllers > Default Domain Controllers Policy and

click Edit.
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Wh

_EJ

File Action View Help

S ENEEER

Group Policy Management Editor

|_§J Default Domain Controllers Poli

4 & Computer Configuration
b [ Policies
b | Preferences
4 2, User Configuration
I || Policies
I || Preferences

w

=/ Default Domain Controllers Policy [AD-DNS.DLIPDR] Policy
Select an item to view its description. Name

& Computer Configuration

4% User Configuration

Extended ;( Standard/

11. Navigate to Computer Configuration > Policies > Windows Settings > Security Settings >
Advanced Audit Policy Configuration > Audit Policies > Account Management.
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File Action View Help
s #F 2 3

Group Policy Management Editor

B [ Windows Firewall with Ad ~
] Network List Manager Pol
Zaff Wireless Network (IEEE 80
| Public Key Policies
| Software Restriction Polic
| Network Access Protectio
[ Application Control Polici
,g IP Security Policies on Act
[ Advanced Audit Policy Ct
4 14 Audit Policies —
s ‘_._d Account Logon

[

Ea Account Managen
5 Detailed Tracking
‘_Jj D5 Access
Eé Logon/Logoff
‘_ﬂ Object Access =
3 Policy Change
5 Privilege Use
System
5 Global Object Acc
I gl Policy-based CoS
I [ Administrative Templates: Policy
I | Preferences

4 4R, User Configuration

-

£ m >

Subcategory

iaf

iz Audit Application Group Management

5| Audit Computer Account Management
5 Audit Distribution Group Management

l*j!o_ Audit Other Account Management Events

i

l21s| Audit Security Group Management
i

lete] Audit User Account Managemer[%

Audit Events

Mot Configured
Mot Configured
Mot Configured
Mot Configured
Mot Cenfigured
Mot Configured

<] m

Expand: Completed successfully.

12. Edit the Audit User Account Management field by double-clicking it.

13. Check the box next to Configure the following audit events.

14. Check the box next to Success.
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Policy | Explain

a Audit User Account Management

[ Corfigure the following audit events:
[v] Success

[ Failure

15. Click OK.
16. Go to Audit Policies > DS Access.
17. Double-click Audit Directory Service Changes.
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Folicy | Explain

a Audit Directory Service Changes

[[] Configure the following audit events: %
[ Success

[ FEailure

18. Check the box next to Configure the following audit events.
19. Check the box next to Success.
20. Click OK.
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L Group Policy Management Editor -

File Action View Help
= zE 2 8

b 7] Windows Firewall with Ad ~ Subcategory Audit Events
[ Network List Manager Pol %) Audit Detailed Directory Service Replication Not Configured
I ;d Wireless Network (IEEE 80 5 Audit Directory Service Access Not Configured
b [ Public Key Policies ] Audit Directory Service Changes Success
I || Software Restriction Polic
I | Metwork Access Protectio
b [] Application Contrel Polici
I: lg IP Security Policies on Act
4[] Advanced Audit Policy Co
4 ﬂ.g Audit Pelicies —
I éﬂ Account Logon
3 Account Managen
Detailed Tracking
D5 Access
Logon/Logoff
Object Access
Policy Change
= Privilege Use %
I é_ﬁ System
I 55 Global Object Acc
I glly Policy-based QoS
B 1 Administrative Templates: Policy
 [] Preferences [ |
a %, User Configuration

< n > <] n >

@51 Audit Directory Service Replication Mot Configured

v v v T T T v

21. Open Active Directory Users and Computers.
22. Ensure that View > Advanced Features is enabled.
23. Right-click the domain (for example, DI.IPDR) created earlier and click Properties.

General | Managed By | Object I Security | Attribute Editor |

a DIIPDR

Domain name {pre-Windows 2000):
]

Description:
i
Domain functional level:
Windows Server 2008

Forest functional level:
Windows Server 2008

24. Click the Security tab.
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| General | Managed By | Object | Security | Attribute Editor

GI'OLID Or USer Names:

B2, SELF

82, Authenticated Users
H2,5YSTEM
2, NETWORK SERVICE

82, Organization Management (DI'\Oraanization Manaaement)

Permissions for Everyone

Allow

Full contral

Fead

Write

Create all child objects
Delete all child objects

Advanced.

For epecial pemmisgions or advanced settings, click

ok || cencd ||

25. Click Advanced.

Owner:

Administrators (DI\Administrators) Change

Permissions

Auditing Effective Access

Permission entries:

For additional infoermation, double-click a permission entry. To modi‘f%permission entry, select the entry and click Edit (if available).

Type
B Allow
2 Allow
8 Allow
82, Allow
82, Allow
82, Allow
B Allow
2 Allow
# Allow
82, Allow
82, Allow

Lda au

Principal

Exchange Windows Permissi...
Exchange Windows Permissi...
Exchange Servers (DI\Exchan...
Exchange Servers (DI\Exchan...
Pre-Windows 2000 Compatib...
Pre-Windows 2000 Compatib...
Pre-Windows 2000 Compatib...

Authenticated Users

ENTERPRISE DOMAIN CONT...

Authenticated Users
Authenticated Users

CRITCARMICE Pumk A8 AL~ AR IT

Access

Change password
Reset password
Special

Special

Special

Special

Special

Enable per user reversi...
Replicating Directory ...

Unexpire password

Update password not r...

= DO CORPE IR . Y

Inherited from
Maone
Mone
Mone
Mone
MNone
Maone
Maone
Mone
Mone
Mone

MNone

Applies to

Special

Special

Descendant InetOrgPerson o...
Descendant User objects
Descendant InetOrgPerson o...
Descendant Group ohbjects
Descendant User ohjects

This object only

This object only

This object only

This object only

Thie liioen ol

[ Add

|| Remove | | View

26. Click the Auditing tab.

27. Click Add.

QK

|| Cancel || Apply |
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28. Enter Everyone.

Select this object type: %
|U5&r. Group, or Built-in security principal | | Cbject Types... |

From this location:
[DIIPDR || Locations...

Enter the object name to select (examples):

Check Names

29. Click OK.

Owner: Administrators (DI\Administrators) Change

Permissions | Auditing Effective Access

For additional infermation, double-click an audit entry. To medify an audit entry, select the entry and click Edit {if available).

Auditing entries:

Type Principal Access Inherited from Applies te
8, Succ.. Everyone MNone Special
8, Succ.. Everyone MNone Special
2, Succ.. Domain Users (DI\Domain Us...  All extended rights MNone This chject only
82, Succ..  Administrators (D\Administr...  All extended rights MNone This object only

8, Succ.. Everyone Special k MNone This chject only

Restore defaults

oK || Cancel || Apply |

30. Double-click Everyone.

31. Check the boxes next to Write all properties, Delete, Delete subtree, Modify permissions,
Modify owner, All validated writes, All extended rights, Create all child objects, Delete all
child objects.
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Type: ‘ Success

Applies to: ‘This object and all descendant ohjects

Permissions:
[] Full central
[] List contents
[[] Read all properties
[] Write all properties
[w] Delete
[w] Delete subtree
[ Read permissions
[w] Modify permissions
[w] Modify owner
[] All validated writes
[#] All extended rights
[w] Create all child objects
[] Delete all child objects
[] Create Computer objects
[w] Delete Computer objects
[ Create Contact objects
[w] Delete Contact objects
[w] Create friendlyCountry objects

[+] Create msExchOmaDeliveryProvider objects

[+] Delete msExchOmaDeliveryProvider objects

[+] Create msExchOmaDeviceCapability objects

[+] Delete msExchOmaDeviceCapability objects

[+ Create msExchOmaDeviceType objects

[+ Delete msExchOmaDeviceType objects

[w] Create msExchOrganizationContainer objects

[+ Delete msExchOrganizationContainer objects

[] Create msExchPoliciesContainer objects

[] Delete msExchPoliciesContainer objects

[] Create msExchProtocolCfgHTTP Container objects
[] Delete msExchProtocolCfgHTTPContainer objects
[+] Create msExchProtocel CfigHTTPFilters objects

[+] Delete msExchProtocol CfgHTTPFilters objects

[+] Create msExchProtocelCfglMAP Container objects
[¥] Delete msExchProtocolCfgIMAPCantainer objects
[+ Create msExchProtocolCfglMContainer objects
[+ Delete msExchProtocol CfgiMContainer objects

[[>

" m

<]

32. Click OK.

| General | Managed By | Object | Security | Attribute Editor

Group or user names:

82 SELF

82, Authenticated Users
82, 5YSTEM
52, NETWORK SERVICE

2 Organization Management {DI"Orqanization Management)

Pemissions for Everyone

Full control

Read

Wirite

Create all child objects
Delete all child objects

Advanced.

For special pemissions or advanced settings, click

33. Click OK.
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2.10.2 Install Semperis DSP

1. If you are using a local SQL Express Advanced server, place the SQLEXPRADV_x64_ENU.exe
installer in a directory called Setup, and ensure that the Semperis Wizard is adjacent to the
Setup folder (not inside it). If an SQL Express Advanced server is not being used, no Setup folder

is required.
B[~ Downloads =N 1
Home Share View b 0
+ | & » ThisPC » Local Disk (C:) » Users » Administrator » Downloads v C;| | Search Downloads 2 |
‘¢ Favorites Mame - Date modified Type Size
B Desktop . Setup File folder
& Downloads Semperis.Wizard.exe Application 143,965 KB

= Recent places

1M This PC

i Desktop

| Documents

4 Downloads

o Music

= Pictures %
& Videos

£, Local Disk (C:)

& DVD Drive (D7) IR2_S

‘?j Network

2items =)

2. If prompted to restart the computer, do so.
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AGREEMENT

Welcome to Semperis installer

The wizard will guide you through installation of the Semperis products

\\

5
L&
LY

b,

Semperis SERVICE AGREEMENT

THIS SERVICE AGREEMENT (THE AGREEMENT) GOVERNS THE USE OF THE 5ERVICE, INCLUDING ITS WEB-BASED
APPLICATION AND ITS PC-DESIGNATED COMPOMNENT.

THIS PRODUCT AGREEMENT (THE "AGREEMENT") GOVERNS THE USE OF SEMPERIS'S DISASTER RECOVERY AND
MAMNAGEMENT SOFTWARE PRODUCTS, FOR ORGANIZATIONAL IT-IDENTITY (ACTIVE DIRECTORY) PLATFORM (THE
"PRODUCT". AS SPECIFIED IN THE PROPOSAL PROVIDED TC YOU).

THIS AGREEMENT CONSTITUTES A BINDING CONTRACT BETWEEN SEMPERIS LTD., ("WE", "US", "OUR" OR "SEMPERIS), AND
YOU — A LEGAL ENTITY (A COMPANY, A PARTNERSHIP. OR ANY OTHER LEGAL ENTITY, HEREINAFTER: "ORGANIZATION"),

| Agree Cancel

Semperis

3. Click I Agree.
4. Select Evaluation License.
5. Select Active Directory State Management.
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LICENSE

License

@ Evaluation license

O Active Directory Forest Recovery

@.‘-; Active Directory State Management

O Full License

Semperis

6. Click the > button.
7. Enter the username and password of the account created earlier.
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AGREEMENT LICEMSE CONFIGURATION INSTALLATION SUMMARY

Service Account

SN :
2N

Enter the username and password to use for the ADSM service account. The Service account is used by
the Semperis Management Server to communicate with the ADSM agents.

Forest Name: Service account: Password:

:Dl\dspservice l...l...l.l.l.l.

Semperils .

8. Click the > button.

Click OK to add the Service Account to the "Sernperis ADSM Service
Accounts” group. The group will be created in the "Users”" container, if

DK& |
9. Click OK.

10. Check the box next to Create the following group.

it does not exist.
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Click QK to create the "Semperis Audit Collectors” group, if it does not
already exist.

11. Click OK.

*
AGREEMENT LICENSE CONFIGURATION INSTALLATION SUMMARY
I '
—
2 ® (==
" (s
{111
Active Directory Audit Configuration
Create the following group:
¢ Name: Semperis Audit Collectors
............ Location: CN=Users DC=DI.DC=IPDR .
v

Semperis .

12. Click the > button.
13. Select the appropriate database option, and enter any required information.
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AGREEMEN CONFIGURATION INSTALLATION 5Lk
|:' = i =] ‘i)f =
— = e
® @ = e o = e 0 =
™ il i ol Ll AN
Select installation type Provide connection details
O Create a new database
Create a new database on an existing SQL server Server:
O Use an existing database Port:
Use an existing database on an existing SQL server
®{instali SOL Exprass iocally Windows Authentication
Use Microsoft SQL Express 2014 running locally
Username:
Password:

Semperls

14. Click the > button.

y Click OK to begin the installation. Click Cancel to go back and review
i any of your installation settings

15. Click OK.
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INSTALLATION

Semperis Management Server has been installed successfully.

Installing Windows Server features

Generating certificates

Generating the configuration file

Configuring Registry entries

Installing SQL Server Express. This may take up to 20 minutes to complete
Configuring the SQL Server database

Installing the Semperis Management Server

Semperls

16. Click the > button after the installation completes.

17. There should now be a shortcut on the desktop linking to the web console for Semperis DS
Protector.

18. On the login page, enter the full domain as well as the NetBIOS name.

19. Enter the username and password of an administrator on the domain.
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& ‘ & Secure | https://semperis-dsp.di.ipdr/ADSM/Login/

Semperis

Active Directory State Manager

A Topology unknown. Log in to run AD
Topology discovery.

DLIPDR

DI

2 Administrator

LOGGING IN.

20. Click Login.
21. Check the box next to the domain controllers that should be monitored by DSP.

==

< Sempers Active Dieecre: X W %
£

C | & Secure | hitps.//serpens-dsp.dupdr/ADSM/NoAgents

@ ADSM AGENT MANAGEMENT

AGENT T 3
O -

= ALL DOMAINS ~ *

a NAME DOMAIN -+ STATUS =+ VERSION » 05 VERSION = ¢ ACTION
=l AD-ONS Ol IPOR MO agent aGoo L ]
(] AD-DNEOB DILIPOR Mo agent cooo 1 G

22. Click Run Action.
23. Enter the password for the account.
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Bulk Deploy the latest version of [1 DCs)

Plpase enter c ials with jini issi on all of the target machines to
deploy the latest version of the ADSM Agent, version 2.5.6744. 25103

Daomain: DLIPOR

Username: Agmiristralos

Change user

Fasswnrn seesesssssss

24. Click OK.

e Success

The requested operation 15 running.

25. Click Close.
26. After the agent finishes deploying, click Login at the top of the page and log in.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

191



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

i Senpers Actve Director X W)
€ = C | & Secure | by

Data synchronization from Active Directory required

The sync process is ready 1o start.
What would you like to go?

EZZT cerionacenis

27. Click Start Sync.

28. After this completes, click Settings at the top of the page.
I seeen s i N

€& O | & Secure | https//sempenis-dsp.diipdr/ADSKivsettings

Current Domain: ‘u SETTINGS

Di.PDR

]N DASHBOARD > Agents (DI.IPDR)
> Dstabase
\ CHANGED
fTEMS
> Emall Alerts
DELETED "
ﬂ e 3 Group Policy
> Data Collection
CONFIGURATION
PARTITION

s n
@ NS Audit Configuration Wizard B

Dsfine audit ssttings 3nd Manage UGt Agents 3nd Audit Callectors
o
</

Auait Agent Downioad Agent

Q REPORTS Audit Collector Downlcad Coliector

v Audit

3 Genersl @

> Operstion Log

29. Click Audit.
30. Click Run.
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i Semperis Active Director X

& C | @ Secure P peris-dsp.didpdr/ADSM#adsnWizard o ¥ i

Semperis

[ ‘Semperis Active Directory State Manager - evaluation expires on Sep 8, 2018 ]
Current Domain
OLIPDR

m ACTIVE DIRECTORY AUDITING WIZARD

)
invsgucion ecrian Hanage Buch Agents

Intraduction

Weicome to the Audit configuration wizard, The wizard will quide you through the of the Audit and

setting

ot 10 funning the i, plesse make sure You have Ihe petissions feduired 1o deslay agents on Domain Contolers sndor deploy Audit
Collectors on the allocsted servers
Please refer 10 the Iatest Semperis Actve Direciory State Manager guide for additional information

31. Click Next.

< C | @ Secure P peris-dsp.diipdr/ADSM#adsnWizard o

[ Semperls Active Directory State Msnager - evalustion expires on Sep 8, 2018 ]
Current Domain
DLIPOR

ACTIVE DIRECTORY AUDITING WIZARD

ImsguTon

iecvan Farage Auon agen

AD Partition Selection

Select the partitions for which the additional Audit data will be coliected. Changes in partitions not selected for collection of Audit data will not.
Contsin the information sbout wh performed the changs

PARTITION

CN=Configuration.DC=DI.DC=IPDR

DC=DIDC=IPDR

~
@ CN=Schema,CN=Configuration, DC=DI,0C=IPDR
]
DC-DomainDnsZones,DC~DI.DC-IPOR
@

DC-ForestDnsZones,DC-01,0CPDR

¥ [ cven |

32. Click Next.
33. Check the boxes next to any Domain Controllers that should be monitored.
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l Semperis Active Directory State Manager - evaluation expires on Sep 8, 2018 |

m ACTIVE DIRECTORY AUDITING WIZARD

IASHBOARE

Irvzun Zrame huzr Das Calscren
b i Rasticns

Audit Agent Management

R i
Domain Contrallers with no Audit Agent installed

I

B G RN R DOWNLOAD AGENT INSTALLER

. ] NAME * DOMAIN & v
300
=] AD-ONS. guipar
a AD-DNSO8 o ipdr

E) aeponTs

Vanaze dust Agei Maraze auar Calazs

Deploy Audit agents on all Domain Cantrollers hosting 3 writable copy of the previously selected AD partitions..
e Partial Oeployment of AuGT Wil re5u 17 The nabily T provide nformation SBOUT Who made Tha changes parformed sgainst thase

JOB STATUS

Deploy Latest Version v uuur: ACTION
STATUS + v VERSION 4 v AcTION
® 2semazsios | X &0
o agent - AP ]
CANCEL

34. Click Run Action.
35. Enter the password.

/s A= e

€ C | sean

Buik Deplay the latest version (1 DCs)

Plasse enter with
ceploy the [stest varsion the Augit Agent, version 2.5 6744 25103
DI

Usetname Admenistrator

Change user

FRbimons sesiaesenias

36. Click OK.
37. Wait for the deployment to finish.

™|

an all of thi target machines to
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et ]

&« @ | @ Securs | hitpsy/semperis-dsp.diipdr/ADSM#sdsnizard

Semperis 8 DiFDR *

[ Sempens AC

ctory State Manager - evaluation expires on Sep 8, 2018
Current Domain:

Dl IPDR

Jd DASHEOARD
s S [rm—

ﬂ Audit Agent Jobs Statuses

— ALL AUDITED DOMAINS — =

@\
& ACTIVE DIRECTORY AUDITING WIZARD

Mansse Auct Agznts

@I . N - DomAN - LATEST UPDATE « - 108 STATUS +

ag-ans di.ipar 08/13/2018. 3:54 P © Completes

a0-0ns08 oiipor

=3 B

Masegs Aust Cofiestars

AGENT STATUS.

MESSAGE

Depioy latest c

38. Click Next.

e s < A 2

- C | @ Secure dsp.diipdr/ADS

o

[ St A iy St Fanagr ~ vaiation e o 5o 8, 078 ]
Current Domain
DI
N
P B ACTIVE DIRECTORY AUDITING WIZARD
N DASHBOARE
4

Eranie Auzi Date Collecvion Panase Aut dgents
Tor A0 Baruens

Audit Collector Management

UIiliZ31i0n Of NeTwark 1esoufcas and 16 control the UG O3ta flaw.

Mamage A Catectore

Audit Collectors act 25 proxies between Audit Agents and Semperis data processing engine. Deploying Audit Collectors allows 10 optimize

11 o AU Collectors are avaiable, e AUGT Agents will GefauT 1o using the builin AUGit Collectar o the Management Sever

Each Audit Agent selects the optimal Audit Collectar 10 use based on Al
Please refer fo the latest Semperis Active Difectory State Manager quide for adgitional infrmation.

< [ ommorcauscron | somonancanmemien

S ) roon - sTATUS <0

No agents found

site topology 3nd Audit Collectors” priorities,

Deploy Latest Version v

JoB STATUS

RUN ACTION

VERSION + + acTion

39. Click Finish.

2.11 Micro Focus ArcSight Enterprise Security Manager

Micro Focus ArcSight Enterprise Security Manager is primarily a log collection/analysis tool with
features for sorting, filtering, correlating, and reporting information from logs. It is adaptable to logs
generated by various systems, applications, and security solutions.
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This installation guide assumes a preconfigured CentOS 7 machine with Enterprise Security Manager

(ESM) already installed and licensed. This section covers the installation and configuration process used

to set up ArcSight agents on various machines, as well as some analysis and reporting capabilities.

Installation instructions are included for both Windows and UNIX machines, as well as for collecting

from multiple machines. Furthermore, integrations with other products in the build are included in later

sections.

2.11.1 Install the ArcSight Console

1. Run ArcSight-7.0.0.2436.1-Console-Win.exe.

< ArcSight FiEDE

=* Introduction
@ License Agreement
@ Special Motice

@ Choose Shortcut Folder
@ Pre-Installation Summary
@ Installing...

@ Install Complete

Installamwheare

Cancel

ArcSight ESM Console [ = [ o [5e]

Introduction

@ Choose ArcSight installatil..

The ArcSight Congole Installer will guide you through the installation
of ArcSight ESM Console | It is strongly recommended that you quit all
programs before continuing with this installation.

Mote: Please be sure to download and read the separate installation
and upgrade documentation available with this software.

Click the Mext' button to proceed to the next screen. Ifyou want to
change something on a previous screen, click the 'Previous' button.

‘You may cancel this installation at any time by clicking the 'Cancel'
hutton.

Previous | PoMext |
40

2. Click Next.

3. Check the box next to | accept the License Agreement.
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<L ArcSight FLEDE
« Introduction

= License Agreement
@ Special Notice

@ Choose Shortcut Folder
@ Pre-Installation Summary
@ Installing...

@ Install Complete

InstallAnmywhere

Cancel

ArcSight ESM Console - = -

License Agreement

@ Choose ArcSight installati.

Installation and Use of ArcSight ESM Console Requires
Acceptance of the Following License Agreement:

this URL apply: ~
hitps Msoftware. microfocus. comiabout/software-licensing.

17. Russian Consumers. Ifyou are based in the Russian
Federation and the rights to use the software are provided to you
under a separate license andior sublicense agreement
concluded between you and a duly authorized Micro Focus
partner, then this Agreement shall not be applicable.

5200-0949 v1.0, 2017
(C) Copyright 2015-2018 EntIT Software LLC

i accept the terms of the License Agreement

Previous | ‘ N@t |

4. Click Next.
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< ArcSight FiEDE
+ Introduction

+ License Agreement
-» Special Motice

@ Choose Shortcut Folder
@ Pre-Installation Summary
® Installing...

@ Install Complete

Install&mywhere

Cancel

ArcSight ESM Console il B -

Special Notice

@ Choose ArcSight installati,..

Only applicable for US Gowvernment Entities:
Limited Rights MNotice (June 1987)

(@) This data is submitted with limited rights under Government
Contract. This data may be reproduced and used by the
Government with the express limitation that they will not, without
written permission ofthe Contractor, be used for purposes of
manufacture nor disclosed outside the Government; except that
the Government may disclose these data outside the Government
for the following purposes, if any, provided that the Government
makes such disclosure subject to prohibition against further use
and disclosure:

(b) This Motice shall be marked on any reproduction of this data,
inwhole orin part.

Restricted Rights Motice (June 1987) %

| Previous | | Mext

5. Click Next.
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< ArcSight FhErE Choose ArcSight installation directory

+ Introduction Choose a directory to install ArcSight Console:

+ License Agreement CharcsightiConsale |
+ Special Notice
= Choose ArcSight installati...
@ cChoose Shortcut Folder
@ Pre-Installation Summary
@ Installing...

@ Install Complete

Restore Default Folder | | Choose.. |

Installamwheare

6. Click Next.
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< ArcSight FiEDE

+ Introduction
« License Agreement
+ Special Notice

+ Choose Arc3ight installati...

=» Choose Shortcut Folder
@ Pre-Installation Summary
@ Installing...

@ Install Complete

Installamwheare

7. Click Next.

Choose Shortcut Folder

Where would you like to create product icons?

(®) In a new Program Group: |ArcSight ESM 7.0.0.1 Console

() In the Start Menu
(Z) On the Deskiop

(2 In the Quick Launch Bar

) Other: |

() Dont create icons

[#] Create Icons for All Users
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ArcSight ESM Console il B -

< ArcSight Fazoe Pre-Installation Summary

Introduction Please review the following information before continuing:
License Agreement
Product Hame:

ArcSight ESM Console
Choose ArcSight installati...

Choose Shortcut Folder Install Folder:
CharcsightiConsale

v
W
" Special Motice
v
v

=* Pre-Installation Summary

@ Installing... Shortcut Folder:
@ Install Complete CAProgramData\MicrosoftiWindowsi3tart Menu\Programs\arcSight

Disk Space Information (for Installation Target):
Required: 578,973,682 Bytes
Available: 42 580,230,144 Bytes

Installamywhera

Ccancel Previous || Install

8. Click Install.
9. Select No, I do not want to transfer the settings.
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B ArcSight Console Configuration Wizard I;Ii-

{ ArcSig ht Do you want to transfer configuration settings fram a previous ArcSight Console
installation? If you installed ArcSight Console before, choasing this option will transfer
settings from your previous ArcSight Console configuration to the new version.

Configure

(") ¥es, I want to transfer the settings

(®) Mo, I do not want to transfer the settings

10. Click Next.
11. Select Run console in default mode. (This can be changed later according to your organization’s
compliance requirements.)

[« | ArcSight Console Configuration Wizard — =] e

{ ArcSight Select the mode for console to run in: -
WARNING 1: Do not install in FIPS 140-2, FIPS with Suite B 128 bits and FIPS with Suite
. E 152 bits mode unless
Canlg ure @ you are a federal agency required to comphy with the FIPS 140-2, FIPS with
Suite B 128 bits and FIPS with Suite B 132 bits standard, AND
@ you have reviewed the setup and configuration steps required for enabling
FIPS 140-2, FIPS with Suite B 128 bits and FIPS with Suite B 192 bits mode -

S —1 o ——

) Run console in default mode

(® Run console in FIPS mode

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 202



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

12. Click Next.

Information -

Are you sure you want to switch to FIPS mode? You cannot revert to default mode once you select FIPS mode.

| ‘f‘rgs | | MNo
13. Click Yes.
14. Select FIPS 140-2.
B ArcSight Console Configuration Wizard = | =]
.9: ArcSig hi Select the cipher suite options:

Before you proceed, be sure to make the necessary configuration changes to the

Configure system. Refer to the ArcSight ESM Installation and Configuration Guide for details.

(®) FIPS 140-2
() FIPS with Suite B 123 bits

() FIPS with Suite B 192 bits

<o | ey |

15. Click Next.
16. Enter the hostname of the ESM server for Manager Host Name.
17. Enter the port that ESM is running on for Manager Port (default: 8443).
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B ArcSight Console Configuration Wizard \;Ii-

.9: ArcSig ht Please complete the following ArcSight Manager information.

MOTE: Only IPv4 iz available as a Preferred IF Protocol.

Configure

iy

Manager Host Mame | arcsight-esm

Manager Port 3443

< Previous | | Mext =

18. Click Next.
19. Select Use direct connection.

B ArcSight Conscle Configuration Wizard M

.{ ArcSig ht ArcSight Console can connect to ArcSight Manager using a HTTP proxy server,
Please choose whether you would like to configure ArcSight Console for a proxy
' connection,
Configure

(#) Use direct connection,

() Use proxy server,

= Prewvious | | Mext =
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20. Click Next.

-§: ArcSight

Configure

ArcSight Console Configuration Wizard \;‘i-

Please choose the authentication configuration to match the settings on ArcSight
Manager. If unsure, select the first option.

(®) Password Based Authentication
() Password Based and 55L Client Based Authentication
() Password Based or S5L Client Based Authentication

() 550 Client Only Authentication

= Previous | | MNext = |

21. Click Next.

22. Select your preferred browser.
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x| ArcSight Conscle Configuration Wizard I;Ii-

.i ArcSig ht Browser information: Please enter the path to your prefered web browser, This will be
used by the console when opening any web-based application in an external browser.

Configure

Browser Executable |'ome‘Application’chrome. exe E

R

< Previous | | Mext = |

23. Click Next.

x| ArcSight Console Configuration Wizard I;li-

.i ArcSig ht The ArcSight Console can be installed for use by single 05 user on this machine who has

write access to the installation directory or for multiple OS users without write access, A
single installation can also be shared by multiple O35 users as long as they all have write
access to the installation directory, Mote: When switching from one mode to the other
your user preferences will not be preserved.

Configure

(®) This is @ single user installation. (Recommended)

() Multiple users will use this installation,

< Previous | | Mext = |

24. Click Next.
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25. Click Finish.

< ArcSight FhnlE Install Complete

Introduction Congratulations!

License Agreement ArcSight ESM Console has been successfully installed to:
Special Notice

Choose ArcSight installati...
Choose Shortcut Folder Click "Done” to quit the installer.

CharcsighfiConsolelcurrent

Pre-Installation Summary
Installing...

U
U
L
Ld
Ld
Ld
Ld
-

Install Complete

InstallAmewhere

Previous || Done

26. Click Done.
27. Run ArcSight Console from the Start menu.
28. Enter the username and password.
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H ArcSight Console 7.0.0.2436.1 [ [ o [

User ID Eﬂ

Password

Manager arcsight-esm -

| Lagin || Cancel

29. Click Login. (If you are unable to connect, ensure that the hostname of the ESM server is
present in your DNS server.)
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Do you want to trust the certificate of server's signer?

BUcFKSdkHaSdtkWee1XIRZdLtmSaEvryM+CLFnDEIILADA UgqVDwAFrWt7k A=vErglghT2zifkg
Q0eTQrIEVmbKFumM3BRUSBLZXYcntiEVQOb3nX4zj Bel YhvivwzuddgoOVSzS, buleXUYDEzcD
*1+N+Hi7vEKwodasacn Y BKILfn TMZZAESID+HP7CZIS+EWtw AD 1Y 7avh 1Fe-+IPnjEKy mk Mo M
Clzz7EdN ABDWsc1epmYM2PEETUOBSQOTWIVZErykavaExhjocg/ 111gUY rHLpigeA kag NIorky SW
Cgfdaquilxrelxirg7dFjrHhDefaclmMEk vl A==

Issued To
CM=arcsight-esm,OU=ESM,O=Arcsight, L=95014,ST=CA,C=US

Issued By
CN=arcsight-zsm, OU=ESM,O=Arcsight L=35014,5T=CA,C=US

Issued On
Sunday, August 13, 2018 B:16:31 AM PDT

Expires On
Mand=y, August 21, 2023 8:15:31 AM PDT

30. Click OK.

2.11.2
1.

Install Individual ArcSight Windows Connectors

Run ArcSight-7.9.0.8084.0-Connector-Win64.exe.
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H ArcSight SmartConnector
<CArcSight  [IFLERE

= Introduction

@ Choose Install Folder
@ Choose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

@ Upgrade

® System Restart

@ Install Complete

— >

Introduction

The ArcSight Installer will guide you through the installation
ofthe ArcSight SmartConnector.

The first step installs the core ArcSight SmanConnector
components; then you selectthe ArcSight SmanConnector
you wish to configure.

ArcSight recommends tl'mvnu quit all other programs
before continuing with this installation.

Click the 'Mext' button to proceed to the next window.
Ifyou want to change something on a previous window,
click the Previous' button. To cancel this installation at
any time, click the 'Cancel' button.

Pravious Mext

2. Click Next.
3. Enter C:\Program Files\ArcSightSmartConnectors\Windows.
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H ArcSight SmartConnector — *

<L ArcSight  [IFLSERE Choose Install Folder

+ Introduction

- Choose Install Folder Please choose the installation folder. It is recommended that you
@ Choose Install Set choose the folder name according to the device that you want to
connectto, for example /ciscoids or /checkpointng. Ifyou are

® Pick Shortcut Folder upgrading from a previous version, please selectthe folder where the

@ Pre-Install Summary ArcSight SmartCaonnector is currently installed.

@ Installing...

@ Uparade Where Would You Like to Install?

@ System Restart C\Program Files\rcSightSmantConnectorsiWindows

@ Install Complete

Restore Default Folder Choose...

Previous Mext

4. Click Next.
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n ArcSight SmartConnector — >

<L Arcsight | CIFLERE Pick Shortcut Folder

" Introduction Where would you like to create product icons?
" Choose Install Folder
+ Choose Install Set

(® In a new Program Group: | ArcSight SmarnConnectors

= Pick Shortcut Folder (O In the Start Menu

@ Pre-Install Summary O On the Desktop

@ Installing...

@ Upgrade i) Inthe Quick Launch Bar

@ System Restart
@ Install Complete

() Other: Choose...

() Don't create icons

[] Create Icons for All Users L\X’

Previous

5. Click Next.
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n ArcSight SmartConnector
<C ArcSight  [IFAERE

+ Introduction

+ Choose Install Folder
+ Choose Install Set

+ Pick Shortcut Folder

=* Pre-Install Summary
@ Installing...

@ Upgrade

@ System Restart

@ Install Complete

6. Click Install.
7. Select Add a Connector.

— >

Pre-Install Summary

Please Review the Following Information Before Continuing:

Product Name:
ArcSight SmantConnector

Install Folder:
CAProgram Files\ArcSightSmanConnectors\Windows

Shortcut Folder:
Cilzers\ddministratorAppDataiRoaming\WWicrosoftWWindows\Start |

%

Previous Install
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E connector Setup % — O
. What would you like to do?
<X ArcSight
Configure
(®) Add a Connector
(") Set Global Parameters
< Previous Cancel
8. Click Next.

9. Select Microsoft Windows Event Log—Native.
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E Connector Setup

<X ArcSight

Configure

Select the connector to configure

Type  Microsoft Windows Event Log - Native

v

< Previous

Cancel

10. Click Next.
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n Connector Setup -

Configure Parameters

<X ArcSight

Configure Security log
System log

Select logs for event collection from local host

Application log
(] ForwardedEvents log
[ ] Custom logs
Source hosts for all forwarded events
[ Do not use any source for Windows QS version
[ Use Active Directory for OS version
O Use file for OS version

Farameters to add hosts for event collection

JUse common domain credentials

[ Use Active Directory

] Enter manually

< Previous

Cancel

11. Click Next.
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B Connector Setup - O X

For the host the following options were selected:

q AfCSIghf Security, System, Application

Configure

< Previous Cancel

12. Click Next.
13. Select ArcSight Manager (encrypted).
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B connector Setup - O
. Enter the type of destinafion
<X ArcSight
Configure
(®) ArcSight Manager {encrypted)
() ArcSight Logger SmartMessage (encrypted)
() ArcSight Logger SmartMessage Pool (encrypted)
() CEF File
(O) Event Broker
() CEF Syslog
() CEF Encrypted Syslog {(UDF)
() CSV File
(") Raw Syslog
< Previous Cancel

14. Click Next.

15. Enter the hostname, port, username, and password for the ArcSight ESM server.
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B connector Setup - O
. Enter the destination parameters
<X ArcSight
Configure
Manager Hostname arcsight-esm
Manager Port 8443
User administrator
Password sesssans
AUP Master Destination |false )
Filter Out All Events false ~
Enable Demo CA false V
< Previous Cancel

16. Click Next.
17. Enter identifying details about the system (only Name is required).
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u Connector Setup

Enter the connector details

< ArcSight

Configure

Name Windows10-1
Location
DeviceLocation

Comment Windows10-1 Client

< Previous Cancel

18. Click Next.

19. Select Import the certificate to connector from destination.
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n Connector Setup

<X ArcSight

Configure

— O
Following certificate will be imported into connector trust store:
Host/port: arcsight-esm 8443
Details: ClN=arcsight-esm, OU=ESM, O=Arcsight, L=05014, ST=CA, C=USs
(®) Import the certificate to connector from destination
(C) Do not import the certificate to connector from destination
< Previous Cancel

20. Click Next.
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E Connector Setup

. Add connector Summary
& ATCSIth Following are the added connector details:

Configure

Connector Name [Windows10-1]. Connector Tvpe [winc]

< Previous Cancel

21. Click Next.
22. Select Install as a service.
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B connector Setup - O

The Smart Connector is currently mstalled as a standalone application

<X ArcSight

Configure

(® Install as a service

(") Leave as a standalone application

< Previous Cancel

23. Click Next.
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B connector Setup - O

Specify the service parameters

<X ArcSight

Configure

Service Internal Name winc
Service Display Name Microsoft Windows Event Log - Native
Start the service automatically |Yes w

< Previous Cancel

24. Click Next.
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B Connector Setup - O

Install Service Summary

<X ArcSight

Configure

The ArcSight SmartConnector is now configured to run as a service.
You can now start the SmartConnector by
Going to the services application and starting the service:

ArcSight Microsoft Windows Event Log - Native

< Previous Cancel

25. Click Next.
26. Select Exit.
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E Connector Setup

<X ArcSight

Configure

Would you like to continue or exit?

() Continue

< Previous Cancel

27. Click Next.
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n ArcSight SmartConnector

X Arcsight | CIHLERE

<

Introduction

Choose Install Folder
Choose Install Set
Pick Shortcut Folder
Pre-Install Summary
Installing...

Upgrade

System Restart

I T T

Install Complete

Cancel

28. Click Done.

— x

Install Complete

Congratulations! ArcSight SmartConnector has been successfully
installed to:

C\Program Filest\ArcSightSmanConnectorsWindows

Press "Done” to quit the installer.

Previous Done

2.11.3 Install Individual ArcSight Ubuntu Connectors

1. From the command line, run:

> sudo ./ArcSight-7.9.0.8084.0-Connector-Linux64.bin
2. Enter the password if prompted.
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0 ArcSight SmartConnector

<C ArcSight | CIFAERE Introduction

= Introduction The ArcSight Installer will guide you through the
installation

® Choose Install Folder of the ArcSight SmartConnector.

@ Choose Install Set

® Pick Shortcut Folder The first step installs the core ArcSight SmartConnector

components; then you select the ArcSight SmartConnector
® Prednstall Summary

® Installing... you wish to configure,

B Upgpads ArcSight recommends that you quit all other programs

@ System Restart before continuing with this installation.
® Install Complete

Click the 'Next' button to proceed to the next window.
If you want to change something on a previous window,
click the 'Previous' button. To cancel this installation at
any time, click the 'Cancel' button.

3. Click Next.
4. Enter /root/ArcSightSmartConnectors/Ubuntu.

B ArcSight SmartConnector

< ArcSight | COFSETE Choose Install Folder

+ Introduction

= Choose Install Folder Please choose the installation folder. It is recommended
@ Choose Install Set that you choose the folder name accordlng_to t_he device
that you want to connect to, for example /ciscoids or

@ Pick Shortcut Folder fcheckpointng. If you are upgrading from a previous
@ Pre-nstall Summary version, please select the folder where the ArcSight
} SmartConnector is currently installed.
@ Installing...
@ Upgrade where Would You Like to Install?
@ System Restart [froctsarcsightSmartConnectors/Ubuntu |

@ Install Complete

Bestore Default Folder H Choose... ‘

Previous | ‘ MNext
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5. Click Next.

D ArcSight SmartConnector

<L AreSight | IFSETE Choose Link Folder

+ Introduction Where would you like to create links?
+ Choose Install Folder
+ Choose Install Set

® In your home folder

= Pick Shortcut Folder ) Other:
@ Pre-nstall Summary

; ) Don't create links
@ Installing...

@ Upgrade
@ System Restart
@ Install Complete

[ zrewous ] [ Hex |

6. Click Next.

B ArcSight SmartConnector

<L ArcSight | JFSETE Pre-Install Summary
+ Introduction Please Review the Following Information Before
+ Choose Install Folder Sontinuing:
+ Choose Install Set Product Name:
+ Pick Shortcut Folder ArcSight SmartConnector
= Pre-Install Summary Install Folder:
® Installing... froot/ArcSightSmartConnectors/Ubuntu
® Upgrade Link Folder:
@ System Restart froot

@ Install Complete

Cancel Previous | ‘ Install
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7. Click Install.
8. Select Add a Connector.

. Connector Setup

What would you like to do?
§ ArcSight
Configure
@ Add a Connector
) Set Global Parameters
< Previous || Next = || Cancel
9. Click Next.

10. Select Syslog File.
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What would you like to do?
{ ArcSight

Configure

® Add a Connector
i) Set Global Parameters

| < Previous || Next = || Cancel
|

11. Click Next.
12. Enter /var/log/syslog for the File Absolute Path Name.
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B Connector Setup

& ArcSight

Configure

Enter the parameter details

File Absolute Path Name [varflog/syslog| [
Reading Events Real Time or Batch |realtime |v|
Action Upon Reaching EOF |None |v|
File Extension If Rename Action |processed |

i | [»]

| < Previous | | Next = || Cancel |

13. Click Next.
14. Select ArcSight Manager (encrypted).
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o Connector Setup

{ ArcSight

Configure

Enter the type of destination

® Arcsight Manager (encrypted)

) ArcSight Logger SmartMessage (encrypted)

) ArcSight Logger SmartMessage Pool (encrypted)
) CEF File

) Event Broker

) CEF Syslog

) CEF Encrypted Syslog (UDP)

) CSV File

) Raw Syslog

| = Previous | | Next = | | Cancel

15. Click Next.
16. Enter the hostname, port, username, and password for ArcSight ESM.
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B Connector Setup
Enter the destination parameters
<X ArcSight

Configure

Manager Hostname |arcsight-esm |
Manager Port [gaa3 |
User [administrator |
Password |
AUP Master Destination |false |v|
Filter Out All Events |fa|5e |v|
Enable Demo CA |false |v|
| < Previous || Next = || Cancel

17. Click Next.
18. Enter identifying details about the system (only Name is required).
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<; ArcSight

Configure

Enter the connector details

Name Ubuntu Client

Location

DeviceLocation

Comment

<Previous | | Next > Cancel

19. Click Next.
20. Select Import the certificate to connector from destination.
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. Connector Setup

é‘[ ArcSight

Configure

Following certificate will be imported into connector trust store:
Host/port: arcsight-esm_8443
Details: Ch=arcsight-esm, OU=ESM, O=Arcsight, L=95014, 5T=CA, C=U5

@ Import the certificate to connector from destination

() Do not import the certificate to connector from destination

< Previous [ Dext > Cancel

21. Click Next.
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o Connector Setup

. Add connector Summary
& ArcSrght Following are the added connector details:
Connector Name [Ubuntu Client], Connector Type [syslog_file]

Configure

22. Click Next.
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> Connector Setup

é: ArcSight

Configure

To modify service configuration, you must be running as root
To manually configure, log on as root and execute the Following script:

Jhome/di2/ArcSightSmartConnectors/Ubuntu2/current/bin/arcsight
agentsve -i-u user

To manually remove the service, log on as root
and execute the following script:

Jhome/di2/ArcSightSmartConnectors/Ubuntu2/current/bin/arcsight
agentsvc -r

< Previous [ Mext = Cancel

23. Click Next.
24. Select Exit.
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& Connector Setup

. Wouldyou like to continue or exit?
& ArcSight

Configure

) Continue

@ [Exit

<Previous | | hlext = Cancel

25. Click Next.
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B ArcSight SmartConnector

<C ArcSight | OFLERE Install Complete
v Introduction Congratulations! ArcSight SmartConnector has been
+ Choose Install Folder successfully installed to:
¥ Choose Install Set fhome/di2fArcSightSmartConnectors/Ubuntu?
+ Pick Shortcut Folder
« Prednstall Summary Press "Done" to quit the installer,
+ Installing...
v Upgrade
+ System Restart
=* Install Complete
)

Installanywhere

:-"_ = gone

26. Click Done.

2114 Install a Connector Server for ESM on Windows 2012 R2

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe.
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<L ArcSight | [JFLETE

- Introduction

@ Choose Install Folder
@ Choose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

@ Upgrade

@ System Restart

@ Install Complete

[= [ |

Introduction

ArcSight SmartConnector

The ArcSight Installer will guide you through the installation
of the ArcSight SmantConnector.

The first step installs the core ArcSight SmartConnector
components; then you selectthe ArcSight SmantConnector
you wishto configure.

ArcSight recommends thatyou quit all other programs
before continuing with this installatio

Click the 'Mext' button to proceed to the next window.
Ifyouwantto change something on a previous window,
click the 'Previous' button. To cancel this installation at
any time, click the 'Cancel' button.

Previous

2. Click Next.

3.

Enter C:\Program Files\ArcSightSmartConnectors\Windows.

<X ArcSight | [IFAETE

+ Introduction

- Choose Install Folder
@ Choose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

@ Upgrade

@ System Restart

@ Install Complete

= [

Choose Install Folder

ArcSight SmartConnector

Please choose the installation folder. It is recommended that you
choose the folder name according to the device that you want to
connect to, for example /ciscoids or /checkpointng. If you are
uparading from a previous version, please select the folder where the
ArcSight SmanConnector is currently installed.

Where Would You Like to Install?
CAProgram FiIechSightSmartConnectors‘.‘.".findows|

Restore Default Folder || Choose...

| Previous | | Mext
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4. Click Next.

<L ArcSight | [IFLETE

+ Introduction

+ Choose Install Folder
+ Choose Install Set
-2 Pick Shartcut Folder
® Pre-Install Summary
@ Installing...

® Upgrade

® System Restart

@ Install Complete

BE

Pick Shortcut Folder

ArcSight SmartConnector

Where would you like to create product icons?

(® In a new Program Group; |ArcSight SmartConnectors
) Inthe Start Menu

() On the Desktop

() In the Quick Launch Bar

) Other: Cho

() Don't create icons

[] Create Icons for All Users

Previous | [ Mext

Click Next.

<L ArcSight | [JFLETE

+ Introduction

v Choose Install Folder
+ Choose Install et

+ Pick Shortcut Folder

= Pre-Install Summary
@ Installing...

@ Upgrade

@ System Restart

@ Install Complete

BE |

Pre-Install Summary

ArcSight SmartConnector

Please Review the Following Information Before Continuing:

Product Name:
ArcSight SmanConnector

Install Folder:
C:\Program Files\ArcSightsmartConnectors\Windows

Shortcut Folder:
CUsers\ddministrator.DlVippData\Roaming\MicrosoftWindows\Ste

< m > %

Previous || Install |
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6. Click Install.
7. Select Add a Connector.

 « | Connector Setup = [ = -

What would vou like to do?

<X ArcSight

Configure

(® Add a Connector

() 5et Global Parameters

| Mext = | | Cancel

8. Click Next.
9. Select Microsoft Windows Event Log—Native.
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<X ArcSight

Configure

Connector Setup

Select the connector to configure

Type |Microsoft Windows Event Log - ative

s

< Previous | |

Next >

Cancel

10. Click Next.
11. Check the box next to Use Active Directory.
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B Connector Setup = | = -

. Configure Parameters
r
i A CS ! g ht Select logs for event collection from local host -
Configure vl Security log

System log
Application log

[] ForwardedEvents log
[] custom logs

Source hosts for all forwarded events

[[] Do not use any source for Windows OS version
[ Use Active Directory for OS version
[[] Use file for OS version

Parameters to add hosts for event collection

[] Use common domain credentials

] Enter manually

< Previous | | Next > | | Cancel

[

12. Click Next.

13. Enter information about your Active Directory server. (It is recommended to create a new
administrator account for ArcSight to use.)

14. Set Use Active Directory host results for to Replace Hosts.
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Enter the parameter details

<X ArcSight

Configure

Domain Name

Domain User Name

Domain User Password

Active Directory Domain

Active Directory User HName
Active Directory User Password
Active Directory Server

Active Directory Filter

B Connector Setup = | = -

DI

arcsight_admin

SEBEBBBBRBIREES

DI.IFDR

arcsight_admin

SRR BBBERINRRS

ad-dns.di.ipdr
(&(cn=")(operatingsystem=%)(whencreated=>))

Active Directory Protocol non_ssl W
Use Active Directory host results for |Replace Hosts W
< Previous | | Mext > | | Cancel

15. Click Next.

16. Check the boxes under any event types that should be forwarded to this connector, for each

individual host, e.g., Security, System, Application.
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Enter the device details
<X ArcSight
[} Host Name Do.. Use.. Pas.. Win.. Is.. Sec.. Sys.. Appl.. For.. Cus.. Fitter Llocale Enc...
Confiaur %] [EXCHANGE.LLIFUR e Winde | [ W | W | | L - en_Us UIFS |
onfigure [¥] REMOTEDESKTOP3.DL... === wind... | [] M| ™| & | O = len_Us |UTF-8
[+ |WINDOWS10-1.DLIPDR == Wind... | [ =] [ [+ O = len_US |UTF-8
[ |WINDOWS10-2.DLIPDR === wind... | [] M| ™8| ™| O = len_US |UTF-8
[¥] HYPERVDLIPDR === wind... | [] M| | & | O = len_Us |UTF-8 [
[¥] |MSsSQL.DLIPDR == Wind.., | [ =] [ [+ O = len_US |UTF-8
[¥] |WINDOWS10-3.DLIPDR === wind... | [] M| & & O = len_US |UTF-8
[¥] |UC-TEST-SERVER.DLIF... === wind... | [] W | | | O = len_Us |UTF-8
[¥] |DESKTOP-7REQ7KD.DL... ==, Wind... | ] [ [ [+l O = len_US [UTF-8
[¥] [RIPWIREEDLIPDR === wind... | [] M| ™| & | O = len_Us |UTF-8
[w]  |WIN-OLIQ7SMEHSZ.DL.... === wind... | [] R | = len_Us JUTF8 |_
[W]  |WINKSIZPEEGOKS.DLL... ===, (Wind... | ] M| M| M| O = len_Us |UTF-8
[w] |WIN-JH4L71215VT.DLL... === wind... | [] M| ™| & | O = len_Us |UTF-8
[¥] |aD-DNS08.DLIPDR == Wind... | [ =] [ [+ O = len_US |UTF-8
| || V| V| | |
[v¥] [BACKUPSERV.DLIPDR === wind... | [] M| | & | O = len_Us |UTF-8
[w] |GLASSWALL.DLIPDR ===, Wind... | [] [l =] [v] O = len_Us |UTF-8
[¥] |SEMPERIS-DSP.DLIPDR === wind... | [] M| & & O = len_US UTF8 [
[ add [ [ tmport |[ Export |
% [ <Previous |[ Mext> || cancel
17. Click Next.
Vill use Active Direct at: af s di
ArcSight Will use Active Directory at: ad-dns.di
I Dnﬂ qure Microsoft Windows Event Collection connector is configured to collect events from 22 hosts.
< Previous ‘ ‘ Mext = | | Cancel

18. Click Next.
19. Select ArcSight Manager (encrypted).
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+ | Connector Setup == -

Enter the type of destination

<X ArcSight

Configure

(®) ArcSight Manager {encrypted)

() ArcSight Logger SmartMessage (encrypted)

() ArcSight Logger SmartMessage Pool (encrypted)
) CEF File

() Event Broker

() CEF Syslog

() CEF Encrypted Syslog (UDP)

() CsV File

() Raw Syslog

< Previous ‘ | Mexts 4 | Cancel |

20. Click Next.

21. Enter the hostname, port, username, and password for the ArcSight ESM server.
= | Connector Setup = I:'-

Enter the destination parameters

<X ArcSight
Configure

Manager Hostname arcsight-esm

Manager Port 8443

User administratar

Password LLITTITY

AUP Master Destination | false v
Filter Out All Events false w
Enable Demo CA false v

< Previous ‘ ‘ Next > | | Cancel |

22. Click Next.
23. Enter identifying details about the system (only Name is required).
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24.
25

a Connector Setup
. Enter the connector details
< ArcSight
Configure
Hame Windows Connector Server
Location
DeviceLocation
Comment
s
<Previous | [ Mext> |[  concel |
Click Next.
Select Import the certificate to connector from destination.
a Connector Setup -8 -
. Following certificate will be imported into connector trust store:
é: ArcSi g ht Host/port: arcsight-esm_8443
Details: CN=arcsight-esm, OU=ESM, O=Arcsight, L=05014, ST=CA, C=US
Configure

®) Import the certificate to connector from destination

() Do notimport the certificate to connector from destination

<Previous |

Mext >

Cancel

26. Click Next.
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a8 Connector Setup

., ‘Add connector Summary
{ Arc5|gh1 Following are the added connector details

Connector Name [Windows Connector Server], Connector Type [winc]

Configure

27. Click Next.
28. Select Install as a service.

B Connector Setup

The Smart Connector is currently installed as a standalone application

< ArcSight

Configure

@ Install as a service

() Leave as a standalone applcation

N

< Previous | [

Next> ‘ Cancel |

29. Click Next.
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30.

< ArcSight

Configure

Connector Setup = | = -

Specify the service parameters

Service Internal Hame winc
Service Display Name Microsoft Windows Event Log - Native
Start the service automatically Yes v

I

&

[ <previous | [T Riext ] [ cancel |

Click Next.

<X ArcSight

Configure

Connector Setup - [o]

Install Service Summary

The ArcSight SmartConnector 1s now configured to run as a service.
You can now start the SmartConnector by

Going to the services application and starting the service:

ArcSight Microsoft Windows Event Log - Native

31. Click Next.
32. Select Exit.
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B Connector Setup - [o]

Would vou like to continue or exit?

<X ArcSight

Configure

O Continue

< Previous | ‘ Next = | ‘ Cancel

33. Click Next.

B ArcSight SmartConnector I;‘i-

<L ArcSight | [JFLERE Install Complete

<

Infroduction Congratulations! ArcSight SmartConnector has been successfully
Choose Install Folder installed to:

Choose Install Set
Pick Shortcut Folder
Pre-Install Summary Press "Done” to quit the installer.

C.\Program Files\ArcSightSmartConnectorstWindows

Installing...
Upgrade
System Restart

L N S U S ¥

Install Complete

Previous

34. Click Done.
35. Note: Ensure that all machines selected do not block traffic from this device through their
firewalls.
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2.11.5

Install Preconfigured Filters for ArcSight

2.11.5.1 Install Activate Base

1.

Go to the ArcSight Content Brain web application (https://arcsightcontentbrain.com/app/) and

log in. This page allows you to keep track of packages to be installed—what packages should be
installed depends on the needs of the organization, but the “Activate Base” is required for all

System Threat
¥ Malware
Health Intefligence fl
Situational
Situational § Situational
weat
Malware
Intelligence

products.

Level 2 Physical Perimeter Network Application Data Entity
SHuatonal Awaranass Situational § Stuational § Situational Situational @ Sttuational @ Situational
SRart with the actiate ase
Oewnioad

Security Products & Connectors

Click the Download link for the Activate Base. (Note: This package should be installed on the
ArcSight Console, not on the ESM.)

Copy the contents of the zip file to ARCSIGHT_HOME. The default for this is C:\arcsight\Con-
sole\current, assuming a Windows Server.

In PowerShell, navigate to the ARCSIGHT_HOME directory (C:\arcsight\Console\current) and
run:

> _\ActivateBaselnstal 1AndUpdate2540 .bat
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[T Administrator: Windows PowerShell l;li-—

eycurrent> .‘\ActivateBaselInstal lAndUpdate2540.bat

: Activate Base 2.5.4.0 requires ArcSight ESM v6.8c or greater!

5. Enter the hostname of the ArcSight machine, the port (default: 8443), and the username and

password used to connect to the ESM.
6. Delete Activate_Base_Updated_2.5.4.0.arb from the ARCSIGHT_HOME directory.
Log in to ArcSight Console.
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ArcSight Comsole 7.0.0.2436.1 [arcsight-esmeadministrator.ast] Trial license. Customer: ARST-Farner, Expiration date: 2019/02/01

8. Under Packages > Shared > All Packages > ArcSight Activate, right-click Activate Base Update
2.5.4.0, and select Delete Package.

2.11.5.2 Install Packages

Once the Activate Base is installed, packages can be installed to monitor for specific types of events. As
an example, find below instructions for the Malware Monitoring package.

1. Navigate to the ArcSight Content Brain web application.
2. Select the Level 1 box labeled Malware.

Level 1 Physi : et - System Threat
e H H H RIS

Security Products & Connectors

Track Execution Devices - @
@ Business Challenges s @ Associated Packages . @ Status = ® Arack Vector Solutions Expand All @

Mabware Monitaring L1 - Mahware Manitoring - indicators and Warnings e

3. Inthe Track Execution section, under Associated Packages, you can see the list of packages used
to address the challenge of Malware Monitoring. In this case, there is just one package, L1-
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Malware Monitoring—Indicators and Warnings. Click the link to be taken to a download page for
the package, and download it. (Note: This package should be installed on the ArcSight Console,
not on the ESM.)

4. Copy the contents of the zip file to ARCSIGHT_HOME. The default for this is C:\arcsight\Con-
sole\current, assuming a Windows Server.

5. In PowerShell, navigate to the ARCSIGHT_HOME directory (C:\arcsight\Console\current) and
run:
> _\L1-Malware_Monitoring_1.1.0.1_bat

e Administrator: Windows PowerShell

b11l, mixed mode)
roperties

ht-esm' with username 'administrator’...done.

1
Tease delete ackag ight Activate/Activate Base Update 2.5.4.0.

: From your ESM ystem:
lease delete ! Updated_2.5.4.0.arb

ministrator

6. Enter the hostname of the ArcSight machine, the port (default: 8443), and the username and
password used to connect to the ESM.

2.11.6 Apply Filters to a Channel

In the ArcSight Console, click File > New > Active Channel.
Enter a name for the channel.
Select a time frame.

P wnN R

For Filter, select one the filters that was imported from the packages you installed.
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| New Active Channel

Channel Mame: unresolved malware

Start Time: ShNow - 30m 000 End Time: $Mow

N

@ Continuou: valuabe time paramet

Use as Timestamp: | End Time

O Ewaluate time parameters once ak attach time

Filter All Unresolved Malware Events

Fields:

Examples Ok Cancel

5. Click OK. All events that match the filter can be displayed in the newly created channel. Filters
from imported packages can be found under Filters > Shared > All Filters > ArcSight Activate >
Solutions.

2.12 Tripwire Enterprise

Notes:

This installation requires MSSQL to be installed on a remote server and configured according to the
instructions in the Tripwire Enterprise 8.6.2 Installation and Maintenance Guide.

2.12.1 Install Tripwire Enterprise

1. Ensure that you have an up-to-date version of Oracle Java. You must install both the Java
Runtime Environment (JRE) and the Java Cryptography Extension (JCE).
2. Download and run the JRE installer.
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Welcome to Java

Java provides access to a world of amazing content. From business solutions to helpful utilities and
entertainment, Java makes your Internet experience come to life.

MNote: No personal information is gathered as part of our install process. Click here for mare information on
what we do collect.

Click Install to accept the license agreement and install Java now.

[[] change destination folder | [ Install =

3. Click Install.
4. Download the JCE and extract the files.

-

Name Date modified Type Size

|_| local_policy 12/20/2013 1:54 PM  JAR File 3KB
| README 12/20/2013 1:54 PM  Text Document SKB
ij US_export_policy 12/20/2013 1:54 PM  JAR File KB

5. Copy the local_policy.jar and US_export_policy.jar files to /lib/security/Unlimited/ and
/lib/security/Limited in the Java installation directory.

6. Run install-server-windows-amd64.

7. Select the Java runtime that was just installed.

Please select the Javatm) Runtime to use

Oraclef5un 1.8.0 64-bit C:/Program Files/Java/jrel.8.0_181/binfjava.: v

Ok || Cancel

8. Click OK.
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!l!l"-ﬁ' Welcome to the Tripwire Enterprise Console installation wizard.
‘E TEEPRISE This wizard will install and cenfigure Tripwire Enterprise Console,

8 7 Before continuing, please review the installation documentation to
L] ensure that you are in compliance with all installation requirements.
Failure to meet all requirements may cause the installation to fail,

I < Back H Mext = || Cancel

9. Click Next.
10. Select I accept the agreement.

. a | TAKE
License Agreement CONTROL.

Please read the following License Agreement. You must accept the terms of this agreement
before continuing with the installation.

IMPORTANT INFORMATION A
TRIPWHIRE SOFTWARE IS LICENSED, NOT S0LD. USE OF THIS SOFIWARE IS I:l
SUBJECT T{ LICENSE RESTRICTIONS. CAREFULLY READ THIS LICENSE

LEREEMENT BEFCRE USINE THE SOFTWARE. USE OF SOFTWARE INDICATES

COMPLETE AND UNCONDITIONAL ACCEPTRNCE OF THE TERMS AND CONDITIONS

SET FORTH IN THIS AGREEMENT. ANY RDDITIONAL COE DIFFERENT PURCHASE
ORDER TEEMS AND CONDITIONMS SHALL NOT APPLY.

(®) ;| accept the agreement

Do you accept this license?
) ldo not accept the agreement

InztallBuilder

<Back || Ned> || Cancel
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11. Click Next.
N w | TAKE

Please specify the directory where all Tripwire Enterprise components will be installed.

Installation Directory IZ::"-._F'r-::-:||'ar'r'| Files' Tripwire' T | rﬂ

InstallBuilder

<Back || MNea> || Cancel

12. Click Next.
13. The installer should automatically detect the hostname of the system on which Tripwire
Enterprise is being installed. If it does not, enter the hostname here.
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Tripwire Enterprise Console Configuration Part 1 of 4 mﬂﬁmm_

Please provide the hostname of the system where Tripwire Enterprise Console will be
installed.

TE Server Hostname (|00 1SS

InstallBuilder

<Back || Net» || Cancel

14. Click Next.

15. Enter each port number to use for the HTTPS Web Services port, HTTP EMS Integration Port,

and Tripwire Enterprise RMI port. The RMI port is used for inbound communication from
Tripwire agents to the server, so ensure that it is allowed through the firewall.
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Tripwire Enterprise Console Configuration Part 2 of 4 mﬂgﬁmm

Specify the ports that Tripwire Enterprise Console uses to communicate,

This port is used for user-initiated Web console sessions.

HTTPS Web Services port |m |

This port is used for external integrations (such as plugins).

HTTP EMS Integration Port | 8080 |

This port is used for Conseole/Agent Java communications.

Tripwire Enterprise RMI Port |93‘EIE |

InstallBuilder

<Back || Net> || Cancel

16. Click Next.
17. Enter a passphrase to use.

Tripwire Enterprise Console Configuration Part 3 of 4 mﬂﬁmﬁmﬂ

The services passphrase is used to secure Tripwire Enterprise communications.

This password must be between 19 and 84 characters, and cannot contain single-quote (),
double-quote ("), less-than (<), greater-than (>), or backslash (\) characters, most other
characters are allowed. 5See the Installation and Maintenance Guide for more details.

Services Passphrase

Confirm Passphrase

InstallBuilder

<Back || Net> || Cancel
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18. Click Next.

1
Tripwire Enterprise Console Configuration Part 4 of 4 mﬂﬁ“ﬁ TROL.

Please review the installation settings for Tripwire Enterprise Conscle.

The following settings are configured for Tripwire Enterprise Conscole:

Installation Directory: CAProgram Files\ Tripwire\ TE
Avvailable Disk Space: 184716 MB

Heostname: TRIPWIRE-E

IP Address(Listening): 0.0.0.0

HTTPS Web Services Port: 443

HTTP EMS Integration Port: 8020

TE Services (RMI) Port: 9358

TEConsolelnstaller: Java Version detected: 1.8.0_181 64

InstallBuilder

<Back || Net» || Cancel

19. Click Next.
20. Check the box next to Install Real-time Monitoring.
21. Enter 1169 for Real-time Port.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

263



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

il 4 i o) TAKE
Tripwire Enterprise Agent Configuration m&mﬂl_

Tripwire Enterprise Agent software is installed on the Tripwire Enterprise Console system to
enable monitoering of that system. Do you want to install Real-time Moenitoring functionality
for this local Agent? The Real-time Monitoring feature can also be installed later.

[/] Install Real-time Monitoring
Please specify the local port to be used by the Real-time subsystem.

Real-time Port [N |

InstallBuilder

| <Back || Net> || Cancel |

22. Click Next.

ol TAKE
oy tripwire )

The installer is ready to begin installing Tripwire Enterprise Console.

Click Mext to begin installing Tripwire Enterprise.
Click Back to make any changes before you begin the installation.

InstallBuilder

<Back || Net> || Cancel

23. Click Next.
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24. Check the box next to Open a browser after clicking Finish to continue configuring Tripwire

Enterprise.

TRERIRE The installation is complete,

S ENTERPRISE

[v] Open a browser after clicking Finish to continue configuring
Tripwire Enterprise.
[ ]

To finish configuration later, use a browser to access

https://TRIPWIRE-E

25. Click Finish.
26. Once at the web address, enter the Services passphrase chosen earlier.

Tripwire Enterprise Post-Install Configuration

Tripwire Enterprise needs additional configuration.

To finish installing, please enter your Services Passphrase for authentication. The Services Passphrase was created when you installed Tripwire Enterprise.

Services Pass?hrase:

Login

27. Click Login.

Tripwire Enterprise Post-Install Configuration

Database Configuration Settings

These settings control how the TE Console connects to a remote database that stores data for all TE operations. You can check the current configuration here, and make
any necessary changes in the fislds below.

Remote Database Type:
Microsoft SQL Server v Remote Database Type: The type of remote database used by TE.
Microsoft SQL Server

—| Qracle
QOracle RAC
MySQL
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28. Select Microsoft SQL Server for Remote Database Type.

29. Select SQL Server for Authentication Type.

30. Enter login details for the account created during the MSSQL setup.

31. Enter the hostname or IP of the database server.

32. Enter the port on which the database is operating.

33. Enter the name of the database to be used for Tripwire Enterprise.

34. Select the appropriate setting for SSL according to your organization’s needs.

Authentication Type:

SQAL Server v Authentication Type: Specifies whether the database login should authenticate using a Windows account (typically of
the format domain‘user), or an SQL Server account (an account defined only in SQL Server). With the Windows
authentication type, NTLMv2 should be used, as itis cryptographically superior to the first version of NTLM. However, as
NTLMv2 is configured in the operating system. not in the database or application, TE can be used with NTLM to ensure

compatibility.
Login Name:
twadmin Login Name: The login name that TE will use to authenticate with the database
Password:
arrrernarareas Password: The password that TE will use to authenticate with the database
Database Host:
192.168.78.125 Database Host: The fully qualified domain name, hostname or IP address of the system where the database is installed

Port (default 1433):

1433 Port: The TCP port that the database is listening on. If an Instance Mame is specified here, then the database connection
will use UDP 1434 to connect to the SQAL Server Browser Service, and this Port field will be disabled. The SQL Server
Browser service listens for incoming connections to a named instance and provides the client the TCP port number that
comresponds to that named instance.

Database Name:
TE DB Database Name: The name of the database that TE should use when connecting to the remote database. Note that the
- login name in SQAL Server should have this database set as the default. and the login name should be mapped to this
database.

Instance Name (Optional):
Instance Name (Optional): The location/name of the database instance on the server. Ask your DBA if a non-default
instance should be used for TE

SSL
Off v SSL (Secure Sockets Layer): Specifies whether the database connection should requast. require or authenticate SSL

= Request - S5L will be used if available.

» Require - SSL will always be used, and an error will occur if SSL is not available for the database.

» Authenticate - SSL will always be used, and an error will occur if SSL is not available for the database. In addition,
the certificate chain of the database server's public key will be authenticated using TE's trust store. If the certificate
chain does not originate from a trusted source, an error will occur.

= Off - SSL will never be used. This setting is not recommended

Test Database Login |+

35. Click Test Database Login to ensure the connection is functional.

Test Database Login |+

Test Results:

Connaction Succeaded

8.7.0.b8.7.0.r20180606173604-£215728.b40 Save Configuration and Restart Console I Logout

36. Click Save Configuration and Restart Console.
37. After the reboot, enter a new administrator password.
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Tripwire Enterprise Post-Install Configuration

Configuration Steps Needed:

Tripwire administrator account password needs to be changed from the default.

Create Administrator Password

Passwords must
Be between 8 and 128 characters in length
Contain at least 1 numeric character
Contain at least 1 uppercase character
Contain at lzast 1 non-alphanumeric character
Supported characters: “~1@#3%~&()-_=+{}\:"<>J?

Support Information

Still having problems with your installation?

Contact Tripwire Support
https //secure tripwire_com/customers/contact-support cfm

Or open a Support ticket: https://secure tripwire.com/customers/

Password.

Confirm Password

Confirm and Continue l

For faster assistance from Support, please generate a support bundle to collect
information about your system and this installation. Attach the support bundle file to your
web ticket or email. What is a Support Bundle?

Generate Support Bundle l

Tripwire Enterprise 8 0.r20180606173604-2215728 b40

38. Click Confirm and Continue.

Tripwire Enterprise Fast Track

Welcome to Tripwire Enterprise Fast Track!

TRIPWIRE®

S ENTERPRISE

Fast Track

Fast Track will help you to configure Tripwire Enterprise for Change Auditing, Policy Management, or an integrated Security Configuration
Management (SCM) solution. It only takes a few minutes to complete the setup questionnaire. After you do, Fast Track will use your

answers to install the components that you need.

Step 1: Add your license file and describe your environment. This includes the platforms you want Tripwire Enterprise to monitor, the
policies you want to enforce, and the schedule that Tripwire Enterprise should use.

Step 2: Review the items that will be configured and save the manifest for your records.

Step 3: Apply the configuration and let Fast Track do the rest

Mote: After Fast Track configures Tripwire Enterprise, you can ahways make changes to your configuration later from the Tripwire

Enterprise user interface

39. Click Configure Tripwire Enterprise.
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Step 1: Add your Tripwire Enterprise license (*.cert)

Choose Fila | No file chosen

40. Click Choose File and select the Tripwire Enterprise license file, which should be a .cert file.
41. Check the boxes next to Change Auditing and Policy Management.

Step 2: Confisure Change Auditing and/or Policy Management

Monitoring Solutions 7] Change Auditing

¥ Policy Management
Available Policies Ccis

¥ PCI

U DiIsA

L NIST 800-53 (FISMA)

42. Select any available policies desired.

Step 3: Specify the platforms to monitor

Nate: You are licensed for the Highlighted platforms
Available Platforms: Selected Platforms.

Operating System % Microsoft Windows Server 2008 R2
= Microsoft Windows Server 2012 R2
¥/ Microsoft Windows Server 2008 R2 Oracle Solaris 10

=
&
Microsoft Windows Server 2012 R2 = Oracle Solaris 11
s
x
¥

Red Hat Enterprise Linux 6
Red Hat Enterprise Linux 7
VMware ESXi 5.5 Server

%l Oracle Solaris 10
¥l Oracle Solaris 11
#! Red Hat Enterprise Linux 6

¥ Red Hat Enterprise Linux 7
Virtual Infrastructure

¥ VMware ESXi 5.5 Server

43. Select all the operating systems that you wish to monitor with Tripwire Enterprise.

Step 4: Set up a schedule for running checks and reports

Change Audit Scheduling
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Checks

How frequently would you like to run checks on
your assets?

| Daily v

Runthe checksat | 100 v| [AM |

Policy Scheduling
Checks

How frequently would you like to run checks on
your assets?

i:"ﬂ_egkly | on ]:§undays v

Run the checks at

Reports

Heow frequently would you like to run reports on
your assets?

| Daily v

Run the reports at (400 v| AM v

Reports

How frequently would you like to run reports on
your assets?

[Weekly 7| on [Sundays v

Runthereportsat (400 7| [AM  v|

MNote: Tripwire does not recommend enabling checks
and reports until after you have installed Tripwire Agent
software on the systems that you want to monitor.

2l Enable Checks and Reports (Optional)
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44. Set up a schedule for running checks and reports according to your organization’s needs. Leave
the box next to Enable Checks and Reports unchecked for now.

Step 5: Configure an email server for sending reports and alerts
L Set up the email server now

'® Set up the email server at another time

Before Tripwire Enterprise can deliver alerts or reports, an
email server must be created. You can set up the server
now, or you can wait and do it later using the Tripwire
Enterprise Console.

45. Select Set up the email server at another time.

Step 6: Create an administrator account for Tripwire Enterprise Console access

Passwords must: User Name
Be between § and 128 characters in length T |'/
Contain at least 1 numeric character ‘
Contain at least 1 uppercase character Password:
Contain at least 1 non-alphanumeric character e e |¥

Supported characters: "~1@#8%"&"()_=+{I}\,."<>.1? L
Confirm Password

R—— v
Email Address

46. Enter a username and password for a new administrator account for Tripwire Enterprise

Console.

bleasm Cougdnispoy - DEUES]

47. Click Preview Configuration.

P UNLY IS TV IMIREGES L ot TV

These tasks will be applied to your configuration
Critical Change Audit Check - RHEL 6

Critical Change Audit Check - RHEL 7

Critical Change Audit Check - Solaris 10

Critical Change Audit Check - Solaris 11

Critical Change Audit Check - Windows

Policy Check - RHEL 6

Policy Check - RHEL 7

Policy Check - Solaris 10

Policy Check - Solaris 11

Policy Check - VMware ESX

Policy Check - Windows

Report Task - Daily File System Changes by Node
Report Task - Daily File System Changes by Rule

Report Task - Test Result Summary - Red Hat - PCIv3.1
Report Task - Test Result Summary - Solaris - PCl v3.1
Report Task - Test Result Summary - VMware ESX - PCIv3.1
Report Task - Test Result Summary - Windows - PCI v3.1
Report Task - Test Results by Node - Red Hat - PCI v3.1
Report Task - Test Results by Mode - Solaris - PCl v3.1
Report Task - Test Results by Node - VMware ESX - PClv3.1
Report Task - Test Results by Node - Windows - PCIv3.1
Report Task - Top 5 Nodes with Daily Changes

Report Task - Waivers - Red Hat - PCl v3.1

Report Task - Waivers - Solaris - PCl v3.1

Report Task - Waivers - VMware ESX - PCI v3.1

Report Task - Waivers - Windows - PCl v3.1

These home pages will be applied to your configuration
Change Audit

Customer Center Home Page

PCl Overview - Red Hat

PCI Overview - Solaris

PCI Overview - VMware ESX

PCI Overview - Windows

Tripwire Enterprise Administrator

48. Click Apply Configuration.
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Cor ing Tripwire Enterprise

Tripwire Enterprise Best Practice for the selected platforms _
PCI for Microsoft Windows Server 2008 R2 ZI Configuring 120 Rules
Change Audit for Microsoft Windows Server 2008 R2 I:I
PCI for Microsoft Windows Server 2012 R2 I:I
Change Audit for Microsoft Windows Server 2012 R2 I:I
PCI for Oracle Solaris 10 |:I
Change Audit for Oracle Solaris 10 |:I
PClI for Oracle Solaris 11 |:I
Change Audit for Oracle Solaris 11 |:|
PCI for Red Hat Enterprise Linux 6 |:|
Change Audit for Red Hat Enterprise Linux 6 |:|
PCI for Red Hat Enterprise Linux 7 I:I
Change Audit for Red Hat Enterprise Linux 7 I:I
PCI for VMware ESXi 5.5 Server I:I

Finalize Policy Management configuration for the selected platforms I:I
Finalize Change Auditing configuration for the selected platforms I:I

49. Click Continue to Tripwire Enterprise when the installation finishes.

2.12.2 Install the Axon Bridge

Ensure that TCP traffic on port 5670 is allowed through the firewall.
Navigate to the Tripwire Enterprise Console installation directory to the /server/data/config
folder. Copy bridge_sample.properties to bridge.properties.

3. Inthe bridge.properties file, find the line that says:
#tw.cap.bridge.registrationPreSharedKey=

“u_n

Remove the “#” character. After the character, enter a password. The password has some
restrictions, so ensure that it meets the requirements in case the connection fails later.
4. Restart the TE console by running the following command from an administrative command

prompt, where <te_root> is the TE installation directory:

> <te_root>/server/bin/twserver restart

2.12.3 Install the Axon Agent (Windows)

1. Download the Axon Agent zip file from the Tripwire customer website
(https://tripwireinc.force.com/customers), under the Product Downloads tab.

Unzip the file.
3. To begin the installation, double-click the .msi file in the extracted folder. Note: No installation
wizard will appear; the installation happens automatically.
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4. After the Axon Agent is installed, navigate to C:\ProgramData\Tripwire\agent\config, and copy
twagent _sample.conf to twagent.conf.

#

# HOST based agent configuration:

Instead of using a DNS SRV record, the agent may be configured

to talk to a specific heost, or list of hosts. Lists use a comma separator and
can optionally specify a port. The default of port 5670 will be used if a port
is not specified.

Example: hostl, host2:5980, 10.123.8.15, [feac:baB@:6fff:93fe]:7582

The agent may be cunFiguked to connect to hosts in a randomized or textual order
(default: true)

## # H H W W

bridge.host=192.168.1.136
#bridge.port=5678
#bridge.randomize.hosts=true
#

5. Open twagent.conf and find the line that says bridge . host. Remove the “#” character, and
enter the hostname or IP address of the Axon Bridge server.

6. Inafile called registration_pre_shared_key, enter the value of the preshared key that was set
in the Axon Bridge.

7. Restart the Axon Agent Service by opening a command prompt and running the following
commands:
> net stop TripwireAxonAgent
> net start TripwireAxonAgent

@ Administrator: Command Prompt — m] X

2.12.4 Install the Axon Agent (Linux)

1. Download the Axon Agent .tgz file from the Tripwire customer website
(https://tripwireinc.force.com/customers), under the Product Downloads tab.

2. Toinstall the software, run the following commands:
RHEL or CentOS: > rpm -ivh <installer_file>
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Debian or Ubuntu: > dpkg -1 <installer_file>

3. Navigate to /etc/tripwire/ and copy twagent_sample.conf to twagent.conf.
Open twagent.conf and find the line that says bridge . host. Remove the “#” character and
enter the hostname or IP address of the Axon Bridge server.

5. In afile called registration_pre_shared_key.txt, enter the value of the preshared key that was
set in the Axon Bridge.

6. Restart the Axon Agent Service by opening a command prompt and running the following
commands:
RHEL or CentOS:
> /sbin/service tripwire-axon-agent stop
> /sbin/service tripwire-axon-agent start

Debian or Ubuntu:
> /usr/sbin/service tripwire-axon-agent stop
> /usr/sbin/service tripwire-axon-agent start

2.12.5 Configure Tripwire Enterprise

2.12.5.1 Terminology

Node: a monitored system, such as a file system, directory, network device, database, or virtual
infrastructure component

Element: a monitored object, which is a component or property of a node being audited by TE

Element Version: a record of an element’s state at specific points in time. Multiple element versions

create a historical archive of changes made to the element.
Rule: A rule identifies one or more elements to the TE Console.

Action: an object that initiates a response to either changes detected by TE or by failures generated

from policy tests
Task: a TE operation that runs on a scheduled or manual basis
TE Policy: a measurement of the degree to which elements comply with a policy

Policy Test: a determination of whether elements comply with the requirements of a policy
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Baseline: the act of creating an element that reflects the current state of a monitored object (also called
the current baseline). When a node’s baseline is promoted, TE saves the former baseline as a historic
baseline.

Version Check: a check on monitored objects/elements. It is a comparison of the current state of the
element against its already recorded baseline for changes.

2.12.5.2 Tags

In Tripwire Enterprise, tags can be used to label and target specific nodes. Tags are not required but
allow for targeting nodes more granularly than by the operating system. This section describes how to
create and assign tags.

Navigate to the TE Console in your browser.
Click Asset View.

® Tripwire Web Console X | @ Firefox Survey x [+ \l‘iq

< c @ T 8 htips/tripwire-e/console/apy App.cmd @ m o =
S ENTERPRISE 1’r\-4,‘,t: ACTIONS | TASKS | POLICIES | LOG | REPORTS | SETTINGS
Nodas. Noda Search Elamant Search Version Search & Refrazh [ pele B Logout
LN anage Tagging All | N 309 ABC & S C
f 192.168.78.126
[ Filter assets by keywore [}
: O 62 168,78 126 -
3 3l | & !
ad.dns.di.ipdr
O o2 160,112 -
EXCHANGE
O 62 1681134 -
¥ System Tag Sets HYPERV.DLIPDR
O £

Database Server 192.168.78.105

3. Click the Manage Tagging tab.
4. Enter the name of a tag set, or use one of the four existing ones (Location, Owner, Platform
Family, Primary Function). Click Add if adding your own tag set.

e

@ENTERPRISE HOME | NODES | RULES ACTIONS | TASKS | POLICI

Nodes. Asset View Hode Search Element Search Verson Sesrch ¥ Rafrazh @ Halp 0 Logout
Create and Edit Tag Sets

Tag Sets
[rutorial Add

Tagging Frofiles N ’

= Location Add tags Tags and Tag Sets are limited to 50 characters in length and may

= not contain the follo

Saved Filters pads newts :

x w Owne 1 tog

DI Testing

5. Under the tag set to which you wish to add a tag, enter the name of the tag.
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Create and Edit Tag Sets

i~ B

|

s -1
* Location (Add tags)
1
|AEI|:I a new tag | _ﬂ»dd] r
1
® w Owner {1 tag) E
¥
L\dd a new tag | Add | :
» DI Testing F
F
s w Platform Family (4 tags) :
L‘-\dd a new tag | Add] 1
* Red Hat = 0
= Solaris
= VMware ESX I
# Windows ®
1
»* w Primary Function (1 tag)
[
Lkdd & new tag | ~-jd] il
x% Domain Controller
% Tutorial {Add tags)
"I’utorial tag | Add]
b
6. Click Add.
7. Navigate to Nodes > Asset View > Filter Assets.
8. Check the boxes next to the nodes to which you wish to add this tag.
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e
@ENTERPRISE HOME | NODES | RULES | ACTIONS | TASKS | POLICIES | LOG | REPORTS | SETTINGS

Asset View
ghionope Taagion ) W) sor3 ABC W || Selscted: 3 | Cloar
b 192.168.78.126
- ol R m ||| it Tags ] Heaith Check ¥
T nealiod ¥ WINDOWS10-1.DLIPDR
o % WINDOWS10-2 DiFF
192.168.1.12 = b5, PO
% WINDOWS10-3.D1.IPDR
EXCHANGE
192.168.1.134 =
ag. || o Hreerv.oLPOR
Database Server 192.168.78.105 =5
Directory Server
Neiwion mssaL
» o 192.166.1.141 =8
Operating System
7 Scaliad TRIPWIRE £.DLIPDR
Virtual Infrastructure 1921684436 -
@ INDOWS104.DLIPDR
» Location 192.168.1.138 =5 ‘
P Owner
» Platform Family |2 V/INDOWS10.2.01IPDR =
¥ Primary Function 192.168.78.118
E: Tusocial @ VINDOWS103.D1IPDR
192.168.78.119 -
Windows 2008 R2 Domain Controllers
Windows 2012 R2 Domain Controllers
» Health
Activate Windows
fiodie Mansger G A0 ADSEE COH0H LG P a0 {00 Lt bl R0 L AN S

9. Click Edit Tags.
10. Check the boxes next to any tags you wish to add to these nodes.

@PENTERPRISE HoMe | NODES | RULES | ACTIONS | TASKS | POLICIES | LOG | REPORTS | SETTINGS

Edit Tags

. 4 Di Testing

[ Red at
[ Solaris

Node Manager Last Axon Agent config: 16 hours ago (Oct 12, 2018 12:00:17 AM) | User: admin

11. Click Close.

2.12.5.3 Rules

This section describes how to create a rule.

1. Click Rules.
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.\'Em’mﬁ HOME '-C.I:{'J.'.'.":‘!\_:

Fules By Swarch 0 ket [t [ Lagaur

2. Select or create a rule group into which the new rule should be put.

e
@PENTERPRISE HOME | NODES | RULES | ACTIONS | TASKS | POLICIES | LOG | REPORTS | SETTINGS

Rales e s 4 Refrash @ Help @ Logout
2% New smup|2 New uusek;j tmport | 1
@ Trowre ates () Tutoriat

5 (5 Root Rule Group
o [ Unux 05 Rue Group | L1 & Name 5

[~ | Solaris OS Ruie Group
mﬂ T Vware VAGaTRirasty

2 (] Windows OS Rule Grous
g [ Crticai Change Audt
& () Policy Rules.
" Testing
(g Uninked

3. Click New Rule.

4. Select the type of rule. For monitoring Windows file systems, we choose Windows File System

Rule.

e Create Rule - Mozilla Firefox ~ |.= | © [0S

GJ # https://tripwire-e/console/app.showEdit = @ ¥ =
Create Rule B Healp

Select the rule type to create:
= 9 Types
= {_3 Database Server
@[] Directory Server
) |_] File Server
% Command Output Capture Rule
E£7i5/0S File System Rule
% i5/05 System Value Rule
Log Transfer Rule
% UNLX File System Rule
Eﬁ’ﬁwmduws Renistry Rule
{i& Windows RSoP Rule
[ [_] Metwork Device
(& [_] Tripwire Data Collector
= !_J Virtual Infrastructure

Selected type: [Eg Windows File System Rule

5. Click OK.
6. Enter a name and description for the rule.
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| GJ. ﬁ; https://tripwire-e/console/app.showWizard.cnd?wizardMName = siweb.specifierRul

New Windows File System Rule Wizard

Enter a name and description for the rule.

Name: ftutorial rule

Description: (3 rule specifically for tutorial documentation

[¥] Enable Tracking Identifier

< Back Next > Finish Cancel

7. Click Next.

| @ £ hitps://tripwire-e/conscle/app.showWizard.cmd?wizardName=siweb.specifierRule *2= ﬁ|

@Iew Start Point |mlew Stop Point | | ;Emwse | X Delete

M — | Type Defauli Severity Criteria Set Recurse Level Archive Content

8. Click New Start Point.

9. For Path, enter a directory that represents the scope of the scan. It can be limited to the
documents folder or be wide enough to encompass all the files on a system. Note that the latter
will take much longer to scan.

10. Check the box next to Recurse directory if you also wish to scan all subfolders.
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@8 https://tripwire-e/console/app.showWizard.cmd?wizardName=si.web.startPoint\\/

Specify the monitored object for the start point, and enter associated settings.

Path:  [C:\Uszers\DI2\Desktop\Tutorial docs @v,

Default Severity: (0-10,000, 0 = no severity assigned)

[] Archive element content
[ Recurse directory

Limit depthto 0 | (0-100, 0 = no limit)

< Back | MNext> | Finish | Cancel |

Activy

11. Click Next.
12. Select Windows Content and Permissions.

| G.? E; hitps://tripwire-e/conscle/app.showWizard.cmd?wizardMName=siweb.startPoint/V; *e* ﬁ' ‘

® Windows - Content and Permissions
O Windows - Content Only

C Windows - Permissions Only

13. Click Finish.

14. Click New Stop Point.

15. Enter the path of any folders or files that should not be included in the scan, and indicate
whether they should end the recursion.
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New Stop Point Wizard @ Help

Specify the monitored object for the stop peint, and enter associated
settings.

Path: [C:\Users\DI2\Desktop\Tutorial docs\Tutorial3 | E‘?‘?

@ Stop recursion

< Back Mext = Finish Cancel

16. Click Finish.
17. Click Next.
18. Click Next.
19. Click Finish.

2.12.5.4 Tasks

This section describes how to create a task on a schedule. These tasks can also be run manually if
necessary.

1. Click Tasks.
.m HOME NOI:ESIQULES ;al:us‘@mu\:(ss LOG | REPORTS | SETTINGS

2. Select a folder for a new task, or create one.
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Tasks

B, |Manage 4|%; New Group B New Task |[d tmport | [l export | Buplicate | % Delete [ Link | 5% rlink |- Move | control 4|6y pun | Bl Bsseline | G stop | Gy Disable | Gy snable |
o & Triowire ke
=l F!Du(TaskGruup . ——
[ Check Tasks £ Name [

= (2 Report Tasks.
cnange Audit Report
(5 Security Configuratio

(529 Testing Tasks.
Tog Uninked

3. Click New Task.
4. Select Baseline Rule Task or Check Rule Task. (Note: Both are needed—baseline creates the
initial state of the monitored object, and check updates the state and reports any changes.)

| (i) #h https://tripwire-e/conscl=  =*s I =

gt

Select the type of task to create:
(®F Baseline Rule Task
()& Check Rule Task

&g Report Task

5. Click OK.
6. Enter a name and description for the task.
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| 6] o https://tripwire-e/console/app.showWizard.cmd?wizardName=wizard.newBaselin = ﬁ'! =

 New Baseline Rule Task Wizard @ Help
Enter the task name and description.

Name: utorial Task

Description: [Task for tutorial documentation

Run as user:
" [v] Use timeout:

o ] hour(s) minute(s)

= Back | MNext> Finish Cancel

7. Click Next.
8. Select whether you want all baselines to be updated or to only create new baselines.

| G).ﬁ\ https://tripwire-e/console/app.showWizard.cmd?wizardName=wizard.newBaseline = *** ﬁ'| =

Select the scope of the baseline operation.
(@ New baselines only
(Al baselines

< Back | Next> | rinish Cancel

9. Click Next.
10. Select the systems to be included in the task. You can use tags or select by operating system (or
other defaults).
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| G)'ﬂ) https://tripwire-e/console/app.showWizard emd?wizardName=wizard.newBaselin:  =»* ﬁ| é)

B. w RUUL INUUE wloup
g O Smart Node Groups

& Q Operational Tag Sets

e Q Saved Fiters

e Q System Tag Sets

=) Q Tag Sets
=) Q Owmer

) Q Dl Testing

@ @ Platform Family
& @ Primary Function
3 ©) Tutorial

o) rutoris 1ag

E'WII\[IOW51 0-1.0LIPDR
= E-WN)OWS1 0-2.DLIPDR
WINDOWS10-3.DLIPDR

L

Selection: () Tutorial tag

Next > Finish Cancel

11. Click Next.
12. Select the rule created earlier.

| G). 28 https://tripwire-e/console/app.showWizard.cmd?wizardMName=wizard.newBaselin Enn 1:]' ! é)

' New Baseline Rule Task Wizard @ Help

Perform baseline on
O selected nodes with currently associated rules
® selected nodes with rule or rule group:

= Root Rule Group
o D Linux 0S5 Rule Group

e DSolaris 05 Rule Group
= [ Tutorial

B Tutorial rule

| DVMware Wirtual Infrastructure Rule Group
= DWinﬂnws 05 Rule Group
] DCriticaI Change Audit Rules

Rule: % Tutorial rule

13. Click Next.
14. Set the schedule of this task according to your organization’s needs.
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e New Baseline Rule Task Wizard - Mozilla Firefox I;Ii-

[l ! https://tripwire-e/console/app.showWizard.cnd?wizardName=wizard.newBasel - @ ﬁ =
New Baseline Rule Task Wizard G Help
Specify when you want this task to run.
Interval: [Manuall

| Hourly
The task w Daily N

Weekly
Monthhy
Monthly by Day
Once

Interval
Periodic

Manually

< Back Finish Cancel

15. Click Finish.
2.13 Tripwire Log Center

2.13.1 Install Tripwire Log Center Manager

See the Tripwire Log Center 7.3.1 Installation Guide, which should accompany the installation media, for
instructions on how to install Tripwire Log Center. Use the Tripwire Log Center Manager installer.

Notes:

a. Itis recommended that you install Tripwire Log Center on a separate system from Tripwire
Enterprise.

b. You will need to install JRE8 and the Crypto library. Instructions are also in the Tripwire Log
Center 7.3.1 Installation Guide.

c. .NET Framework 3.5 is required for this installation—install this from the Server Manager.
You may need to unblock port 9898 on your firewall for the Tripwire Enterprise agents.

e. Do notinstall PostgreSQL if you wish to use a database on another system—this guide will use a
local PostgreSQL database, however.

f.  When it finishes installing, there should be a configuration wizard (see below for configuration
steps).

2.13.2 Configure Tripwire Log Center Manager

1. The configuration wizard should start after the installation is complete.
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Welcome to the
Tripwire Log Center Manager
Configuration Wizard

To begin the configuration process, click Start.
For further guidance, see the Tripwire Log Center
Installation Guide.

?

2. Click Start.

Configuration Type

Configure Tripwire Log Center Manager as
your Primary Manager

k

Configure Tripwire Log Center Manager as a
Secondary Manager

U Tripwi Center M
U fe Existing pgrade Tripwire Log lanager
Installation

3. Click New Install.
4. Enter the registration details for your Tripwire Log Center license.
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Register Tripwire Log Center

To continue you must register your copy of Tripwire Log Center.

Get Help

5. Click Register.
6. Enter details about the database that Tripwire Log Center should use.

Default Event Database

An optional component of your Tripwire Log Center envil an Event-M t
Database stores Events. Following installation, you may add other databases to manage your
Tripwire Log Center data.

Connectivity Security

Database software | MS SQL Encrypt data with SSL O
Host IP address 152.168.1.141
Hest port

{Uze Windows authentication  [v]

This option uses the Windows credentials
assigned to the Tripwire Log Center Manager
Service to connect to an MS SQL instance.

.

Password

7. Click Next.

8. Select a directory in which to store log messages, such as C:\Program Files\Tripwire\Tripwire

Log Center Manager\Logs\AUDIT.
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Audit Logger Settings

The Audit Logger is the log-management tool in Tripwire Log Center. Collected log messages

are stored in the Audit Logger File Store.

Root directory for the Audit Logger File Store

| C:\Program Files\Tripwire\ Tripwire Log Center M |E||

[€ Bock | New 3] [® et |

9. Click Next.
10. Enter a password and an email.

11. Change the IP to a hostname if preferred.

Primary Manager Settings

Enter a name of your choosing for the Primary Manager, as well as the Manager's |P address.
Additionally, enter and confirm a password for the default Administrator user account. You will

need this password to log in to Tripwire Log Center.

~ Primary Manager

Manager name | Primary Manager

Manager IP/hostname |

arcsight-cons.di.ipdr

¥ Enable ALrtD—DiSDDveryo

~ Administrator Settings

Administrator password |

Administrator password (cenfirm) |

Email address | administrator@di ipdi

[€ Bock | Net 3] [® et |

12. Click Next.
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Manager Service Credentials

Specify the user account with which Tripwire Log Center will authenticate with other hosts.

Authenticate with:

' The local Windows System user account

" Domain user account

Username:

Password:

Password (confirm): |

E Apply Settings

| € Back [[liad $ [[B Eit |

13. Click Next.

14. Select any log sources that you expect to collect with Tripwire Log Center. Examples: Tripwire

Enterprise, Microsoft Windows 10, Tripwire IP360 VnE, Linux Debian, Ubuntu Linux, Microsoft

Exchange, Microsoft SQL Server.

Log Source Types

Select the types of Log Sources from which Tripwire Log Center will collect log messages.
Following installation, you may add other types of Log Sources to your Tripwire Log Center

environment.

["] Sophos Enterprise Console
[ Sophos SG Series UTM
[] Sourcefire
] Sourcefire Clam Antivirus
[ Sourcefire Snort
(] Squid Cache
[ SSH Tectia Server
[] Symantec
[] Symantec AntiVirus
[ Symantec EPC
[[] Symantec EPM
[] TACACS+
[] Tefine Configurator
[] Tofine Xenon S4
<

[] TopLayer [] Verifone Co
[] Transition Networks Indura [] Verifone Say
[] Trend Micro [] Veritas Bacl
[] Trend Micro OSSEC [ Veritas Sys
[] Trend Micro Third Brigade [ WMware ES]
[] Trend Micro TippingPoint ] VMware ES]
[] Tripp Lits BOSE Series [] WMware Paq
[ Tripwire CCM [ WMware vCq
[##] Tripwire Enterprise [ wsFTPD
[] Tripwire for Servers [] watchGuar
[] Tripwire IP360 VnE [[] vave Data
[ Trustwave Secure \Web Gateway [ \Websense 1
[w] Ubuntu Linu [ WELF

[[] Vasco IDENTIKEY Server [ westell

e

[€ Bock | New 3| |B et |

15. Click Next.
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Perform Configuration

[€ Bk [B o | B et |

16. Click Start.

Configuration Compleie

Importing Tags...
Tags Import... Completed

Rules : Adding

Importing Rule : Linze Debian

Importing Rule : Microsoft Exchange Server

Importing Rule : Microsoft SQL Server

Importing Rule : Microsoft Windows 10

Importing Rule : Tripwire Enterprise

Importing Rule : Tripwire |P360 VnE

Importing Rule - Ubunitu Lirnwoe

Comelation Lists : Adding

Tasks : Adding
Importing Tasks for Event Databases tasks to database...
Tasks for Event Databases Import... Completed
Importing Audit Logger Queries and Reports tasks to |
Audit Logger Queries and Reports Import... Completed

Alerts : Adding

Comelation Rules  : Adding

Adding Comelation Rules.

Configuration Files: Generating

Validating Monitored Assets

Corfiguration Wizard Complete

17. Click Next.
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> Configuration Wizard - Tripwire Log Center -

Assign Normalization Rules to Monitored Assets

ITo classify log messages with TLC Classfication Tags., at least one Normalization Rule should be
assigned to each of your Monitored Assets. f a Monitored Asset lacks Mommalization Rules, then the
Asset Group containing the Monitored Asset should have at least one Nomalization Rule.

To assign Momalization Rules to a Monitored Asset or Asset Group, open the Rules tab in the
object's properties dialog in the Configuration Manager of your TLC Console. For further details, see
the Tripwire Log Center User Guide or Online Help.

Start Tripwire Log Center Manager on Finish

18. Click Finish.

2.13.3 Install Tripwire Log Center Console

Chapter 4 of the Tripwire Log Center 7.3.1 Installation Guide details installation of the Tripwire Log
Center Console. Use the Tripwire Log Center Console installer.

You can install this on the same machine as the Tripwire Log Center Manager, if desired.

2.14 Cisco Web Security Appliance

This section details installation and some configurations for the Cisco Web Security Appliance (WSA). It

assumes the use of the WSA virtual machine.

2.14.1 Network Configuration

Log in to WSA by using the default username and password (admin/ironport).
Use the command sethostname to set the hostname of the machine.

3. Use the command dnsconfig to set the DNS server. Enter SETUP when prompted, and then
enter DNS information specific to your organization’s needs.

4. Use the command interfaceconfig to set the IP of the machine. Enter EDIT when
prompted, and then enter IP information specific to your organization’s needs.

5. Use the command passwd to change the default password of the machine.
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2.14.2

o vk wnNPR

Use the command commit to commit all of these changes.
Use the command reboot to reboot the machine.

Use the command loadl icense to either paste the license file contents or select a license

file uploaded via FTP. You can enable FTP in the interfaceconfig command.
You should be prompted at the console to visit a web page in the browser, usually
http://<ip_address>:8080. The setup wizard will be here.

System Setup

In the web console, click System Administration > System Setup Wizard.
Verify that the hostname matches the desired hostname.

Enter the desired DNS servers.

Enter a time server if desired.

Select the time zone.

Select Standard for an on-premises setup.

<<<<< x

&« > C @ Not secure | coeus.diipdr:8080/system_administration/system_setup/wsassw_network_basic

aliali Cisco SO00V M e

CISCO Web Security Virtual Appliance

1. Start 2. Network 3. Security 4, Review

System Secttings

Default System Hostname: (7) [eoeus.di.ipdr

£.9. proxy.company.com

DNS Server(s): | () Use the Internet's Root DNS Servers

®  Use these DNS Servers:

[t92.168.1.12
I (optional)
[ (optional)
NTP Server: | fiime.dmz.ncooe nist.oov
Time Zone: | pegion:
Country: United States v
Time Zone / GMT Offset: | Fastern Time (New_York) v]

Appliance Mode of Operation | @  standard
This appliance will be used for on-premise policy enforcement (Standard Web Security Appliance installation).

) Cloud Web Security Connector
This appliance will be used primarily to direct traffic to Cisco Cloud Web Security for cloud policy enforcement and threat
defense (Cloud Web Security Connector installation).

= Prev | Cancel k MNext =
| < prev | Cancel |

Copyright @ 2003-2017 Cisco Systems, Inc. Al rights reserved. | Privacy Statement -

Click Next.
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asls Cisco Web Security Virtual Applic X

« - C @® Not secure | coeus.diipdr:8080/system_administration/system_setup/wsassw_network_context

coeus.di.ipdr

alialn Cisco SO00V

CISCO Web Security Virtual Appliance

1, Start 2. Network 3. Security 4, Review

Network Context

["] 1s there another web proxy in your network?
After completing the System Setup Wizard, you will have the option to define additional upstresm proxies.
Proxy Group Name:

Address: |
e.g. 10.1.1.1, 2001:420:80:1::5, example.com

Port: [3128

If another web proxy is present, the Cisco Web Security Appliance is recommended to be placed downstream of the existing proxy {closer to the dlient), as illustrated

below:
CLIENTS [RONPORT S-sERIES ,lu"’“‘ﬂ.'jgfy FIREWALL  INTERNET

= Prev | Cancel Next »
| =< prev | Cancel |

Copyright @ 2003-2017 Cisco Systems, Inc. Al rights reserved. | Privacy Statement

Click Next.
Verify that the interface is correctly configured.
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' 4l Cisco Web Security Virtual Applic X

& > C (@ Notsecure | coeus.diipdr8080/system_administration/system_setup/wsassw_network_proxy ¥

1. Start 2. Network 3. Security 4. Review
M1 T1\ '{2

a s E ]

P1

Note:

1M1: This interface is used to manage the appliance. Optionally, it may also handle web traffic.

P1: This interface may be used to handle web traffic.

Ethernet Port: | 11

" Pl
) Use M1 port for management only (Optional if M1 used for data)

IPv4 Address / Netmask: |—192.168.1.59/24 l—

If muitiple interfaces are configured, they must be assigned IP addresses on different subnets.

IPv6 Address / Netmask: I I

lizzaanmz coeus.diipdr

(e.g. wsa.example.com) (e.g. data.exampie.com)

10. Click Next.
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4l Cisco Web Security Virtual Applic X

&« - C @ Not secure | coeus.diipdr:8080/system_administration/system_setup/wsassw_network_l4tm

aliali Cisco SO00V Lo

Neb Security Virtual Appliance

1. Start 2. Network 3. Security 4. Review

Layer 4 Traffic Monitor Wiring

Note:
T1, T2 : These interfaces are used for the L4 Traffic Monitor.
In addition, web proxy interfaces (M1, P1 or P2) may be used for L4TM blocking.

Wiring Type:

@ Duplex TAP:
T1 (In/Out)
) Simplex TAP:
T1 {In) and T2 (Out)
R

Copyright © 2003-2017 Cisco Systems, Inc. All rights reserved. | Privacy Statement

11. Click Next.
12. Enter the default gateway and any additional gateways to use for routing.
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s Cisco Web Security Virtual Appli- X

<« - C @ Not secure \ coeus.diipdr:8080/system_administration/system_setup/wsassw_network_routes

alialn CiECO S000V coeus.di.ipdr

y Virtual Appliance

1. Start 2. Network 3. Security 4, Review

IPv4 Routes for Management and Data Traffic (Interface M1: 192.168.1.59)

Default Gateway:  [182.168.1.1
This will be the default route for external traffic as well as internal traffic with no static route below.

Static Routes Table

Optionally, add static routes for Management access to the Cisca Web Security Appliance as well as Data traffic. Depending on the appliance functions you
enable, these routes will be used for monitoring by the Secure Web Proxy and optional blocking by the L4 Traffic Monitor.

Name Internal Network Internal Gateway
I I " @
Identifying name for route IPv4 Address (such as 10.1.1.10) or CIDR IPv4 Address

(such as 10.1.1.0/24)

—

Copyright @ 2003-2017 Cisca Systems, Inc. Al rights reserved. | Privacy Statement

13. Click Next.
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x

<« (] @ Not secure \ coeus.diipdr:8080/system_administration/system_setup/wsassw_network_switch

coeus.di.ipdr

stlialne Cisco SO000V

CISCO Web Security Virtual Appliance

1. Start 2. Network 3. Security 4, Review

Transparent Connection Settings

For the Cisco Web Security Appliance to accept transparent connections, it must be connected via a Layer 4 switch or WCCP router.

Transparent Redirection Devicei | @  Layer 4 Switch or No Device
If no transparent redirection device is connected, only explicit forward reguests can be proxied.

) WCCP v2 Router

Enable standard service ID: 0 web_cache (port 80)

Router Addresses: I

Separate multiple addresses with commas or whitespace.

Enable router security for this service

Passphrase: [ s

Confirm Passphrase:

Must be 7 or less characters.

Additional WCCP services and advanced options can be configured after completing the System
Setup Wizard.

« Prev || Cancel Next »
| < Prev ] Cancel |

Copyright @ 2003-2017 Cisco Systems, Inc. All rights reserved, | Privacy Statement

14. Click Next.

15. Set a passphrase for the administrator.

16. Enter an email address to which alerts should be sent.

17. Enter the hostname of the email server.

18. Decide whether to forward alerts and reports to Cisco Customer Support, as well as whether to
share anonymous statistics based on the needs of your organization.
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19.
20.
21.
22.
23.

i Cisco Web Security Virtual Appli- X

e

c (D Not secure \ coeus.di.ipdr:8080/system_administration/system_setup/wsassw_network_admin

aliali Cisco SO00V e

CISCO Web Security Virtual Appliance

1. Start 2. Network 3. Security 4. Review

Administrative Settings

Administrator Passphrase: Generate a passphrase:

| Generate

®  Enter a passphrase of your cheice

Passphrase:

Retype Passphrase:

Email system alerts to: |admm|stratur@d|.|pdr
e.g. admin@company.com

Send Email via SMTP Relay Host (optional): (7]

|exchange.di.ipdr Port: (7) |
i.e., smtp.example.com, 10.0.0.3 optional %
AutoSupport: | [ Send system alerts and weekly status reports to Cisco Customer Support
SensorBase Network Participation
Network Participation: | ] allow Cisco to gather anonymous statistics on HTTP requests and report them to Cisco in order to

identify and stop web-based threats.

Participation Level: Limited - Summary URL information.

* standard - Full URL information. {Recommended)
Learn what information is shared...

Concel

Click Next.

Select Monitor All Traffic.

Select Block for Action for Suspect Malware Addresses.

Select Block for Action for Detected Malware.

Configure the rest of the malware policy according to your organization’s needs.
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s Cisco Web Security Virtual Appli- X

<« - C @ Not secure \ coeus.diipdr:8080/system_administration/system_setup/wsassw_security

alialn CiECO S000V coeus.di.ipdr

y Virtual Appliance

1., Start 2. Network 3. Security 4, Review

Security Settings

Global Policy Default Action: (Z)

®  Monitor all traffic

) Block all traffic

If block all traffic is selected, the Global Access Policy will be initially configured to block all proxied
protocols (HTTF, HTTPS, FTP over HTTF, and native FTF).

L4 Traffic Monitor: | action for Suspect Malware Addresses () Monitor only

® Block

Acceptable Use Controls: (7 @ Enable
The Global Access Policy will be initislly configured to monitor all pre-defined categories.

Reputation Filtering: | #  Enable

The Global Access Palicy will be initially configured to use Web Reputstion Filtering and Adaptive
Scanning.

Malware and Spyware Scanning: | 4 Enable Webroot [# Enable Sophos

The Global Access Policy and Outbound Malware Scanning Policy will be initially configured to apply the
actions configured below.

Action for Detected Malware: () Menitor only
® Block

Cisco Data Security Filtering: # Enable

The Global Cisco Data Security Policy will be initially configured to block uploads based on Web
Reputation (if enabled) and monitor all other uploads.

Iy

Prev

Copyright @ 2003-2017 Cisco Systems, Inc. Al rights reserved. | Privacy Statement

24. Click Next.
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' il Caco Wel Security Virtual App - _

<« C  ® Notsecure | coeus.diipdr:8080/system_administration/system_setup/wsassw_review ¥ e (4]

Management (M1)

IPvd4 Address: | 192.168.1.59/24

Hostname: | coeus.di.ipdr

Use M1 port for management only: | No

L4 Traffic Monitor:

wiring Type: | Duplex TAP: T1 (In/Out)

Default IPv4 Gateway: | 192.168.1.1

Static IPv4 Routes: | No static routes have been defined.

Transparent Connection Settings

Transparent Redirection Device Type: | Layer 4 Switch or No Device

Administrative Settings Edit

Administrator Passphrase: | (hidden)

Email System Alerts To: | administrator@di.ipdr
Internal SMTP Relay Hosts: | exchange.di.ipdr:25
AutoSupport: | No

SensorBase Metwork Participation:  No

Security Settings Edit
Global Policy Default Action: | Monitor
L4 Traffic Monitor: | Monitor and Block k
Acceptable Use Controls: | Enabled
Reputation Filtering: | Enabled
Cisco DVS Engine: | Webroot: Enabled
McAfee: Disabled
Sophos: Enabled
Cisco Data Security Filtering: | Disabled

25. Click Install This Configuration.

2.14.3 Using WSA to Proxy Traffic

Cisco WSA is intended to act as a proxy between clients and the internet, to prevent malicious traffic
and software from reaching the client systems before they can do any damage. The appliance must
have a way of intercepting traffic from the clients to the internet.

To achieve this, we used a Proxy Auto Config (PAC) file on our DNS server (Windows 2012 DNS), and this
section details how to set up a simple PAC file to forward all traffic to WSA. This may not be an ideal
setup for every environment, particularly in environments that use an external DNS server.
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2.14.3.1 Creating a PAC File

1. Create a new file named wpad.dat and enter the following JavaScript function:

function FindProxyForURL(url, host) {

return “PROXY coeus.di.ipdr:31287;

This is the most basic template for a proxy that directs all traffic to the host coeus.di.ipdr. The
return value of this function can take the form “PROXY <hostnamel>; PROXY
<hostname2>" if you wish to have fail-over proxies, or “DIRECT”” to not use any proxy. You can
also add rules to allow certain types of traffic through the proxy or direct them to other proxies. For
more information, see https://findproxyforurl.com.

For the purposes of our setup, we will simply direct all traffic to Cisco WSA, but be aware that PAC
files can be more complex and designed according to the needs of the organization.

2. Inthe web console, navigate to Security Services > Web Proxy.

&« & (@ Notsecure | coeus.diipdr:8080/security_services/web_proxy/proxy_manage T 6

frale Cisco SO00V @ Logged in as: admin on coeus.di.ipdr

CISCO Web Security Virtual Appliance My Favorites - Options - Support and Help -

A Reporting Web Security Manager Security Services Hetwork System Administration

No Changes Pending
Proxy Settings
‘Web Proxy Settings
Basic Settings
Proxy:  Enabled
HTTP Ports to Proxy: | 80, 3128

Caching: | Enabled Ao

Proxy Mode: | Transparent
IP Spoofing: | Mot Enabled

Advanced Settings

Persistent Connection Timeout: | Client Side: 300 Seconds
Server Side: 300 Seconds

In-Use Connection Timeout: | Client Side: 300 Seconds
Server Side: 300 Seconds

Simultaneous Persistent Connections: | Server Maximum Number: 2000

Generate Headers: | X-Forwarded-For: Do Not Send
Request Side VIA: Send
Response Side VIA: Send T

Use Received Headers: | Identification of Client [P Addresses using ¥-Forwarded-For: Disabled

Range Request Forwarding: | Disabled

Edit Settings...

jela |
el

Copyright @ 2003-2017 Cisco Systems, Inc. All rights reserved. | Privacy Statement o
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3.

Click Edit Settings.

4. Remove port 80 from HTTP Ports to Proxy (ensure that 3128 is in this field).

5.
6.
7.
8.
9.

12. Enter 80 for PAC Server Ports.

' i Ciseo Wb Securty Virtual dpe - X _

<« c A Not secure | coeus.diipdr:8080/security_services/web_proxy/proxy_manage ¥

LUll WTU FIUAY JTUyg>

Web Proxy Scttings

Basic Settings

HTTP Ports to Proxy: | 5128 ]
Caching: | ¥l Enable

Proxy Mode: | @ Tiansparent

& Forward
When in Transparent mode, the proxy can accept both transparent and explicit forward connections.

Transparent connections require a transparent redirection device (see Network > Transparent
Redirection). When in Forward mode, only explicit forward connections are supparted.

1P Spoofing: | [ Enable 1P Spocfing

©  For Transparent Connections Only
For All Connections,

When enabling IP spoofing in forward mode, you should ensure that you have appropriate network devices to
route return packsts back to the Web Sscurity sppliance.

Persistent Connection Timeout: @

Client Side: 300 seconds

Server Side:  [300 seconds
In-Use Connection Timeout: (7) i i l—

Client Side: 300 seconds

Server Side:  [300 seconds

Simultaneous Persistent Connections:

Server Maximum Number:  [Zgo

Generate Headers:

X-Forwarded-For: () send  ® Do Mot Send
Request Side VIA:  ® send ) Do Not Send

Response Side VIA:  ® cend ) Do Not Send

Use Received Headers:

[ Enable Identification of Client IP Addresses using X-Forwarded-For

Click Submit.

Navigate to Security Services > PAC File Hosting.

Click Enable and Edit Settings.

Under PAC Files, click Choose File.
Select the wpad.dat file created earlier.
10. Click Open.
11. Click Upload.
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dils Cisco Web Security Virtual Appl- X

&« > C A Not secure \ coeus.di.ipdr:8080/security_services/web_proxy/pac_file_hosting T e
n wen oTCuTIty TenEger uryservce T S— -

Edit Proxy Auto-Configuration File Hosting Settings

Proxy Auto-Configuration File Hosting

¥ Enable Proxy Auto-Config File Hosting

Basic Settings
PAC Server Ports: | [gg
Enter muiltiple ports separated with 3 comma

PAC File Expiration: | () allow PAC file to expire in browser's cache

PAC file will expire after |0 minutes

If this option is enabled, some supported browsers will automatically download 3 new copy of the PAC file if
it is available after the defined expiration schedule.

R

Uploaded Files Add Row
wpad.dat Download PAC File... |
No file chosen @

Upload
Hostnames for Serving PAC Files Directly @

To serve PAC files for PAC file requests that do not include the PAC server port, enter one or more hosts here and choose a default PAC file name. You can specify hosts
using hostnames or IP addresses.

Hostname Default PAC File for "Get/” Request through Proxy Port Add Row
[ @
| Submit |

g |
45 Coifll

Copyright © 2003-2017 Cisco Systems, Inc. Al rights reserved. | Privacy Statement

13. Click Submit.

14. Click Commit Changes.

15. Enter a comment if desired.
16. Click Commit Changes.

2.14.3.2 Setting Up Web Proxy Auto Discovery (WPAD)

1. Onthe DNS server, open regedit.exe.
2. Navigate to HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services > DNS >
Parameters.
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File Edit View Favorites Help
. CNG ~ || Name
..... | CngHwhss || ab) (Default)
I~ |, Composite || %4 AdminConfigured
----- L COMSysAr || 2] BootMethod
L condrv #d|EnableGlobalQu...
----- Jeyet2 ) Eowarders
b CyptSve |2 g ko mardingTime...
B DCLocator | g e oiuery B
bl Deomlaun | o0 %
lave
bolu deftagaie | ousLocalH
b || DeviceAss:
b ). Devicelnst:
b1l Dfs
b )l Dfsc
b | DfsDriver
bl DFSR
b )l DfsiRo
b, Dhep
b ). DiagTrack
b || DirectoryS
b disk
U dmvsc
4-). DNS
|| Params
..... . Perforn
b -l Drscache
). dotdsve
b DPS
b )l DsmSve v

Type
REG_SZ
REG_DWORD
REG_DWORD
REG_DWORD
REG_MULTI_SZ
REG_DWORD
REG_MULTI_SZ
REG_DWORD
REG_SZ

Data
{value not sef)
0x0000000T (1)
0x00DDD00 (3)
0x0000000T (1)
192,162.78.1
0x00DDD00 (3)
wpad isatap
0x00D0D00D (0)
AD-DNS.DIIPDR

[ Bl
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\DMS\Parameters

3. Double-click GlobalQueryBlockList.

4. Remove wpad from the list but leave isatap on the list.

Walue name:

|GlobalQueryBlocicList

Value data:

satap

5. Click OK.
6. Open Task Manager.
7. Click Services.
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- Task Manager

ile | Options  View

| Processes | Performance I Users I Detai|s| Services |

==

Marme PID Description Status Group ~
5. Dhep 792 DHCP Client Running LocalServicel...
. DPS 732 Diagnostic Policy Service Running LocalServicel..,
Lo WdiServiceHost Diagnostic Service Host Stopped LocalService
S WdiSystemHost Diagnostic Systermn Host Stopped LocalSystemM...
L. DiagTrack 1463 Diagnostics Tracking Service Running utcsve _
56 TrkWks Distributed Link Tracking Client Stopped LocalSystemM... =
L MSDTC 3424 Distributed Transaction Cocrdin..  Running
5. Dnscache 80 DMS Client Running NetworkService

ELC: DINS 1438 DNS Server N Running :
. DsRoleSve D5 Role Server L‘E Stopped
&4 EFS Encrypting File System (EFS) Stopped
. Eaphost Extensible Authentication Protocol  Stopped netsves
S NitFrs File Replication Stopped
Lo fdPHost Function Discovery Provider Host  Stopped LocalService
. FDResPub Function Discovery Resource Pu...  Stopped LocalServiceh...
. gupdate Google Update Service (gupdate)  Stopped
. gupdatem Google Update Service (gupdate...  Stopped
S gpsve 244 Group Policy Client Running netsves
S hkmsve Health Key and Certificate Mana..,  Stopped netsves
S hidsery Human Interface Device Service Stopped LocalSystemM...
Sowvmickvpexchange Hyper-V Data Exchange Service Stopped LocalSystemM..
Sevmicguestinterface Hyper-V Guest Service Interface Stepped LocalSystemM...
Sowmicshutdewn Hyper-V Guest Shutdown Service  Stopped LocalSystemM., v

@ Fewer details | "5 Open Services

Restart the DNS Server service.
Open DNS Manager.

. Enter wpad for Name.
. Enter the IP address of WSA.

. Right-click on your enterprise’s domain, and click New Host (A or AAAA).
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Mew Host -

Mame (uses parent domain name if blank):

| wpad |

Fully qualified domain name (FQDM):
| wpad.DLIPDR. |

IF address:
| 192.168.1.59 |

[ ] Create assodated pointer (FTR) record

[ ] Allow any authenticated user to update DNS records with the
Same oWner Name

Add Host || Cancel

13. Click Add Host.

This will set up the WPAD proxy file as the default proxy—so browsers that are using “Automatically
detect settings” for their proxy setting will find this file. Be aware that this is not sufficient for a
secure setup but will allow you to quickly test the proxy’s functionality.

2.14.3.3 Configure Group Policy to Use Explicit Proxy

Note that, at this point, WPAD is vulnerable to an attack where the server hosting WPAD is brought
down and the browser automatically attempts to find the next WPAD proxy, which may be
controlled by an attacker.

To mitigate this vulnerability, we explicitly point to this proxy file with any browsers used by clients.
For Internet Explorer and Google Chrome, it is sufficient to change group policy in Active Directory
to direct the change across all systems.

For Mozilla Firefox, see this link (https://support.mozilla.org/en-US/kb/connection-settings-firefox)

for configuration, including how to set it to “Use system proxy settings.”

1. In Group Policy Management, right-click the Default Domain Policy and click Edit.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 304


https://support.mozilla.org/en-US/kb/connection-settings-firefox

'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

2, Group Policy Management Default Domain Policy
4 A3 Forest: DLIPDR T‘ma'm
4 [55 Domains .
4 &3 DLIPDR Links
Display links in this location: ‘ DIIPDR v
I 2] Domain Controllers’ The following sttes, domains, and O'Us are linked to this GPO:
b &1 Microsoft Exchange Security Groups — ————
b [ Group Policy Objects & Tires o N DLIPDR
b [ WMI Filters .
b [3 Starter GPOs
b L[n Sites
ﬁ‘ﬁ‘ Group Pelicy Modeling
[, Group Policy Results ,
Security Filtering

The settings in this GPO can only apply to the following groups, users, and computers:

Name
B2 Authenticated Users

I Add [[ Bemove ||  Fopetes |
s
WMI Filtering
This GPQ is linked to the following WMI fiter:
‘ <none> "‘l ‘ Open |

2. In Group Policy Management Editor, navigate to User Configuration > Preferences > Control
Panel Settings > Internet Settings.
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g

| File | Action View Help
e pE L0 w2 HE RO +
=/ Default Domain Policy [AD-DNS.DLIPDR] P| BEES
4 & Computer Configuration e r",-'-.“ -
" Computr 't Internet Settings
b [l Preferences
4 i, User Configuration
b ] Policies There are no items to show in this view.
4[| Preferences
b ] Windows Settings
4 (@] Control Panel Settings
@ Data Sources

g Devices

G Folder Options
Local Users and Groups
Network Options
W8 power Options Description
58 Printers Mo policies selected
0 Regicnal Options
cheduled Tasks
E Start Menu

Order

\Preferences Extended #, Standard

3. Right-click Internet Settings and select New > Internet Explorer 10.
4. Click the Connections tab.
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Programs I Advanced | Common |
General I Security I Privacy I Content | C%WEC'J'OHS

To set up an Internet connection, dick

Setup.

Dial-up and Virtual Private Network settings

Add...

Choose Settings if you need to configure a proxy

server for a connection,

(®) Mever dial a connection

() Dial whenever a network connection is not present

() Always dial my default connection
Current Mane Set default

Local Area Metwork (LAM) settings

LAN Settings do not apply to dial-up connections.
Choose Settings abowve for dial-up settings.

5. Click LAN Settings.

6. Enter the address of the WPAD file for address. This will likely take the form
http://wpad.my.domain/wpad.dat if you followed these instructions for configuring the proxy
file.

7. Pressthe F8 key to disable all settings in this dialogue box. (Note: This should underline
everything in the box in red.)
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Automatic configuration

Automatic configuration may override manual settings. To ensure the use of
manual settings, disable automatic configuration.

[ ] Automatically detect settings

Proxy server
m Ise a proxy server for your LAN (These settings will not apply to

| Advanced... |

[ |Bypass proxy server for local addresses

oo | [ e ]

8. Select the Address you just entered.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

308



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

Local Area Network (LAN) Settings | b

Automatic configuration

Automatic configuration may override manual settings. To ensure the use of
manual settings, disable automatic configuration.

[ ] Automatically detect settings

Iise automatic configuration script

Address: | http:/fwpad.di.ipdr fwpad. dat| |

Proxy server
m Ise a proxy server for your LAN (These settings will not apply to

Address; Port: Advanced...

Bypass proxy server for local addresses

9. Press F6 to enable this setting. (Note: The explicit WPAD address should now be underlined in
green.)

10. Click OK.

11. Click OK.

This Group Policy Object will update across all Windows systems whenever gpupdate.exe runs. An
insider or technically capable user could manually disable this to avoid using the proxy, but benign

clients who do not attempt to circumvent it will be protected from external (internet-based) threats

by Cisco WSA. Protection from insiders and local threats on the network is provided by other
products in the architecture, such as the network protection component (CryptoniteNXT).

2.14.4 Denylisting

1. Navigate to Web Security Manager > Custom and External URL Categories.
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Wl Cisco Web Security Virtual Appli- X [RS8

& % ® Notsecure | coeus.diipdr:8080/web_security_manager/custom_policy elements/custom_url_categories b e

alialie Cisco S000V @ Logged in as: admin on coeus.di.ipdr

CISCO Web Security Virtual Appliance My Favorites - Options - Support and Help -

] Reporting Web Security Manager Security Services Network System Administration

|_No Changes Pending

Custom and External URL Categories

Categories List

Ij\didaategory...

No Custom and External URL Categories are defined.

Copyright © 2003-2017 Cisca Systems, Inc. All rights reserved. | Privacy Statsment

Click Add Category.

3. Enter a name for Category Name.

4. Select Local Custom Category. (The other option, External Live Feed Category, allows WSA to
use a list of websites hosted somewhere else, potentially externally. For this demonstration we
will simply enter websites in the Sites field, but note that this other option is available for
convenience.)

5. For Sites, enter any sites to denylist. (Note: Entering .mysite.abc will include any subdomains of
mysite.abc.)
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als Cisco Web Security Virtual Applic X

€& > € A Notsecure | coeus.diipdr8080/web_security manager/custom_policy elements/custom_url_categories

«lali Cisco SO00V

CISCO Web Security Virtual Appliance

'y Reporting Web Security Manager

Security Services Network

(OB Uporade Available v

My Favorites - Options - Support and Help -

Logged in as: admin on coeus.di.ipdr

System Administration

Category Name:

Custom and External URL Categories: Add Category

Edit Custom and External URL Category

|Ma|icmus Blacklist

No Changes Pending

List Order:

—

Category Type:

Local Custom Category M

Sites: @

-evil.kp

(e.g. 10.0.0.1, 2001:420:80:1::5, example.com.)

Sort URLs
Click the Sort URLs
button to sort all site
URLs in Alpha-numerical
order.

= Advanced

Regular Expressions: @

Enter one regular expression per fine.

Copyright © 2003-2017 Cisco Systems, Inc. All rights reserved. | Privacy Statsment

Activate Window
GO S

Click Submit.

Navigate to Web Security Manager > Access Policies.
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s Cisco Web Security Virtual Appl X |

-+ C @ Not secure \ coeus.di.ipdr:8080/web_security_manager/proxy_security/policy_groups

il Cisco SO00V @ Logged in as: admin on coeus.di.ipdr

CISCO Web Security Virtual Appliance My Favorites - Options . Support and Help -

a Reporting Web Security Manager Security Services Network System Administration

Access Policies

Protocols and
Order  Group User Agents URL Filtering | Applications Objects Anti-Malware and Reputation Delete
Glabal Poli ot 3 Web Reputation: Enabled
identification Profile: All Ne blocked items | Monitor: 86 Monitor: 356 | Mo blocked items ArirMalars Boanningt caablod ‘
e = 5 ! e
| Edit Policy Order... |

Copyright & 2003-2017 Gisco Systems, Inc. All rights reserved. | Privacy Statement

I

Commit Changes »

8. Click the link under URL Filtering.
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Ciseo Web Security Virtual Applic X

alaln Ci
CISCO We

bsco S000V

urity Virtual Appliance

Security Services

Web Security Manager

f Reporting

(OB Upgrade Available ¥

My Favontes - Options - Support and Help -

Metwark System Administration

Logged in as: admin on coeus.di.ipdr

No Custom Categories are included for this Policy.

Access Policies: URL Filtering: Global Policy

Custom and External URL Category Filtering

Commit Changes =

Select CustonyCategories...

Predefined URL Catego ering

These URL Cstegories are defined a5 group membership criteria. All other categories sre not spplicable for this policy.

Category

Block Monitor

Warn @ Quota-Based Time-Based

Select all | Select all

Select all | {(Unavailable) | (Unavailable)

€ Adult

) Advertisements

0 Alcohol

© Arts

0 Astrology

0 Auctions

0 Business and Industry

) Chat and Instant Messaging

0 Cheating and Plagiarism

O Child Abuse Content

ASAASA AL SLNLNEN

9. Click Select Custom Categories.

10. For the category just created, select Include in policy under Setting Selection.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

313



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

b Cisco Web Security Virtual Appli- X

& 3 C @ Notsecure | coeus.diipdr:8080/web_security_manager/proxy_security/url_categories_http?action=FormEdit&policy_group... Y& e

oV

| \Web Securiﬁl Manager

Logged in as: admin on coeus.di.ipdr

Opbions -

Support and Help -

Custom and External URL Category Fil

Ne Cu: m Categories are included for

| Select Custom C s

Access Policies: URL Filtering: Global Policy

These URL Categories are dg

Category

Category Type

Setting Selection

Malicious Blacklist

Custom (Local)

\ Include in policy

v

a-Based

Category | Cancel |

@ adult

ky

Time-Based
©

vailable)

{Unavailable)

©) advertisements

@ Alcohal

@ arts

@ astrology

@ auctions

) Business and Industry

&) Chat and Instant Messaging

€ cheating and Plagianism

Go tgSystenti

) child Abuse Content

LSESIE L SESL YL WL SIS

Actizate Wirldgivs

11. Click Apply.
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sl Cisco Web Security Virtual Appli- X
&« c @ Not secure \ coeus.diipdr:8080/web_security_manager/proxy_security/url_categories_http?action=FormEdit&policy_group... T e

w]ialee Cisco S000V @ Logged in as: admin on coeus.di.ipdr

CISCO Web Security Virtual Appliance My Favorites - Options - Support and Help -

A Reporting Web Security Manager Security Services Network System Administration

Access Policies: URL Filtering: Global Policy

om and al URL Catego ering

These URL Categories are defined as group membership criteria. All other categories are not applicable for this policy.

Block Redirect | Allow (2} | Monitor | Warn (2} | Quota-Based | Time-Based

Category Category Type Select all | Select all | Select all | Select all | Select all | (Unavailable) = (Unavailable)
a Malicious Blacklist Custom (Local) V% - -

Select Custom Categories...

These URL Categories are defined as group membership criteria. All ather categories are not applicable for this palicy.

Block Monitor Warn @ Quota-Based Time-Based
=) @ (4]

Category Select all | Select all | Select all | (Unawvailable) | (Unavailable)
© Adult

9 Advertisements

©) Alcohol
© arts
) Astrology

8 Auctions

- ek, ont

ANESENESLNEN

12. The category should now show under Custom and External URL Category Filtering. Put a
checkmark in the Block box. (Selecting Allow lets you permit domains that are being incorrectly
classified as malicious.)

13. Click Submit.

14. Click Commit Changes.

15. Enter a comment if desired.
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16.

2.15

2.15.1
1.

[-[==0

< { & A Not secure | coeus.diipdr:8080/commit?referrer=http;//coeus.di.ipdr:8080/web_security_ manager/proxy security/policy_g... ¥r e

dls Cisco Web Security Virtual Appl. X [N KENEWS: X ‘ -+

alialn Cisco SO00V 6] Logged in as: admin on coeus.di.ipdr

CISCO Web Security Virtual Appliance My Favorites - Options - Support and Help -

A Reporting Web Security Manager Security Services Network System Administration

Uncommitted Changes

Commit Changes

You have uncommitted changes. These changes will not go into effect until you commit them,

Comment (optional): | [malicious blacklist created.
Abandon Changes | Show Changes Commit Changes

Copyright @ 2003-2017 Cisco Systems, Inc. All rights reserved. | Privacy Statement

Click Commit Changes.

Symantec Data Loss Prevention

Install Oracle 12c Enterprise

Unzip the Symantec DLP installation files.
Download the Oracle 12c installation files from https://www.oracle.com if they are not included

with the Symantec DLP installation files.

Move both sets of installation files to a temporary directory, such as C:\temp.

Copy the Symantec 12.2.0.1_64_bit_Installation_Tools folder to C:\temp\Oracle\tools.

From a command prompt, navigate to C:\temp\Oracle\database, assuming the Oracle
installation files were unzipped to C:\temp\Oracle.

Run the following command:

> C:\temp\Oracle\database\setup.exe -noconfig -responsefile
C:\temp\Oracle\tools\responsefiles\Oracle_12.2.0.1 Enterprise_Edi
tion_Installation_WIN.rsp

Once the wizard opens, you will be asked to configure security updates. If you do not possess a
My Oracle Support account, leave the box unchecked and provide an email.
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Configure Security Updates

Jrog’ . ORACLE 1 zc

s =

= Py DATABASE

@J Configure Security Updates
|
Inzstallation Option

Database Installation Options

Install Type

Oracle Home User
Installation Location
Prerequisite Checks
Summary

Install Product

T—r——e—e—— %"

Finish

Provide your email address to be informed of security issues, install the product
and initiate configuration manager. View details.

Email:

Easier for you if you use your My Oracle Support email address/username.

|:| | wizh to receive security updates via My Oracle Support.

My Oracle Support Password:

[ <oec [(hea> ] [ s | (Ccancel ] |

8. Click Next.

9. Select Install database software only.
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Select Installation Option

B o o

e DATABASE

¥ LConfigure Security Updates

@ Installation Option

/+ Database Installation Options
Install Type

Oracle Home User
Installation Location
Prerequisite Checks
Summary

Install Product

(—C—C—C—C—C—X

Finish

Select any of the following install options.

O Create and configure a database

@ @ |hstal database software nnlyi

O Upgrade an existing databaze

10. Click Next.

11. Select Single instance database installation.

= s )
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Select Database Installation Option

ConfiqpreSeamiylpiates Select the type of database installation you want to perform.

Installation Option @ Single instance database installation

Database Installation Options | (™) gracle Real Application Clusters database installation

O Oracle RAC One Node database installation
Oracle Home User

Installation Location
Prerequisite Checks
Summary

Install Product

T
)f\
G
T Database Edition
.T.

Finish

[ <Back | wext> || w=ar || cance

12. Click Next.

13. Select Standard Edition.

14. Click Next.

15. Select Create New Windows User.

16. Enter the username and password of a new user for Active Directory.
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1 .\‘ﬂ‘ .
Specify Oracle Home User G 1 ORACLE 12C
h—} - DATABASE

Configure Security Updates For enhanced security, you may choose to run Windows Services from this Oracle home with a
non- ini t. Oracle that you cheoose a Virtual Account or specify a standard
Installation Option Windows User Account for this purpose.

Database Installation Options () Use Virtual Account

T
)T\

T ;
url Database Edition
7

!

.T.

.T.

.T.

() Use Existing Windows User

Oracle Home User

) ) |I:I'.;'ad ministrator
Installation Location

Prerequisite Checks Word: |

o g
FoED () Create New Windows User

Install Product

User Name: |5ymantec

Finish

Confirm o |

The newly created user is denied Windows logon privileges.

() Use Windows Built-in Account

[ <Back | Next» || nstall

17. Click Next.
18. Select a location to install the software, if desired.
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Specify Installation Location

Sy SaE12°

DATABASE

T Lonfigure Security Updates
)Tg Installation Option

)Tg Database Installation Options
T Database Edition
¢
|
.T.
.T.

Oracle Home User

Installation Location

Specify a path to place all Oracle and guration-related files i by this i ion owner.
This location is the Oracle base directory for the installation owner.

Oracle base: |Clapp\Administratorivirtual [VJ [B[nw&e...J

Specify a location for stering Oracle files from

p files in the
Oracle base directory. This software directory is the Oracle database home directory.

Prereguisite Checks Software Iocation:  |Capp\Administratorvirtuahproducti12 2 (\dbhome_1 [VJ [Brn!?se J
Summary
Install Product
Finish
[ <Back || mext> | [ msmi || CanoeIJ

19. Click Next.
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Configure Security Updates = Oracle 12c Rel

E| Global settings
- Disk space: reguired 5.0 GB available 73.08 GB [Edi]
-~ Oracle Home User: symantec [Edif]

Installation Option

Database Installation Options
Database Edition

- Source location: C:\Users\Administrator DND \winx54_12201_datab

Oracle Home User - Database edition: Enterprize Edition (Install database software only) [Edif]

Installation Location - Oracle base: C\app\Administratorivirtual [Edit]
- Software location: C:happ\Administratorivirtuahproducti12.2.0\dbhome_1 [Edit]
OraMTS Port Number: 48157

el
]

equisite Checks

%]
=
3
3
=
]

Install Product

T
)Tk
)Tk
T
T
T
'?
?
!

-

=
5

=

[ I
Save Response File...

[<gocx ] 1o | (st ] [conce ] |

20. Verify the information and click Install. The installation may take a long time.
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| £f Oracle Database 12c Release 2 Installer - Step 10 of 10 = | = -
Srich ORACLE 12(,‘
DATABASE
The installation of Oracle Database was successful
i
! Finish
| Help | Close

21. Click Close when the installation is complete.

2.15.2
1.

Create an Oracle Database for Symantec DLP

Set the ORACLE_HOME environment variable by running the following command. Adjust the
path accordingly if using a version other than 12.2.0.

> set
ORACLE_HOME=C:\app\Administrator\virtual\product\12.2_0\dbhome 1

Copy the Oracle database template named Oracle_12.2.0.1_Template_for_64_bit_WIN.dbt
from the Symantec DLP zip file into
C:\app\Administrator\virtual\product\12.2.0\dbhome_1\assistants\dbca\templates.
Ensure that the response file Oracle_12.2.0.1_DBCA_WIN.rsp is located in the folder
C:\temp\Oracle\database\tools\responsefiles.

Run the following command.

> %ORACLE_HOME%\bin\dbca -createDatabase -progressOnly -
responseFile
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2.153
1.

5.
6.

C:\temp\Oracle\database\tools\responsefiles\Oracle 12.2.0.1 DBCA _
WIN.rsp

Enter a password for the SYS user. (Only the special characters _, #, or $ are allowed.)
Enter a password for the SYSTEM user. (Only the special characters _, #, or S are allowed.)
Enter a password for the Oracle Home User.

Configuring the Oracle Listener

Ensure that the database services OracleServicePROTECT and
DistributedTransactionCoordinator are running.

In the file O0RACLE_HOME%\network\admin\sqlnet.ora, change the line
SQLNET.AUTHENTICATION_SERVICES=(NTS) to SQLNET.AUTHENTICATION_SERVICES=(none).
Navigate to Start > All Programs > Oracle 12.2.0 > Configuration and Migration Tools > Net
Configuration Assistant and run the program.

Select Listener configuration.

B Oracle Net Configuration Assistant: Welcome -

Welcome to the Oracle Met Configuration Assistant.
This tool will take you through the common
configuration steps, listed below.

Choose the configuration you would like to do:
® | jstener configuration
" Naming Methods configuration

" Local Net Service Mame configuration

" Directory Usage Configuration

Cancel J Help )

Click Next.
Select Add.
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7. Click Next.
8. Enter a name for the listener.
9. Enter a password.

DiListener

10. Click Next.
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11. Move the TCP protocol to the Selected Protocols column.

12. Click Next.
13. Select Use the standard port number of 1521.

14. Click Next.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

326



'GZ-008T'dS LSIN/8209°0T/840°10p//:sd11y :Wwiou) 984YD JO 9.} 3|qejieAe s| uofedljgnd siy |

15. Select No.

16. Click Next.

17. Click Next.
18. Select Local Net Service Name configuration.
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19. Click Next.
20. Select Add.

21. Click Next.
22. Enter the word “protect” for the name.
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23. Click Next.
24. Select TCP.

25. Click Next.
26. Enter the IP address of the system hosting the Oracle Database.
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27. Select Use the standard port number of 1521.

28. Click Next.
29. Select No, do not test.

30. Click Next.
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31. Click Next.
32. Select No.

33. Click Next.
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34. Click Next.

35. Click Finish.
36. In an administrative command prompt, run the following command to stop the listener.
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> Isnrctl stop

37. Open the file 0RACLE_HOME%\network\admin\listener.ora.

38. Change (ADDRESS = (PROTOCOL = IPC)(KEY = <key_value>)) to (ADDRESS = (PROTOCOL =
IPC)(KEY = PROTECT)).

39. Add the line SECURE_REGISTER_LISTENER=(IPC) to the end of the file.

istener - Nowgpad [=T=E

| # listener.ora Hetwork Configuration Filer Ci\app\Administratorivirtualiproduct\12.2.@\dbhose_1inetwork\adein\listensr . ora
# Generated by Oracle configuration tools,

File Edd Fomat Vew Help

SID_LIST_DILISTEMER =
(SID_LIST =
(510_pesc =
(SID_NAME = CLRExtProc)
(ORACLE MOME = C:\app\Administrator\virtual\product\12. 2. @\dbhome_1)
(PROGRAM = extproc)
(EMVS = “EXTPROC_DLLS=OMLY:C:\app\Administrater\virtual\preduct)ll.2.@\dbhome_1\oin\eraclrll.dll™)

1
(SID_DESC =

(SID_NAME = CLRExtProc)

{ORACLE_HOME = C:\app\Administrator\virtual\product\12.7.@\dbhosa 1)

(PROGRAM = extprac)

(EWVS = "EXTPROC_DLLS-OMLY:(:\app\Adainistratorivirtual\praducti12. 2. 8\dbhone_1\bin\oraclrl2.4117)
)

3
1

DILISTEMER =
(DESCRIPTION_LIST =
(DESCRIPTION =
(ADORESS = (PROTOCOL = TCP)(HOST = SYMANTEC-DLP.DI.IPDR)(PORT = 1521))
(ADORESS = (PROTOCOL = IPCH(KEY = PROTECT))
1

SECURE_REGTSTER_LTSTERER = (1PC) |

40. Save the file and exit the editor.

41. Ensure that OracleServicePROTECT and OracleVssWriterPROTECT services are running in Task
Manager.

42. In an administrative command prompt, run the following command to start the listener. Re-
place dilistener with the name given to your listener.

> Isnrctl start dilistener

43. Run the following commands to connect the listener to the database using SQL Plus. Replace
password with the password used for the SYS user.

> sqglplus /nolog
> conn sys/password as sysdba

44. Run the following commands in the SQL prompt. (Note: If errors occur relating to the SPFILE, try
replacing ORACLE_ HOME or ORACLE_base values in %ORACLE_ HOME%\dbs\init.ora with the
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45.

46.
47.
48.

49.
50.
51.

absolute path. Then run CREATE SPFILE FROM PFILE="%ORACLE_HOME%\dbs\init.ora’ and CRE-
ATE PFILE FROM SPFILE="%0ORACLE_HOME%\dbs\init.ora’. Restart the database after doing
this.)

> ALTER SYSTEM SET local_listener = " (DESCRIPTION=(ADDRESS=(PRO-
TOCOL=1pc) (KEY=PROTECT)))" SCOPE=both;

> ALTER SYSTEM REGISTER;
> exit
Run the following command to verify the status of the listeners:

> Isnrctl services

oo Administrator. Command Prompt

opyright <c> 1991, 2816, Oracle. All rights reserved.

gngggiigg to (DESCRIFTION=CADDRESE={PROTOCOL=TCF>{HOST=8¥YMANTEC-DLF.DI . IPDR>{F0
Cervices Summary...
Cervice "CLRExtFroc' has 1 instanced{s).
Instance "CLRExtProc'. status UNKNOWM. has 1 handler{s> for this service...
Handler<s):
"DEDICATED" estahlizhed:d@ refuszed:A
LOCAL SERVER
Bervice "protect' has 1 instancefs>.
Instance "protect', status READY,., has 1 handler(s) for this service...
Handler<sl:
"DEDICATED" estahlished:78 refused:@ state:ready
LOCAL SERVER

Cervice "protectXDB'" hasz 1 instance<s>.
Inztance “protect'. status READY. hasz 1 handler{s? for thiz service...
Handler{sl:
"DABAY” establizhed:@ refused:B current:® max:1822 state:ready
DISPATCHER <{machine: SYMANTEC-DLF. pid: 3936>
(ADDRESS =(PROTOCOL=tcp><{HOST=SYMANTEC-DLP.DI . IPDR>{PORT=51687>>
he command completed successfully

sUserssAdministrator. DI >

Open a new administrative command window.
Navigate to C:\Temp\Oracle\database\tools.
Run the following command:

> sqglplus /nolog
> @oracle_create_user.sql

Enter the password for the SYS user.
For sid, enter “protect”.
For a username, enter “protect”.
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52.
53.

54.

55.

Enter a password for the “protect” user. (The special characters &, S, and # are not allowed.)

When this process is finished, open a new administrative command window and run the follow-

ing command.

> sqlplus /nolog

Log in as the SYS user with the following command (replace “password” with the password for

the SYS user).

> connect sys/password@protect as sysda

Verify the version information with the following command.

> SELECT * FROM v$version;

5QL> SELECT * FROM vSversions

NE for Gg—hit

LSRTL Uegsinn

Administrator: Command Prompt - sqlplus /nolog \;li-

12.2.8.1.8 - Production

Production

Windows: Version 12.2.8.1.8 - Production

12.2.8.1.8 - Production
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2.15.4 Install Symantec DLP

1. Inthe folder DLP Installs\DLP 15.1\Symantec_DLP_15.1_Platform_Win-
IN_15.1.0.25021\DLP\15.1\New_Installs\x64\Release, located in the download folder for the
DLP files, run ServerJRE.msi.

Welcome to the Symantec Data Loss
Prevention Server JRE Setup Wizard

The Setup Wizard will install Symantec Data Loss Prevention
Server JRE on your computer, Click Mext to continue or
Cancel to exit the Setup Wizard.

s

2. Click Next.
3. Select | agree to the terms in the license agreement.

End-User License Agreement
Flease read the following license agreement carefuilly

SYMANTEC SOFTWARE LICENSE AGREEMENT

SYMANTEC CORPORATION AND/OR ITS AFFILIATES ["SYMANTECT)
SPECIFIED IMN THE EMNTITLEMENT COMNFIRMATION 1S WILLING TO
LICEMSE THE LICEMSED SOFTWARE TO YOU AS THE INDIVIDUAL, THE
COMPANY, OR THE LEGAL ENTITY THAT WILL BE UTILIZING THE
LICENSED SOFTWARE (REFEREMNCED BELOW AS “YOU™ OR “YOURT)
OMLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS AND
CONDITIONS OF THIS SYMAMTEC SOFTWARE LICENSE AGREEMENT
AND THE PRODUCT USE RIGHTS SUPPLEMENT (AS DEFINED BELOW)
(COLLECTIVELY, THE “LICENSE AGREEMENT"). READ THE LICENSE
AGREEMEMT CAREFULLY BEFORE USING THE LICENSED SOFTWARE. v

[T accept the terms in the License Agreement

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events 336



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

4. Click Next.

Click Mext to install to the default folder or didk C

Install Symantec Data Loss Prevention Server JRE to:

IC ‘\Program Files\Symantec'Data Loss Prevention,

5. Click Next.

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

6. Click Install.
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Completed the Symantec Data Loss
Prevention Server JRE Setup Wizard

Click the Finish button to exit the Setup Wizard.

Badk @L\( Cancel

7. Click Finish.
8. Run SingleTierServer.msi (located in the same folder as ServerJRE.msi).

Welcome to the Symantec Data Loss
Prevention 15.1 Single-Tier Server Setup
Wizard

The Setup Wizard will install Symantec Data Loss Prevention
15.1 Single-Tier Server on your computer, Click Mext to
continue or Cancel to exit the Setup Wizard,

9. Click Next.
10. Check the box to accept the license agreement.
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Please read the following license agreement careful

SYMANTEC SOFTWARE LICENSE AGREEMENT

SYMANTEC CORPORATIOM ANDIOR ITS AFFILIATES ("SYMANTECT)
SPECIFIED IMN THE ENTITLEMENT COMNFIRMATIOM 1S5 WILLING TO
LICENSE THE LICEMNSED SOFTWARE TO YOU AS THE INDIVIDUAL, THE
COMPANY, OR THE LEGAL ENTITY THAT WILL BE UTILIZING THE

LICENSED SOFTWARE (REFERENCED BELOW AS “YOU™ OR “YOURT)
ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS AND
CONDITIOMS OF THIS SYMAMTEC SOFTWARE LICENSE AGREEMENT
AND THE PRODUCT USE RIGHTS SUPPLEMEMT (AS DEFINED BELOW)
(COLLECTIVELY, THE “LICEMSE AGREEMEMNT"). READ THE LICENSE |
AGREEMEMT CAREFULLY BEFORE USING THE LICEMNSED SOFTWARE. v |

[T accept the terms in the License Agreement

|Prnt||Bad<||NE)&\__‘Ca1cel

11. Click Next.

Click Mext to install to the default folder or dick Chang

Install Symantec Data Loss Prevention 15, 1 Single-Tier Server to:

IC:\,Program Files\Symantec\Data Loss Prevention,

12. Click Next.
13. Select Enabled for FIPS 140-2 Compliant Algorithms.
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FIPS Cryptography Mode
lUse FIPS 140-2 Compliant Algarithms for Cry

Spedfy if this server should use FIPS 140-2 algorithms for cryptography.
Symantec requires that the same setting be used for all DLP Platform Servers.

() Disabled
(®) Enabled

14. Click Next.

Select the directory of the JRE that you wish to use.

IC:\ngram Files\Symantec\Data Loss Prevention\Server JRE\1.8.0_162

15. Click Next.
16. Click on New Users.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

340



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

Service User
Select Service User Type

Select whether you want to create new users or use existing users for the DLP
SErvice Users,

(®) New Users

() Existing Users

17. Click Next.
18. Enter a password and optionally a username.

Create a New Service User

Enter the credentials for the service user to be created for DLP services. This
user will be granted logon as a service privileges.

ISwﬂanter.:DLP

19. Click Next.
20. Enter a password and optionally a username.
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Update User
Create a New Update User

Enter the credentials for the update user to be created for DLP services. This
user will be added into the local Administators group and granted logon as a
service privileges.

Username ISyT‘r‘lanheleLPUpdate

Password || T YT I I

Confirm Password || LTI TSI T ]

(o e | [Cona |

21. Click Next.
22. Enter the password used for the “protect” user.

Oracle Database 3
Spedify Orade Database Connection Settings

Spedfy on which hostname or IP address, port, SID, username, and password
the Enforce server should use for connecting to the database.

|12?.n.o.1

|1521

Iprotect

Iprotect

23. Click Next.

24. Select Initialize Database.

25. Click Next.

26. Set the initial password for logging into the Enforce Administrator account.
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Enforce Administrator Password
Set Enforce Administrator Password

Set the initial password for the Enforce Administrator account.

Pmo{d || SEFRRERANRRRERN

EOf'I‘FrI'I'I Pmord || SRERRERANRRRERN

27. Click Next.
28. Select Database.

External Storage
Enable External Storage

Spedify if incident attachments should be stored on the database or in external
storage. Storing incddent data in external storage saves space in your
database, but you cannot migrate this data into the database in the future.

29. Click Next.
30. Select None.
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Additional Locale .
Add a single additional locale for ui sorting 2

|None

31. Click Next.

Specify on which host and port this server should accept connections from
Enforce on.

32. Click Next.
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Ready to install Symantec Data Loss P

Click Install to begin the installation. Click Back to review or chanae any of your
installation settings. Click Cancel to exit the wizard.

33. Click Install.

Completed the Symantec Data Loss
Prevention 15.1 Single-Tier Server Setup
Wizard

Click the Finish button to exit the Setup Wizard.

Cancel

34. Click Finish.

35. Ensure that the services are running in Task Manager:
a. SymantecDLPManager
b. SymantecDLPIncidentPersister
c. SymantecDLPNotifier
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2.15.5

o vk wnNPRE

10.
11.
12.
13.
14.
15.
16.
17.

18.
19.
20.
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d. SymantecDLPDetectionServer

Configure Symantec DLP

Navigate to https://127.0.0.1 in the browser to get to the Symantec DLP web console.
Navigate to System > Settings > General and click Configure.

In the Edit General Settings screen, upload your license file provided by Symantec.

Click Save.

In Task Manager, stop the SymantecDLPManager service.

Copy the classpath.txt file located in <DLP Download Home>\DLP\15.1\Solution_Packs\ and
overwrite the classpath.txt located at C:\Program Files\Symantec\Data Loss
Prevention\Enforce Server\15.1\Protect\Config\SolutionPackinstaller.

In an administrative command window, use the following commands to import the chosen
solution pack. For example, to import the financial solution pack, use:

> cd “C:\Program Files\Symantec\Data Loss Prevention\Enforce
Server\15.1\protect\bin”

> _\SolutionPacklnstallerexe import “C:\Program
Files\Symantec\Data Loss Prevention\Financial_v15.1.vsp”

After this is installed, restart the SymantecDLPManager service.
Log on to the Enforce Web Console as Administrator.

Navigate to System > Servers > Overview.

Click Add Server.

Select the type of Detection Server to add.

Click Next.

Enter a name.

Enter the hostname of the DLP server.

Enter 8100 for the port.

Navigate to System > Settings > General.

Process Control

Advanced Process Contral

Check the box next to Advanced Process Control.
Specify any configuration options according to the needs of your organization.
Click Save.
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2.16 Cisco Identity Services Engine

This section details the installation and some configurations for the Cisco Identity Services Engine (ISE).
It assumes the use of the ISE virtual machine.

2.16.1 Initial Setup

1. When prompted to log in for the first time, enter setup. (You can use the command reset-
config to change these values later.)
Enter the desired hostname for the machine.
Enter the desired IP address for the machine. (Ensure that the specified hostname is associated
with this IP address in your DNS.)

4. Enter the netmask for the machine.

5. Enter the default gateway.

6. Enter the default DNS domain (the name of your domain).

7. Enter the primary nameserver (the IP address of your DNS).

8. Enter a second nameserver if desired.

9. Enter a Network Time Protocol (NTP) time server.

10. Enter the timezone.

11. Enter Y for SSH service.

12. Enter an administrator username for the machine.

13. Enter a password twice.

2.16.2 Inventory: Configure SNMP on Routers/Network Devices

See the corresponding vendor documentation for the correct way to enable Simple Network
Management Protocol (SNMP) on your network device. Ensure that the community string you choose is
considered sensitive, like a password.

2.16.3 Inventory: Configure Device Detection

1. Login to the web client by visiting https://hostname/admin but replace hostname with the
hostname of the ISE machine.
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-~

[dentity Services

]
cisco

Engine

Userame  admin
PasSWOrd | ssssssssssnenes
Problem logging in?
af S and certain other counliies. Cisca ISE ullizes open source software from various

PassivelD Setup
Visibility Setup
Wireless Setup (BETA)

3. Click Next.

lizard

‘aisco  Identity Services Engine Home  » Comtext Visbiity b O

# Welcome 1 Endponts 2 Network Devices 3 Active Direclory
sty

1 Pos

abions b Poicy b Admmistraton  » Wark Centers License Waming £k

sture o Summary

Get to know the devices and users' details of your network. Gain visibility and context with this setup wizard

Demain
Cisco.com
Cisco.com
GCisco.com
Cisco.com
Cisco.com

Cisco.com

DC Host

DC1.Cisco.com
DC2 Cisco.com
DC3 Cisco.com
DCA.Cigco.com
DCS Cisco.com

DB Cisco.com

1P Address Group Name

10565576 Cisee.comMetaork Configuration Operalors
10.86.53T7 Cisoo.comPerformanca Monkior Usars
10965378 Cisco.comPerformance Log Use’s
10565579 Cisco.comDisributed COM Users

10.5653.80

Cleco.comCrynlographic Operaiors

10565381
G0 comEvant Log Reader

If you already have configured some of these seftings in ISE, continue using this wizard vl overwrite prior configurations.

4. Enter the range of IP addresses to add to ISE’s inventory.

5. Ensure that Active Scanning is checked.

G Exil Wizard
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Aol ienity Servicss ENGINE Home  » Contet Visbdty b Oporsioms 4 Fokey > Admmnistration

Endpoints Discavery

We ate going 15 discover the endncinks usng the 1P raspels) beko.

Click Next.
Click the Add Device Manually link.
Enter a name.

L N

10. Select 1 for SNMP version.
11. Enter the community string you created.

Add Network Device

SNMP Version *

RO Community *

12. Click OK.

Licwnsie Worming L

Enter the IP address of the network device you configured for SNMP.

=
y
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thatlh identity Services Engine b

» Operations » Policy  + Adeninistration

ISE VISIBILITY SETUP WIZARD

# Welcome 1 Endpoints 2 Metwork Devices 3 Actwe Dieclory 4 Postre  of Surnmary
et e

MNetwork Devios Discovery
Total Added (1) Failed (0}

Q Scan 4 Add B Remove @ Add Location
Name IP Address Device Type Location Description

GATEWAYROUT 15216811

13. Click Next.

14. Enter a display name.

15. Enter the domain name.

16. Enter the hostname of Cisco ISE.

17. Enter a username and password.

18. Click Test Connection to ensure that this works.

et jome. s Vestlity » Operations » Pokcy b AdSAion b Wi

19. Click Next.

20. Enter a username and password.

21. Check the box next to Enable Endpoint Logging.
22. Check the box next to Include Range.

Action

License Waming &

G Server e

O» Exit Werand

¥ Fiter=

5 g
Webwork Devices crested sucoeshully

Licerse Warning 4

- DD
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bl

cisco  |dEntily Services Engine ome (s Visibdity » Operatons ¥ Polcy Wi BYS License Waming &k

ISE VISIBILITY SETUP WIZARD

Exit Wigan
# Walcoms 1 Endpoints 2 Network Davices 3 Active Directory 4 Posturs o Summary O Ext Wizard
Posture Discovery
Discaver postire an endponts using common adminstrative account and same IF range(s) from step 1
Usermame = Administrator
Password * mrans
Enable Endpomnt Logging @ @
P Addess Range * | 1921680 018
nclude Range # O
R eock L next ]

23. Click Next.

tisco  Identity Services Engine

Netwark Device Discovery GEd

GEdn
Posture Discovery Gedn
1P Seanning Rangs 1921 1 =
nchidsd [
[ gaci T oone ]

24, Verify the settings and click Done. (This should begin importing endpoints connected to the
network device, and they will be visible on the ISE dashboard.)

2.16.4 Policy Enforcement: Configure Active Directory Integration

1. Navigate to Administration > Identity Management > External Identity Sources > Active
Directory.
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 Administration

» System  wldentity Manag » Network » Device Portal Management  pxGod Servces  » Foid Service  » Theeat Cen
Chick here to do wireless setup and visibility setp Do not =

¥ ldentities  Groups  External ldentity Sources  ldentity Source Sequences  # Selfings
—_—

External Tdentity Sources

Active Directory
dt g Add Delete  NodeView g Advanced Tools =  Scope Mode

TiEr e
» [ Cenificate Authenticatin Profae [ | Join Pownk Name & Active Directory Domain
) Active Due(:ua'f| No data available
(=
3 coec

(5 RADILIS Token
[ RS SecuriD
[ SAML 1d Providers
(53 Social Login

2. Click Add.
3. Enter a name.
4, Enter the domain.

= Administration

» System  + dentity _ » Network » Device Postal Management  pxGiid Seivices  # Feed Service  » Thieat Cen

Click here 10 do wirehess selup and visibility setup Do nol

» Identities  Groups  External identity Sorces  Identity Source Sequences  » Settings
B

External Identity Sources “

A = -iéﬁ-
* Join Paint N i
v [ Cenmicate Auihentication Protie funthisne g 4o o |
[ Active Directory * Active Directory Domain ! di.ipdr | L
L: LoAP
& opBc

[ RADIUS Token
[ RSA SecusD

[ SAML id Providers
[ Sl Login

5. Click Submit.
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o Wondd yons like: o Join  1SE Nodies to this Active Directary Domain?

Click Yes.
7. Enter a username and password to join ISE to the domain.

Join Domain
Please specify the credentials required to Join ISE nade{s) to the Active Directory Domain
* 4D Uses tiame | D\adminstratoe
LT p——

| Specify Organizatianal Unit
) Store Credentials

8. Click OK.
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Juin Operation Stalus
Status Summary: Successful
1SE Noge &  MNode Status

CisCo-ise dipdr @ Completed

9. Click Close when the join is finished.

2.16.5 Policy Enforcement: Enable Passive |dentity with AD

This configuration allows users to use Active Directory usernames/passwords as authentication for the
portal. The web portal will allow clients to download profiling software to ensure that clients have up to
date software and can be trusted on the network.

1. Navigate to Administration > System > Deployment.
2. Check the box next to ISE.

dantity gina e

System | b ldentity Management  » Network Resources.  » Device Portal Management  piod Services  » Feed Sendce b Theeat Cenric NAC
Deployment  Licensing  » Cerdicates b Logging b Maintenance  Upgrade  » Backup & Restore  » Admin Access  # Setings

DBeployment Deployment Nodes
AxiEr e Salacted 1| Total 1 8 66 _
* ::,:m S edt B Reguter | By smop [l Devegieer Show | All - |1
[ Hosinama | Parscras. Rale(s) Sanices. Node Status
[ cncoise Administration, Moretaring, Pelicy Senvice STANDALONE IDENTITY MAFPING SESSION PROFILER. [
ke
3. Click Edit.
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4. Check the box next to Enable Passive Identity Service.

‘thuehe Identity Services Engine Home b Context Visi v - Adminisiration

m b identty Management  » Network Resowrces  » Device Porial Management  pxGeid Sendces b Feed Service b Threat Centric NAG
Deployment  Licensng  » Cenficates  # Loggng ¢ Marenance  Upgrade  » Backup & Restore  » Admin Access  » Settings
e sTANGALGNE
; Administration
4w Manitoring
Foie PRIMARY
Cither Manitcring Node
# w Poicy Servce
w Enable Session Servces |
Include Node & Node Group | None
Enabie Profitng Service |
[0 Enabée Trveat Centnc NAC Serice
] » Enable 5X° Servce i
ul Enatie Device Admin Service
@  Enable Passive Identity Senvice

pacind

5. Click Save.

6. Navigate to Administration > Identity Management > External Identity Sources > Active
Directory.

7. Click the name of the Active Directory machine.
Check the box next to the join point you just created.

“Oito’ Identity Services Engine ome 4 Co b C s : Cicense Fwning “&

P Syslem | wident agement | b Network Resources # e Porial Management  pxGnd Senaces  » Feed Serice  #

b iderties  Groups  Exdemal idertiy Sources  Ideriity Source Sequences b Seftings

External Identity Sources Active Directory
B Sfgr eadd Mber  nedsvien @ Adencsd Took « Scope Mode
e in
] Jon Pont Namse o  Active Dirctory Domain
& Aoons BIPOR

9. Click Edit.
10. Click the PassivelD tab.
11. Click Add DCs if there are no domain controllers listed.
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Add Domain Controllers

DC Host

8.5 SUpp.di ipde

AD-DNS DI IPDR Detault.Firs1-Sae. Mame

ad-cnsdf o ipdr

12. Select the Active Directory domain controller.

13. Click OK.

14. Check the box next to the selected domain controller.
15. Click Edit.

16. Enter credentials for an administrator account.

Edit Item

Edit Domain Controller

17. Click Save.
18. Click Config WM.
19. Click OK.
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‘5”__. Config WMI in process...

Configuration of WM has begun and will take some time.
Status will be shown on completion. Run in background?

20. Click OK when this configuration finishes.
21. Navigate to Administration > System > Settings > Client Provisioning.
22. Set Enable Automatic Download to Enable.

il
e1sen

identity Services Engine Mome  » Conk ity b Op by [EETEIESIEN Work Centers
*Systemn b ideridy Managernerd  » Network Resources  » Device Portal Mamagemen!  pxGrid Services.  » Feed Service  » Thiead Centric NAC
Deployment  Licensing  » Gertificales  » Loggng  » Mamndenance  Upgrade  » Backup & Festore  » Admin Access. = Settings.

]

Chient Provissaning
Client Provisioning
FIPS Mode
Socunty Settings * Enabie Provssioning.  Enabie

Alarm Satings * Enable Automatic Download: | Enatée = (i

* Posture * Update Feed URL. | s e B

Protiing * Native Supghcant Provesioring Policy Unavadable. | Appy Defined Authanzation Poliry =

Py Save | | Resst

23. Click Save.

24. Navigate to Administration > Identity Management > External Identity Sources > Active
Directory.

25. Click the Groups tab.

26. Click Add > Select Groups from Directory.

27. Click Retrieve Groups. (This should populate the window with the groups from Active
Directory.)

28. Select them all.
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29.

30.
31.
32.
33.

34.
35.

Select Directory Groups
This chalog 15 used to select groups from the Declory.

Hame Fiter * | 510 Fimed *

=
%]
15|
%]
&l
%]
(T
&
(ci|
%]
(ci]
%]
17|

Domain di.ipdr

Retrieve Groups. | 68 Groups Retneved

ceess Control Operators
DI IPDR)Busltin/Account Cperators
DLIPDR/Bultin/adminisirators
DI IPDRBuitinBackup Operators
DLIPDR/Buitin/Centificale Senace DCOM Access
D IPDR/Builtin/ Cryptographic Operators
DLIPDR/Bultin Distributed COM Uisers.
DI IPDR/Busitin/Event Log Readers
DLIPDR/Bultin/Guests
DI IPDR/Bustin/biyperV Administrators
DLIPDR/BultinS_IUSRS
DL IPDRBuiinincoming Forest Trust Builders
DLIPDR/Builtin/Metwork Configuration Operators
DLIPDRBultinPerformance Log Users

e

Group SID

di.ipdriS-1-5-32-5T8
i ipdri§-1-6-32-548
diipdrS-1-5-32-544
di ipdriS-1-6-32-661
dlIpdriS-1-5-32-574
di ipdr§-1-5-32-560
di.ipdr/S-1.5-32-562
di ipdriS-1-5-32-573
di.ipdriS-1.5-32-546
i ipdri§-1-6-32-578
di.ipdriS-1-5-32.568
diipdri§-1.5-32-557
di.jpdriS-1.5-32-556
di ipdri§-1.6-32-560

iy

Groip Type

BUILTIN, DOMAIN LOCAL
BUILTIN, DOMAIN LOCAL
BUILTIN, DOMAIN LOCAL

BLILTIN, DOMAIN LOCAL

BUILTIN, DOMAIN LOGAL

BUILTIN, DOMAIN LOCAI

BUILTIN, DOMAIN LOCA

BUILTIN, DOMAIN LOCAL

BUILTIN, DOMAIN LOCAL

BUILTIN, DOMAIN LOCAL
BUILTIN, DOMAIN LOCAL
BUILTIN, DOMAIN LOCAI
BUILTIN, DOMAIN LOCAL

BUILTIN, DOMAIN LOCAL i,

Click OK. (If you add more groups to Active Directory they can be imported in the same way in
the future.)
Click the Attributes tab.

Click Add > Select Attributes from Directory.

Enter a username.

Click Retrieve Attributes. (This will populate the window with Active Directory’s available
attributes, so they can be used for policy in Cisco ISE.)

Click OK.

Select any desired attributes.
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Directory Attributes

Ondy attributes selecled belaw will be available for wse as poicy condibons in policy rubes.
* Samphe User or Machine Account | cscoiszadmin

[0 Name
LI loganHours

mDBUseDefaulls
memberCH
msExchDumpsterQuata

msExchHomeSenverName
msExchisarAcoountControl
Tame

chjeciCategory
objeciClass

ebectGUID

objectSid

peimany GrouplD
protocoiSettings

L asiSel
sAMAccountName

SAMArrnant Tuna

O
(m]
L]
O
O
a
O
O
a
i
(m}
a
m]
a
a
n

36. Click OK.
37. Click Save.

Retrieve Attributes.

- Type

UCIEI_SIRING
STRING
STRING
STRING

msExchDumpsterWamingCuota  STRING

STRING
STRING
STRING
STRING
STRING
STRING
STRING
STRING
OCTET_STRING
STRING
STRING
STRING

Example Vahe
(Bnary Value)

TRUE

GH=Organization Management, OU=Microsoft Exchange Security Grow
31487280

20871520

{Naon-Displayable or XSS data)

1]

cxscosgadmin

CN=Person CN=Schema, CH=Configuration DC=DI DC=IFDR
fop

HAT 220006062 4665180ACIBEEEADCT
5-1-5-21-2803005080- 304658434524 197 365301 268

513

(Binary Value)

131BEMIB4H5AB4ET2

ciscaiseadrnin

ANEVARA

2.16.6 Policy Enforcement: Developing Policy Conditions

1. Navigate to Policy > Policy Elements > Conditions > Posture.

Expand the Posture section. This will reveal a list of categories for conditions. (Note: These

conditions allow you to select or define requirements that endpoints should meet. In typical

enterprises, these conditions can be used as requirements to gain network access—however,

this strongly depends on the capabilities of your network device.)

3. Asan example, we will require that Cisco AMP be installed on all Windows devices. If you are

using a different anti-malware software, locate that instead. Click Anti-Malware Condition.
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@ Identity Sennces Engmne

xﬁ

= » O & Notsecure | kips/cisco-ise.dilpdr/admin/#palicy/palicy_elements/policy elements conditions/posture/posture_am_condition o e

il jdentity Services Engine

» Operainns » Adminestration

» Work Centers

1 License Wamnng 4

Dictionaries  » Conditions.

Liirary Gonditions
Semart Condilians
Time and Date
Profing

+ Posture

Anti-Malware Condition
Anti-Spyware Conaition
Anti-Virus Condition
Appication Condition
Compound Conditicn

Diisk Encryption Condition
File Conditian

Firewall Condition

Pach Management Condition
Registry Condition

Service Conditian

USE Candition

Hardware Altnbules Condibion

Policy Sets  Profiing  Posture

» Results

Chent Provisioning

Anti-Malware Conditions

Jedt oeadd  yDuplcate

Narme
AMY_am_win_inst
ANY_am_win_def

ANY_am_mac_def
Cisco-AMP

ooooo

~ Policy Elements

AMY_am_mac_ingt

K Dciete
Description
Any AM installation check on Win.,
Any AM definition check on Wind..
Any AM instaliation check on Mac
Anry AM definition check on Mac
Resquires Cieen AMP

Click here to do wirehss setup and visiility setug
|

Show [ Al

Click Add.
Enter a name.

L e NV

Protection with the version number you have installed.

Enter a description if desired.

Select Windows All for Operating System.
Select Cisco Systems, Inc. for Vendor.

Under Products for Selected Vendor, check the box next to Cisco Advanced Malware
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2.16.7

10. Click Submit.

Nou .k wnNe

& Izentity Senvice: x 4

&« [ I cure | hbtps/cisco-ise difpdr/admin/#palicy/policy_slements/policy_elements_conditions/posture/posture_sm_conditior it B
il - . ; i .
clm:ln Identity Services Engine Home + Contexd Visibility » Operations + Administration ¥ Work Centers [ 1] Lscerese Wamning 4k
Policy Sets  Profiling ~ Posture  Chent Provisioning Folicy Elements

Click here to 60 wireless setup and wisibity setug
Dicfionaries = Condiions  » Riesulls
[
o-

Ant-Malware Condibons List = New Anti-Malware Condition
Library Condiions : Lirieabony:

Anti-Malware Condition
Smart Conditions. -
*Mame | CcoAMP
Tirne and Date
2 Description | Cheek for cisen AMP
Profiling |
Comphance Module 4 x or later §
= Posture
" Dperaling System | Windows Al
Anti-Malware Condition =

Anb.Spyware Condition Veador [
Anti-Vines Condition Check Type (#) Installation () Definition
Agplication Condition
Compound Condrtion * Products for Selected Vendor
Disk Encryption Canddion Product Name « Version Remediation Support  Definition Check Latest Definition Date Latest Dedindtion
e 0 ANY ANY A YES
File Candition 5
L] Cisco Advanced Malware Protec Sx NO YES 021872019 T.T8603
e leit i [ Cisco Advanced Makwars Protec. . 6x NO YES 021182019 779603
Patch Management Condibion
Regstry Condition
Service Condition
USB Condition lx
Hardware Attributess Condition

Policy Enforcement: Developing Policy Results

Navigate to Policy > Policy Elements > Results > Posture > Requirements.

Click one of the black arrows next to the Edit link, and select Insert New Requirement.

Enter a name.

Select Windows All for Operating Systems.

Select 4.x or later for Compliance Module.

Select Temporal Agent for Posture.

Select User Defined Conditions > Anti-Malware Condition > Cisco AMP (substitute Cisco AMP
with the name of the condition you just created).

Select Message Text Only for the Remediation Action. (Other remediation actions can be
defined by going to Policy > Policy Elements > Results > Posture > Remediation Actions, but
there is not an option for Cisco AMP to be installed, so we leave the default for now.)

Enter a Message to inform the user that they must install Cisco AMP.
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H: ety Servkces Engiee % _

€ + C & Notsewre | hitpsy/dsco-tsediipdr/admin/#policy/policy_elements/policy elements_permissions/posture_permissions/posture_requirements policy % @
| 855" Identity Services Engine Home  » Context Vesibdity » Admansaration
Folicy Sets.  Profil Fosture  Chent Provisioning = Pokicy Elément
=i L Chcik hare 00 do wirekess sefup and visiblity setup Do not show
Dictinanes  # Conditions = FResults
o ANY _arv_win_inst et Message Text Only E
» Authentication Any_A_Defintion_Win Windows Al 3 of earier AnyConnect |
ANY_av_win_dal Dot AnyANDeRemediationVi e
b Authorization = |
Any_AS_Instalation_Win Windaws A8 r 3% of eatlier AayConnect
¥ Profiling ANY_as_win_inst T Message Tex Only 3
Any_AS_Detintion_Win for Windows Al o 3 or eadier | AnyCannect
v Postre ANY_as_win_def 10 AnyASDefRemedition W e
n
i Fmch ot Actcha & | ae_coecx | e [wWidows At % | uing [ o laer +] g [Temporal Agens <] metit
P [ csconrr & [THA| Message & | o
Any_AV_installation_ac Mac DSX 3xof earher AmyConnect
* Client Provisioning ANY_av_mac_ingt e Message Text Oaly ?.
Any_AV._Definition_Mac Mac 05X 3% or carlier 3 AnyConnect [
ANY_av_mac_def then AnyAvDefRemediaboniia 8
A i
Any_AS_Instatation_Mas Mac 05X 3% or eartior AnyConnect
ANY_as_mac_insl h Message Text Only 5
Any_AS_Defndion_Mac Mae OSX 3x or earher AnyConnect
ANY_as_rmac_def i AnyASDefRemedationha 2
<
Any_AM_instaliation_Wir Windaws A3 4 of ke AnyConnect
ANY_am_win_inst e Message Tes Only E
Arvy_AM_Definition_Win Windows Al 4% or ater 7 AnyConnect
ANY am win def then AnyAMOeRemediationyVi { et
7 »

10. Click Save.

2.16.8 Policy Enforcement: Enforcing a Requirement in Policy

Navigate to Policy > Posture.

Click one of the black arrows next to the Edit link, and select Insert New Policy.
Enter a name.

Select Windows All for Operating Systems.

Select 4.x or later for Compliance Module.

Select Temporal Agent for Posture Type.

No vk wnNe

Select Cisco AMP (substitute Cisco AMP with the name of the requirement you just created).
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@ Idenby Seraces Engane o

€ & C & Notsers | bitpsy/dsco-isediipdr/admin/#policy/policy_posture * O

Policy Sets  Profiing  Post Chent Provisioning . » Palicy Elements
s Chck here o do wireless setup and visibiity setup Do not show
and - Mag 08X e 4% or later and Temporal Agent and R g e
ac_temnparal

and 4 of ater st AnyConnect and e Any_AM_Installateon W
n
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8. Click Done.
9. Ensure that the green checkboxes next to the rules you wish to apply are the only checkboxes
enabled, as anything enabled will be enforced.

2.16.9 Policy Enforcement: Configuring a Web Portal

1. Navigate to Administration > Device Portal Management > Client Provisioning.
2. Select the Client Provisioning Portal (default).

gine A S, cmunistration e
* System b identity L - [ Py puGrd Services  » Foed Service & Threat Centric HAG
Blackint  BYOD ifi wg  Cliert i ng  Mobile Device My Devices  Custom Fortal Files  » Semings

Client Provisioning Portals

i can edit d customize the difaull Chert F and create additions

3. Click Edit.
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4. Under Portal Settings, go to Configure authorized groups and select the groups that should
require a Cisco ISE client.
5. Enter a domain name for FQDN, and add it to your DNS.

License Wamng &

Administration > Syswm > Certificates >
System Certificates

Authertication methed: *  Certificate_Request_Sequence
Administration > identity Management >
Identity Source Sequences

Avatatie

# Choose all

Fully quaiied doman name (FODN)

6. Click Save.

2.16.10 Configuring RADIUS with Your Network Device

Cisco ISE requires a Remote Authentication Dial-In User Service (RADIUS) session for posture to
function. Posture refers to ISE’s ability to check that a machine complies with a specified policy, which
may be based on the operating system (OS) and may contain requirements such as installation of
certain security applications or the presence of configuration files. Machines that are not in compliance
can be kept separated from the network. The process for setting this up varies widely among machines,
but the overall requirements have commonalities among systems.

e The Network Device (i.e., the router or switch) must support RADIUS functions, specifically
Authentication, Authorization, and Accounting. Furthermore, it must also support CoA, which
is Change of Authorization. To configure this, you must configure your network device to use
Cisco ISE as a RADIUS server. What this means is that your network device will forward
authentication requests to Cisco ISE, and Cisco ISE will respond with an “accept” or “reject.”

e The Network Device must support some form of 802.1x. Note that this is not supported on
certain routers, even if RADIUS is supported. 802.1x is a mechanism for authenticating the end
workstation to the network device, potentially over wireless or through Ethernet.

a. This can take various forms, such as a captive web portal, MAC address authentication,
or user authentication. A captive web portal, if the device supports it, may be ideal for
configuration without the correct hardware.
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b. There are also many switches that provide direct 802.1x username/password
authentication. Note that if you choose to use this mechanism, a client is still required,
and it will not be in the web browser. Windows has a built-in 802.1x client, which can be
configured on network adapters under the Authentication tab. To enable it, you must
first start the service Wired AutoConfig, and then the Authentication tab will become
available for configuration.

c. Whatever form of 802.1x is chosen, the request for authentication must be forwarded
to Cisco ISE. Cisco ISE will process the request for authentication.

e The two steps above detail the authentication phase. Once authenticated, the network device
must redirect the user to the client provisioning portal (or to a guest portal), depending on the
setup. The URL for this can be acquired from the active Authorization Profile in ISE.

e The user will then authenticate to the Guest Portal or Client Provisioning Portal (depending on
your setup). The portal will prompt the user to download an executable, which will run posture.

o The executable will first check for the existence of a RADIUS session in Cisco ISE for the user
who downloaded the executable. It will primarily check the MAC address that visited the ISE
web portal against the MAC addresses of existing sessions. If and only if a session exists, it will
run posture based on the policy you set up. You can verify that a session exists by navigating to
Operations > RADIUS > Live Sessions.

2.16.11 Configuring an Authentication Policy

Navigate to Policy > Policy Elements > Results > Authentication > Allowed Protocols.

Select the Default Network Access protocol or create your own.

Ensure that any protocols that need to be supported for your network setup are allowed. In
particular, if using 802.1x, it is likely that you should check the box next to Allow MS-CHAPv2.
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atlulne

eisen Mdentity Services Engina

Policy Sets  Profiling  Posture  Client Provisioning | = Policy Elements

Dictionaries  » Condilions  ~Resulis
L]
Adlowed Protocols Senices List > Defaalt Network Acoess
» Authentication

Allowed Protocols
» Autnorization Name | pefault Network Access
Deserphon | Defauit Allowed Protocol Service
» Prefiling

* Posturs
w Allowed Protocols

¥ Client Provisioning nite: Bypass

(m] Process Hest Lookup

]
:
|

3]

Adiow PAPIASCH

]

Allow CHAP

=

Allow MS-CHAPVY

Q|

Allow MS-CHAPVZ

=

Allow EAP-MDS

]
=

Allow EAP-TLS

O Enatie Statcless Session Aesume

Chick here 10 do wirthess selup and visibilty setup Do not show )

O atew Authenticason of axpirad cenficates to allow cerifeata renawal in Authorization Peley (|

Click Save.
Navigate to Policy > Policy Sets.
Select the default policy.

No v ks

created/edited.

Ensure that the Allowed Protocol selection matches the allowed protocol you just

8. Expand the Authentication Policy section, and select the ID stores from which to authenticate

users. For example, if you set up an Active Directory integration, it may be desirable to

authenticate users from there.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

366



'GZ-008T°dS 1SIN/8209°0T/840°10p//:sd1y :woly 981eyd Jo 9244 d|qe|ieAe s| uoliedljgnd syl

» Work Centers @  Lcensewamng 4

Clicik hare to do wireless setup and visiity setup

Policy Sets = Default m

Status  Policy Set Name Description Conditions Allowed Profocols / Server Seque:

Default Detaut pabey set Dietaust Network Access

¥ Authentication Policy (1)

+ Status  Rule Name Conditions Use Hits

¥ Options

* Authorization Puoilicy - Local Exceptions

¥ Authorization Peiicy - Global Exceptions
. P Aidmarivabing Dalie (91 [6
9. Click Save.

2.16.12 Configuring an Authorization Policy

1. The Authorization Profile is likely dependent on your network device, but it is possible that the
Cisco_Temporal_Onboard profile will work even for non-Cisco devices. You can edit the
authorization policy by navigating to Policy > Policy Elements > Results > Authorization >
Authorization Profiles.

2. The temporal onboard profile will attempt to redirect the user to a client-provisioning portal.

This redirection will most likely happen only automatically on compatible Cisco network devices.

If another device is used, the device may need to manually redirect the user to the client-

provisioning portal after authentication. (We accomplished this in pfSense for our build by using

a “post-authentication redirection” feature in the Captive Portal.)

Once you are finished configuring the Authorization Profile, navigate to Policy > Policy Sets.

Select the default policy.

Expand the Authorization Policy section.

o vk w

Note that you can configure this for as many groups and conditions as desired, potentially
specifying different authorization profiles for various user groups or levels of authentication,
including unauthenticated access. Under Results > Profiles, you can select the authorization
profiles you configured.
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2.17

& denity Services Enging ®

€ = C A Notsecure | hitps//dsco-isediipdr/admin/#palicy/policy arouping new Tt 6
alutlie

eisen  Identity Services Engine Home:

Palicy Seis | Prafil Posture:  Cllent Provisaning  # Palicy Elements
¥ Click here to 0o wireless setup and visibility setup Do nol sfice

¥ Authentication Palicy (1)

> Palicy - Local

¥ Authorization Policy - Global Exceptions

w Authorization Policy (2)

+
Status  Rule Name Conditions Profiles Security Groups Hit:

Search

Guests

@ Basec_Authentcated_Access B machineuseraun

@ Defau | « Cisco_Tempoeal_Onbaard Unkmewn "

Click Save.

Tripwire IP360

This section details installation and configuration for Tripwire IP360.

2.17.1
1.

Installation

Move or copy the Tripwire IP360 Virtual Machine into your virtual environment; start Virtual

Machine and observe its successful start-up.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

368



woJy 284eyd Jo aaJy a|ge|ieAe si uonealgnd siyL

sdny:

"GZ-008T°dS LSIN/8209°0T/34010p//

2. Login using default admin credentials.
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[INFO1 IP368 Event Daemom build # starting
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loader
tran

xon-stream-1iste
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ivity col lector
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135842 login

= Appliance
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4. Use the command system hostname update <hostname> to update the system’s hostname in

accordance with your environment’s naming scheme.

6585381
6585511
6506611
6586811
6516371

@
}.8516581

Setting host
hecking ile

[drm] Hax dedica
 is 28488
URAM at Bxc8ABH888 28488 kiB
[drm] MMI0 at BxfcBBOBER s s kiB
Idrm] global init
[TMM] Zone kernel
[TTM] Zone  dma3: gre
[TTH] Initiali 1lacator
[TMM] Initializing DM pool allocator
[drm] Supports vblank timestamp caching Rev 2
Idrm] M r suppart [ lank timestamp que
fdrm] S =t Display device initialized
Idrm] width 1288
[drm] height 768
fdrm] bpp 3
d: Fifo ms B>48848888 min BxABB81888 cap BxBEBBAT7{
fdrm] Using co buffers with DMA pool
[drm] DX: no
fbcon: sugadrmh (Fb@) is primary
Co e: suitching to col e ffer d e
[drm] Initi i 1 21 for B88A
random: fast
Floppy drive(

with ordered data m
Mounted roc
Switching root

ion 147
ler
: crng init d
piix4_smbus 9980:98:07.3: SMBus Host Controller wot enabledt
via_umci B8P8:80:87.7: Found UCI PCI device at Bx11888, irq 16
wm_umci B8BA:BA:E7.7: | lities 8
Guest pers aliz s active
I host umci, major=18, ®
Initiali
input: PC k v atfarm/pespke
FUJITSU e Network De
c1868: Inte Network Driver - vei NAP
e1888: Copyright 2886
1080 BARA:H2 ¢ ha: (PCI bit) B8:58:5
1888 BABA ] R) PRO1888 Hetwork

ppdev: use
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Copyright (c) 2815 FUJITS

U LIMITED

5. Use command network interface update <interface> <IP>/<Broadcast IP> to update network

interface information in accordance with your environment’s network.

Stopping he

Paint...

already

Point Gateway..
is alre

not need t
activity
0 Acce:
int
R
int Gateway is already running.
vents [
[
Hemory
[
[
IP368 Event Daemon build # starting up
ibche: V4.6

[
[
[
[
[
[

[
annot translate ‘wne-934358a2° to FQDN name r = nat known
14 daemon with http interface at [localho
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login: admin

934351
ommand sucs
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rface update eth8 192.168.1.144,255.255
1 £1888: ethd NIC Link Up 1888 Mbps Full Duplex, Flow Control: None
ADDRCONF (NETDEU_UP): eth@: link is not ready
ADDRCONF (NETDEU_CHANGE) : eth8: link becomes dy
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6. Use command network route_default create <gateway> to update the system’s default
gateway information in accordance with your environment’s network.

[
starting ¢ td: [INFO] IP368 Event Daemon build # starting up
[INFO] ncl U?7.48 and libch .6

[
[
[
[
[
[

!
3 to FQDN name i not knowm
Monit 5.14 daemon with http interface at [localhost]:Z
[

t up t
: ethB NIC Linl B8 Mby Fi p Flow Control: Hone
ADDRCONF (NETDE ‘ ethd

: ADDRCONF (NETDEU_CHANGE) : ethB: link becomes

k route_default create 192.168.1.1
ethd NIC Link Up 1888 Mbps Full Duplex, Flow Control: None
: ADDRCONF (NETD! UP): eth@: link is not ready
HANGE) : ethB: link becomes
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7. Use command system nameserver create <nameserver IP> to set up the DNS server.
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2.17.2 Web Portal

1. From a web browser that can access the newly installed machine’s IP address, navigate to the IP

address and log in using the updated credentials from the setup process.

/ [ Authonzation x N

€ C | A Notsecure | hetpsy//192.168.1.144/indexice

TRIPWIRE®

$(P360

ip360@tripwire.com

ssssacessasases

© 20092017 Trigwie, loc. Trowine, inc. Use-of ths sollwass i subsect 1o Koanse resirictions, s4e
mn-mhmm‘-

2. Check the box next to | accept the above User License Agreement.

'D Tripwire VnE - License A= X

L C | A Notsecure | https//192.168,1.144/vne/eula/

TRIPWIRE®

$IP360 o e

IMPORTANT INFORMATION s
TRIPWIRE SOFTWARE IS LICENSED, NOT SOLD. USE OF THIS SOFTWARE IS
SUBJECT TO LICENSE RESTRICTIONS. CAREFULLY READ THIS LICENSE
AGREEMENT BEFORE USING THE SOFTWARE. USE OF SOFTWARE INDICATES
COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND
CONDITIONS SET FORTH IN THIS AGREEMENT. ANY ADDITIONAL OR
DIFFERENT PURCHASE ORDER TERMS AND CONDITIONS SHALL NOT APPLY.

END-USER LICENSE AGREEMENT ("Agreement")
Clicking "accept" or installing and/or using the Software (defined below) establishes
a binding agreement between Tripwire, Inc. ("Tripwire") and you as the person or
entity licensing the Software ("Customer”); provided that if you are accepting this
Agreement on behalf of a legal entity, you represent that you have the authority to
£

B canch actii Ea Shis A ok thao b, " x

¥ I accept the above User License Agreement Next
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3. Click Next.
4. Browse to location of downloaded license file.

& Tripwire Vn - Licenses x

You must install a valid IP360 ficense in order to use IP360.

Current License Details

Company licensed to: Scanned IPs: 0

License Type: Licensed IPs: 0

License Device Profilers: 0
Cy Disabled

5. Click Install.
6. Tripwire IP360 should now be installed and running.

€IS : om0 ] o o2 8
. ~
.‘“‘i"i’,“‘gso & a o W 1 & O
LegacyUl  Nolificaions  Help  Settngs  Defaull  Logout
s RN BN
SCANNING AGENTS TRIPWIRE REPORTING FOCus |
SCANNING B
(% SCHEDULED SCANS = o)
[ ] Name “*  Scan Profile Network Pool Type Status
No Scheduled Scans Available i
v
<H >
© Acd < < Jor1 3
b v
S AMACTIVITY. e £ N KA

2.17.3 Scanning

This section details instructions for using Tripwire IP360 to run a scan on enterprise systems. The
specific details of the scan will vary based on each enterprise’s security needs.
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1. Navigate to the web interface and log in.

& Authorization x

TRIPWIRE®

P36

ip360@tripwire.com

.....l.........l - ‘

©2003-2017 Tripwire. inc. Tripwire. inc. Use of L restrictons. see

2. Navigate to the Scanning tab.

TRIPWIRE i
. Legacy ul Ncuﬁaabms Help Settings Defaun Lugoul
°. IENENICR =1
SCANNING AGENTS TRIPWIRE ENTERFRISE REPORTING FOCUS
SCANNING
:: SCHEDULED SCANS tio1 (Yrewe | @3
[] » windows10-1 Trpwire: Standard Profile windows10-1 w360 Recurring
® Add [ ot
3. Click Add.

4. Complete the information regarding the new scan according to the preferences of your
organization.
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Add New Scan

Name (defaulits to Network Name if unspecified)
(ad-ans

Scan Profile *

; Tripwire: Deep Scan Profile

®Add £ Edit

192.168.1.12

@ Add 2 Edit

Appliance Pool *

[ waso

®Add £ Edit
On Demand
on

® Cancel @ Finish

5. Observe successful scan activity.

® Add [ Jor1
i SCAN ACTIVITY 19010 20O@
B Name Duration  End Date + Hosts  Score Result |
[1» addns 1 minute - In Progress (1%) Al
[J» windows10-1 5 minutes - Paused (0%)
[1» scanning-ping-port Iminutes  7/919 1 0 Finished
[1» scanning-ping-port 2minutes  7/9119 1 0 Finished
[1» scanning-ping-port 2minutes 719119 1 0 Finished
[]» scanning-ping-port 1 minute 719119 1 0 Finished
[1» scanning-ping-port - 71919 - Failed v
i NETWORKS 12012 23O i
B Name “ IPICIDR Asset Value Status
[1» ad-dns 192.168.1.12 ~
[ » windows10-1 192.168.1.138
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2.18 Integration: Tripwire Log Center and Tripwire Enterprise

1. Create a user account in Tripwire Log Center by logging into Tripwire Log Center Console.

File View Options Help

QAN A5 08 WIRS B OE| O mefitr 24k ~

Administration Manager

.'JI -egwgistrato

2. Click the Administration Manager button.
3. Click User Accounts.
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File View Options Help

‘R TQ% L@ WmMYHODL PTG O Timefiter 24Hours

& &ib

LT Permissions l% Admin View - 1 Users

] Global Ssttings ID¥F  Mame 7 Full Name ¥ Description W LastLogin
» 1 administrator administrator Default Global Administrator Account  08/06 12:35:56

-.'ll User:administrato

4. Click the Add button.
5. Enter the details of the user.

6. Click Add.
7. Double-click the user account.
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Audit Logger Permissions

General |n User Groups |o |nfl:l1'r‘ia‘|ll:l’l—|g Permissions 5_ Database Permissions

Full name

Description

Phaone

[v]

|
|
Email |
|
|

Phene

[v]

Authentication

validIPs |

Authmethod | Tripwire Log Center v

External User |

Account is Disabled [

=l =

8. Click the Permissions tab.

a User Name | tweuser

? Manager Permissions | E

Audit Logger Permissions

General |n User Groups |° Information éJ Permissions Database Permissions

2|35 &

Name Description

9. Click Edit list of permissions.
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10. Select Databases.

Name Description
View System Databas  Allows the user to view the System Database dat

—[7] Discovered Assets

11. Check the box next to View System Database.
12. Select APIL.

Name Description
Allow REST APl Logon  Allows the user to connect using the REST API.

I

—[] Discovered Assets

13. Check the box next to Allow REST API Logon.
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a User Name | tweuser

? Manager P

Audit Logger Per

Genercl BUSHGW |° Infc i Q Permissi Datab
ST G
Mame Description
p View System Database  Allows the user to view the System Database data.
Allow REST APl Logon  Allows the user to connect using the REST API.

14. Click OK.

15. Click OK.

16. Log in to the Tripwire Enterprise web console.
17. Click Settings.

pwire Web Console X

"S7-008T'dS"LSIN/8Z09'0T/810°10p//:5d1y ‘w0l a81eyo jo 92 3|qe|iee si uonedgnd siyL

< c ‘ A Not secure | hetps//tripwire-e/console/app.showApp.cmd 1’(‘ E
s
@ENTERPRISE HOME | NODES | RULES | ACTIONS | TASKS | POLICIES | LOG | REPORTS | SETTINGS
Settings % Refresh Helo [ Logout
Table page size: (1-500)
[i] Differences
Refresh rate: (5-3,600 seconds, 0 to disable)
= [C] System
Y Preferences Max version display: (Kbytes)
5k Log Management Max element name display width: [0 | (characters, 0 to disable)
A Database Max description display width: [0 | (maximum display for description columns, 0 to view first line)
&z Severity Ranges

¢ Global Variables

Ej Approval Templates
L5} E-mail Servers
(&% Configure TE Consal
Import Seffings
[z3) Export Settings
(i Support Data

9 [[]) Administration
(5 PostRemediation Se
(B Users
B User Groups
4] Home Pages
Gy Roles
L, Login Method
RpLicenses

{9 L] Custom Properties
[ Version Properties
[% Element Properties
&5 Node Properiies

= [L) Monitering
[=@] Cusiom Node Types
(553 Criteria Sets
[ File Systems

4 »

Settings Manager

(¥ Always login to Home Page

(| Display exact table count
Display elements
() Only within node property editors
1 Only within the Node Manager
(® 1In both locations

Tree

[ | Animation

|| Disable Multi-Expand s
[ | Enable Tree Filter Field

¢ Detailed node view

[#] Open property editors to the last sheet visited

¥/ Display remediation disclaimer in popup

#| Display automated remediation disclaimer in popup

Apply

Last Axon Agent config: 16 hours ago (Sep 6, 2018 lz:i;biii‘daie |‘v'm£b€lﬁh'ﬂ§istmmr

GO 1o System in Control Panel i |
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18. Go to System > Log Management.

19. Check the box next to Forward TE log messages to syslog.

20. Enter the hostname and port of the Tripwire Log Center server. The default port is 1468.

21. Check the box next to Allow TE to use information from Tripwire Log Center.

22. Enter the service address like this: https://arcsight-cons.di.ipdr:8091/tlc. Replace the hostname
with the hostname of your Tripwire Log Center server.

23. Enter the account information of the account just created for Tripwire Log Center.

24. You can use Test Connection to verify that the connection is working.

B-1=1=

@ Tripwire Web Console % \\ |

< C | A Notsecure | https//tripwire-e/console/app.showApp.cmd ¥

T
‘ﬁmnﬁ HOME | NODES | RULES | ACTIONS | TASKS | POLICIES | LOG | REPORTS | SETTINGS

Settings +% Refresh [ Help [ Logout
= @ Tripwire Log Management Preferences
2 [0 User
55 Pref
{j Profarences | Forward TE log messages to syslog
[EgiDiflerencas
o (1 System Transport protocol: |TCF ¥
Ly Preferences Host: arcsight-cons.di.ipdr
Port: 1468
18 Database: -
Test Connection|

iz Severity Ranges
gy Global Variables

[ Approval Templates w| Allow TE to use information from Tripwire Log Center
) E-mai Servers Service address: |https://arcsight-cons.di.ipdr:8091/tle
(8 Configure TE Consol
User name: tweuser
@] Import Settings
(13 Export Settings Password:  |stsssssssssesss
=] Support Data Confirm: ~ [seessssasneens
£ AR Test Connection|
(3} Post-Remediation Se
(flp Users
5B User Groups Apply
4] Home Pages
e .
L Login Method
fpLicenses

=[] Custom Properties
[ Version Properties
[ Element Properties
& Node Properties

= [ Monitoring
=8| Custom Node Types
(£ Criteria Sets
%%, File Systems. -

»

Settings Manager Last Axon Agent config: 16 hours ago (Sep 6, 2018 12:00:11 AM} - | User: administrator

25. Click Apply when finished.
26. Go back to the Tripwire Log Center Console.
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File View Options Help

‘@RTQ% @ F WHDG: @ & © i TimeFiter 24Hours ~

27. Click Configuration Manager.
28. Click Resources > Tripwire Enterprise Servers.

File View Options Help

‘@FTQ% 25 @ 2 WHYDGL @O L D Tmefiter 24Hours

Resource View - O Tripwire Enterprise Server

Drag a column header here o group by that calumn.

Name ¥ URL 7 User Name 7 Enabled for Asset View 7'

bk

Bl Canfiguration /¥, Manager Stat: rent|| Useradministrato
!

29. Click Add.
30. Enter a name for the server.
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31.

Enter the URL of the Tripwire Enterprise server.

32. Enter the name of a user account on the Tripwire Enterprise server. The account must have the

33.

following permissions: create, delete, link, load, update, view.

> Tripwire Enterprise -

Name Tripwire

Base URL | hitps:/tnpwire-e.di.ipdr
Username | tlcadmin

Passphrase

Use this server for Asset View [
Cryptographic Protocols
I ssLa [T Ts10 T TLs11 T TLS12

g’ Tripwire Enterprise Server connection successful. %

Save H Cancel ‘

Click Save.

2.19 Integration: Tripwire Log Center and Tripwire IP360

2.19.1

1.

Configure IP360 and Log Center

On the Tripwire Log Center Manager machine, navigate to C:\Program Files\Tripwire\Tripwire

Log Center Manager\Agent Services\config.
Copy bridge_sample.properties to bridge.properties.

Modify the Pre-Shared Key to use a password by changing the following line (be sure to remove the “#”

sign):

tw.cap.bridge.registrationPreSharedKey=newpasswordhere

Save the file.

From the command line, run the following two commands:

> net stop TripwireBridge

> net start TripwireBridge

On the Tripwire IP360 machine, from the command line, enter the following command to
specify the hostname of the Tripwire Log Center (TLC) machine:

> tlc config bridge host update <hostname>

Enter the following command using the preshared key specified earlier:
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> tlc config bridge password update <password>

8. Enter the following command to start the TLC service on the IP360 machine (this will use port
5670 on the TLC machine by default):
> system service tlc enable

9. Download the “Content update—June 2018” package from the Tripwire Customer Center.

10. Open the Tripwire Log Center Console.

11. Enter the username and password.

gl Tripwire Log Center Login -

TRIPWIRE®

% L0G CENTER jirpwires
Authentication Type | |nternal

Username administraior \F}L Maore
Password |
Version: 7.3.1.117 @

12. Click Login.

13. Click Options > Import TLC Content > Content.

14. Select Use a custom file.

15. Click Browse, and locate the zip file downloaded from the Tripwire Customer Center.
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A Security & Compliance Content File (or ‘Cantent File' zip format) contains a callection of TLC content, such as Normalization Rules and Tasks
In this dialog. choose to import content from the latest default content file provided by Tripwire or a custom content file created by someone in
your organization
Select the Security and Compliance Content File
O Download via the Web the latest defautt file from Tripuire

O]l fle |C

Last successful update: 6/18/72018

Select and Impart content

£ Normalization Alizses

=i Normalization Rules

[[import | hame: Revision Date_| Revision |

410 Networks 5142018
Adiscon EventReporter 5142018
Adiran Nef¥anta ADS 5472018
AIDE 5142018
Alcatel OmniSwitch A0S 5472018
Alcatel VAFi 5042018

Status | Detalled Status |
Impart Status

16. Expand the Normalization Rules section.
17. Check the box next to Tripwire IP360 VnE.
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A Security & Compliance Content File (or ‘Content File': zip format) contains 3 callection of TLC content, such 2s Normalization Rules and Tasks
In this dialog, choose to import content from the latest default content file provi Tripuire or & custom content file created by in
your erganization.

Select the Security and Compliance Content File
O Download via the ieb the Iatest default file from Tripwire
®U fle [C: ini . 731_content . i || Browse.

Last successful update: 61182018

Select and Import cantent
[ import | Name Revision Date | Revision |
Trend Micro 5142018 1
Tripp Lite BOSE Series 542018
Tripwire CCM 5142018
Tripwire Enterprise 5142018

[

Status | Detalled Status |
Import Status

18. Click Import.

2.19.2 Collect Tripwire IP360 Operational Logs

1. Click Configuration Manager.
2. Click Resources > Managers.
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Resource View - 1 Managers

Drag a column header here to group by that column

DY  Neme ¥ 1P T Status ¥ Description
» 1 Frimary Manager _arcsight-cons.diipdr Current Primary Manager

4 Tripwire Enterprise Servers
& Active Directory

Classification

3. Double-click the Primary Manager.
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Name \Prirnﬂyhhmger ‘

Description | Primary Manager ]

Audit Logger Advanced Setings =] Permissions [@ Asset-C fion Rules

Settings | Installed Modules [I# Email [%) Looging B ication |88 Proxy [ Network Collector [fid File Collector [df Advanced Windows Collector

Host Address arcsight-cons.dipd]

877

Activate Windows

[EF configuration [fgManager-Pr._|

Go to System in Control Panel to activate]

4. Click the Installed Modules tab.
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File View Options Help

‘@FQ%N RO @Y WHDG @A E O Tmefiter 24Hous  ~

Name | Primary Manager |

Description | Primary Manager |

5} Audit Logger Advanced Setiings =] Permissions & Asset-C fion Rules
|G Settings | @ Installed Modules | Email [%) Logging | (@ ication [ Proxy |13 Metwork Collector [f] File Collector [y Advanced Windows Collector
I X2 X I
D Enabled Name Type
»i 1 True I Wetwork Collecior “FLE Tletiiork Caliecior
37 Trie FLE WinLog Callecior TLE WinLeg Calector
3 @ True TLC File Collector TLC File Collector
4 @ True Advanced Windows Collector Advanced Windows Collector

5 @ Tre AdvancedFile Collector  Advanced Fill Callector
6 @ True Schedule Engine TLC Schedule Engine
7 @ True License Service TLC License Service

8 @ Tre Correlation Engine TLC Correlation Engine
9 @ True Audit Logger TLC Audit Logger

Activate Windows

Go to System in Control Panel to activate:]

[E Corfiguration ][ Manager —Pr__

5. Ensure that there is an Advanced File Collector. If not, click the Create new module button, and
specify a name. Set the type to Advanced File Collector. If there is an Advanced File Collector,
skip this step.

6. Click OK.

7. Click Resources > Asset Groups.
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Resource View - 8 Asset Groups

Drag a column header here to group by that column.

0¥ MName

Description

1 Auto-discovered Assets  Auto-discovered Assets

—« Tripwire Enterprise Servers 2
—J& Active Directory

Classification

System Group
Firevall Devices
DS Sensors

VPN Concentrators
Windows Systems
Heartblesd
ShellShock

8. Click Add.

9. Enter Tripwire VnE Managers in the Name field.

10. Click the Normalization Rules tab.

* Name | Tripwire VnE Managers |
Description | |

9 Monitored Assets | £.J Normalization Rules |5 Advanced Collector Collection |

The order below determines the priority in which the Nermalizatien Rules will be selected to process inceming log messages

+ %

Enabled ¥ Action ¥ Rule ID ¥

Name

11. Click Add.
12. Expand the Tripwire IP360 VnE group.

13. Click the Check selected rows button at the top to check the box next to everything in this

section.
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Assigned W Enabled ¥ RuleID 7

Linux Debian (55 items)

Microsoft Exchange Server (17 items)
Microsoft SQL Server (222 items)
Microsoft Windows 10 (238 items)
Tripwire Enterprise (115 items)
Tripwire IP360 VnE (157 items)

[# Group Name :
[# Group Name :
[# Group Name :
[+ Group Name :
[+ Group Name :

B Group Name :

Tripwire I[P360 VnE An Array Drive Has Failed
Tripwire |P260 VnE Attempting System Upgrade

Tripwire [P360 VnE Calculating Backup
Tripwire |P360 VnE Certificate Verification Error
Tripwire IP360 VnE Config File Imported on Upgrade

The order below determines the priority in which the Normalization Rules will be selected to process incoming log messages

& %
Enabled ¥ Action ¥ Rule D ¥ Name
n’ True  log 78128 Tripwire IP360 Vnk v7.4 Posth Terminating
@ Tue g 378138 Tripwire IF360 VnE v7 £ Postix Daemon Started
@Tre  log 278127 Tripwire IP360 VnE v7.4 Postfix Starting
@Tre  log 278124 Tripwire IP360 VnE v7.4 Failed Login User Unknown
@Tue  log 278119 Tripwire IF360 VnE v7.& Onebox Starting First Boot Configuration
@Tue  log 278121  Tripwire IP360 VnE v7.4 Onebox Already Configured
@Tre  log 278120 Tripwire IP360 VnE v7.4 Onebox First Boot Configuration Dane
@Tue g 278123 Tripwire IF360 VnE v7.4 Job Locked by Another Anacron
@Te  log 278122 Tripwire IF360 VnE v7.4 Protocel Major Versions Differ

T

15. Click OK.

16. Click Resources > Monitored Assets.
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17.
18.
19.
20.
21.
22.

File View Options Help

‘@F@% Q0@ 9 WMYBDG @ L O TimeFiter 24Hours

e REERHWe

o Tripwire Enterprise Servers
{4 Active Directory
Normalization
Correlation
Classification

Resource View - 1 Monitored Assets

Drag a column header here to group by that column

ID 7 Enabled 7 Name T IP Address 7 Hestname 7 AS
p1 .Tme TRIPWIRE-EDLIPDR 1521681136 TRIPWIRE-EDILIPDR ap

Click Add Monitored Asset.
Enter a name.

Select Advanced File Collector for Collector.

Select the IP360 server from the Hostname drop-down. It may appear as an IP address.

Enter the IP address of the server.

Select ips for Asset type.
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Log Sources

[ izt

Collector | Advanced File Collector

[v]

Hostname | 192.168.1.14¢

&[]

IP address [192.168.1.144

Location |

[v]

Assettype | lps

[+]

23. Click the Asset Groups tab.
24. Click Add.
25. Select Tripwire VnE Managers.

Tripwire VnE Managers

26. Click Add.
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27. Click the Output Destinations tab.

28. Click Add.

29. Select File=Text File for Input Type.

30. Select Correlation Engine for Output Destination.

Input Type: | File - Text File [v]

Dutput
Destination: | & (oMo =T [v]

31. Click Add.
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Log Sources

5T

Input Type Output Destination
p File- Text File m Correlation Engine

32. Click the Log Sources tab.

33. Click Add.

34. Enter a name for the log.

35. Enter /data/log/ironwood.log for Log file path.
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Hame | 1360 Irenwood |
Leg file path | /dataog/ronwood log|
Use * wildcard for one or more characters (e.g.: C:\Folder'”,
C:\FalderiFile™ t«f)
Ti format |
Example format - MMMiddlyyyy HH:mm:ss (e.g.: JAN/O1/2013
12:00:00)
Time zone offset Eg;::nﬂ'r;;r;mmmﬂmhhmmufh
This may not be y if the i is
recorded directly in UTC.
Dioes this log fik
coinmultine N0 [
events?
File |uTF2 [v]
[_concel |
36. Click OK.
37. Click Add.

38. Enter a name for the log.

39. Enter /data/log/upgrade.log for Log file path.

Name | IP360 Upgrzde |
Log file path | J/dataAog/upgrade log|
Use * wildcard for one or more characters (e.g.: C:\Folder'”,
Ci\FolderiFile” bt)
Ti format |
Example format - MMMiddlyyyy HH:mm:ss (e.g.: JAN/O1/2013
12:00:00)
Time zone offset Eg&ﬁﬁ;;ﬁmmmﬂmhhmmu{h
This may not be y if the i is
recorded directly in UTC.
Does this log fil
compinmutiine [N [
events?
File |uTF2 [v]
| Geneal |
40. Click OK.
41. Click Add.

42. Enter a name for the log.

43, Enter /var/log/messages for Log file path.
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Name | IP360 messages |
Log file path | Avarflog
Use ~ wildcard for one or more characters (e.g.: C:\Folder”,
C:\FolderiFile” bxt)
Ti format | |
Example fermat - MMMiddiynyyy HH:mm:ss (e.g.: JAN/O1/2013
12:00:00)
Adjust the timestamp to reflect the time zone of the
Time zone offset %] collecting asset.
This may not be vy if the i is
recorded directly in UTC.
Dioes this log file
contain multi-line [No [v]
events?
File |UTFe [v]

44. Click OK.

| ip360 (operational logs)

[] Setings |pls Asset Groups [ig8) Output Destinations | L] N
e

Log Sources

45. Click OK.
46. Click Resources > Managers.
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file View Options Help

‘@Ta%h A5@8 WAHYDG @G L O Tmefiter 24Hours

@ Tripwire Enterprise Servers
—& Active Directory
I gty

Manager Settings Updated

47. Select the Primary Manager and click Push Updates to Manager.

2.19.3 Configure Tripwire IP360 Scan Results Forwarding

Click Configuration Manager.

Click Resources > Manager.
Double-click the Primary Manager.
Click the Advanced Settings tab.

A wnN e
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Configuration EEE
(LA S A

=1

| Primary Manager |

] Description | Primary Manager ]

[] Setiings & Installed Modules |2, Emil %] Logging | G Authentication [ Proxy [ Network Callector [{ File Callector [y Advanced Windows Collector
] Audit Logger Advanced Settings i Permissions ) Beset-C tion Rules

+ %

Advanced Option Value
» Database Server - Query Timeout 300
Log Message Forwarding - Destinations  192.168.1.121:514:tcp

ke
I B T R =
sten trol Panel to activate
[B Configuration |[@#Manager-Pr_] Manager Status: Current User:administrator -
5. Click Add.

Select Vulnerabilities—IP360 High Value Host Threshold for the Advanced Option.

7. Enter a number between 0 and 999,999,999 for the Value. This number corresponds to the
priority level of the host system being scanned. The value entered will be the minimum value
for a host machine to be considered high priority. Half of this value will be the minimum value
for a host machine to be considered medium priority.
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@M% 0 0@ ¥ MBI @@L O Timefiter 24Hours -
Views a [ §
- ] Configuration E“E“Z‘
p— Ed@ O Xm
!_-QJ (= =
ashbo i
I Name | Primary Manager |
] Description | Primary Manager |
Logging [ (5 Authentication | @8 Proxy [ Network Collector |[] File Collector |dffy Advanced Windaws Collector
g Permissions & Asset-C fion Rules
& %
Advanced Option Value
Database Server - Query Timeout 300
5 Log Message Forvarding - Destinati 192.168.1.121 514:1cp
Aud N bilties - IP360 High Valuz Hos old [
Discovered
oK Cancel — .
Lom | [ | [ Activate Wir

Go to System in anel to activate]

Manager Status: Current| User:administrator

[Al Configuration | WanagerPr-_]

8. Click Add.

9. Select Vulnerabilities—IP360 High Risk Score Threshold for the Advanced Option.

10. Enter a number between 0 and 999,999,999 for the Value. This number corresponds to the risk
level of a vulnerability event. The value entered will be the minimum value for an event to be

considered high risk. Half of this value will be the minimum value for an event to be considered
medium risk.
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File View Options Help
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Configuration

Permissions

Log Message Forwarding - Destinations ~ 192.168.1.121:514:1cp
Vulnerabilities - P360 High Value Host Th 100
Vulnerabilities - P380 High Risk Score Th 3000

Activate Windows

Go to System in Control Panel to activate]

11. Click Apply.
12. Click OK.
13. Click Resources > Monitored Assets.
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File View Options Help
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—4® Tripuire Enterprise Servers
—j& Active Directory
Normalization
Correlation
Classification

Resource View - 2 Monitored Assets

Drag a column header here to group by that colurmn.

ID¥ Enabled ¥ Name 7 IPAddress ¥ Hostame ¥ £
p 4 @True  ip380 (operationallogs) 192.168.1.144  tw3B0.di ipdr i
[t @Tue TRPWREEDIFDR 1821681138 TRIFWREEDIFDR =

14. Click Add Asset.

15. Select TLC File Collector for Collector.
16. Enter the IP address of the IP360 machine.

17. Select ips for Asset type.
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[) Setings |y Asset Groups |85 Output Desti

Collector | TLC File Collector

IP address | 1521681144

Location |

Asset type | ips

18. Click the Asset Groups tab.

19. Click Add.

20. Select Tripwire VnE Managers for Host Group.
21. Click Add.
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Description

u Tripwire VnE Managers

22. Click the Output Destinations tab.
23. Select File-1P360 for Input Type.
24. Select Events for Output Destination.

Input Type: | File - IP360

Output
Destination: | 3 (2000

25. Click Add.
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26. Click OK.
27. Click Resources > Managers.
28. Select the Primary Manager.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

406



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

le View Options Help

Q%W 5@ MG @ L O TimeFiter 24Hours
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@ Tripwire Enterprise Servers
—& Active Directory

-] Normalization

& Normalized-Message Fields
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29. Click Push Update to Manager.
30. Log in to the Tripwire IP360 Web Console.
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< (& |A Mot secure | hitps://tw360/ui/#/dashboard/2
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TRIPWIRE® .
. ngso = 4 2] 1 1
Legacy Ul Notifications Help Settings Default
* El

Logout

o

SCANNING TRIPWIRE ENTERPRISE REPORTING
(ax - ~ o)
i SCHEDULED SCANS cou
u Name “  Scan Profile Network Pool Type Status
No Scheduled Scans Available -
®aAdd 2 Edit TiDuplicate [ Delete &) Scan < 0” >
L J

if SCAN ACTIVITY

No Scans Available

31. Click Legacy Ul at the top.
32. On the left, click Administer > System > VnE Manager > Automated Export.

P s A= 2

2

L Name Duration End Date ~ Hosts Score Result .

& C | & rotsecure | s | 3
A e Heip + Wy Account « Log Ot
. Cursemd VIE o Boemsl  Lasl Sackunn s e o iy sk + 0 Wansied Sactutn Quisklins

\ File export status: Inactive
& Syatem DB aupod status Inactive
Autormated sxpor angine status: Acthve

Last Export Time: 082472018 00:05
4~ Genecal Extemal database schama version: 1.0

33. Click the Export to File tab.
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34,
35.
36.
37.
38.
39.
40.

Click Modify.

Enter the username of a TLC user account for User.
Enter the IP address of the TLC Manager for Host.
Enter “/” for the directory.

Select Active.

Select SSH2 DSA (sftp) for Protocol.

Select XML2 for Format.

Y C | Mot secure | Beps//wWIB0/inder ice T class = indexlidn | O
e G Help + My Acsount - Log Out
E Currant NE mads Hormal Lt iy ews Puam o iy sl « 0 rarntsme backps. -

[ Discover
& Anaiyze

'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

41. Click Submit.

[, Focus
4+ Respond

Q, Artmaiuer

o System
+- 1t Dashbosd

| Eosdguntsn | Oxpoctiafis |
| “User | administraton
“Host: 152 168 1 143
“Directary: 1

ashedes gedsilive
=oWS05s]

e s

YEAGI01 8T e TR T iv s Yk Intda TS SXQtADY

RER1TECEETEND:

VITTa3341 TR avse

caha4dzivwes Tripwire IFI60 Consale

Downiosd Key P | Format - Infine], [SECSH]

Status: | #Acie Clnacive
hm:i SSH2 DSA (shp) o
crmat: || ¥HLZ ) ]

42. Download the generated key by clicking [Inline].

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events



'§2-008T°dS LSIN/8Z09°0T/840°10p//:sdny :wouy d84eyd 4o 3.4 d|qejieAe si uonedljqnd siy |

43. In TLC Console, click Configuration Manager.
44. Click Resources > Managers.

File View Optiens Mep
‘@fQ% 1508 WORS WO LG Tmeliter Hom ~

Foscusce Vorw - 1 Mansgess

e———

Lo s ¥ L2 o Stha 7 Descrighon ¥

45. Double-click the Primary Manager.
46. Click the File Collector tab.
47. Ensure that the Collect log messages via FTP and SSH option is enabled.

48. Enter 22 for the port. (Note: The IP360 Integration Guide says to use a different port, but the

IP360 system appears to be unable to use a port other than 22.)
49. Click Add.
50. Under Users, select the user for whom the key was generated.
51. Under Key Path, enter the path to the downloaded key.
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52. Click OK.

53. Select the Primary Manager.

54. Click Push Updates to Manager.

55. On the IP360 web console, click Test to ensure that the connection is successful.
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56. Any recurring scans will now forward the scan results to Tripwire Log Center. To ensure that a
scan is recurring, select a scan in Scan Profiles on the main dashboard of the IP360 web console.
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& O | A Notsecwe | isteps/ 36000 # dashbosrd/2 |0
i SCHEDULED SCANS

if SCAN ACTIVITY

= -~ en 3 BT > ~ =
= NETWORKS o o i SCAN PROFILES 17007 | ¥ re =T 0
J b Trpwrs; Agoranty Agent Only o
1 p  Trowae Deep Scan Profie Viener abity (-]
v Trgwn: Hom mvanioey Doncwer o
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57. Click Edit.
58. Click Next until the Scan Schedule page.
59. Select Recurring, and set a schedule for the scan according to the needs of the organization.

Ll | Mot secure | e tw360/uy # dashbosrd/2 | O

Edit Scan Profile
SCAN SCHEDULE

Mo mere than 1 Jpergay  +

TIN TONF
GMT

@ cancel @ Finsh ©) Nesa

60. Click Finish.

2.20 Integration: Tripwire Enterprise and Backups

This section details how to back up Tripwire Enterprise configuration data.

To back up Tripwire Enterprise integrity information, refer to the database vendor’s documentation for
backing up data.
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2.20.1 Export Configuration from Tripwire Enterprise

1. On the Tripwire Enterprise server, navigate to C:\Program Files\Tripwire\TE\Server\bin.
Run the following command to stop Tripwire Services.
> twservices stop
3. Run the following command to export the configuration files to a backup (replace config.bak
with the desired name of the backup).
> tetool backup config.bak

4. Run the following command to restart Tripwire Services.
> twservices start

2.20.2 Back Up the Tripwire Enterprise Configuration

The configuration backup will be stored in the file specified in step 3 of the previous section. To back
this up to the enterprise backup server through a Duplicati client, see the documentation in Section
2.8.4 for how to set up a Duplicati instance on the Tripwire Enterprise server, and then simply select
the configuration file.

2.21 Integration: Cisco ISE and CryptoniteNXT

This section details an integration between Cisco ISE and CryptoniteNXT, allowing ISE to dictate the
Cryptonite registration process based on the posture of the client machine. Please see the
CryptoniteNXT Generic RADIUS Integration Guide for more details about the integration.

2.21.1 Requirements for Integrating Cisco ISE and CryptoniteNXT

As described in the ISE installation section, ISE requires RADIUS to be configured to perform posture. As
such, this guide assumes the use of some sort of switch to provide RADIUS functionality.

CryptoniteNXT requires the switch to use L2 technologies for the RADIUS server, which means a captive
portal will not work for this scenario. The feasibility of this depends on your networking setup.

This integration requires the following:

The switch is bridged to CryptoniteNXT.
Cryptonite is configured to accept RADIUS packets from the switch (detailed below).

3. Clients on the switch’s Local Area Network (LAN) authenticate to the switch via 802.1x (see your
switch’s documentation).
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2.21.2
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Y
N B O

The switch is configured to accept CoA packets from ISE (see ISE installation).

The switch sends RADIUS accounting and authentication packets to Cisco ISE (see ISE
installation).

ISE sends an authentication response to the switch and then later uses CoA to modify the
authorization based on posture (see ISE installation).

If the authorization is successful, the switch tells the client and forwards the accounting packets
to the CryptoniteNXT ACC node (see your switch’s documentation).

Configuring CryptoniteNXT for RADIUS

Open the CryptoniteNXT GUI and log in.

Navigate to the CryptoniteNXT Nodes tab.

Click Enable Editing.

Select the Endpoint node, which will have your switch attached to it.

Under Endpoint Node-Specific Configuration, select Strict Access for Access Control.
Select After Delay for the next field.

Enter -1 for Captive Portal delay.

Enter 5 for the Registration delay.

Select the Gateway node.

. Click Save.
. Navigate to the Integration tab.
. Under Built-In RADIUS Configuration, check the box next to Enable Built-In RADIUS Accounting

Server.
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13. Click the plus button to add the IP of the switch as well as a shared secret. You can use 0.0.0.0/0
as the IP to accept RADIUS Accounting packets from all IPs, however this is not recommended in
production.

2.22 Integration: Backups and GreenTec

This section details integration between the backup capability and GreenTec WORMdisks. Because
GreenTec WORMdisks provide write protection for files on the disk, they are an ideal place to store
important backups. There are a couple options for this integration, but before these backups can be
replicated onto secure storage, it is important to be able to identify the location of backups to be
replicated.

2.22.1 Locate Backups with FileZilla and Duplicati

1. To locate backups in FileZilla, open the FileZilla Server console.
2. Click Edit > Users.
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Account settings Users
[v| Enable account
gl d folders [ password: | George
pezd Limits -
L. IP Filter Group membership: | <none =

"] Bypass userlimit of server

Maximum connection count: D
Connection limit per IF: D

[]Force TLS for user login

Description

You can enter some comments about the user

3. Click Shared folders in the left pane.

] Shared folders Users
Files =
General Directories 7 Rad

Shared folders Py R George

speed Linits ] C: backups admi... [ Wite
‘.. TP Filter [ Delete
(] Append
Directories
[ Create
[ Delete
[w] List
[<] n | [>]| [+ Subdis | add | Remove |

| #ad || Remoe || Rename | |setashomedr| [ Repame [| comy |

A directory alias will also appear at the specified location. Aliases must contain the full virtual
path. Separate multiple aliases for one directory with the pipe character (1)

If using alizses, please avoid cyclic directory structures, it will only corfuse FTP clients.

4. Under Directories is a list of directories in which the selected user can store backups. The one
marked H is the default home directory.
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5. The path to the backups from the home directory is specified in the Path on server field in

Duplicati (see Section 2.8.6).
windows 101 badups | =&

6. Each backup should have three associated files. An easy way to determine what files belong
together is to check the Date Modified field. These files are encrypted.

2.22.2 Back Up to a GreenTec Disk

The first, most flexible option involves backing up the backup server to a separate server with GreenTec
WORMdisks. Simply set up a FileZilla server on the GreenTec storage server and a Duplicati client on
the backup server (see Section 2.8 for these installation processes). When choosing where to store files
on FileZilla, indicate a folder on the GreenTec WORMdisk. Sectors of the disk can be locked using the
mechanism in Section 2.6.4, providing firmware-level write security for any backups in the locked
sectors.

There are some considerations when doing this. First, if this is done on a schedule and permanent locks
are used, space will be consumed quickly and the WORMdisks will need replacements as the space
cannot be reused. The trade-off between space and backup frequency must be considered—a lower
backup frequency inevitably means more data loss in the event of a restoration, while higher backup

frequency increases the cost of maintaining secure storage.

Alternatively, secure storage can be used for specific types of backups, such as “golden disks”—which
would contain backups of the basic level of functionality required for the enterprise without necessarily
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utilizing a backup schedule. This would afford protection for some basic functionality but would forfeit
the secure storage capability for day-to-day data.

In addition to the options above, there are other ways to minimize wasted space on a GreenTec disk.
Temporary Locks, or TLocks, can be employed after the data is backed up to a GreenTec disk to protect
data integrity while making less space unavailable for future use. After the drive is full, a permanent lock
should still be executed. Wasted space can also be minimized with the use of dynamic partitions, or
with the Force-Field Write-Once File System, which can also reduce the overhead administration of the
GreenTec disk.

2.22.3 Configure Network-Accessible GreenTec Disk

Another option for GreenTec disks is to make them network accessible. This allows them to be used
specifically in situations where secure storage protection is desired, and it makes them options for
backup locations even on servers to which they are not necessarily physically connected.

1. To configure a GreenTec disk to be network accessible, right-click the disk on the GreenTec

server.
Sl ERc Drive Tools This PC |- [o [
Computer View Manage v 0
© - 1 [y Thiskc v & [ Search This PC 2|
e - UCVILSS allu Jnives (1) A
A Favorites wm  Local Disk (C) DVD RW Drive (D:) GreenTec-USA
Bl Desktop .- -

& Downloads

1= Recent places

=, I
S 250 GE free of 135 GB

DIo01 (E:)

S 153 GB free of 465 GB

&g/ 567 MB free of 702 ME

NISTO10 (F)

" 2 775 GB frec of 176 GB

1™ This PC
| Destiop " ﬂ-BACKUP_(G:_}_ o NISTOT2 ()
El Documents || W 703 GE free of 7.6 GB S 7758 e of 176 GE
oy -Dounlback NISTODT (R) _ NISTOS2 (51
j :z;s S0 515 GB fres of 77.6 63 S0 7758 fres of 776 GB
B Videos ISTO03 [T NISTO04 U}

iy Local Disk (C:)
&% DVD RW Drive (D
ca DIODT (E)

[ NISTO10 (F)

[a AD-BACKUP (G:)
ca NISTO12 (H:)

S 75 Bfeeof 77668

NISTD03 (V)

77.5 GE firee of 7.6 GB
NISTOO7 (X))

Vf;;:;?‘ 77.5 GB[ee of 7.6 GB

| S TscefecciTinGE

NISTOO6 (W)

S TsGefecotT6GE

V}HSTDDS _(Y:]"

| S 7758 e ot TI6GE

= NISTOOT (R:)
= NISTOD2 (S} NISTOOS (Z)
NISTO03 (T: o
= 1E) 0" 77568 free of 77668 v
MISTANL 1Y

21items  1item selected

2. Click Share With > Advanced Sharing.
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Shadow Copies | Previous Versions | Quota | Customize

General | Tools | Hadware | Shaing | Secuty

Netwaorl File and Folder Sharing

. KN
4 Mot Shared

Network Path:
Mot Shared

Advanced Sharing

Set custom permissions, create multiple shares, and set other
advanced sharing options.

By Advanced mm...

3. Click Advanced Sharing.
4. Check the box next to Share this folder.
5. Enter a name for the drive if desired.
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o NIST007 (X:) Properties e

[w] Share this folder
Settings
Share name:
[x

| Add ” Remove

Limit the number of simultaneous users to:

Comments:

[ | [ e A (Bl

6. Click OK.
7. Click Close.
8. The drive should now be accessible at //SERVER-NAME/X.

2.22.4 Secure Storage for Semperis ADFR

1. On the Semperis ADFR server, the default backup location is C:\Semperis.
2. Inthis folder there is metadata for the backups (C:\Semperis\ADFR) as well as the backups
themselves (C:\Semperis\BackupStore).

nme Share Wi v
s ) E
@ = T | . » ThisPC » Local Disk (C:) » Semperis » W G‘ | Search Semperis o
5 Aon REMOTEDE ~ Name Date modified Type Size

¥ € on REMOTEDE
¥ D on REMOTEDE
__H Desktop

_E Documents

j Downloads

_ﬂ Music %
_El Pictures

i Videos

£, Local Disk (C3)
8 DVD Drive (D7) IR|_|

| ADFR 8/9/2012 10:00 AM File folder
| BackupStore 8/13/201812:03 PM  File folder

€ Network il
2Zitems  1item selected
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It is important to consider the limitations of the backup software when considering whether to replicate
backups to secure storage. Ideally, the replication of backups ensures that they can be used on a
separate server when the original server is affected by an incident. The replication of backups in this
case can offer some write protection for these specific backup files, but if the entire server is lost, it is
not guaranteed that the backups will be usable on a new instance of ADFR. This risk can be mitigated by
exporting the configuration of the ADFR server for the purpose of building a failover ADFR server.

Though these backups can be replicated to WORMdisks, this is currently not supported by Semperis
ADFR. Instead, Semperis ADFR offers a different type of “secure storage” by not joining to the domain,
allowing the machine to be taken offline and brought online only during creation/application of a
backup.

2.23 Integration: Micro Focus ArcSight and FileZilla

In this section an integration between ArcSight and FileZilla is detailed so that logs from FileZilla are
forwarded to ArcSight by using an ArcSight syslog file connector.

2.23.1 Enable Logs in FileZilla

1. On the server with FileZilla installed, open FileZilla Server.

FileZilla Server (127.00.1) =-|0 -
Server Edit 2
e nghr ce@-
018 212813 PM - ot logged
2/2018 21: 2818 PM -

sritten by Tim Kosse fim kosse @fleaila-project org)
Please visit https:/Ailezila-project .ong/

UTH TLS

M - {not logged in) (192.168.1.138)> 234 Using authentication type TLS

- fnot logged in) (192.168.1.138} TLS connection established

- {not logged in) (192.168.1.138)> USER george

- {not logged in) (192.168.1.138)> 321 Password required for george

Protection level set to P
PTS uif8 on
02 UTFB made is always enabled. No need to send this command

/"is curent directory

M - george (192.168.1.138]
- george (192.168.1.138)
8/22/2018 21:28:18 PM - george (192.168.1.138]
8/22/2018 21:28:18 PM - george (192.168.1.138)
2/2018 21:28:18 PM - george (192.168.1.138]
22/2018 21:28:18 PM - george (192.168.1.138)
18/22/2018 21:28:18 PM - george (192.168.1.138)> 221 Goodbye
000086)8/22/2018 21:28:18 PM - george (192.168.1.138)> disconnected.

Retrisving seftings, plesss watt

Done retrieving settings s

Entering Passive Mode (192,168,1,121,199,178)
ETR windows 101backups/duplicati-bd$a79b0d47124d 805 248 3af8d6be 379 dblock zip aes
50 Opening data channel for file download from server of "/windows 101backups/duplicati-bd%a 79b 0d4 7124d80a 248 3af 8d6be 379.dblock zip aes”
LS connection for data connection established
26 Successfully transfemed " /windows 10Tbackups/duplicati-bd 9a 790 0d4 7124d80a245f 3af 8d6be 379 dblock zip aes”
UIT

D ¢ Account 1P Transfer Progress Speed

7,712 bytes received 0B/s 38,760 bytes sent 0B/s X

2. Click Edit > Settings.
3. Click Logging.
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=- G_eneral settings

- Passive mode settings

- Security settings

- Miscellaneous

- fdmin Interface settings
- Gpeed Limits

- Filetransfer compression
- FTP aver TLS settings

- Autoban

Logging

["]Enable logging to file

[ Limit log file size to KB

Logfile type:
(®) Log all to 'FileZilla Server.log'
() Use a different logfile each day (example: fzs-2003-02-10.log)

[ pelete old logfiles after days

All log files will be saved in the "Logs™ subfalder in the FileZilla Server folder.

R

4. Check the box next to Enable logging to file.

FileZilla Server
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[=]- General settings
i Welcome message
i~ IP bindings
- IP Filter
- Passive mode settings
- Security settings
- Miscellaneous
- fdmin Interface settings
- Logging
- Gpeed Limits
- Filetransfer compression
- FTP aver TLS settings
- Autoban

5. Click OK.

Logging

[+ Enable logging to file

[]uimit log file size to 100 KB

Logfile type:
(®) Log all to 'FileZilla Server.log'
() Use a different logfile each day (example: fzs-2003-02-10.log)

[ pelete old logfiles after days

All log files will be saved in the "Logs™ subfalder in the FileZilla Server folder.

2.23.2 Install Micro Focus ArcSight

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe.

FileZilla Server
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2.
3.

<CArcSight | CIFASETD

ma

= Introduction

@ Choose Install Folder
@ cChoose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

® Upgrade

@ System Restart

@ Install Complete

BE |

Introduction

ArcSight SmartConnector

The ArcSight Installer will guide you through the installation
ofthe ArcSight SmartConnector.

The first step installs the core ArcSight SmarConnector
components; then you selectthe ArcSight SmartConnector
youwish to configure.

ArcSight recommends that you quit all other programs
hefore continuing with this installation.

Click the Mext' button to proceed to the next window.
[fyou wantto change something on a previous window, [%s
click the 'Previous' button. To cancel this installation at

any time, click the 'Cancel' button.

Previous

Click Next.

Enter C:\Program Files\ArcSightSmartConnectors\Windows.

<CArcSight | CIFAET

mo

+ Introduction

= Choose Install Folder
@ Choose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

® Upgrade

@ System Restart

@ Install Complete

=E |

Choose Install Folder

ArcSight SmartConnector

Please choose the installation folder. It is recommended that you
choose the folder name according to the device that you want to
connect to, for example fciscoids or icheckpointng. If you are
upgrading from a previous version, please select the folder where the
ArcSight SmartConnector is currently installed.

Where Would You Like to Install?
C\Program Files\ArcSightSmanConnectors\Windows

Restore Default Folder || Choose...

Previous | | Mext
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4. Click Next.

<CArcSight  CIFAERE

+ Introduction

v Choose Install Folder
+ Choose Install Set
= Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

@ Uparade

@ System Restart

@ Install Complete

(= [ |

Pick Shortcut Folder

ArcSight SmartConnector

Where would you like to create product icons?

® In a new Program Group: | ArcSight SmartConnectors

O Inthe Start Menu

() On the Desktop

) In the Quick Launch Bar

) Other Choose...

() Don't create icons

[] Create Icons for All Users

&

Previous | | Met |

Click Next.

<CArcSight | CIFAET

mo

+ Introduction

+ Choose Install Folder
+ Choose Install Set

+ Pick Shortcut Folder

= Pre-Install Summary

@ Installing...

® Upgrade

@ System Restart

@ Install Complete

=E |

Pre-Install Summary

ArcSight SmartConnector

Please Review the Following Information Before Continuing:

Product Name:
ArcSight SmanConnector

Install Folder:
C/\Program Files\&rcSightSmarConnectors\Windows

Shortcut Folder:
Cilsers\ddministrator.DippData\RoamingMicrosoftWindows\Ste

Previous || Install |
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6. Click Install.
7. Select Add a Connector.

B Connector Setup = | = -

What would you like to do?

<X ArcSight

Configure

(®) Add a Connector

() Set Global Parameters

a
£

@
w
3
v

]
m

8. Click Next.
9. Select Syslog File.
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| Connector Setup = = -

Select the connector to configure

<X ArcSight

Configure

Type |SyslogFile Y]

< Previous | | Next = | | Cancel

10. Click Next.
11. Enter C:\Program Files (x86)\FileZilla Server\Logs\FileZilla Server.log for File Absolute Path
Name.
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Enter the parameter details

<X ArcSight

Configure

File Absolute Path Name

x| Connector Setup

s (x88) \FileZilla Server\Logs\FileZilla Server.log l:‘

realtime

Reading Events Real Time or Batch v
Action Upon Reaching EOF Mone w
File Extension If Rename Action processed|

< Previous | | Next = | | Cancel

12. Click Next.
13. Select ArcSight Manager (encrypted).
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x| Connector Setup = = -

Enter the type of destination

<X ArcSight

Configure

(®) ArcSight Manager (encrypted)

() ArcSight Logger SmartMessage {encrypted)

() ArcSight Logger SmartMessage Pool (encrypted)
() CEF File

() Event Broker

() CEF Syslog

(") CEF Encrypted Syslog (UDP)

() €3V File

() Raw Syslog

b

< Previous | [ Next> | Cancel

14. Click Next.
15. Enter the hostname, port, username, and password for the ArcSight ESM server.
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x| Connector Setup = = -

Enter the destination parameters

<X ArcSight

Configure

Manager Hostname arcsight-esm

Manager Port 3443

User administrator

Password XTIy

AUP Master Destination |false v
Filter Out All Events false v
Enable Demo CA false v

I

< Previous | | Mext = | | Cancel

16. Click Next.
17. Enter identifying details about the system (only Name is required).
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B Connector Setup = | = -

Enter the connector details

<X ArcSight

Configure

Name FileZilla Logs
Location
DevicelLocation

Comment

< Previous | | Next > | | Cancel

18. Click Next.
19. Select Import the certificate to connector from destination.
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| Connector Setup == -

. Following certificate will be imported into connector trust store:
é: AfCSIg ht Host/port: arcsight-esm_3443
Details: CN=arcsight-esm, OU=ESM, O=Arcsight, L=03014, ST=CA, C=US
Configure

(@) Import the certificate to connector from destination

(_) Do notimport the certificate to connector from destination

< Previous | [ Mext> | Cancel

20. Click Next.
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B Connector Setup = | = -

. Add connector Summary
é: A’C5|ghf Following are the added connector details:
Connector Name [FileZilla Logs], Connector Type [syslog_file]

Configure

1=}
m
a

us MNext > | | Cancel

21. Click Next.
22. Select Install as a service.
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x| Connector Setup = = -

The Smart Connector is currently installed as a standalone application

<X ArcSight

Configure

(®) Install as a service

() Leave as a standalone application

%

< Previous | [ Next > Cancel

23. Click Next.
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 x | Connector Setup = | = -

Specify the service parameters

<X ArcSight

Configure

Service Internal Name syslog_file
Service Display Name Syslog File
Start the service automatically | Yes % W

< Previous | [ Next> | Cancel

24. Click Next.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

435



"GZ-008T"dS’ 1SIN/8Z09°0T/840°10p//:50d11y :woJ) 984D Jo 9344 d|qe|ieAe s| uonealjgnd siyL

x| Connector Setup = = -

Install Service Summary

<X ArcSight

Configure

The ArcSight SmartConnector is now configured to run as a service.
You can now start the SmartConnector by
Going to the services application and starting the service:

ArcSight Syslog File

Cancel

25. Click Next.
26. Select Exit.
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B Connector Setup = | = -

‘Would you like to confinue or exit?

<X ArcSight

Configure

() Contirue

< Previous | | MNext > | | Cancel

27. Click Next.
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B ArcSight SmartConnector I;‘i-

<CArcSight  [IFLERE Install Complete

<

Introduction Congratulations! ArcSight SmartConnector has been successfully
Choose Install Folder installed to:

Choose Install Set
Pick Shortcut Folder
Pre-Install Summary Prass "Done” to quitthe installer.

C\Program Files\ArcSightSmartConnectorsWindows

Installing...
Upgrade
System Restart

L S Y T T Y

Install Complete

InstallAmawhare
Ca % Previous

28. Click Done.

2.24 Integration: Micro Focus ArcSight and Tripwire

This section details forwarding logs from Tripwire Log Center to Micro Focus ArcSight. This will forward
Tripwire IP360 and Tripwire Enterprise logs to ArcSight, assuming those logs are being collected by
Tripwire Log Center.

2.24.1 Install Micro Focus ArcSight

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe on any server except the one running Tripwire
Log Center.
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3.

<CArcSight | [CIFLERE

=» Introduction

@ Choose Install Folder
@ Choose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

® Upgrade

@ System Restart

@ Install Complete

(= [= |

Introduction

ArcSight SmartConnector

The ArcSight Installer will guide you through the installation
ofthe ArcSight SmartConnector.

The first step installs the core ArcSight SmantConnector
components; then you selectthe ArcSight SmatConnector
you wish to configure.

ArcSight recommends that you quit all other programs
before continuing with this installation. E[%

Clickthe Mext' button to proceed to the next window.
Ifyou wantto change something on a previous window,
click the 'Previous' button. To cancel this installation at
any time, click the 'Cancel’ button.

Previous

Click Next.

<C ArcSight | [IFAER

(=]

« Introduction

=* Choose Install Folder
@ Choose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

® Upgrade

@ System Restart

@ Install Complete

(= [= |

Choose Install Folder

ArcSight SmartConnector

Please choose the installation folder. 1t is recommended that you
choose the folder name according to the device that you want to
connect to, for example /ciscoids or /checkpointng. If you are
upgrading from a previous version, please select the folder where the
ArcSight SmanConnector is currently installed.

Where Would You Like to Install?
C:\Program Files\ArcSightSmantConnectors\Tripwire|

Restore Default Folder || Choose...

| Previous | | Mext

Enter C:\Program Files\ArcSightSmartConnectors\Tripwire.

NIST SP 1800-25C: Identifying and Protecting Assets Against Ransomware and Other Destructive Events

439



"GZ-008T"dS’ 1SIN/8Z09°0T/840°10p//:50d11y :woJ) 984D Jo 9344 d|qe|ieAe s| uonealjgnd siyL

x| ArcSight SmartConnector M

Pick Shortcut Folder

ma

<CArcSight | IFAETD

+ Introduction Where would you like to create product icons?
+ Choose Install Folder
v Choose Install Set

® In a new Program Group: | ArcSight SmartConnectors

- Pick Shortcut Folder ) In the Start Menu

@ Pre-Install Summary ) Onthe Desktop

@ Installing...

@ Upagrade () In the Quick Launch Bar

® System Restart
@ Install Complete

O Other: Choose...

() Don't create icons

[[] Create Icons for All Users

Previous | [ Mext

4. Click Next.

B ArcSight SmartConnector \;‘i-

<X ArcSight | CIHFLED

ma

Pre-Install Summary

+ Introduction Please Review the Following Information Before Continuing:
v Choose Install Folder
+ Choose Install Set

+ Pick Shortcut Folder

Product Name:
ArcSight SmarConnector

- Pre-Install Summary Install Folder:
) C\Program Files\ArcSightSmanConnectors\Tripwire
® Installing...
@ Upgrade Shortcut Folder:
@ System Restart Ci\Users\administrator DIVAppData\Roaming\Micros oftWindows\Ste

® Install Complete

s

Previous || Install  §

5. Click Install.
6. Select Add a Connector.
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H Connector Setup

What would vou like to do?

<X ArcSight

Configure

(®) Add a Connector

() Set Global Parameters

MNext =

Cancel

7. Click Next.
8. Select Syslog Daemon.

B Connector Setup

Select the connector to configure

< ArcSight

Configure

< Previous | |

Mext =

Cancel
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9. Click Next.
10. Enter a port for the daemon to run on.
11. Select Raw TCP for Protocol.

< ArcSight

Configure

Connector Setup

Enter the parameter details

Network Port | 514
IP Address (ALL)

Protocol Raw TCP

Forwarder false

< Previous | |

MNext =

Cancel

12. Click Next.
13. Select ArcSight Manager (encrypted).
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B Connector Setup = | = -

Enter the type of destination

< ArcSight

Configure

(® ArcSight Manager {encrypted)

() ArcSight Logger SmartMessage (encrypted)

() ArcSight Logger SmartMessage Pool (encrypted)
(O CEF File

() Event Broker

(") CEF Syslog

() CEF Encrypted Syslog (UDP)

(O €SV File

() Raw Syslog

< Previous | [ Next> | Cancel

14. Click Next.
15. Enter the hostname, port, username, and password for the ArcSight ESM server.

B Connector Setup = | = -

Enter the destination parameters

< ArcSight

Configure

Manager Hostname arcsight-esm

Manager Port 3443

User administrator

Password LTTTTITTY

AUP Master Destination | false %
Filter Qut All Events false W
Enable Demo CA false v

< Previous | | MNext = | | Cancel
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16. Click Next.
17. Enter identifying details about the system (only Name is required).

B Connector Setup == -

Enter the connector details

<X ArcSight

Configure

Name Tripwire Log Cenher|
Location
DeviceLocation

Comment

< Previous | | Mext = | | Cancel

18. Click Next.
19. Select Import the certificate to connector from destination.
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20

B Connector Setup = | = -

. Following certificate will be imported into connector trust store:
{ ArcSi 9 ht Host/port: arcsight-esm_8443
Details: CN=arcsight-esm, OU=ESM, O=Arcsight, L=05014, ST=CA, C=US

Configure
e Import the certificate to connector from destination
() Do not import the certificate to connector from destination
< Previous | [ Next> | Cancel |
Click Next.

[« | Connector Setup == -

. Add connector Summary
{ AfCSIght Following are the added connector details:
Connector Name [Tripwire Log Center], Connector Type [syslog]

Configure

us Next = | | Cancel

21. Click Next.
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22.

23.

Select Install as a service.

[« | Connector Setup

The Smart Connector is currently installed as a standalone application

<X ArcSight

Configure

(@) Install as a service

() Leave as a standalone application

< Previous | [ Next >

Cancel

Click Next.
B Connector Setup
. Specify the service parameters
< ArcSight
Configure

Service Internal Name syslog
Service Display Name Syslog Daemon
Start the service automatically Yes W
< Previous | [ Next> | Cancel
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24. Click Next.
[« | Connector Setup = I:'-

Install Service Summary

<X ArcSight

Configure

The ArcSight SmartConnector is now configured to run as a service.
You can now start the SmartConnector by:
Going to the services application and starting the service:

ArcSight Syslog Dasmon

< Previous Next = | | Cancel

25. Click Next.
26. Select Exit.
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H Connector Setup =0 -

Would you like to continue or exit?

<X ArcSight

Configure

() Continue

< Previous

MNext = | | Cancel

27. Click Next.

B ArcSight SmartConnector \;‘i-

System Restart

<CArcSight | CIFAERE Install Complete
v Introduction Congratulations! ArcSight SmartConnector has been successfully
+ Choose Install Folder installed to:
¥ Choose Install Set C:\Program Files\ArcSightSmartConnectorsiTripwire
+ Pick Shortcut Folder
+ Pre-Install Summary Press "Done” to guit the installer.
+ Installing...
+ Upgrade
v
_)

Install Complete

28. Click Done.
29. Open the Tripwire Log Center Console.
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30. Go to the Configuration Manager.

file View Options Help

‘@FQ% 2@ 8 WAYDG @ T L O Tmefiter 24Hous =

&gy Asset Groups
Locations
Datebases
& Tripwire Enterprise Servers
—§& Active Directory
Normalization
Correlation
Classification

Drag a column header here to group by that column.

Dv b4 P 7 Satus 7 Description
» 1 Priny Manager arcsight-cons diipdr Current Primary Manager

[0 Configuration

Manager Status: Current| Us

31. Select Resources > Managers.

32. Double-click the Primary Manager.
33. Click the Advanced Settings tab.

File View Options Help

‘'R@FEQ% A p @8 WMYHYD S @ O L @ Tmefiltler 24Hours  ~

Configuration

Mame | Primary Manager

Description | Primary Manager

Asset-Ce tion Rules

| Frowy B Network Collector Lﬂr File Collector |y Advanced Windows ¢
=] Permissi )

Value

[3 Configuration |[@ Manager - Pr.._| [y Manager - Pr._. | [ Manager - Pr...

| Manager Status: c.nmtwmmw
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34. Click the Add button.

35. In the Advanced Option box select Log Message Forwarding—Destinations.

36. In the Value box next to it, type <ip_address>:<port>:tcp with the IP address and port of the

syslog daemon just created.

Successfully forwarded test log message to destination
192.168.1.121:514

37. Click OK.

-

File View Options Help

R@F@% Ao @Y WMYHYDL G IO Timefiter 2Hous ~

Views @
= Configuration [—[[a][x]
= =
. =
Dashbo
o
- Authentication 85 Network Collector | [ File Colloctor |#fl Advanced Windows Collector
Vi Permissions ]
9 wil %
o b Advanced Option Value
. @ |  Database Server - Query Timeout 00

@ » Log Message Forwarding - Destinations 192.168.1.121:514:1cp

foly |

Manager Saved

[@ Configuration |8 Manager - Pr._] /i Manager Status: Not Current | User: Administrator, -

38. Click OK.
39. Restart the Tripwire Log Center Manager.
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2.25 Integration: Micro Focus ArcSight and Cisco WSA

This integration briefly details how to send logs to an ArcSight syslog collector from Cisco WSA. Please
see Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already
configured, you do not need to install a new one—simply forward logs to the address of that server.

2.25.1 Configure Cisco WSA to Forward Logs

1. Inthe Cisco WSA web client, navigate to System Administration > Log Subscriptions.

| #= Cioes Wb Securny Virusl Appl % :<+ ) |H’ .l o
L c re | eoeus.diipdrBiiisystem administration/log_subscriptons * O

L corade Avniatle v | Logged in as: on coeus.dl.igdr

My Favorites - Ogtions < Support and telp -

[, Reporting Wb Secunty Manager Securty Services Network Syatermn Admurestration

Log Subscriptions
£4d Log Subsanptee,. ]

Rellover
Lo Films Interval Baliumr

PoDEDEENONDUENYDDDDD® ]

Log Mams

=t

Hane

Hene

s Mene
Hizne
s | Mone
Mene
Feedsd Logs Mane
FIPS Logs
FTP Server Lags
GUT Logs
Haysteck Logs
Diata Seeunty Logs
Logging Logs

Mane
Mane
Mane
Mane
Mane

Hane

2. Click Add Log Subscription.
Select Access Logs for Log Type. (These are the logs of client web requests that have gone
through the proxy.)

4. Enter a name for Log Name.
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. Cisco Web Security Virtual Apel - _

& c A Not secure| coeus.di.ipdr:8080/system_administration/log_subscriptions

sl Cisco SO00V

Cisco

ecurity Virtual Appliance

ON ypgrade Available =

i 6

Logged in as: admin on coeus.di.ipdr

My Favorites - Options - Support and Help -

] Reporting ‘Web Security Manager

Security Services Netwaork System Administration

New Log Subscription

Log Type:

| Access Logs A

No Changes Pending

Log Subscription

Log Name:

Jaccess Logs Arcsight Forwarding
(will be used to name the log directory)

Rollover by File Size:

100M Maximum

(Add = trailing K or M ta indicate size units)

Ralloer oy Time:
Log Style: | @ squid
) Apache

(r Squid Details

Custom Fields (optional):

| Custom Fields Reference &

File Mame:

Jaclog

Log Compression:

[ Enable

Log Exclusions (Optional):

—

(Enter the HTTP status codes of transactions that should not be included in the Access Log)

Retrieval Methed:

O |FTPon coeus.di.ipdr

Maximum Number of Files:

100

| FTP on Remate Server

FTP Host: ‘ |

Activd

Ga:10 5

Select Syslog Push.

® N oo

Enter the hostname of the ArcSight syslog collector server.

Enter 8192 or a custom message-size limit.

Select TCP. (Ensure that your syslog collector server is configured to use TCP.)
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Cisco Web Security Virtual Appli- X

€ > C @ Notsecure | coeus.diipdr8080/system_administration/log_subscriptions?action=Edit&CSRFKey=3a09cb45-15fa-cc.. 37 9

Retrieval Method: | (O

FTP on coeus.di.ipdr

Maximum Number of Files:

100

@

FTP on Remote Server

FTP Host:

Directory:

Username:

Passphrase:

SCP on Remote Server

SCP Host:

| sCP Part: o2

Directory:

Username:

Enable Host Key Checking

® Automatically Scan
Enter Manually

Syslog Push

Hostname:

Ibackupserv.di.ipdr

Protocol:

O upp ® Tep [

Maximum message size:

[p192

Facility:

user v

Cancel

9. Click Submit.
10. Click Commit Changes.
11. Enter a comment if desired.
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ity Cisco Web Security Virtual Applic X

< C A Notsecure | coeus.diipdr8080/commit?referrer=http://coeus.diipdr:B080/system_administration/log_subscriptions r O

ol | 1l | 1. Cisco S000V @ Logged in as: admin on coeus.di.ipdr

CISCO Web Security Virtual Appliance My Favorites - Options - Support and Help -

A Reporting Web Security Manager Security Services Hetwork System Administration

Uncommitted Changes

Attention — 4 In order to process these changes, the proxy process will restart after Commit. This will cause a
brief interruption in service. Additionally, the authentication cache will be cleared, which might
require some users to authenticate again.

Commit Changes

You have uncommitted changes, These changes will not go into effect until you commit them,

Comment (optional): ILug forwarding [%
Abandon Changes || Show Changes Commit Changes

Copyright @ 2003-2017 Cisco Systems. Inc. All rights reserved. | Privacy Statement

12. Click Commit Changes. The server will restart, so the web page connection will be temporarily
lost.

2.26 Integration: Micro Focus ArcSight and Cisco ISE

This integration briefly details how to send logs to an ArcSight syslog collector from Cisco ISE. Please see
Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already configured,
you do not need to install a new one-—simply forward logs to the address of that server.

2.26.1 Configure Cisco ISE to Forward Logs

1. Inthe Cisco ISE web client, navigate to Administration > System > Logging > Remote Logging
Targets.
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M et S Baghne * _

I < =+ C & Notseoure | kitpsy/cisco-isediipdr/admin/sadmini Jging/remate._log w O
. 1 License Waming &
*System | b Kdentity Management  » Network Rescurces  » Device Portal Management Grid Services  » Feed Service  » Threat Cen |
i Chick here 10 do wireless saiup and vissilty setup Do not show §
Deployment  Licensing  » Certificates  ~Loggng  » Mamtenance  Upgrade  » Backup & Restore ¢ Admin Access  # Softngs
o
Local Log Settings Remote Logging Targets .
Selected 0 | Total < §
Remate Lagging Targets s L
Feot oifndd Qybecioe | 3 Deleto Show [ Al
Loggng Categones = —————
e Name: - P Address Port Type Description St
Message Catalog O LogCollector 137,001 20514 LDP Sysiog Sysioxg Taget for Log Collector BEn)
Debug Log Configuratan 0 ProfilerRadisProbes 127.0,0.1 0514 Profiler Syslog Syshag Target for Profiler RADIUS Probe BEn
Colieetion Fiess O SecureSysiogColecios 127.0.0.4 6514 Secure Syslog Sacure Syslog Collector BEn|
O TCPLogCollecion 127.0.0.1 1468 TCP Syslog TCP Syslog collector & 0ef
‘ »
Click Add.

Enter a Name.
Enter the hostname of the ArcSight syslog collector server for Host/IP Address.

vk W

Select TCP SysLog for Target Type. (Ensure that your syslog collector server is configured to use
TCP.)

Enter 514 or the port used on the syslog server.

7. Enter 8192 or a custom message-size limit for Maximum Length.

8. Ensure that Status is set to Enabled.
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& Identity Services Engmne ®

€ = C A Motsecure | ipsy/eisco-ise.diipdr/ad . oy ion_syst o _system_logging/  log * @

Identity Services Engine

ity » Operations b Pokey  [REESSTETY

- ¥ Identity Management b Network Resowces  » Device Portal Management  pind Serices. b Feed Senace & Theeat Cen
o Click here 0 do wireless setup and visiidy setup Da ot show

Deployment  Licensing b Cestficates ~logging  » Maindenance  Upgrade  » Backup & Restore  » Admin Access  » Sehiings

Remote Loggng Targets List = New Logging Target

LLocal Leg Ssmngs
Remote Loggng Tarpets Logaea Taiget " X
e *Name [ Arcsone IR T I |
Mhestage Colaioy Description | statis [ Enabled ~
Debug Lag Canfiguraton *Host 1P Address. | badkupsery.diipdr ]
Collecton Fiters “Pont [S14 | (valia Range 1 1o 85535
Facy ot
*Masmum Length [8182 | (Vabd Range 20010 8192)

Include Alarms For this Target ]

Bufter Messages When Server Dosn
Enabie Server tdensty Check )
Butler Size (MB) | 100 (Walid Range 10 to 100)
Reconnect Timecut (Sec) [30_ | (Vald Range 30 10 120)

 cyor QRSN

& Identity Services Engmne

€ = C & Motsecure

You have chosan to ereate an unsacure (TCR/UDP) connaction to tha server, Are you sure you want i procesd?

10. Click Yes.
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2.26.2
1.

Select Logs for Forwarding

Navigate to System > Logging > Logging Categories.

& identity Services Engine

e >

abale |dentity Services Engine

* Sysiem
Deployment  Licensing
Local Log Setings
Remote Leggng Targels
Logging Calegones
Message Catalog

Debug Log Configuration
Coliechon Filters

» Identity Management

 Certificates

Homwe:

» Network Resources

» Device Porial Management

=Logging  k Maintenance  Upgrade
AAL Audit
(0]
(@]
O AAA Diagnostics
0
(@]
0
(o]
0]
(@]
o]
(0]
o}
O Accounting
® k
(0]
O Admmistrative and Operabonal Audit

2. Select a log file to forward to ArcSight.
3. Click Edit.

@ Identity Sennces Engine

C A Notsecure | kitps://cisco-ise.diipdr/admin/fadministration/administration_system/administration_system_logging...

¥ Pohcy = Adminislration » Wl
pxGrid Services  » Feed Service  » Threat Cen
- Chck here to do wireless
b Backup & Restore b Admin Access  » Seftings
AR Asclit LogCollector
Faled Attempls LogCollector ProfiferRadisPro
Passed Aulhentications LogCollector ProfilerRadivsPro
ANA Diagnostics LogCallector
A h and ArcSight
Authenbicabon Fiow Dhagnostics
Identity Stores Diagnostics
Paolicy Diagnostics,
RADIUS Diagnostics LogCollector
Guest LogCollector
MylDevices LogCallector
AD Connector LogCollector
TAGALS Dragroshcs LogCollector
Accounting LogCallector
RADILIS Accounting cryptonite, cryptonite?, LogCall
TACACS Accounting LogCollector
Admanistratve and Operabonal Avdil LogCollector

C A Notsecure | hitps//cisco-ise.diipdr/admin/#administration/administration_system/administration_system_logging... ¥

Identity Services Engine

* Syslem
Deployment  Licensing
Local Log Settings
Remote Logging Targets
Logging Categonies
Message Catalog

Debug Log Configuration
Caollection Filters

4

» Identity Management

* Network Resources.

b Certificates

b Context Visibality

» Device Portal Management

¥ Operations

» Pohcy

pxGnd Services

¥ Feed Service

» Work Centers

¥ Threat Cen

Click here o do wireless.
=Logging  » Maintenance  Upgrade  » Backup & Restore  » Admin Access  » Settings
—————
Logging C. List > RADTUS Ac
Logging Category
Name RADIUS Accounting
Log Seventy Level INFO
( Log bevel can not be changed. )
Local Logging 4
Tergens Avaitable; Selected:
SecureSyslogCollector . | | ArcSight 73
© | |eryptonite
— | |cnyplonite?
= LogCollector
ProfilerRadiusProbe [y
L> |
- « -
¥

4. Move the ArcSight logging target you just created to the Selected box.
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@ Identity Services Engine

L2 C A Notsecure | h#ps//cisco-ise.diipdr/admin/#administration/administration_system/administration_system_logging...

asco Identity Services Engine Home: ¥ Confext Visiility ¥ Operations. ¥ Policy = Administration » Work Centers

~System | ¥ identity Management  » Network Resources ¢ Device Portal Management  peGrid Senvices  » Feed Service  » Threal Gen

Deployment  Licensing ¢ Cenificates  =Llogging  » Maintenance  Upgrade  » Backup & Restore ¢ Admin Access  » Settings
LogCellecior

e ProflerRadsusProbe
Local Log Sethings
b
Remote Logging Targets -
Logging Categories »| | « -

Message Catalog

e
Debug Log Configuration iy | fleset |

Collection Filters

+ B

r

Click here to do wireless

5. Click Save.
6. Repeat steps 1-5 for any log files you wish to forward to ArcSight.

2.27 Integration: Micro Focus ArcSight and Symantec DLP

This integration briefly details how to send logs to an ArcSight syslog collector from Symantec DLP. If a

server is already configured, you do not need to install a new one—simply forward logs to the address of

that server. It is important to note that DLP requires a UDP server, so a TCP syslog server will not work.

2.27.1 Install Micro Focus ArcSight

1. Run ArcSight-7.9.0.8084.0-Connector-Win64.exe on any server except the one running Cisco

Stealthwatch.
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<CArcSight | [CIFLERE

=» Introduction

@ Choose Install Folder
@ Choose Install Set
@ Pick Shortcut Folder
@ Pre-Install Summary
@ Installing...

® Upgrade

@ System Restart

@ Install Complete

(= [= |

Introduction

ArcSight SmartConnector

The ArcSight Installer will guide you through the installation
ofthe ArcSight SmartConnector.

The first step installs the core ArcSight SmantConnector
components; then you selectthe ArcSight SmatConnector
you wish to configure.

ArcSight recommends that you quit all other programs
before continuing with this installation. E[%

Clickthe Mext' button to proceed to the next window.
Ifyou wantto change something on a previous window,
click the 'Previous' button. To cancel this installation at
any time, click the 'Cancel’ button.

Previous

2. Click Next.
Enter C:\Program Files\ArcSightSmartConnectors\WindowsUDP.

3.

< ArcSight | [IFLER

ma

+ Introduction

=» Choose Install Folder
@ cChoose Install Set
@ Pick Shortcut Folder
@ Pre-nstall Summary
® Installing...

® Upgrade

@ System Restart

@ Install Complete

[= = |

Choose Install Folder

ArcSight SmartConnector

Please choose the installation folder. It is recommended that you
choose the folder name according to the device that you want to
connectto, for example iciscoids or/checkpointng. If you are
upgrading from a previous version, please select the folder where the
ArcSight SmanConnector is currently installed.

Where Would You Like to Install?
C:\Program Files\ArcSightSmanConnectors'WindowsUDP

Restore Default Folder | | Choose...

Previous | | Next

4. Click Next.
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B ArcSight SmartConnector I;‘i-

<X ArcSight | [FLERE Pick Shortcut Folder

+ Introduction Where would you like to create product icons?
+ Choose Install Folder
+ Choose Install Set

® In a new Program Group: | ArcSight SmartConnectors

= Pick Shortcut Folder O Inthe Start Menu

@ Pre-Install Summary O Onthe Deskiop

® Installing...

@ Upgrade ) In the Quick Launch Bar

® System Restart
@ Install Complete

O Other: Choose...

(O Dont create icons

[] Create Icons for All Users

Previous | I Next %J

5. Click Next.

B ArcSight SmartConnector = || = -

< ArcSight | [IFAERE Pre-Install Summary

+ Introduction Please Review the Following Information Before Continuing:
+ Choose Install Folder
+ Choose Install Set

+ Pick Shortcut Folder

- Pre-Install Summary Install Folder:
C\Program Files\ArcSightSmartConnectors\Windows UDP

Product Name:
ArcSight SmanConnectar

® Installing...
® Upagrade Shortcut Folder:
® System Restart Clsers\ddministrator. DlAppData\RoamingiMicrosofttWindows\Ste

@ Install Complete

Previous || Install

6. Click Install.
7. Select Add a Connector.
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B Connector Setup == -

What would vou like to do?

<X ArcSight

Configure

(@) Add a Connector

() 5et Global Parameters

8. Click Next.
9. Select Syslog Daemon.

B Connector Setup =-|0 -

Select the connector to configure

<L ArcSight

Configure

Type Eyslog Daemon v

< Previous ‘ | Next > | | Cancel

10. Click Next.
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11. Enter an unused port on which the daemon can run. (Ensure that this port is allowed through

the firewall.)
12. Select UDP for Protocol.

[ x| Connector Setup |;|i-
. Enter the parameter details
<X ArcSight
Configure
Network Port |6514
IP Address  |(ALL)
Protocol upP W
Forwarder false Y
< Previous | | Next = | | Cancel

13. Click Next.
14. Select ArcSight Manager (encrypted).
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B Connector Setup -0 -

Enter the type of destination

<X ArcSight

Configure

(®) ArcSight Manager (encrypted)

() ArcSight Logger SmartMessage {encrypted)

() ArcSight Logger SmartMessage Pool (encrypted)
() CEF File

() Event Broker

() CEF Syslog

(_) CEF Encrypted Syslog (UDP)

() C5V File

() Raw Syslog

s

< Previous | | Next> | Cancel

15. Click Next.
16. Enter the hostname, port, username, and password for the ArcSight ESM server.

B Connector Setup -0 -

Enter the destination parameters

< ArcSight

Configure

Manager Hostname arcsight-esm

Manager Port 3443

User administrator

Password sesnsene

AUP Master Destination | false v
Filter Qut All Events falze w
Enable Demo CA false W

< Previous | | Mext = | | Cancel

17. Click Next.
18. Enter identifying details about the system (only Name is required).
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B Connector Setup -0 -

Enter the connector details

<X ArcSight

Configure

Name Windows UDP Syslog
Location
Devicelocation

Comment

< Previous | | Next > | | Cancel

19. Click Next.
20. Select Import the certificate to connector from destination.

[ = | Connector Setup == -

. Following certificate will be imported into connector trust store:
é: AfCSIght Host/port: arcsight-esm_8443
Details: CN=arcsight-esm, OU=ESM, O=Arcsight, L=05014, ST=CA, C=US

Configure

(®) Import the certificate to connector from destination

() Do notimport the certificate to connector from destination

I3

< Previous | [ Next> | Cancel
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21. Click Next.
B Connector Setup = I:'-

. Add connector Summary
{ Af(SIght Following are the added connector details:
Connector Name [Windows UDP Syslog]. Connector Type [syslog]
Configure

< Previous Mext = | | Cancel

22. Click Next.
23. Select Install as a service.
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B Connector Setup -0 -

The Smart Connector is currently installed as a standalone application

<X ArcSight

Configure

(@) Install as a service

() Leave as a standalone application

< Previous | | Next > %J | Cancel

24. Click Next.
25. Enter a service name and display name.

B Connector Setup -0 -

Specify the service parameters

<X ArcSight

Configure

Service Internal Name arc_syslog_udp
Service Display Name Syslog UCY Daemon
Start the service automatically |Yes “
< Previous | | MNext = | | Cancel
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26. Click Next.

<X ArcSight

Configure

Connector Setup
Install Service Summary
The ArcSight SmartConnector is now configured to run as a service.
You can now start the SmartConnector by:
Going to the services application and starting the service:

ArcSight Syslog UDP Daemon

Iz

| Next= | Cancel
27. Click Next.
28. Select Exit.

[« | Connector Setup I;Ii-
. Would you like to continue or exit?
<X ArcSight
Configure
() Continue
< Previous | | Mext = | | Cancel
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29. Click Next.

| ArcSight SmartConnector = | = -

<L Arcsight | [IFAETE Install Complete

<

Introduction Congratulations! ArcSight SmartConnector has been succassfully
Choose Install Folder installed to:

Choose Install Set
Pick Shortcut Folder
Pre-Install Summary Press "Done” to quitthe installer.

C\Program Files\ArcSightsmanConnectors\WindowsUDP

Installing...
Upgrade
System Restart

L O T T T U S

Install Complete

InstallAnywhere %

30. Click Done.

2.27.2 Configure Symantec DLP to Forward Logs

1. Loginto the Symantec DLP web console.

Manage System -

Policies | Policy List
Data Profiles Resleonse Rules i
Discover Scanning Datg..lentiﬂers

User Groups

Sender/Recipient Patterns

2. Navigate to Manage > Policies > Response Rules.
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‘ @ B https://127.0.0.1/ProtectManager/ResponseRuleList.do

(V) Symantec Data Loss Prevention | Home | Incidents ~ | Manage = | System = ‘
Manage > Polies > Response Rules

s T—

Order Rule Actions Conditions

https://127.0.0.1/ProtectManager/ChooseResponseRuleType.do 1]

3. Click Add Response Rule.
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- ® Symantzc Data Loss Prevention X _
Z

'.\(—/.‘ = ¢ o ‘ @ & https/127.0.0.1/ProtectManager/ChooseResponseRu e ﬁ| L In @O =
(¥ Symantec Data Loss Prevention Home | Incidents = = Manage - | System - @
Manage - Policies > ResponssRules > New Response Rule A

Cancel Nex@

Choose the type of response rule to add, then dick next

(@ Automated Respanse
These rules are automatically executed in response to policy detection rule
conditions.

(0) Smart Response
The rules are manually executed from the incident commands.

https://127.0.0.1/ProtectManager/ChooseResponseRuleType.do# [ >

Click Next.
Enter a name for the rule.

Set any conditions for sending syslog messages. If you do not add conditions, all incidents will

be forwarded.
Select Log to a Syslog Server for Actions.
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V) Symantec Data Loss Prevention X | == \;Ii-
&« c o @ & https://127.0.0.1/ProtectManager/RemoveCon B e w + N @D =
V) Symantec Data Loss Prevention | Home | Incidents ~ | Manage = | System @
Manage > Policies > ResponseRules > Configure Response Rule A
Save Cancel

General

Rule Mams || o0 Incidents

Description

Used in no

active

policies,

Conditions Add Condition

Network

Actions | Log to a Syslog Server Add Action

Response actions will be executed in order they appear belowr. Please choose one or more actions for

this rule.

< m >

8. Click Add Action.

9. Enter the IP address of the ArcSight syslog server.

10. Enter the port of the ArcSight syslog UDP server.

11. Select variables and format a log message to include all the information desired to be sent to
the ArcSight server. Below is a sample format for the syslog message, which can potentially be
parsed according to the needs of your organization.

CEF:0]Symantec|DLP]12.0.1]rulelD|$POLICY$|5]BLOCKED=$BLOCKED$
DATAOWNER_NAME=$DATAOWNER_NAME$ DATAOWNER_ EMAIL=$DATAOWNER EMAIL$
ENDPOINT_DEVICE_ID=$ENDPOINT DEVICE_1D$
ENDPOINT_MACHINE=$ENDPOINT MACHINE$ PATH=$PATH$

FILE NAME=$FILE_NAME$ PARENT_ PATH=$PARENT PATH$

INCIDENT _ID=S$INCIDENT_ID$ INCIDENT_SNAPSHOT=$INCIDENT SNAPSHOT$
MATCH_COUNT=$MATCH_COUNT$ RULES=$RULES$ PROTOCOL=3$PROTOCOL$
QUARANTINE_PARENT_PATH=$QUARANT INE_PARENT_PATH$
RECIPIENTS=$RECIPIENTS$ SCAN=$SCAN$ SENDER=$SENDER$
SEVERITY=$SEVERITY$ SUBJECT=$SUBJECT$ TARGET=$TARGETS$
FNAME=$ATTACHMENT _NAME$
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I W00 Probectianager/SelectRes X [ Guambelings fox pravsionsesg Sril X f+ Hﬂ-
« @ @ 8 hitps/127.00. ProtectManager Selectitespanseiisk B -9 n M @

V) Symanec Data Loss Prévention | Home | Incidents = | Manage = System = @

) () R *

[R T pre——

12. Click Save.

2.28 Integration: Micro Focus ArcSight and CryptoniteNXT

This integration briefly details how to send logs to an ArcSight syslog collector from CryptoniteNXT.
Please see Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already
configured, you do not need to install a new one— simply forward logs to the address of that server.
Ensure that you are using a TCP syslog collector. This section assumes that the collector is already under
CryponiteNXT’s network protection.

2.28.1 Configure CryptoniteNXT to Forward Logs to ArcSight

Navigate to the Enclave tab in the CryptoniteNXT ACC GUI.
Under SIEM Configuration, check the box next to SIEM is an internal endpoint.
Select the endpoint running the TCP syslog collector.

P wnN PR

Enter the port used.
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(] CryptoniteNXT ACC Client - User: administrator (EDIT) Licensed to nccoe-diipdr.lic.diipdr
Enable Editing Synch with Server Connected to "acc’
Refresh Registra
a Policy | B3 cryptonitenxT Nudes| a Endpoints ;?} Enclave ‘ 8 Integration ‘ @ D'sptay‘ % Software Update ‘
Encive Compltenes: | TS T
Enclave Configuration SIEM Configuration Timeout Configuration
Name: ) SIEM i 3n intemnal endpoint WMinimum hours to preserve stale registration state: 168
T diipdr Endpoint: backupserv -

Certificate Expiration:  Jul 4 18:04:14 2021 GMT

ACC Configuration

ACC Node: 13 ~
ACC Endpont:

ACC Engine NTP Servers

NTP Server: |

time-a.nist.gov
time.nist.gov

Upstream DNS Servers

192.168.1.12

(] =] [

1P Configuration
# Enable IPv6 to/from endpoints

TCP Port: 514

Whitelisted Domains

Dormain: |

*.diipdr

*.download.windowsupdate.com

*.update.microsoft.com
*.windowsupdate.microsoft.com
*.ws.microsoft.com

Endpoint Configuration
# Auto-configure endpoints' ingress gateway and IP

Apply to: [New endpoints only -

& Synchronize endpoints’ ingress IP (if set) with egress IP

Apply to: [New endpoints only B |
[T ED i Allowed via internal connection ~
Per-Endpoint Permission Level:

Apply to: [New endpoints only -]

[} synchronize endpoint's ingress IP with local IP

‘Applies to all endpaints
Registration of Unverified Endpoints
Permission Level:

) Allow endpoint moves without owner credentials

Maximum hours before logging off idle user:
Time before deregistering idle, verified endpoints:
Time before deregistering idle, unverified endpoints:

R

Time before deleting unregistered, unverified endpoints:  |720

=E |

Policy Status

Enclave Actions

License

Policy Enforcement:  Enforced Enclave-wide

[ Backup DB] [ Download Enclave State

[ Synchronize Gateways from External DNS

Licensed by CryptoniteNXT to: nccoe-dipdr.lic.di.ipdr
Domain: nccoe-dipdr.lic.diipdr
Organation: Corporate
Department: Research
Country: US
State/Province: Maryland
Email: support@cryptonitenxt.com

Start Date: 2018-09-27 04:39:46 PM UTC
End Date: 2019-09-27 12:00:00 AM UTC
Days remaining untit expiration: 16
Entitlemients: 1.F.09-27-2016.600

600 endpoints licensed (31 currently in use)

Browse for New License File

5. Click Save.

2.29 Integration: Micro Focus ArcSight and Semperis DSP

This integration briefly details how to send logs to an ArcSight syslog collector from Semperis DSP.

Please see Section 2.24 for instructions for setting up an ArcSight syslog collector. If a server is already

configured, you do not need to install a new one—simply forward logs to the address of that server.

Note: This integration requires Semperis DSP version 2.6.

2.29.1

Select TCP.

vk wN e

Configure Semperis DSP to Forward Logs

In Semperis DSP, navigate to Settings > SIEM Integration.
Check the box next to Enable SysLog.

is how often it will poll for new logs to forward.

Under Syslog Server, enter the hostname for the ArcSight syslog collector, as well as the port.

Enter a value for Change Event Polling Frequency based on the needs of your organization— this
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6. Under Change Event Filtering, select AD Changed Items, and Send Operation Log to SysLog.
Ensure that All is selected for Partitions.

7. You can also select any specific operations, classes, and attributes to be forwarded or simply
leave as All.

« B (EE |

semperis-dsp.diipdt/ DS 4siemntegrat t @

@ rominisrase ™ wosout

SIEM INTEGRATION

~
‘\“g-“'i
d
@ Enatie Syslog
o] Syui0g Server
| %
ad
Peimary Syslog Server:  backupsery di ipdr Primaty Sysiog Pert: 514 & TCP () UDP
;‘:_ '-i TS
Secondany Sysiog Server ERVE Secondary Syuog Port 514 & TeP
@) e
Change Event Polling Frequenty: 10 minutes
"’"j
| [5]
- Change Event Filtering |»5
InCluch Thise Bvents
m Coration AN IO itermy shietec) * B 4D Changed tems
s
Object Classes MO iterns seiemes v Patitons Al
a® o
. Atributes A0 iteme salectes) L=
B Send Operations Log 10 Syslog

8. Click Save.

@ Success

Syslog configuration has been saved.

9. Click Close.

2.30 Integrations: CryptoniteNXT

For the architecture, it is necessary to create the following source groups. If your organization’s desired
architecture is different from the one described in this document, it is necessary to adapt the following
instructions to avoid loss of network or security function. This section will describe the creation of
source groups and destination groups used in this enterprise.
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Create the following destination groups and source groups and apply them to the correct endpoints to

allow these products and integrations to communicate under CryptoniteNXT.

2.30.1 Active Directory and DNS

This guide assumes the use of Active Directory and DNS on the same Windows 2012 server. The

following ports may vary for other products.

Destination Source Group Protocol | Port Range
Group Name Name

ad-dns ad-dns-clients TCP 389
ad-dns ad-dns-clients uDP 389
ad-dns ad-dns-clients uDP 53
ad-dns ad-dns-clients TCP 88
ad-dns ad-dns-clients uDP 88
ad-dns ad-dns-clients TCP 25
ad-dns ad-dns-clients TCP 42
ad-dns ad-dns-clients TCP 137
ad-dns ad-dns-clients TCP 139
ad-dns ad-dns-clients TCP 53
ad-dns ad-dns-clients TCP 636
ad-dns ad-dns-clients TCP 3268:3269
ad-dns ad-dns-clients TCP 445
ad-dns ad-dns-clients ubDP 445
ad-dns ad-dns-clients TCP 9389
ad-dns ad-dns-clients TCP 5722
ad-dns ad-dns-clients TCP 464
ad-dns ad-dns-clients uDP 464
ad-dns ad-dns-clients uDP 123
ad-dns ad-dns-clients ubDP 137:138
ad-dns ad-dns-clients ubDP 67
ad-dns ad-dns-clients ubDP 2535
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Destination Source Group Protocol | Port Range

Group Name Name

ad-dns ad-dns-clients uDP 49152:65535

ad-dns ad-dns-clients TCP 49152:65535

Endpoint Source Groups Destination Groups

(all endpoints that need access | ad-dns-clients

to AD/DNS)

AD/DNS server ad-dns
2.30.2 Microsoft Exchange
This guide assumes the use of Microsoft Exchange. The following ports may vary for other products.

Destination Source Group Protocol | Port Range

Group Name Name

exchange exchange-clients TCP 443

exchange exchange-clients TCP 80

exchange exchange-clients TCP 25

exchange exchange-clients TCP 379

exchange exchange-clients TCP 3268:3269

exchange exchange-clients TCP 636

exchange exchange-clients TCP 143

exchange exchange-clients TCP 993

exchange exchange-clients TCP 110

exchange exchange-clients TCP 995

exchange exchange-clients TCP 119

exchange exchange-clients TCP 563

exchange exchange-clients TCP 465

exchange exchange-clients TCP 443691

exchange exchange-clients TCP 102

exchange exchange-clients TCP 135
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Destination Source Group Protocol | Port Range

Group Name Name

exchange exchange-clients TCP 389:390

exchange exchange-clients TCP 53

exchange exchange-clients UDP 53

exchange exchange-clients TCP 2525

exchange exchange-clients TCP 475

Endpoint Source Groups Destination Groups
MS Exchange exchange-clients exchange
(all email clients) exchange-clients

AD/DNS server exchange-clients

2.30.3 Filezilla

The default port for FileZilla is 21.

To determine the ports being used for your instance, open the FileZilla console.
Navigate to Edit > Settings > General Settings > Listen on these ports, and allow any ports listed
here.

3. If your server listens in passive mode, navigate to Edit > Settings > Passive mode settings > Use
custom port range, and allow any ports listed here.

Destination Source Group Protocol | Port Range
Group Name Name

FileZilla BackupClients TCP 21 (default—see instructions)

Filezilla BackupClients TCP 51120-511230 (passive mode—see instructions)
Endpoint Source Groups Destination Groups

(any endpoints that need to BackupClients

perform backups)

FileZilla server Filezilla
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2.304

GreenTec

If GreenTec is configured to use a FileZilla server, refer to the above section. If GreenTec is configured to

use Windows Network Share, see below for ports required.

Destination Source Group Protocol | Port Range

Group Name Name

NetworkShare | GreenTecClients TCP 80

NetworkShare | GreenTecClients TCP 135-139

NetworkShare | GreenTecClients TCP 445

Endpoint Source Groups Destination Groups

(any endpoints that need access
to GreenTec disks)

GreenTecClients

GreenTec server

NetworkShare

2.30.5

Tripwire Enterprise

In Tripwire, the Axon Bridge is used for Tripwire Enterprise to contact endpoints. Therefore, the port

5670 must be allowed on endpoints to allow TE to initiate communications. Furthermore, TE requires

MSSQL to function, so it must be granted access to that as well.

Destination Group Source Protocol | Port Range
Name Group Name
TripwireEnterprise TEClients TCP 443
TripwireEnterprise TEClients TCP 8080
TripwireEnterprise TEClients TCP 9898
TripwireEnterprise TEClients TCP 1169
TEAxon TripwireE TCP 5670
MSSQL MSSQLCli- TCP 1433

ents
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Endpoint

Source Groups

Destination Groups

(any endpoints that need to be
monitored by Tripwire Enter-
prise)

TEClients

TEAXon

Tripwire Enterprise server

TripwireE, MSSQLClients

TripwireEnterprise

MSSQL server MSSQL
2.30.6 ArcSight ESM
Destination Source Group Protocol | Port Range
Group Name Name
ArcSight ArcSightConnect- | TCP 8443
ors
Endpoint Source Groups Destination Groups

(any endpoints with an ArcSight
Connector installed)

ArcSightConnectors

ArcSight ESM server

ArcSight

2.30.7 Cisco ISE

Please see the CryptoniteNXT Generic RADIUS Integration Guide for instructions on how ISE should be

integrated with CryptoniteNXT.

To access the web console for ISE, allow port 443 for any machines that should be able to access the ISE

administrative console.

To access the portal for ISE, allow port 8443 (default) for any machines that will need to access the

portal. You can find this value by looking at your portal configuration in ISE.

Furthermore, if RADIUS is configured for the posture integration, you will need to add any ports used in
RADIUS for both ISE and the internal switch. The default for these is 1812 (Authentication), 1813
(Accounting), and 1700 (CoA). RADIUS can be TCP or UDP, so you can restrict this to your organization’s

configuration.
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Destination Source Group Name Protocol | Port Range

Group Name

ISE ISEConsole TCP 443

ISE ISEClients TCP 8443

radius ISESwitch, ISEServer TCP 1812

radius ISESwitch, ISEServer uDP 1812

radius ISESwitch, ISEServer TCP 1813

radius ISESwitch, ISEServer uDP 1813

radius ISESwitch, ISEServer TCP 1700

radius ISESwitch, ISEServer ubDP 1700

Endpoint Source Groups Destination Groups
(any endpoints that need to do | ISEClients

posture under ISE)

(any endpoints that need to ac- | ISEConsole

cess the ISE web console)

ISE server ISEServer ISE, radius
(internal switches or RADIUS ISESwitch, ISEClients radius
servers used for ISE Posture)

Cryptonite ACC Node radius

2.30.8 Semperis DSP

Semperis DSP recommends allowing full network access during the initial database sync. After that, the

following ports should be left open for communication.

Destination Source Group Protocol | Port Range
Group Name Name

dsp dsp-admin TCP 443

dsp dsp-agents TCP 8903

dsp dsp-agents TCP 135

dsp dsp-agents TCP 445
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Destination Source Group Protocol | Port Range

Group Name Name

dsp dsp-agents TCP 1024:1034

ad-dsp dsp-client TCP 8772

ad-dsp dsp-client TCP 8750

ad-dsp dsp-client ICMP 0:255

Endpoint Source Groups Destination Groups

(any endpoints that need admin
access to DSP)

dsp-admin

Semperis DSP ad-dns-clients, dsp-client, ex- dsp
change-clients
Active Directory server dsp-agents ad-dsp

2.30.9 Symantec DLP

This largely depends on how distributed the setup of DLP is. See here for a list of ports required by

Symantec DLP: https://support.symantec.com/us/en/article.tech220846.html.

For this build, we used a single server that contained the database, so only the agents and

administrative clients needed to be allowed to communicate through Cryptonite.

Destination Source Group Protocol | Port Range
Group Name Name

dip dlp-admin TCP 443

dip dlp-clients TCP 10443

2.30.10 Cisco WSA

WSA uses a proprietary command line, which means it does not have a way of authenticating to the

CryptoniteNXT portal. For devices such as this, there are two options.

1. The device can be left outside CryptoniteNXT.

2. The device can be placed under CryptoniteNXT on a CryptoniteNXT Endpoint Node with the

portal disabled.
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To prevent MAC spoofing, by default Cryptonite pins MAC addresses to the port + VLAN (Virtual LAN) to
which a device is connected, so a malicious device connecting to the end-point node with the same
MAC as an already connected IP360 would still be required to authenticate. Physical security for the
end-point node can further mitigate concerns about MAC spoofing.

If you can find a way to authenticate WSA to CryptoniteNXT or decide to use the disabled portal option
with strong physical security, we provide the ports below for integration.

To access the web console for WSA, allow port 8080 for any machines that should be able to access the
ISE administrative console.

To access the proxy, allow port 80 and port 3128 for any machines that will need to go through the
proxy, which will likely be most clients in the enterprise. Port 80 is for the wpad.dat file, and port 3128
is for the proxy itself.

Destination Source Group Name | Protocol | Port Range

Group Name

wsa wsa-clients TCP 80

wsa wsa-clients TCP 3128

wsa wsa-admin TCP 8080

Endpoint Source Groups Destination Groups
(any endpoints that need to use | wsa-clients

the proxy to connect to the in-

ternet)

(any endpoints that need to ac- | wsa-admin

cess the WSA web console)

Cisco WSA wsa

2.30.11 Tripwire IP360

IP360 uses a proprietary command line, which means it does not have a way of authenticating to the
CryptoniteNXT portal. For devices such as this, there are two options.

1. The device can be left outside CryptoniteNXT.
2. The device can be placed under CryptoniteNXT on a CryptoniteNXT Endpoint Node with the
portal disabled.
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To prevent MAC spoofing, by default Cryptonite pins MAC addresses to the port+VLAN to which a
device is connected, so a malicious device connecting to the end-point node with the same MAC as an
already connected IP360 would still be required to authenticate. Physical security for the end-point
node can further mitigate concerns about MAC spoofing.

If you can find a way to authenticate IP360 to CryptoniteNXT or decide to use the disabled portal option
with strong physical security, we provide the ports below for integration.

To access the web console for IP360, allow port 443 for any machines that should be able to access the
IP360 administrative console.

IP360 should have access to all ports of the client machines it needs to scan. Another option is to simply
add IP360 to all the source groups present in your enterprise, and it will give an overview of the
vulnerabilities of clients on ports that CryptoniteNXT is not actively protecting. Alternatively, you can
disable policy enforcement temporarily on the CryptoniteNXT Endpoint Node to which IP360 is
connected, but you should do this only during scans.

Destination Source Group Name | Protocol | Port Range

Group Name

ip360 ip360admin TCP 443

scantarget ip360scanner TCP 1:65535

scantarget ip360scanner UDP 1:65535

scantarget ip360scsanner ICMP 0:255

Endpoint Source Groups Destination Groups
(any endpoints need to access ip360admin

the IP360 web console)

(any endpoints to be fully scantarget
scanned by IP360)

IP360 ip360scanner ip360

2.30.11.1 Tripwire Log Center; Tripwire IP360, Tripwire Enterprise, and ArcSight ESM

The guide details an integration among Tripwire IP360, Tripwire Enterprise, Tripwire Log Center, and
ArcSight ESM. This section describes the ports needed to allow the integrations through Cryptonite.
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First, traffic must be allowed from Tripwire Log Center to the MSSQL server. To do this, ensure that

Tripwire Log Center can access 1433 on the MSSQL server. (Note: Tripwire Enterprise also has access to

this port, as described above in the Tripwire Enterprise section.)

Then traffic from Tripwire Enterprise to Tripwire Log Center should be allowed on ports 8091 and 1468.

Traffic from IP360 to Tripwire Log Center should be allowed on port 22 for the SFTP (Secure FTP)
transfer. Also, traffic from Tripwire Log Center to 5670 on Tripwire IP360 should be allowed. If you

chose to leave IP360 out of the Cryptonite NXT enclave, Tripwire Log Center will need to be able to

reach it externally.

Traffic from Tripwire Log Center to the machine containing the ArcSight TCP syslog container should be
allowed on the port configured (in the guide, we use port 514). As a last note, the server running the

ArcSight syslog connector requires an IP and not a hostname for its integration with Tripwire Log

Center—you must set a static IP for the connector server in Cryptonite and enter this IP in the

appropriate place in Tripwire Log Center’s configuration.

Destination Group Source Group Name | Proto- Port Range
Name col
MSSQL MSSQLClients TCP 1443
TLC TLCClients TCP 8091
TLC TLCClients TCP 1468
TLC TLCClients TCP 22
ArcSightTCPSysConn | TCPSysClients TCP 514
ip360 ip360admin TCP 5670
Endpoint Source Groups Destination Groups
Tripwire Log Center TCPSysClients, MSSQLClients, TLC
ip360admin
Tripwire Enterprise TLCClients
(server running ArcSight TCP ArcSightTCPSysConn
syslog connector)
MssQL MssaL
IP360 TLCClients ip360
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2.30.12 FileZilla and ArcSight

The guide details an integration between FileZilla and ArcSight ESM to forward logs from FileZilla to
ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.

Because this integration involves the use of an ArcSight Connector directly on the FileZilla server, only
one port is needed. The FileZilla server should be able to directly communicate with 8443 on the
ArcSight ESM server.

Destination Source Group Name Protocol | Port Range

Group Name

ArcSight ArcSightConnectors TCP 8443

Endpoint Source Groups Destination Groups
Filezilla ArcSightConnectors

ArcSight ESM ArcSight

2.30.13 Cisco ISE and ArcSight

The guide details an integration between Cisco ISE and ArcSight ESM to forward logs from ISE to
ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.

Traffic from Cisco ISE to the machine containing the ArcSight TCP syslog container should be allowed on
the port configured (in the guide, we use port 514).

Destination Group | Source Group Name | Protocol | Port Range

Name

ArcSightTCPSysConn | TCPSysClients TCP 514

Endpoint Source Groups Destination Groups
Cisco ISE TCPSysClients

(server running ArcSight TCP ArcSightTCPSysConn
syslog connector)
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2.30.14 Cisco WSA and ArcSight

The guide details an integration between Cisco WSA and ArcSight ESM to forward logs from WSA to

ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.

Traffic from Cisco WSA to the machine containing the ArcSight TCP syslog container should be allowed

on the port configured (in the guide, we use port 514).

Destination Group Source Group Name | Protocol Port Range

Name

ArcSightTCPSysConn | TCPSysClients TCP 514

Endpoint Source Groups Destination Groups
Cisco WSA TCPSysClients

syslog connector)

(server running ArcSight TCP

ArcSightTCPSysConn

2.30.15 Semperis DSP and ArcSight

The guide details an integration between Semperis DSP and ArcSight ESM to forward logs from DSP to

ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.

Traffic from Semperis DSP to the machine containing the ArcSight TCP syslog container should be

allowed on the port configured (in the guide, we use port 514).

Destination Group Source Group Name | Proto- Port Range

Name col

ArcSightTCPSysConn | TCPSysClients TCP 514

Endpoint Source Groups Destination Groups

Semperis DSP

TCPSysClients

syslog connector)

(server running ArcSight TCP

ArcSightTCPSysConn
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2.30.16 Symantec DLP and ArcSight

The guide details an integration between Symantec DLP and ArcSight ESM to forward logs from DLP to

ArcSight. This section describes the ports needed to allow the integrations through Cryptonite.

Traffic from Symantec DLP to the machine containing the ArcSight UDP syslog container should be

allowed on the port configured (in the guide, we use UDP and port 6514).

Destination Group Source Group Name | Proto- Port Range

Name col

ArcSightTCPSysConn | TCPSysClients ubDP 6514

Endpoint Source Groups Destination Groups

Symantec DLP

TCPSysClients

(server running ArcSight TCP
syslog connector)

ArcSightTCPSysConn
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ACC
AD
ADFR
CoA
DDNS
DHCP
DNS
DSP
ESM
FTP
FTPS
GUI

s

ISE

IT

JCE
JRE
LAN
LDAP
mssQL
NAT
NCCoE
NIST
(o}
PAC
RADIUS
SDK
SFTP
SNMP
saL
TE

TLC
VLAN
WDV
WORM
WPAD

Administration Control Center

Active Directory

Active Directory Forest Recovery
Change of Authorization

Dynamic Domain Name System
Dynamic Host Configuration Protocol
Domain Name System

Directory Services Protector

Enterprise Security Manager

File Transfer Protocol

File Transfer Protocol over TLS
Graphical User Interface

Internet Information Services

Identity Services Engine

Information Technology

Java Cryptography Extension

Java Runtime Environment

Local Area Network

Lightweight Directory Access Protocol
Microsoft SQL

Network Address Translation

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
Operating System

Proxy Auto Config

Remote Authentication Dial-In User Service
Software Developer Kit

Secure FTP

Simple Network Management Protocol
Structured Query Language

Tripwire Enterprise

Tripwire Log Center

Virtual LAN
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